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Preface

The endoplasmic reticulum (ER) is a truly multifunctional organelle, displaying a wide range
of structural, biosynthetic and metabolic functions. The network of tubules and sheets
(cisternae) bounded by a single membrane effectively bisects the cytosol into two phases,
a reducing cytosol and oxidative ER lumen, and the ER itself thus has two membrane
surfaces and its lumen with which to support its biosynthetic capabilities.

As the first organelle of the secretory pathway, the ER is perhaps best known for its role
in the co- and post-translational glycosylation and folding of proteins destined for post-
Golgi secretion and the associated quality control of the cargo prior to export to the cis-
Golgi [1, 2]. The list of the other functions of the ER is far too long to discuss in detail but
includes: lipid biogenesis [3], the biogenesis of storage protein bodies in cereal seeds [4, 5],
the biogenesis of oil bodies [6], immunity [7], biogenesis of peroxisomes [8, 9] and calcium
homeostasis [10]. More recently, the ER has been linked to autophagy and the generation of
the phagophore membrane [11, 12]. The cytosolic membrane surface also supports a range
of enzymic activities including hosting enzymes involved in the biosynthesis of hormones
such as auxin [13], which are perhaps organised into biosynthetic complexes known as
metabolons.

Besides the extensively studied ER–Golgi interactions, it is now becoming clear that the
ER interacts and may indeed form direct connections with other cellular organelles,
although the study of the function of these is still in its infancy. For instance, there is an
ungated connection with the outer nuclear envelope [14], transport of key plastid enzymes
possibly via a close association of chloroplast stromules (tubular membrane extensions from
the plastid surface) with the ER [1] and recently characterised contact sites with the plasma
membrane which could facilitate exchange of lipids and signalling molecules as well as
stabilising the ER network [15].

In this volume, we present a range of different techniques that have been used to
characterise the structure and function of the higher plant ER. These include the application
of modern microscopy techniques by fluorescence and electron microscopy, new protocols
for analysing ER network structure, methods to purify and analyse ER membrane structure
and to study protein glycosylation, protocols to study the unfolded protein response and the
role of the ER in autophagy.

Oxford, UK Chris Hawes
Verena Kriechbaumer
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Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263

viii Contents



Contributors
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Chapter 1

Labeling the ER for Light and Fluorescence Microscopy

Chris Hawes, Pengwei Wang, and Verena Kriechbaumer

Abstract

The ER is a highly dynamic network of tubules and membrane sheets. Hence imaging this organelle in its
native and mobile state is of great importance. Here we describe methods of labeling the native ER using
fluorescent proteins and lipid dyes as well as methods for immunolabeling on plant tissue.

Key words Endoplasmic reticulum, Labeling, Fluorescent protein, Stable expression, Transient
expression, Immunofluorescence, Fluorescent dyes

1 Introduction

The endoplasmic reticulum (ER) forms a dynamic, continually
changing network of tubules and membrane sheets or cisternae
that ramify throughout the cytoplasm of cells. As such in order to
appreciate its true nature, it is often necessary to image the organ-
elle in its native state in living cells. For convenience it is often best
to think of the ER as two interconnected populations of tubules
and cisternae. Firstly, there is the geometrical cortical network,
which overlies the cortical cytoskeleton and is connected to the
plasma membrane at specific contact points [1]. Secondly, cytoplas-
mic ER often rapidly streams and also transverses the vacuolar
lumen via transvacuolar strands.

Two strategies are available for imaging the ER in its native
form. A number of different probes have been used to directly label
the ER in living cells. Most of them are not 100% specific for the ER
membrane andmay label other organelles at varying concentrations
and incubation times. Two probes with different emission wave-
lengths which are relatively easy to use on a range of plant tissues are
the rhodamine B hexyl ester [2] and 3,30-dihexylocarbocyanine
iodide (DiOC6, green emission) [3, 4]. Expression of fluorescent
protein constructs which are targeted to the ER is another efficient
strategy for in vivo labeling. It is possible to use labeled proteins or
peptide sequences that are targeted to the ER membrane [5, 6];

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
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although on occasions these can perturb the membrane and alter
the structure of the ER network [5, 7, 8]. Alternatively a simple
construct comprising a signal sequence and fluorescent protein
with a KDEL or HDEL retrieval motif spliced to the C terminus
is sufficient to label the lumen of the ER and is often the construct
of choice [10].

Immunocytochemistry is an important technique for locating
native proteins and confirming the validity of the location of fluo-
rescent protein constructs. Many different preparative techniques
for the immunofluorescence labeling of plant proteins have been
described over the years, including production of single cells by
enzyme digestion (the root squash technique), cryo-sectioning,
wax or resin embedding and sectioning [11]. Here we describe a
modification of the root squash technique to permeabilize root tip
cells and the freeze shatter technique developed by Wasteneys et al.
[12] that permits the physical rupture of arabidopsis tissues and
cells, permitting antibody penetration, and is particularly suitable
for arabidopsis seedling tissues.

In this chapter, we describe the following methods:

(a) Agrobacterium-mediated transient protein expression in
tobacco epidermal leaf cells.

(b) Stable protein expression in tobacco.

(c) Stable protein expression in arabidopsis.

(d) Immunofluorescence in arabidopsis roots.

(e) Freeze-shattering and immunofluorescence.

(f) The use of lipid dyes Rhodamine B hexyl ester or DiOC6.

2 Materials

2.1 Solutions and

Equipment

2.1.1 For Agrobacterium-

Mediated Transient Protein

Expression in Tobacco

Epidermal Leaf Cells

1. YEBmedium: 5 g/l of beef extract, 1 g/l of yeast extract, 5 g/l
of sucrose, 0.5 g/l of MgSO4·7H2O.

2. Infiltration buffer: 50 mM MES, 2 mM Na3PO4·12H2O,
0.1 mM acetosyringone and 5 mg/ml glucose.

3. Water bath.

4. Nanodrop spectrophotometer (or equivalent) to determine
optical density of bacterial culture.

2.1.2 For Stable Protein

Expression in Tobacco

1. Sterilization solution: 1:1 hypochlorite solution: dH2O, 0.01%
(v/v) Tween 20.

2. Plates with shooting medium: 2.15 g/l Murashige and Skoog
salts, pH 5.2 (without IAA, kinetin or sucrose; MP Biomedicals
Inc.), 0.8% (w/v) agar, 3.0% (w/v) sucrose, 0.1 mg/l indole
butyric acid (1.0 mg/ml stock), 0.8 mg/l 6-
benzylaminopurine (1.0 mg/ml stock), 0.1 mg/l carbenicillin,
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0.2 mg/l Ticarcillin/Clavulanic acid (Ducheva) and suitable
selection for the binary vector carrying your FP fusion con-
struct. Dissolve Murashige and Skoog salts and sucrose in
ultrapure deionized water. Add stock solutions of plant growth
regulators. Adjust the pH to 5.2 and autoclave. When the
medium has cooled to 50 �C, add filter-sterilized antibiotics
and pour into Petri dishes. Plates are kept at 4 �C in the dark.

3. Plates with rooting medium: 2.15 g/l Murashige and Skoog
salts, 0.8% (w/v) agar, 3.0% (w/v) sucrose, 0.5 mg/l indole
butyric acid (1 mg/ml stock), 0.1 mg/l carbenicillin, 0.2 mg/l
Ticarcillin/Clavulanic acid (Ducheva).

2.1.3 For Stable Protein

Expression in Arabidopsis

1. LB broth: Tryptone 10 g/l, NaCl 10 g/l, Yeast extract 5 g/l.

2. Dipping buffer: 5% sucrose, 50 μl/l Silwet L-77 in dH2O.

2.1.4 For

Immunofluorescence in

Arabidopsis Root Cells

1. MBS ester (m-maleimidobenzoyl-N-hydroxysuccinimide).

2. Fixative: paraformaldehyde (PFA) 4%, glutaraldehyde 0.5%,
EGTA 5 mM (pH 8.0), PIPES 50 mM (pH 7.0), MgSO4

2 mM, 0.01% Triton X-100 0.01% (see Note 1).

3. PBS buffer (pH 7.4).

4. Blocking buffer: PBS supplemented with 2% BSA.

5. Permeable buffer: PBS supplemented with 0.1% Triton X-100.

6. Dricelase solution: Dricelase (2%) in PBS.

7. Proteinase inhibitors: PMSF, leupeptin, and pepstatin A.

8. Liquid nitrogen.

9. Metal block and a hammer.

10. Glass Microscope slide.

11. Plastic Sieves.

12. Vectashield.

2.1.5 For Freeze-

Shattering and

Immunofluorescence

1. MBS ester (m-maleimidobenzoyl-N-hydroxysuccinimide).

2. PBS buffer.

3. Blocking buffer: PBS supplemented with 2% BSA.

4. Permeable buffer: PBS supplemented with 0.1% Triton X-100.

5. Driselase solution: Driselase (2%) in PBS.

6. Proteinase inhibitors: PMSF, leupeptin, and pepstatin A.

7. Liquid nitrogen.

8. Metal block and a hammer.

9. Glass Microscope slide.

10. Plastic Sieves.

11. Vectashield or equivalent antifade mountant.

Labeling the ER 3



2.1.6 For Lipid Dyes

Rhodamine B Hexyl Ester

or DiOC6

1. Rhodamine B hexyl ester solution: stock solution 1 mM in
DMSO, working solution 1 μM in water.

2. DiOC6 (Molecular Probes): working solution: 1.8 mM in
water.

3. 2 ml Eppendorf tubes.

2.2 Antibodies for

Immunofluorescence

Various suppliers are possible for both primary and secondary
antibodies.

1. Polyclonal mouse antibody against VAP27-1 [13].

2. Polyclonal mouse antibody against NET3C [1].

3. Polyclonal Rabbit antibody against BIP2 (Agriserum).

4. Polyclonal Rabbit antibody against HDEL (Agriserum).

5. Goat anti-rabbit FITC-conjugated antibody (Immuno Jackson
or other supplier).

6. Goat anti-mouse TRITC-conjugated antibody (Immuno Jack-
son or other supplier).

2.3 Microscopy 1. Upright or inverted laser scanning or spinning disc confocal
microscope, TIRF microscope, super-resolution fluorescence
microscope.

3 Methods

1. Agrobacterium-mediated transient expression in tobacco epi-
dermal leaf cells.

2. Stable protein expression in tobacco.

3. Stable protein expression in arabidopsis.

4. Immunofluorescence in arabidopsis root.

5. Freeze-shattering and immunofluorescence.

6. Labeling of ER with lipid dyes.

3.1 Agrobacterium-

Mediated Transient

Expression in Tobacco

Epidermal Leaf Cells

1. For agrobacterium-mediated transient expression, 5-week-old
tobacco (Nicotiana tabacum SR1 cv Petit Havana) plants
grown in the greenhouse are used. Transient expression is
carried out according to Sparkes et al. [14]. Alternatively N.
benthamiana plants are also suitable for transient expression
experiments.

2. Construct a suitable expression vector using standard molecu-
lar biology techniques such as conventional cut&paste cloning
[15] or gateway cloning [16] Table 1 lists examples for con-
structs that can be used for labeling the ER in epidermal cells.

3. Introduce the expression vector into agrobacterium strain
GV3101 by heat shock.
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4. Inoculate transformants into 5 ml of YEB medium with the
appropriate antibiotic for the bacterial vector used as well as
25 mg/l rifampicin.

5. After overnight shaking at 28 �C, pellet 1 ml of the bacterial
culture by centrifugation at 2000 � g for 5 min at room
temperature.

6. Wash the pellet twice with 1 ml of infiltration buffer and then
resuspended in 1 ml of infiltration buffer.

7. Initially dilute the bacterial suspension to a final OD600 of 0.1.
If expression is successful, then different OD600 values can be
tested to improve the expression results, or to reduce expres-
sion levels, such as OD600 of 0.05 or 0.01.

8. Carefully press the suspension through the stomata on the
lower epidermal surface using a 1 ml syringe (see Note 2).
The surface infiltrated appears darker at this point and should
be outlined with a thin black marker pen to aid removal of
correct segments of leaf for microscopy (for details see Fig. 1).

9. Inoculated plants are then incubated under normal growth
conditions for 48–72 h depending on the proteins expressed.
This will have to be determined experimentally by checking the
expression after e.g., 2, 3, and 4 days after infiltration.

10. Excised a 0.5� 0.5 cm piece of the infiltrated leaf andmount in
a drop of water and observed with a microscope (see Note 3
and Subheading 3.7).

11. Images can be recorded, e.g., using a laser scanning confocal
microscope with �63 or �100 high numerical aperture oil or
water immersion objective lenses. For imaging of combinations
of the green fluorescent (GFP) and red fluorescent protein
(RFP), samples should be excited using 488- and 543-nm
laser lines in multitrack mode preferably using line switching.
Images can be analyzed with proprietary software from the
confocal manufacturer, with commercial image analysis soft-
ware or freeware such as Fiji Image J (Fig. 2).

Table 1
Some suggested constructs suitable for imaging the ER in epidermal cells

Construct Comments Reference

SS-FP-HDEL Labels ER lumen [10]

Reticulon-FP Labels membrane of ER tubules and cisternal rims. Overexpression can
constrict tubules

[5]

Calnexin-
TMD-FP

Membrane marker—Can induce cisternae on high expression [6]

Derlin-FP Labels membrane of whole ER network [17]
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Fig. 2 GFP-labeled ER in tobacco leaf epidermal cells. The ER network is labeled with the ER membrane
localized protein TAR2 [18] fused to GFP as a fluorophore and visualized using confocal microscopy. Scale
bar ¼ 10 μm

Fig. 1 Infiltration of tobacco epidermal leaf cells with Agrobacterium tumefaciens. (a) A hole is punched into a
leaf section using a 100-μl pipette tip. (b) The bacterial suspension culture is carefully pressed into the leaf by
covering the hole with a 1 ml syringe on the lower epidermal site and a finger on the upper side. (c) As much
as possible of that leaf section is filled with the culture. (d) The infiltrated parts will show up darker now. (e)
Mark the infiltrated area with a pen. (f) Infiltrate as many leaf sections as required for the constructs tested
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3.2 Stable

Transformation of

Tobacco from

Transiently Expressing

Tobacco Cells

1. Infiltrate at least two leaves on two different tobacco plants
according to Subheading 3.1 and check the expression of the
fusion protein by microscopy. If expression is low, then repeat
infiltration until transformation levels are satisfactory and at
least 70% of the cells in the field of view on the microscope
are expressing the fusion protein.

2. Remove infiltrated leaves from the plant using scissors and
immerse them completely into sterile 500 ml beakers contain-
ing sterilization solution to remove trace amounts of Agrobac-
terium and other microbes from the leaf surface.

3. Carefully agitate the leaves for 8 min and then rinse them in a
series of three sterile beakers containing sterile water (see Note
4).

4. Using scissors cut the leaves into pieces approximately 2� 2 cm
avoiding the midrib (see Note 5).

5. Place the leaf squares onto agar plates of shooting medium plus
the corresponding antibiotics for the transformation vector
used and incubate at 25 �C, 16 h light, 8 h dark, until shoots
appear. This will take between 3–4 weeks.

6. Check regularly for contamination and, if apparent, transfer
uncontaminated pieces to plates of fresh shooting medium.

7. When shoots are present, transfer them from the tissue with
sterile forceps to plates with rooting medium. Roots will appear
within 7–10 days.

8. Check again with the microscope for expression as there may be
many shoots to deal with.

9. If the plants are expressing well, transfer them to Phytatrays or
other suitable growth containers containing 0.5% Murashige
and Skoog agar to develop until they are large enough to be
transferred to soil.

3.3 Transformation

of Arabidopsis Using

the Floral Dip Method

1. A 5 ml liquid pre-culture, inoculated from single colony of
agrobacterium, carrying the appropriate binary vector, is
grown with vigorous agitation (180 rpm) overnight at 28 �C
with the appropriate antibiotics.

2. 100 ml of LB medium is inoculated with 1 ml of the pre-
culture and shaken overnight at 28 �C and 180 rpm.

3. Decant culture into two 50 ml Falcon tubes.

4. Pellet the cells by centrifugation at 4 �Cwith 4000 rpm (1180 x
g) for 10 min. Discard the supernatant and wash the resulting
pellets by resuspension in 10 ml infiltration medium.

5. The pelleting step is repeated and the two pellets are combined
into one Falcon tube in a total of 50 ml of dipping buffer.
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6. Remove siliques from the inflorescence shoots from 2–4 plants
of Arabidopsis thaliana (wild-type Col-0) so only unfertilized
flowers remain.

7. Dip the shoots upside down into the Falcon tubes containing
the Agrobacteria suspension and soaked for 30 s.

8. After dipping seal the plants with transparent plastic bags or
cling film for the next 24 h, then remove the cover and return
plants to their normal growing conditions (see Note 6).

9. After 2–3 weeks, the plants should not be watered anymore to
allow the seeds to ripen. Plants with seeing heads should be
bagged to stop loss of material or siliques grown through
Aracon containers (Arasystem) to collect any loose seed.

10. Collect the seeds which are brown and dry (approximately after
about 6 weeks).

11. Selection of transformed arabidopsis plants is carried out by
germinating seeds collected from transformed plants on MS
plates containing 1% sucrose and the appropriate antibiotics or
herbicide depending on the vector used.

3.4 Immunofluore-

scence in Arabidopsis

Roots

This protocol is designed for immunolabeling of root tips, a similar
method and also be used for fixing cells from suspension culture
(e.g., BY2 cells).

1. Arabidopsis seedlings are grown vertically in Petri dishes for
5–7 days before fixation. The tips region (about 1 cm) are
collected and transferred into a plastic sieve (Fig. 3).

2. The fixative is prepared fresh each time. For making 10 ml,
0.4 g of PFA is added to 5 ml of ddH2O in a falcon tube. The
mixture is warmed to 65 �C in a water bath, and drops

Fig. 3 Experiment setup for immune-labeling (a) and freeze-shattering (b)
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(about 20 μl per 10 ml) of 0.1 M NaOH solution are added.
The tube is agitated periodically until the PFA is dissolved.
Cool the solution to room temperature, and add remaining
buffer components. Bring the final volume to 10 ml with
ddH2O. Finally, add Triton X-100 to 0.01% v/v (see Note 7).

3. Fix roots for 90 min, and then wash in PBS buffer three times
for 5 min each.

4. Incubate roots in a Driselase solution (2% w/v) for 7 min at
room temperature. Driselase solution is stored at �20 �C. For
each 1 ml solution, add 10 μl of PMSF (100 mM), 1 μl of
leupeptin (10 mg/ml), and 1 μl of pepstatin A (1 mg/ml)
immediately before use (see Note 8). The protease inhibitors
are there to block proteinases in the driselase solution.

5. Quickly wash roots in PBS three times, and incubate them for
15 min in PBS containing 0.1% Triton X-100 to make cells
permeable.

6. Quickly wash roots in PBS three times, and leave them in
blocking buffer for 1 h.

7. Incubate roots in primary antibody (diluted in blocking buffer,
seeNote 9) for 3–6 h at room temperature or overnight at 4 �C.

8. Wash roots in PBS buffer three times for 30 min each, and
incubate them in secondary antibody solution for 1–3 h. Anti-
bodies (e.g., FITC or TRITC conjugated) with minimal cross
activity should be used for dual labeling; this is especially
important for using primary antibodies raised in two close
related species (e.g., rat and mouse, see Note 10).

9. Wash roots in PBS buffer three times for 30 min each (seeNote
11), and mount the slide using Vectashield. Samples are now
ready for microscopy.

10. In most cases, ER bodies, a spindle-like ER-derived structure,
can be seen in wild-type arabidopsis root cells. This can affect
the visibility of the ER network (Fig. 3). To overcome this
problem, an arabidopsis mutant without ER bodies (nai1,
[19]) can be used (Fig. 3).

11. If plants expressing GFP-HDEL are used for immunocyto-
chemistry, the GFP signal can withstand fixation; therefore it
can be used as a marker to test the co-localization of any
protein of interest. As an example arabidopsis (nai1) roots
expressing GFP-HDEL were immuno-stained with anti-
NET3C antibodies (an ER-PM contact site protein). The
result indicates the endogenous NET3C localized to punctate
structure that co-aligned with the ER (see Note 12).
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3.5 Freeze-

Shattering and

Immunofluorescence

This protocol is designed for immunolabeling of whole plant tissue,
ideally for leaf epidermal cells [11]. It is based around using physical
pressure on frozen material, after fixation, to fracture the cuticles
and cell walls, thus enabling the easy penetration of antibodies.

1. Whole arabidopsis plantlets or excised leaves (10 days old)
grown in Petri dishes can be used; they are preincubated for
15 min in MBS ester (100 μM) solution. Transfer plants to
fixative (supplemented with 100 μMMBS ester) as described in
Subheading 3.4 for 1 h.

2. After incubation, wash samples twice in PBS to remove all
fixative. Transfer seedlings onto a glass slide and dry them
using tissue paper. Put another glass slide on top to make a
“sandwich” (Fig. 3).

3. Rapidly freeze the “sandwich” by immersion in liquid nitrogen,
and place it in-between two metal blocks that are also cooled in
liquid nitrogen (Fig. 3). Knock the top metal block gently with
a hammer; this will shatter the arabidopsis seedlings into small
pieces (1 mm � 1 mm, see Note 13).

4. Use cold tweezers to transfer plant pieces to a plastic sieve
(Fig. 3). Then follow the protocol in Subheading 3.4 (steps
5–9) for antibody incubation.

5. Mount the slide using Vectashield or Citifluor antifade moun-
tants. Samples are now ready for microscopy (Fig. 4).

3.6 Lipophilic Dyes

Rhodamine B Hexyl

Ester or DiOC6 for Live

Imaging of the ER

1. Whole arabidopsis seedlings 7–10 days after germination are
transferred to an Eppendorf tube containing the staining solu-
tion (Rhodamine B hexyl ester-1 μM or DiOC6-1.8 mM) and
incubated for 15 min for Rhodamine B or 10–30 min for
DiOC6 (see Note 14).

2. After incubation in the dye, transfer the seedlings to a fresh
Eppendorf tube containing water to wash off excess staining
solution.

3. Samples stained with Rhodamine B hexyl ester can be imaged
with a 514-nm line of an argon ion laser using a 458/514
dichroic mirror, and the subsequent emission can be detected
using 470- to 500-nm and 560- to 615-nm band-pass filters
(Fig. 5).

4. Samples stained with DiOC6 should be imaged with a 488-nm
line of an argon ion laser and emission can be detected at
492–629 nm.

3.7 Microscopy While it is perfectly feasible to image fluorescent endoplasmic retic-
ulum with a conventional wide-field epifluorescence microscope,
the use of a point scanning or spinning disc confocal is
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recommended. For cortical ER in epidermal cells of living tissue it is
also possible to obtain excellent images with a TIRF (Total Internal
Reflection Fluorescence microscopy).

4 Notes

1. Concentrated stock solution of PIPES, EGTA, andMgSO4 can
be made, aliquoted, and stored at �20 �C.

Fig. 4 Immunolabeling of the ER network from different cell types. (a) The ER network is labeled with anti-
HDEL in combination with a FITC-conjugated secondary antibody; ER bodies can be identified throughout the
cell. (b) Arabidopsis mutant (nai 1) transformed with GFP-HDEL does not produce ER bodies. The GFP-HDEL
labeled ER network is still strong after fixation. The ER network from root meristem cells and a dividing cell at
the anaphase is shown. For both (a) and (b), nuclei are stained with DAPI. (c) GFP-HDEL expressing root cells
(nai 1) are fixed and stained with anti-NET3C in combination with a TRITC-conjugated secondary antibody. As
demonstrated, NET3C-labeled punctate structures are localized to the ER network. (d) After freeze-shattering,
arabidopsis leaf epidermal cells are stained with anti-BIP2 (ER) and anti-VAP27-1 (ER and ER-PM contact
sites) antibodies. The ER structure is much clear and defined in leaf cells than in root tips
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2. Try to avoid large veins. A small hole may be punched into the
lower epidermis to aid infiltration.

3. For use with an inverted microscope it can be useful to stick
coverslips to the slide with a tape such as electrical tape, in order
to prevent movement of the coverslip and specimen during
observation of the specimen.

4. Make sure the leaves are not damaged by hypochlorite and
shorten the exposure time to a minimum of 5 min if necessary.
Incubations longer than 8 min will be detrimental to the tissue,
resulting in cell death.

5. From this step on throughout the following tissue culture steps
proper sterile techniques need to be applied.

6. The same plants can be dipped again about 5–7 days after the
first dipping, which can dramatically increase the transforma-
tion efficiency. Note: do not cut any siliques for the second
dipping as they might already have been successfully trans-
formed in the first round.

7. The concentration of Triton X-100 is critical here, especially for
fixing fragile ER network. High levels of detergent can destroy
the membrane structure and produce fragmented ER.

Fig. 5 Confocal image of arabidopsis reticulon6 mutant dyed with Rhodamine B
hexyl ester. The ER network is stained with the dye Rhodamine B hexyl ester and
visualized using confocal microscopy. Scale bar ¼ 5 μm
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8. After enzyme treatment, handle the roots gently to avoid loss
of tips.

9. Dilution factors vary for different antibody, 1:100–200 is
recommended to start with. For the experiments described
here, about 200–300 μl of antibody solution was sufficient to
cover root in the plastic sieve.

10. For negative controls, omit the primary antibody and the
secondary antibody only sample should not produce any signal.
Likewise with anti-peptide antibodies, the antibody in the
serum can be titrated out through addition of the peptide.

11. For nuclear staining, PBS supplemented with 10 ng/ml DAPI
or Hoechst can be used after the second wash.

12. The ER network is cisternalized in cells from root tips, and
these cells are small. Therefore, it can often be difficult to
resolve the ER membrane from the cytoplasmic signals.

13. Only a gently tap with the hammer is required. Wear eye
protection when handling liquid nitrogen.

14. Low concentrations of DiOC6 will label mitochondria.
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Chapter 2

3D Electron Microscopy of the ER

Maike Kittelmann

Abstract

The endoplasmic reticulum (ER) forms an extensive network in plant cells. In leaf cells and vacuolated root
cells it is mainly restricted to the cortex whereas in the root meristem the cortical and cytoplasmic ER takes
up a large volume throughout the entire cell. Only 3D electron microscopy provides sufficient resolution to
understand the spatial organization of the ER in the root. However, high contrast staining and optimally
ER specific staining is essential. Here we describe a protocol for selective ER staining that allows automated
or semiautomated segmentation of the organelle in 3D datasets obtained from serial sections, Array
Tomography, Serial Block Face Scanning Electron Microscopy (SBFSEM), or Focused Ion Beam (FIB)
SEM.

Key words 3D EM, Serial Block Face SEM, Endoplasmic reticulum, ZIO, Automated segmentation

1 Introduction

The plant endoplasmic reticulum has a very distinct morphology of
tubular and cisternal domains [1]. However, how they are gener-
ated and maintained and how alterations in ER morphology alter
ER function remains to be fully understood in all eukaryotic cells.
In plants, the physical nature of ER exit sites and their connection
to the Golgi apparatus [2], ER function in cell plate formation
during cell division [3], and the characterization of anchor points
of the ER with the plasma membrane [4] are still under investiga-
tion and require high resolution imaging in 3D. Light microscope
resolution is usually not sufficient to analyze these ultrastructural
details, especially not in small arabidopsis root cells. Electron
microscopy has therefore been the imaging technique of choice.
For a long time, the 3D architecture of the ER in these cells could
only be studied by serial sectioning, tomography, or high voltage
electron microscopy of thick sections (Fig. 1). However, these
techniques are either extremely laborious or would only depict a
very small area of the ER.

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_2, © Springer Science+Business Media LLC 2018
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Recent developments of automated 3D EM techniques now
enable us to study the root ER of entire cells more easily and in
more detail. FIBSEM, SBFSEM, and array tomography allow the
acquisition of hundreds of images in the Z axis, of a fairly large area
in an automated or semiautomated fashion. Especially SBFSEM has
recently become more widely used for imaging of plant tissue [5].
FIBSEM and SBFSEM are both destructive techniques where the
surface of the resin-embedded sample is scanned and then a layer is
removed by either ion beam milling (removing a layer of few
nanometers) or diamond knife sectioning (sections of at least
20 nm). Both techniques require strong pre-embedding staining
to allow sufficient signal detection without the electron beam
penetrating too far into the sample.

Fig. 1 High voltage electron micrograph of a 1 μm thick ZIO impregnated zea
root tip meristem cell. The cortical ER and the nuclear envelop (NE) are heavily
stained. Scale bar ¼ 2 μm
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Array tomography involves the collection of serial sections
which can now be automated with the ATUMtome (RMC) [6].
The sections are collected onto a moving tape and can then be post-
stained for additional contrast, immunolabeled or otherwise post-
processed and imaged repeatedly with desired settings and region
of interest (ROI) in a high resolution field emission SEM.

To allow automated or semiautomated segmentation of the
complex ER network in a 3D image stack, tissue or organelle specific
staining is essential. Automated algorithms including thresholding,
region growth, or watershed then allow unbiased 3D modeling [5].

There are two main ways to achieve selective staining of the ER:
(1) Enzyme cytochemistry, based on heavy metals as osmium or
lead salts reacting with enzyme substrates at the site of targeted
enzyme activity. For example, the inosine 50-diphosphatase
(IDPase) shows specific dictyosome staining [7] in the green alga,
Gloeomonas kupfferi. In animal cells, a horseradish peroxidase can
be targeted to the ER by fusion with the KDEL retention signal
[8]. A variety of other enzymes for plant enzyme cytochemistry
were reviewed by Sexton and Hall already in 1991 [9]. More
recently, miniSOG [10] and APEX [11] have been developed as
genetically encoded tags allowing also correlative microscopy.
However, their usefulness in plants still needs to be evaluated. (2)
Endomembrane specific staining techniques where zinc-iodide or
potassium ferryicyanide guide osmium reduction to the membrane
and cisternae of the ER [12, 13] or a combination of uranyl acetate,
copper and lead citrate that leads to selective membrane and poly-
saccharide contrast [14]. So far the zinc-iodide-osmium technique
(ZIO) is the most reliable and selective method for the ER. After
prefixation in aldehydes the tissue is incubated in a mixture of zinc-
iodide and osmium and then embedded in resin. The ER mem-
brane as well as ER lumen, Golgi bodies, and the nuclear envelop
are heavily stained, whereas other organelles show no or only very
little staining (Fig. 2).

ER network characteristics can then be quantified not only in
2D but also in 3D. Measurements of the surface area and volume
are standard options in 3D rendering programs. Algorithms that
are able to distinguish between sheets and tubules and allow the
quantification of tubule lengths and sheet size have yet to be
developed but will in the future allow the analysis of ER network
composition and changes in mutant backgrounds.

2 Materials

1. Fixative: 1% paraformaldehyde (see Note 1), 1% glutaralde-
hyde, 2% sucrose, 50 mg calcium chloride, drop of Brij.35
surfactant (see Note 2) in 0.1 M sodium cacodylate buffer
(NaCac, pH 6.9) (see Note 3).
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2. Zinc-Iodide: Add 3 g zinc to 20 ml of deionized water, add
0.5 g of resublimed iodine (see Note 4), stir for 5 min, then
filter through No. 1 filter paper.

3. Osmium: prepare 2% osmium tetroxide in deionized water (see
Note 5). Mix 2% osmium and filtered zinc-iodide 1:1 just
before adding to the sample.

Fig. 2 Arabidopsis root meristem cell stained with the ZIO technique. The endomembrane system including the
cisternal ER (cER), tubular ER (tER), nuclear envelop (NE) with clearly visible nuclear pores (NP) and Golgi
bodies (G) is heavily stained (top). Mitochondria (M) show variable staining as well. This staining technique
allows a semiautomated rendering of the ER network (green, bottom). Scale bar ¼ 1 μm
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4. EtOH dilution series and absolute EtOH dried over a
molecular sieve.

5. Spurr resin, hard (see Note 6).

3 Methods

3.1 Fixation of

Arabidopsis Seedling

for 3D EM

1. Prepare fixative and zinc-iodide.

2. Place 1-week-old seedling or cut off root and leaves (see Note
7) into small glass vial with fixative and apply mild vacuum for
1 min by placing open vial into vacuum pump (see Note 8).

3. Close glass vials and leave on rocker for 1 h at room tempera-
ture to fix.

4. Wash seedlings 2� with 0.1 M NaCac buffer for 10 min, then
1� with deionized water for 10 min.

5. Mix zinc-iodide and 2% osmium tetroxide 1:1 to make an
appropriate volume of ZIO depending on the number of sam-
ples and size of fixation vials. Remove water from samples and
add ZIO mix.

6. Leave closed vials for incubation for 4 h for roots or at least
12 h for leaf tissue to obtain sufficient staining (see Note 9).

7. Wash quickly 3� with deionized water to remove precipitates
and ZIO solution.

8. Wash 2� for 10 min with deionized water.

9. If seedlings are still intact, cut off roots to allow better dehy-
dration and resin infiltration.

10. Dehydrate tissue in ethanol series for at least 15 min per
dilution in 10%, 30%, 50%, 70%, 90%, and 100% EtOH. Dehy-
drate 2� 30 min in absolute EtOH.

11. Infiltrate with Spurr resin (seeNote 10) for at least 1 h per dilution
in 10%, 30% and at least 3 h in 50%, 70%, and 90% and 3� in 100%
Spurr (see Note 11). Mix with fresh 100% Spurr resin and pour
into flat embedding dishes or place samples into embedding
molds and polymerize for 12 h at 70 �C (seeNote 12).

4 Notes

1. 10% stock paraformaldehyde: mix 2 g of PFA in 20 ml deio-
nized water and heat up to 70 �C while stirring. When reaching
target temperature, slowly add drops of 1 M NaOH until PFA
is completely dissolved. Store in fridge.
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2. Brij.35 surfactant is used to enhance access of the fixative to the
hydrophobic leaf surface. Other or no surfactant may be used
and may result in similarly good fixation results.

3. 0.2 M stock sodium cacodylate buffer: Mix 400 ml of deio-
nized water with 21.4 g sodium cacodylate, adjust pH with
HCl and add deionized water to final volume of 500 ml. Dilute
1:1 with deionized water for 0.1 M buffer.

4. Resublimed iodine currently available from most companies
seems to cause precipitates when used in the previously pub-
lished ratio with zinc [15]. We reduced the iodine to 0.5 g per
3 g zinc and found that the precipitates disappeared almost
completely and the ZIO solution after incubation showed
significantly less precipitates.

5. If preparing osmium tetroxide solution from crystalline
osmium tetroxide, leave overnight for the crystals to dissolve
completely. Sonication speeds up the process if needed.

6. Depending on the country, Spurr resin is now available again
with ERL 4221D instead of ERL 4206 or a similarly low
viscosity resin is offered as a substitute.

7. For arabidopsis seedling roots, one can leave the seedlings
intact for at least the initial fixation step to allow easier
handling. For larger tissues and plants, cut off tissue of interest
to allow quicker diffusion of fixative into the tissue.

8. Air is extruded from the intercellular space and thus allows the
fixative to enter the leaves more easily for quicker fixation. If
only the roots are of interest, this procedure is not necessary.

9. Depending on the tissue, those incubation times vary. It’s a
good idea to run an initial experiment with three different time
points to determine the ideal incubation time to obtain enough
staining but prevent cytoplasmic precipitates.

10. We prefer Spurr resin due to its low viscosity and thus quicker
and better infiltration properties through the cell walls. Other
resins might be similarly suitable but potentially require longer
infiltration times.

11. Resin infiltration times can be shortened by mild centrifuga-
tion to about half an hour each step; however, the root tips are
very delicate at this stage and damage may occur when trying
to detach the roots from the tube wall.

12. To label the sample we print fixation date, strain, and other
important information in Arial font size 3 and place the paper
into the mold or embedding dish with the sample. Test if the
ink is stable in Spurr resin before using the label. Color printed
labels usually don’t work, therefore use the black and white
print option.
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Chapter 3

Characterization of Proteins Localized to Plant ER-PM
Contact Sites

Pengwei Wang, Chris Hawes, Christine Richardson, and Patrick J. Hussey

Abstract

Like in most eukaryotic cells, the plant endoplasmic reticulum (ER) network is physically linked to the
plasma membrane (PM), forming ER-PM contact sites (EPCS). The protein complex required for main-
taining the EPCS is composed of ER integral membrane proteins (e.g., VAP27, synaptotagmins), PM-
associated proteins (e.g., NET3C), and the cytoskeleton. Here, we describe methods for identifying
possible EPCS-associated proteins. These include GFP-tagged protein expression followed by image
analysis, and immuno-gold labeling at the ultrastructural level. In combination, these methods can be
used to identify the localization of putative EPCS proteins as well as used to postulate their subcellular
function.

Key words Endoplasmic reticulum, ER-PM contact sites, N. benthamiana, Chi-square analysis,
Immuno-gold TEM, VAP27 family, NET3C

1 Introduction

The cortical endoplasmic reticulum (ER) in plants forms a dynamic
geometrical network, and these dynamics are controlled, in part, by
the cortical actin network [1] and several members of the myosin
XII family [2, 3]. Another interesting feature of the ER network is
that it forms physical interactions with various membrane compart-
ments and organelles [4, 5] and the most well characterized to date
is the ER-PM contact/anchor site (EPCS, [6–9]). Contact sites can
be identified using electron microscopy, but their function in plants
is not fully understood, possibly due to the lack of molecular
markers and the difficulty in resolving the EPCS structure using
conventional microscopy.

Our understanding of plant EPCS at the molecular level has
increased dramatically over the last few years. Various proteins have
been reported to be associated with the EPCS [6–9], and this has
allowed studies to be carried out on the function of plant EPCS
(e.g., cargo transport, signal communication, and cytoskeleton

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_3, © Springer Science+Business Media LLC 2018
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reorganization). In this chapter, we present several methods that
can be used to confirm the EPCS localization of candidate proteins.
These include conventional light and electron microscopy
approaches, as well as immunocytochemical studies.

Fluorescent protein fusions and transient protein expression in
leaf epidermal cells (N. benthamiana or N. tabacum) are widely
accepted for studying protein localization [10] and this is the most
straightforward approach for studying putative EPCS localized
proteins in plants. But due to the nature of light microcopy,
EPCS structures can be difficult to resolve, and protein overexpres-
sion, in rare cases, can cause problems in ascertaining the endoge-
nous localization. Therefore, additional confirmation is required,
such as using electron microscopy and immuno-gold labeling.

ER-PM contact sites can be distinguished at the ultrastructural
level. Morphologically, EPCS can be defined as a region where the
two membranes are less than 10 nm apart and where ribosomes are
excluded (as suggested our study [6], and studies conducted in
yeast). At the EPCS, PM and ER membranes contact each other
but are not fused (Fig. 1). We have found that overexpression of
certain EPCS proteins (e.g., VAP27, or VAP27 and NET3C
together) can enhance the ER-PM association and, as a conse-
quence, the size of the EPCS appears enlarged [7]. Furthermore,
immuno-gold labeling can also be used to characterize the sites,
and we routinely use chi-square analysis to ensure that gold parti-
cles found at the EPCS are specifically localized and enriched. In
summary, we suggest a few methods for studying EPCS in plants
which can be used to test if a protein candidate is localized to the
ER-PM contact site.

Fig. 1 Transmission electron microscopy image of a cell from arabidopsis hypocotyl (a) and a N. benthamiana
leaf epidermal cells (b). The ER-PM contact site (arrowhead) can be observed. ER membrane and plasma
membrane are connected but not fused to each other, the average space between the membranes is less than
10 nm (scale bar ¼ 100 nm)
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2 Materials

2.1 Plant and

Microscopy Material

1. N. benthamiana or N. tabacum grown in plant growth rooms
with a 16 h day length (25 �C) and 8 h dark (18 �C) regime.
Plants around 5 weeks old are ideal for transient expression
studies.

2. Arabidopsis (Col-0) wild type or genetically transformed can be
grown either on compost or 1/2MS medium (1% Sucrose,
0.7% Plant Agar) in a growth chamber with a 16 h light
(22 �C) and 8 h dark (18 �C) regime.

3. Low melting point agarose.

4. FM4-64 membrane dye.

5. Glass slides and coverslips.

6. Razor blade.

2.2 Plasmids and

Agrobacterium

Mediated

Transformations

1. Endoplasmic reticulum markers: GFP/RFP-HDEL, Calnexin
(TMD)-GFP [6].

2. ER-PM contact site markers: VAP27-1-YFP, GFP-NET3C,
SYT1-GFP [6, 9, 11].

3. Suppressor of post-transcriptional gene silencing (PTGS):
pCB301-p19 [12].

4. Agrobacterium strain: GV3101::pMP90.

2.3 Immuno-Gold

Labeling

1. Monostep Lowicryl HM20 (Agar Scientific).

2. Mouse polyclonal antibody raised against NET3C, NAP1 [6,
13], or protein of interest.

3. 5 or 10 nm gold-conjugated goat anti-mouse antibody (British
Biocell International, Cardiff, UK).

4. Blocking buffer: PBS supplemented with BAS, 1% w/v.

5. BSAc buffer: PBS buffer supplemented with acetylated BSA,
0.1% w/v.

6. Phosphate Buffered Saline (PBS).

2.4 Computer

Programs Required

1. Image J.

2. Adobe Photoshop.

3 Methods

3.1 Live Cell Imaging

and Quick

Identification of

Immobile ER-PM

Contact Sites

The method described here can be used for a brief determination of
putative EPCS localized proteins using fluorescence protein fusions
and bacteria infiltration-mediated transient expression.
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1. Follow the leaf infiltration protocol (see Chapter 1), infiltrate
with Agrobacterium (GV3101) transformed with the relevant
construct, e.g., VAP27-1-YFP (see Notes 1 and 2).

2. Normally 48–60 h after infiltration dissect a leaf segment
(25–50 mm2) and mount on a slide with coverslip. To avoid
sample drifting during live imaging, lowmelting agarose can be
used here instead of water for mounting (see Note 3) or tape
can be used to stick coverslips to the slide.

3. Using a laser scanning confocal microscope, capture a time
series over 3–5 min (frame size 512 � 512; two times line
average; no time interval between every image).

4. Make sure samples do not drift during the image capture series,
and choose three frames at different time points and assign
them a different color. For example, use red for image at 0 s,
green for 15 s, and cyan for 30 s (Fig. 2).

5. With Adobe Photoshop, overlay three images on top of each
other andmerge them into one picture. Any persistent sites over
the time period should be colored magenta; and the color for
each point should still be distinguished for mobile structures.

6. As shown in Fig. 2a, a time series of VAP27-YFP over 30 s, each
image represents a time point and is pseudo-colored to repre-
sent the different time frames. A merged picture indicates that
the ER-PM contact sites are persistent (magenta) while the rest
of the ER network remodels. In contrast, when the same
analysis is applied to moving Golgi bodies, no persistent struc-
tures can be identified (Fig. 2b).

Fig. 2 Persistency analysis of VAP27-1-YFP labeled EPCS (a) and ST-GFP labeled Golgi bodies (b). Images
representing time points (0, 15, and 30 s) are pseudo-colored, and structures colored magenta indicates they
are persistent during the time frame, such as VAP27-1 labeled EPCS (a). In contrast, when the same analysis
is applied to moving Golgi bodies (b), no persistent structures can be identified (scale bar ¼ 5 μm)
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7. Persistent structures that appear to be localized to stable ER
nodes are likely to be ER-PM contact site associated, and can
be analyzed using the procedures detailed in Subheadings 3.2
and 3.3.

8. In addition, protein co-expression studies with EPCS markers
(e.g., VAP27, NET3C) can be used to determine EPCS locali-
zation. But care should be taken, as our recent study suggested
the EPCS in plants are likely to be represented by different
protein complexes (e.g., SYT1), which do not necessarily over-
lap (Fig. 3).

9. Further determination of ER-PM contact sites is also recom-
mended (Subheading 3.3 especially).

3.2 ImageJ Analysis

for Signal Distribution

By definition, protein complexes of EPCS must localize in-between
the ER and PM. Using fluorescent protein markers, we should be
able to distinguish distribution of the signals from the ER, PM, and
EPCS localized proteins.

1. Agrobacterium-mediated transformation and sample prepara-
tion are the same as in Subheading 3.1.

2. Dissect a leaf segment (5 � 5 mm2) and incubate it in water
solution containing FM4-64 (8 μM) for 10 min. This will stain
the plasma membrane without the labeling of endocytotic
vesicles.

Fig. 3 N. benthamiana leaf epidermal cells expressing EPCS proteins. (a) SYT1-
GFP is associated with ER-PM contact sites and the ER network labeled by RFP-
HDEL. (b) SYT1 labeled EPCS do not co-localize with RFP-NET3C, another known
EPCS protein. Most are closely attached, suggesting different populations of
EPCS exist in plants (scale bar ¼ 5 μm)
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3. Set the focal plane in the middle of the cell, and take images of
cell periphery, where cytoplasm, plasma membrane, and cell
wall can be distinguished (see Note 4).

4. Open the merged picture using ImageJ, and draw a line where
ER-PM contact sites can be identified (Fig. 4a, arrow).

5. In the Plugins option, go to Graphics and then choose RGB
Profile Plot. An image that indicates signal distribution should
appear. The signal from ER network, ER-PM contact sites, and
plasma membrane should be identifiable. For example, the
signal from EPCS structures and PM appear to be overlapped;
while ER network/cytoplasmic labeling is separated from PM
(Fig. 4b, arrow)

6. This only gives a rough idea of the signal distribution, and it
largely depends on the quality of the image. Further analysis is
required (see Subheading 3.3).

3.3 Immuno-Gold

TEM and Chi-Square

Analysis of Gold

Particle Enrichment

Protein localization at the ultrastructural level can be achieved by
immuno-gold labeling. This approach, in combination with Sub-
headings 3.1 and 3.2, can provide convincing results for determin-
ing the location of proteins and proteins of the ER-PM contact site.

1. Ideally, high pressure freezing with freeze-substitution should
be used for this purpose. It faithfully preserves cell structure
especially the plasma membrane which is important for correct
location of EPCS.

Fig. 4 Signal distribution of EPCS (a) and the ER network (b) in relation to the plasma membrane. A selected
area (arrow) was analyzed and signal from VAP27-1 labeled EPCS (green) overlaps with PM (red); whereas
signal from ER network (GFP-HDEL) is distinct from the PM (scale bar ¼ 5 μm)
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2. The protocol is adapted from [14] with some modifications.
Before high pressure freezing, the distal 1–2 mm tips of the
Arabidopsis roots (7 days after germination) were excised with
a razor blade in 20% BSA.

3. The samples were freeze-substituted in anhydrous acetone
containing 0.25% (v/v) glutaraldehyde and 0.1% (w/v) uranyl
acetate for 48 h at �80 �C, then the temperature was slowly
raised to �50 �C over a 30 h period.

4. After several rinses in anhydrous acetone at�50 �C, infiltration
continued at �50 �C into Monostep Lowicryl HM20 (Agar
Scientific) by increasing the concentration of resin to acetone
stepwise (12 h in 22%, 33%, and 66%, and then three times in
100% 96 h). Final embedding and UV polymerization was
carried out at �50 �C for 48 h followed by a slow warming to
20 �C; the polymerization then continued for a further 24 h.

5. Ultrathin sections (50–70 nm) are prepared according to [11]
and transferred onto Formvar-coated nickel grids.

6. Incubate sections for 20 min at room temperature in a PBS
buffer supplemented with glycine (0.1% w/v), and then incu-
bate for a further 30 min in a blocking buffer containing 1%
BSA.

7. Wash the grids in BSAc buffer three times for 5 min.

8. In a humid chamber, incubate the sections for a further 30 min
with primary antibody, which is diluted in blocking buffer
(dilution from 1:50 to 1:200 depends on antibody, seeNote 5).

9. After washing in BSAc buffer (3 � 5 min), incubate the sec-
tions in 5–10 nm gold labeled goat anti-mouse antibody
diluted in blocking buffer (1:20) for 30 min (see Note 6).

10. With the TEM, the structure of ER-PM contact sites can be
identified (Fig. 5). The closely associated gold particle indicates
that the protein that the primary antibody recognizes is loca-
lized to these sites.

11. Next, a chi-square test can be used to test if the gold particle
labeling is enriched at the selected region is genuine or
random.

12. For ER-PM contact sites, count the number of gold particles in
an area 50 nm either side of the plasma membrane. Similarly,
count the number of gold particles at the EPCS (Fig. 5).

13. From these measurements, the area of EPCS in proportion to
the PM, the density of gold particle in EPCS, and the expected
number for a random distribution (total gold number � the
proportion of EPCS area) can be calculated (Fig. 5).

14. Finally, the p value can be calculated based on the real distribu-
tion of gold particles compared to the expected number from a
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random distribution. This can be achieved using the online
program http://graphpad.com/quickcalcs/chisquared1.cfm.

15. As shown in Fig. 5, the real association (Fig. 5a) and random
association (Fig. 5b) can be distinguished based on their
p values, and a number below 0.05 indicates the enrichment
of gold particles in the selected area.

4 Notes

1. When infiltrating the leaf epidermis of N. benthamiana, the
viral p19 suppressor [12] can be used to increase protein
expression and signal intensity. But it cannot be applied to N.
tabacum due to lethality.

2. The ideal optical density of GV3101 (OD600) used in infiltra-
tion depends on the construct that has been transformed.
Normally OD600 around 0.05–0.2 are used; the principle is
to use the lowest OD that can result in a useable level of protein
expression.

3. Prolonged imaging on the same leaf segment should be
avoided; the mechanical pressure from coverslips can induce
cellular stress. Normally samples should be changed at least
every 20 min.

4. Such procedures can also be carried out on most proprietary
confocal and image analysis programs.

Fig. 5 Immuno-gold labeling of Arabidopsis root tips. (a) With an NET3C antibody gold particles are located at
the ER-PM contact sites and the PM. The region of ER-PM contact sites is highlighted in red. The p value of
0.002 from chi-square analysis indicates that the labeling of NET3C positive gold is enriched at the EPCS
compared to the PM. (b) When a NAP1 (actin binding protein) antibody is used as a control, it is evenly
distributed on the PM. The calculated p value is much larger than 0.05, indicating that any association with
EPCS is a random event. The chi-square calculation for PM and EPCS is shown in a table (scale bar¼ 100 nm)
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5. For each grid, approximately 10 μl of antibody solution can be
applied.

6. Negative controls are required; to do this the secondary anti-
body can be applied directly without primary antibody
incubation.
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Chapter 4

Preparation and Imaging of Specialized ER Using
Super-Resolution and TEM Techniques

Karen Bell, Karl Oparka, and Kirsten Knox

Abstract

The plant endoplasmic reticulum (ER) forms several specialized structures. These include the sieve element
reticulum (SER) and the desmotubule formed as the ER passes through plasmodesmata. Imaging both of
these structures has been inhibited by the resolution limits of light microscopy and their relatively inacces-
sible locations, combined with the fragile nature of the ER. Here we describe methods to view desmotu-
bules in live cells under 3D-structured illumination microscopy (3D-SIM) and methods to fix and prepare
phloem tissue for both 3D-SIM and transmission electron microscopy (TEM) which preserve the fragile
structure and allow the detailed imaging of the SER.

Key words 3D-SIM, BY2, Endoplasmic reticulum, Desmotubule, Sieve element reticulum, Imaging,
OMX, ZIO

1 Introduction

The limit of lateral resolution in light microscopy was determined
more than 100 years ago [1]. The diffraction limit of light means
that objects closer together than 200 nm cannot be fully resolved,
instead appearing blurred. This limit remained largely unchal-
lenged, despite the development of confocal laser scanning micros-
copy (CLSM). Theoretically, CLSM can produce images below the
diffraction limit, but this is not generally seen with biological
samples, principally as the pinhole needs to be smaller than the
Airy pattern [2]. This results in most of the superfluous out-of-
focus light being discarded, but also has the unwanted consequence
of losing a significant portion of the in-focus emission. With
biological specimens the fluorescence is often too weak, or labile,
to sustain a detectable signal when emission light is discarded.
Therefore, in practice, the pinhole is used at an aperture larger
than the Airy pattern, and as such any chance of significantly
increased lateral resolution is lost.

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_4, © Springer Science+Business Media LLC 2018
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Structured Illumination Microscopy (SIM) offers an alternative
method to gain greater resolution while avoiding discarding the
desired emitted light [3]. Optimally conducted, SIM can increase
the lateral resolution to 100 nm and the axial resolution to 200 nm
[4]. The technique relies on using spatially patterned excitation light.
By introducing structure to the excitation light, and subtracting that
known value from the emitted light pattern, it is possible to gain new
information about the unknown sample. Exciting a fluorescently
labeled sample with such structured light results in a Moiré interfer-
ence fringe, created by the two different fine patterns being super-
imposed. As the illumination pattern is predetermined, the Moiré
Fringe will describe the unknown structure of the sample, thus
accessing super-resolution data otherwise unobtainable [3].

Due to the directionality of the light, and to gain a complete
image, it is necessary to shift the phase of the light through five
patterns, and then the orientation angle, which is usually shifted
three times by at least 60� [5]. Post-imaging processing then pro-
duces the final image from 15 raw images from each z-plane.

The 3D-SIM imaging system was developed commercially by
Applied Precision Inc. (Washington, USA) and the platform was
named Optical Microscope eXperimental (OMX). The OMX is
designed to maximize physical stability and photon budget with
the aim of producing a platform suited to both rapid live-cell
imaging and super-resolution of fixed material [5–7]. The basic
components of the OMX system are described in [5] and the
current Deltavision OMX Blaze model specification is available on
the GE Healthcare website (http://www.gelifesciences.com).

In this chapter, we present protocols that describe methods of
preparing fixed and live plant cells in order to visualize specialized
ER components. Each protocol presents its own challenges
concerning image optimization. Elements of these protocols have
been described elsewhere [8–10] but here we describe methods
optimized for the imaging of specialized ER structures.

Acquiring high-resolution 3D-SIM images from fixed tissue
requires that the samples are labeled with a probe that is specific,
highly photostable and with a high quantum yield. The tissue must
be carefully fixed in order to preserve as much of the fine morpho-
logical structure as possible.

Imaging live cells requires a highly stable fluorophore for label-
ing structures that will not move during the timescale required to
capture an image. During live-cell imaging, speed is of the essence
in order to avoid any blur caused by components streaming within
the cells. In this regard, the OMX system offers several advantages;
simultaneous recording of up to four separate channels, or in cases
where there may be some emission overlap between fluorophores,
sequential imaging combined with rapid shuttering and fast, stable
focusing resulting in delays of less than 1–2 ms. This means that
together with its fully integrated electronic control, fast and precise
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3D high-resolution image capture is possible [5, 6]. Despite this,
many live cells will suffer bleaching during the image capture so it is
important to optimize the setup to minimize bleaching, although
this may come at the cost of losing some of the resolution.

The sieve element reticulum (SER) is a specialized ER system in
the phloem of higher plants [11] and has long posed difficulties
when imaging, as the sieve elements are located deep within tissues,
beyond the working distance of most objectives. Fixation and
sectioning is therefore a good way to visualize this structure
(Fig. 1e and f). However, extreme care must be taken that the
fixation method chosen does not disrupt the delicate structure.

In addition, tobacco-derived BY2 cell lines make good model
systems as they are readily transformable, both transiently and stably
with fluorescent reporters and often divide in long chains along one
plane, allowing single cell layers to be imaged [12]. Close to the cell
wall the ER is tightly appressed as it passes through the plasmodes-
mata, forming a desmotubule [13]. At just 15 nmwide this structure
is well beyond the resolution limit of a standard confocal, but 3D-
SIM allows greater resolution [14] (Fig. 1b and c).

Although super-resolution imaging can resolve structures
beyond the diffraction limit, it cannot compete with transmission

Fig. 1 (a) Confocal image of plasmolyzed BY2 cells, showing ER labeled by RTN6-GFP (green) and the cell wall
labeled with Calcofluor White (blue); scale 10 μm. (b) 3D-SIM image of the cross wall between two BY2 cells;
scale 5 μm. (c) Detailed view of the boxed area in (b), showing the narrowing of the ER as it forms the
desmotubule (arrow, scale 1 μm). (d) Confocal image of sieve elements showing the SER labeled by pSEO2:
GFP-HDEL; scale 5 μm. (e) 3D-SIM image showing structural details of the reticulum not resolved by the
confocal scale 5 μm. (f) Detailed view of a region of SER similar to the region marked (asterisk) in (e); scale
2 μm
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electron microscopy (TEM) for the magnification of fine struc-
tures. To observe such fine structures requires contrast enhance-
ment and this is usually achieved by using specific electron dense
heavy-metal based stains. In this chapter, we describe a protocol for
zinc-iodide osmium tetroxide (ZIO) staining of the SER (see Fig. 2
for representative images). The impregnation of tissue with ZIO
was initially used to stain autonomic nerve fibers for visualization
using light microscopy and subsequently TEM [15]. Notable for
forming electron dense accumulations between double-
membraned structures, it was soon adopted for the study of the
ER in general [16], and by our group for imaging the SER.

2 Materials

2.1 Preparation

of Phloem Tissue

for 3D-SIM

1. Fixative: 50 mM 1,4-piperazinediethanesulfonic acid (PIPES)
pH 6.9, 2 mM EGTA, 1% (w/v) bovine serum albumin (BSA)
in dH2O. Add 4% (v/v) formaldehyde and 0.25% glutaralde-
hyde (see Note 1).

2. Stabilizing solution: 5% (w/v) Phytoagar in ddH2O (see
Note 2).

3. Wash Buffer: 2 mM EGTA, 1% BSA, 50 mM PIPES, pH 6.9 in
ddH2O.

4. PBS: Phosphate buffered saline, 1 mM KH2PO4, 155 mM
NaCl and 10 mM Na2HPO4 in ddH2O, pH 7.4.

5. Calcofluor White solution: 10 μg/ml in dH2O.

Fig. 2 TEM images taken at the sieve element and companion cell walls of
tobacco petioles, stained with ZIO. (a) The SER adjacent to the cell wall has
strongly labeled showing detailed structure of the SER cisternae. (b) An alternate
angle section of the SER, with ZIO clearly enhancing the contrast between the
lumen and the membranes. Scale 0.5 μm
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2.2 Growth and

Preparation of BY2

Cells for Live Imaging

1. BY2 growth media: 0.43% MS Basal Salts media, 3% sucrose,
2 μg/ml 2,4-Dichlorophenoxyacetic acid in ddH2O. Sterilize
by autoclaving.

2. 1 M Mannitol: dissolved in dH2O.

3. 170 μg/ml Calcofluor White Stock Solution: dissolved in eth-
anol. Stored in the dark at �20 �C.

4. 100 mM DiOC6 (3,30-dihexyloxacarbocyanine iodide) stock
solution: dissolved in DMSO. Stored in the dark at �20 �C.

2.3 ZIO Staining 1. Fixative: 3% (v/v) glutaraldehyde in 0.1 M sodium cacodylate
(see Note 3).

2. 0.2 M sodium cacodylate: In a fume cupboard, add 21.4 g
sodium cacodylate to 400 ml dH2O. Mix well and add dH2O
to a final volume of 500 ml. Add 0.1 MHCl dropwise until the
solution reaches pH 7.3. For wash buffer dilute 1:1 with
dH2O.

3. 1% Osmium tetroxide in 0.1 M sodium cacodylate: Add a
0.25 g glass vial of osmium tetroxide to a glass duran bottle
and screw lid on. Shake to break vial and then add 12.5 ml
dH2O, mix gently on a rocking platform. Mix equal volumes of
osmium tetroxide and sodium cacodylate buffer

4. Zinc iodide: 3 g zinc powder and 1 g resublimed iodine to
20 ml dH2O, stir for 5 min and then filter. Leave to mature in
flow hood for 4 h (see Note 4).

5. ZIO: Combine equal volumes of zinc iodide with 2% osmium
tetroxide in a small aliquot, mix and use immediately.

6. Epon812.

7. 1:1 ratio of Epon812:propylene oxide.

8. 2:1 ratio of Epon812:propylene oxide.

3 Methods

3.1 Preparation of

Phloem Tissue

1. Cut the stem or petiole of a 35–55-day-old tobacco plant
expressing the desired fluorescent reporter (in this case
pSEO2.GFP-HDEL [17]) and transfer immediately to a glass
beaker containing the fixative solution and submerge the cut
end. Trim approximately 5 mm from the end of the stem to
avoid air blocks. Allow to transpire in an illuminated fume hood
for 1 h (see Note 5).

2. Trim the tissue and add to molten stabilizer cooled to 40 �C.
Submerge sample fully by gently pressing with a blunt instru-
ment. Remove any air bubbles and carefully orient the tissue to
allow for the desired angle of sectioning, e.g., positioned at 90�

to the surface for transverse sections or at 180� for longitudinal
sections.
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3. When set, trim around the sample to form a block and then
section using a vibrating microtome on a medium-fast setting
to obtain sections of 100 μm.

4. Place sections into wash buffer contained in a 5 ml petri dish.
Wash by replacing the buffer three times, 10 min for each wash.

5. Rinse with PBS and stain with Calcofluor White (at 10 μg/ml)
for 1 min at room temperature. Rinse sections well with dH2O.

6. Mount sections directly on a number 1.5 coverslip with a drop
of Citifluor AF1 antifade medium. Apply gentle pressure to
spread the mountant and remove air bubbles before sealing
with nail varnish.

3.2 Preparing BY2

Cells for Live 3D-SIM

Imaging

1. In advance, culture BY2 cell lines in 50ml Erlenmeyer flasks with
sterile Murashige and Skoog Basal Salts media supplemented
with 3% (w/v) sucrose and 2μg/ml 2,4-Dichlorophenoxyacetic
acid (see Note 6).

2. Aliquot 1 ml of cell suspension to an Eppendorf tube and stain
cell walls with Calcofluor White at a final concentration of
3.5 μg/ml. Stain for 5 min at room temperature before rinsing
cells twice with fresh media. Optional: if imaging wild-type
cells, use DiOC6 to stain the ER at a final concentration of
50 μM (see Note 7). Incubate for 10 min and then rinse twice
with fresh media.

3. Induce plasmolysis by pipetting off 450 μl of media and adding
450 μl 1 M mannitol. Incubate for 10 min at room temperature
before gently inverting the tube to resuspend the cells (seeNote8).

4. Pipette 40 μl of cells onto a very clean microscope slide before
carefully placing the coverslip. Using a folded paper towel apply
gentle, even pressure to remove excess media from the slide (see
Note 9). Carefully wipe all edges, making sure the coverslip
does not become smudged. Seal with nail varnish.

3.3 3D-SIM Imaging

with an OMX

Deltavision Blaze

1. Locate ideal cells on the auxiliary microscope (PersonalDV
Deltavision) which has stage coordinates synchronized with
the OMX. Use the lowest level brightfield possible to view
candidate cells and mark their position on the slide using the
point visiting tool. Expose all candidate cells briefly to check
that both the Calcofluor White stain and the GFP reporter (or
DIOC6) are sufficiently bright (see Note 10).

2. Transfer the slide to the OMX and apply immersion oil (see
Note 11). Using the Point List, find the marked cells and then
center the cell in the image using the Spiral Mosaic function.

3. Empirically determine the lowest laser power required to achieve
optimal intensities of between 1000 and 3000 counts in a raw
image acquired by a 15-bit dynamic range Edge sCMOS camera.
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Also optimize the shortest exposure times for each channel,
typically between 100 and 200 ms (see Note 12).

4. Following optimization, acquire image stacks of appropriate
cells. Set the start and end positions for a minimal z-stack
quickly to avoid excess light exposure.

5. Using the SoftWorx 6.0 alignment tool, adjust the images from
the separate channels and then reconstruct 3D super-
resolution image stacks using SoftWorx 6.0 with channel spe-
cific OTFs and Wiener filter settings of 0.002 (see Note 13).

3.4 ZIO Staining of

the SER

1. Cut the stem or petiole of a 35–55-day-old tobacco plant
expressing the desired fluorescent marker (in this case
pSEO2.GFP-HDEL [17]) and transfer immediately to the
fixative solution and submerge the cut end. Trim approxi-
mately 5 mm from the end of the stem to avoid air blocks.
Allow to transpire in an illuminated fume hood for 1 h (see
Note 5).

2. Remove the leaf and chop the petiole into 5 mm by 5 mm
sections.

3. Wash twice in 0.1 M Sodium Cacodylate for 10 min each wash.

4. Wash twice in dH2O for 10 min each wash.

5. Incubate in ZIO solution at room temperature for 4 h in a
sealed vial with gentle agitation on a rotating wheel.

6. Wash twice in dH2O for 10 min each wash.

7. Dehydrate tissue in an ethanol series: submerge for 15 min per
solution in 50%, 70%, and 95% ethanol before two 15 min
incubations in 100% ethanol.

8. Infiltrate dehydrated tissue with a 1:1 ratio of Epon812 and
propylene oxide at room temperature for 2 h.

9. Continue infiltration overnight in a 2:1 ratio of Epon812:
propylene oxide at 58 �C.

10. Incubate in 100% Epon812 at room temperature for 1 h.
Replace the Epon812 and incubate for one further hour.

11. Embed in flat bed molds, for 48 h at 58 �C.

12. Check orientation and quality of the tissue by cutting semi-thin
sections (0.5–1 μm) using a glass knife. Stain sections briefly
with Toluidine blue for accurate visualization on a bright field
microscope.

13. Following identification of an appropriate area of a block, cut
ultrathin sections (60 nm) with a diamond knife and float onto
dH2O. Mount sections on an EM grid by touching the dull
face of the grid to the middle of a section without breaking the
surface tension of the water. The sections will readily adhere to
a clean grid.
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14. Stain sections with uranyl acetate and lead citrate by first wet-
ting the grids in dH2O (seeNote 14) and then float section side
down for 45 min on a drop of uranyl acetate (see Note 15).
Wash by dipping in dH2O, manipulating the grid by its edge
using fine forceps for 1 min and repeat the wash in fresh dH2O.
Invert the grid onto a drop of lead citrate for counter staining,
for 10min. Wash again in dH2O for 1 min and then repeat for a
further 1 min in fresh dH2O.

15. Air dry before imaging with the TEM.

4 Notes

1. The fixative solution should be prepared freshly on the day of
use. However, the PIPES, EGTA, and BSA stock solutions may
be prepared in advance and stored on the bench following
autoclave sterilization. Glutaraldehyde should be EM-grade
and formaldehyde from a methanol free solution. Fixatives
provided in single-use glass ampules provide the best source
and any unused can be decanted into a glass bottle and sorted
for up to 1 month, glutaraldehyde at 4 �C and formaldehyde at
room temperature.

2. Phytoagar is a specialist agar used for plant tissue culture. With
a high gel strength at a 5% solution this matches the mechanical
properties of petiole tissue and thus supports the tissue well
during sectioning. The concentration may require optimiza-
tion when used as a stabilizer for other tissues types to avoid the
agar pulling away from the tissue or disintegrating.

3. To preserve the fine ultrastructure of the cell in ultrathin TEM
sections, it is necessary to increase the glutaraldehyde content
of the fixative to 3%.

4. The solution should turn a light straw color during the matu-
ration process.

5. Due to transpiration the fixative is drawn up into the xylem,
from where it moves laterally to the phloem and other tissues,
providing a gentle delivery system which avoids mechanical
damage of the phloem cells.

6. Incubate liquid BY2 cell cultures at 28 �C, in the dark, shaking
at 140 rpm. Sub-culture cells weekly using a 1:40 dilution. If
the cells are stably transformed with a fluorescent marker for
the ER such as RTN6-GFP, ensure that the signal is strong and
relatively homogenous in the line of choice. Best results are
usually obtained with cells which were subbed 3–4 days prior to
imaging.

7. DiOC6 will stain the ER, mitochondria, and vesicle mem-
branes. It is, however, extremely phototoxic so the cells must
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be kept in the dark once stained and illumination minimized to
reduce ER damage.

8. Plasmolysis allows clearer imaging of the desmotubules as the
membrane is retracted away from the cell wall, and the Hech-
tian strands can be clearly labeled either by RTN6-GFP or
DiOC6.

9. To achieve optimal imaging, the cells need to be as close to the
coverslip as possible.

10. It is vital to keep all light exposure as brief as possible prior to
the SIM imaging so as to minimize any pre-imaging photo-
bleaching or phototoxicity from DiOC6.

11. The type of immersion oil should be matched as closely as
possible to the refractive index of the sample to minimize
spherical aberrations. To achieve the best combination, in the-
ory the cells should be mounted in a high concentration of
glycerol/antifade mountant, but this was found to affect the
ER structure, so cells were mounted in media.

12. It is advisable to carry out the optimization on a sacrificial
cell—by the time the process is complete, the GFP is likely to
have bleached sufficiently to prohibit good image capture dur-
ing the 3D-SIM process.

13. The microscope must be routinely calibrated by measuring
channel specific optical transfer functions (OTFs) to optimize
both lateral and axial image resolution. Alignment tools should
also be regularly calibrated based on alignment parameters
obtained from calibration measurements with 100 nm-diame-
ter TetraSpeck beads.

14. Pre-wetting the EM grids minimizes potential artifacts by
reducing air–stain contact [18].

15. Spot stain on to a plastic petri dish and keep covered to reduce
contamination or artifacts from dust, evaporation, and CO2

(particularly important for lead citrate).
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au tétraoxyde d’osmium-iodure. Bull Assoc
Anat 79:233–394

16. Barlow PW, Hawes C, Horne JC (1984) Struc-
ture of amyloplasts and endoplasmic reticulum
in the root caps of Lepidium sativum and Zea
mays observed after selective membrane stain-
ing and by high-voltage electron microscopy.
Planta 160:363–371

17. Knoblauch M, Peters WS (2010) M€unch, mor-
phology, microfluidics: our structural problem
with the phloem. Plant Cell Environ
33:1439–1452

18. Hayat MA (1968) The principles and techni-
ques of electron microscopy, vol 1. Van Nostt
and Reinold Company, New York, NY

42 Karen Bell et al.



Chapter 5

Quantitation of ER Structure and Function

Mark Fricker, Luke Heaton, Nick Jones, Boguslaw Obara,
Stefanie J. M€uller, and Andreas J. Meyer

Abstract

The plant endoplasmic reticulum forms a network of tubules connected by three-way junctions or sheet-like
cisternae. Although the network is three-dimensional, in many plant cells, it is constrained to a thin volume
sandwiched between the vacuole and plasma membrane, effectively restricting it to a 2-D planar network.
The structure of the network, and the morphology of the tubules and cisternae can be automatically
extracted following intensity-independent edge-enhancement and various segmentation techniques to
give an initial pixel-based skeleton, which is then converted to a graph representation. Collectively, this
approach yields a wealth of quantitative metrics for ER structure and can be used to describe the effects of
pharmacological treatments or genetic manipulation. The software is publicly available.

Key words Confocal imaging, Endoplasmic reticulum, Network analysis, Phase congruency, Reticu-
lon, ER tubule morphology, ER cisternae

1 Introduction

The endoplasmic reticulum (ER) forms a complex and dynamic
network of tubules and sheet-like cisternae that ramify throughout
the cytoplasm [1]. In this chapter, we describe an ER network
analysis program that is designed to quantify:

1. The length, width, and morphology of the ER tubules (Fig. 1a
and b).

2. The topological organization of the network (Fig. 1c).

3. The size and shape of the ER cisternae (Fig. 1d).

4. The size and shape of the polygonal regions enclosed by the
network (Fig. 1a).

The programs were originally designed to quantify ER organi-
zation in plant epidermal cells, where the ER is confined to a very
thin layer of cytoplasm appressed to the periclinal cell wall as a

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_5, © Springer Science+Business Media LLC 2018
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planar, 2-D network. The input image typically comprises single
plane (x,y) confocal fluorescence images of ER-targeted fluorescent
proteins.

The simplest method to identify the ER automatically would be
an intensity-based segmentation of the fluorescence image to give a
binary image, with ones representing the ER structure and zeros for
the background. However, the resultant binary image is critically
dependent on the value for the threshold used, and it is rare that a
single threshold provides adequate segmentation without either
losing dimmer structures if it is set too high, or artificially expand-
ing and fusing adjacent regions if it is set too low [2]. Thus the
approach adopted here exploits additional intensity-independent
information over a range of scales and orientations to enhance the
network structure, prior to segmentation as a single-pixel wide
skeleton. The skeleton is then used as a template to interrogate
the image locally to provide an estimate of the relative amount of
fluorescent probe present and to provide an indication of the tubule
width.

cisterna

polygonal
region

free end

bulge
constric�on

tubule

three-way
junc�on

C - weighted 
graph 

representa�on

nodes

edges

B - pixel 
skeleton

minor axis

major axis

cisternal
area

0.5 μm

average
centre width,

excluding nodes

A - ER morphology

super
node

D - cisternal
analysis

Fig. 1 Schematic outline of the terminology used to describe the ER morphology. (a) Representation of the
main features of the ER including tubules, cisternae, enclosed polygonal regions, three-way junctions, and
free ends. Measurements of the tubule width may average over the “centre” region, excluding the junctions,
or involve more detailed analysis of local bulges and constrictions. (b) The image of the network is converted
to a single-pixel wide skeleton following automated ridge enhancement and segmentation. (c) Elements within
the pixel skeleton are classified as nodes (junctions and free ends) connected by edges that inherit the length
and width of the underlying tubules. Cisternae are represented as a super-node that is connected to each
tubule incident on the boundary. (d) The cisternae (and polygonal regions) are analyzed separately to
determine their area and various shape metrics such as the major and minor axis of a bounding ellipse
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The expected width of the ER tubule is 50–70 nm [1], which is
below the resolution of the confocal microscope, but can just be
resolved with super-resolution techniques, such as stimulated emis-
sion depletion microscopy (STED [3]), although this is extremely
challenging for dynamic imaging. For most laboratories, access to
super-resolution techniques may be limited, necessitating the
development of approaches that can be used on a routine basis
with existing systems. Nevertheless, with additional assumptions
about the distribution of the fluorescent lumenal marker and the
point spread function (psf) of the microscope, the approximate
width of the ER can be estimated, even if this is below the resolu-
tion limit of the microscope system [4]. In this approach, the
skeleton is used as a template to interrogate the image locally to
provide an estimate of the relative amount of fluorescent probe
present, and the width is inferred from the integrated intensity
signal from estimates of the profile of intensity with distance normal
to the skeleton. We describe some basic routines to estimate the
relative tubule width (effectively convolved with the psf) and also
introduce measures using the intensity values to infer the approxi-
mate sub-resolution tubule width.

Topological measures of the ER network structure can also be
extracted following conversion of the pixel skeleton to a weighted,
undirected graph, where nodes represent junction points and edges
represent the tubules that connect them [2, 5, 6] (Fig. 1c). A wide
range of metrics can be calculated using such a graph representa-
tion, such as betweenness centrality of nodes or edges, although it
is not yet clear how these may relate to underlying mechanism or
function. Nevertheless, unlike morphological measurements, the
topology of the network is less sensitive to the resolution of the
imaging system as it reflects the connectivity of the ER rather than
the physical size of the components [2].

In addition to analysis of the ER structure and topology, a
number of engineered fluorescent reporters have been developed
to characterize dynamic physiological processes in living cells. In
particular, fluorescent reporters, such as the roGFP family [7] or
the tandem fusion proteins Grx1-roGFP2 [8] or roGFP2-Grx1
[9], respond to the glutathione redox potential and allow redox
imaging in vivo. roGFP and its derivatives can be expressed in the
cytoplasm or targeted to different organelles, such as the ER, giving
fine control of measurements from subcellular compartments [7, 8,
10–13]. The redox potential of the ER is of particular interest as it
influences the rate and fidelity of protein folding [14]. Measure-
ments of physiological parameters in the ER, however, demand less
reducing probes with midpoint potential tweaked to the redox
potential in the ER. For this roGFPn-iX variants with midpoint
potentials between �229 and �238 mV have been designed [15,
16]. Furthermore, potential potential artifacts due to formation of
intramolecular disulfide bridges and probe dimerization [17] can
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be minimized by the use of Grx1 fusion proteins, which also confer
specificity for GSH redox potential and greatly increase the probe
response kinetics [14]. The difference in redox potential between
the cytoplasm and ER can also be harnessed to probe the topology
of ER membrane proteins by introducing roGFP in predicted
lumenal or cytoplasmic loops in a technique termed redox-based
topology analysis (ReTA [18]). The relative ratio of the roGFP
signal gives a macroscopic readout of whether the labeled loop is
within the ER (more oxidized) or facing the cytoplasm (more
reduced).

1.1 Outline of the

Main Steps in the ER

Analysis

The ER network analysis progresses through a number of parallel
threads that are designed to extract different information from the
underlying image to characterize the tubular network, cisternae,
and enclosed polygonal regions of cytoplasm. A flow diagram of the
overall sequence for morphological measurements is shown in
Fig. 2 and is discussed in more depth in Subheading 3.1.

We also outline the steps required to make measurements of
physiological parameters in the ER using roGFP as an example,
although the same methods can be applied to any ratioable reporter
[13, 19, 20]. The sequence of steps implemented for physiological
measurements is shown in Fig. 5. A full description of the redox
ratio analysis package is given in [20].

2 Materials

The ER network analysis and redox ratio analysis programs were
written in MATLAB (The Mathworks, Nantick, MA) and are each
packaged in a single compiled executable file for distribution as a
stand-alone package, or as MATLAB apps that run within the
MATLAB 2016a or later environment. In the case of the apps,
the ER network analysis package requires the MATLAB image
processing toolbox, while the redox ratio analysis package requires
the MATLAB image processing toolbox and statistics toolbox. The
programs, manuals, and tutorials can be downloaded from:

www.markfricker.org

The software has been tested on Windows10 and requires a
minimum screen resolution of 1600 � 900. In addition, an appro-
priate version of the MATLAB Compiler Runtime (MCR) is
required to install the set of shared libraries that enables execution
of the compiled MATLAB application. The MCR should automat-
ically be downloaded from MathWorks when the program is
installed for the first time. Alternatively, the MCR can be down-
loaded from the MathWorks Website:

http://www.mathworks.com/products/compiler/mcr
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Fig. 2 Flow diagram showing the main steps in the morphological ER analysis. (a) The starting point is typically
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maximum tubule diameters are estimated manually from line transects to resample the image and standardize
all the subsequent processing parameters; (c) ER tubules are segmented following filtering and enhancement
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A number of additional files needed to run the full suite of
programs may also be installed at the same time as the main pro-
gram. For example, the Bio-Formats package [21] has been
designed to read in images from different microscope manufac-
turers and store them in a standardized format. Full details are
available on the open microscopy website:

http://www.openmicroscopy.org/site/support/bio-formats4/

The bioformats_packages.jar program needs to be available on
the search path or installation directory of the matlab programs.
The bioformats_package.jar is available from:

http://downloads.openmicroscopy.org/bio-formats/5.6.0/

The latest version of Java needs to be installed and is available
from:

http://www.java.com/en/

Output of images at full resolution uses export_fig.m originally
written by Oliver Woodford (2008–2014) and now maintained by
Yair Altman (2015-present). When exporting to vector format
(PDF or EPS), this function requires Ghostscript which can be
downloaded from:

http://www.ghostscript.com

When exporting images to eps, export_fig additionally requires
pdftops, from the Xpdf suite of functions. This can be downloaded
from:

http://www.foolabs.com/xpdf

3 Methods

3.1 Extraction of ER

Network Structure

3.1.1 Setting the Scale

Parameters

Images of the ER may have been collected at different pixel resolu-
tions, depending on the microscope settings, and may span differ-
ent width scales depending on the experimental treatment and
genetic background. If estimates of the tubule width are required,
the pixel size may need to be reduced below the optimal Nyquist
sampling value (as low as ~20–30 nm) to reduce downstream
discretization errors due to pixelation. To standardize all the

�

Fig. 2 (continued) steps to give a single-pixel wide skeleton. This provides basic morphological information on
the length and width of the tubules and can be interrogated further to examine individual tubule morphology.
(d) The analysis can be constrained to a particular cell or subcellular region by masking the image; (e) ER
cisternae are detected independently using image opening followed by active contour refinement; (f) The
performance of the automated segmentation approaches can be compared to a manually defined “gold-
standard” pixel skeleton
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subsequent processing steps, it is useful to define the expected
minimum and maximum width of the tubular components manu-
ally using a transect drawn on the image.

1. Draw a two-point transect on the image across a tubule that, by
eye, appears to be close to the smallest tubule diameter. A graph
of the transect profile is automatically displayed, and the full
width at half-maximum peak height (FWHM) calculated to
give FWHMmin.

2. Repeat the transect profile across the largest diameter tubule
present to give the maximum tubule diameter (FWHMmax).

3. Values for FWHM displayed in the interface are given in pixels,
while the peak intensities are given in normalized units ranging
from 0 to 1 (see Note 1).

3.1.2 Defining a

Boundary Mask

In some instances, it may be appropriate to define a boundary mask
to exclude regions that should not be analyzed, or to restrict the
analysis to a specific region of the cell or tissue. Several approaches
are available to segment the main fluorescent structures automati-
cally or manually:

1. Automatic segmentation using a threshold determined by
Otsu’s method [22] that minimizes the intraclass variance of
the foreground and background distributions.

2. Manual segmentation using a threshold determined from a
region-of-interest (ROI) placed on the background. The
threshold is calculated as mean þ 2 � SD.

3. Manual delineation by drawing a boundary on the image. If
this option is selected, a separate window opens to give access
to a number of drawing tools. The edited binary image is
automatically saved alongside the other parameters used for
processing the image and can be reapplied or edited further
every time the image is processed (see Note 2).

3.1.3 Background

Measurement and

Correction

Accurate measurements of the fluorescence signal from the ER
typically require correction for the instrument dark current, ampli-
fier offset, and background signal. A number of options to auto-
matically or manually correct the background contribution are
provided, including:

1. Subtraction of a single measured value: A constant value is
measured from a ROI defined on the image and is subtracted.
This is appropriate for removing instrument black-level offsets
or very diffuse fluorescence.

2. Image opening: The image is processed with a grayscale open-
ing function using a disk-shaped kernel with the radius set by
FWHMmax (i.e., twice the size of the largest tubular feature
expected). This removes any features smaller than
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2 � FWHMmax and provides an estimate of the local back-
ground around each pixel. The opened image is subtracted
from the original to correct for the local background. This
method may be useful if there is some out-of-focus blur in
the image or an amount of signal from another compartment,
such as the cytoplasm. However, it is less useful if there are
sheet-like cisternal regions larger than FWHMmax, as these
remain after the opening operation and are then subtracted
from the image, distorting the pixel intensities in the neighbor-
ing regions.

3. Subtraction of a surface fit to the local background: The local
minima across the image are detected and a smooth surface fit
to points in the 10–90% interval of the local minimum distri-
bution. The surface is converted to an image and subtracted
from the original.

4. Subtraction of a low pass filtered image: The image is filtered
using a Gaussian kernel with a large radius sufficient to remove
all the high-frequency information in the image. The standard
deviation for the Gaussian kernel is calculated as FWHMmax, or
approximately twice the size of the largest tubule diameter. The
low pass image is subtracted from the original and the image
renormalized. This approach also suffers if there are cisternal
regions present.

3.1.4 Filtering the Image

to Improve Signal-to-Noise

Most simple noise reduction algorithms use isotropic kernels and
smooth the noise in the image equally in all directions. This is not
desirable when analyzing the ER, as the tubule boundaries will
become blurred. Instead a number of adaptive anisotropic filters
are provided that smooth within the tubular network structures,
but do not spread across boundaries. In addition, the image inten-
sities can subsequently be rescaled using local contrast-limited
adaptive histogram equalization (CLAHE [23], see Note 3).

1. Coherence filtering: This applies an anisotropic diffusion filter
written by Dirk-Jan Kroon [33] that smooths regions of low
variance, but avoids blurring of object boundaries.

2. Guided filtering: This uses an edge-preserving smoothing filter
that is “guided” by the structure of the underlying image [24]
(see Note 4).

3.1.5 Enhancing the

Tubular Elements

A number of options can be used to improve the relative contrast of
tubular ER elements prior to segmentation, by using kernels
designed to pick out “ridge” like features that are detected over a
range of scales and angles. These include:

1. Phase Congruency: This uses the phase-congruency approach
developed by Peter Kovesi [25, 26] which provides contrast-
invariant ridge detection over a range of scales and angles. The
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MATLAB implementation [26] provides a number of outputs,
including the level of phase congruency as a measure of the
edge strength, and also the “feature type,” calculated as the
weighted mean phase angle at every point in the image. A value
for the feature type of pi/2 corresponds to a bright line,
0 corresponds to a step, and �pi/2 is a dark line. The feature
type has proved to be one of the most robust and reliable
outputs for subsequent segmentation, as all ridges irrespective
of their original intensity are identified with almost equal
strength in the feature type image.

2. Frangi vesselness filter: This calls the Matlab implementation of
the classic Frangi “vesselness” filter [27] written by Marc Schrij-
ver and Dirk-Jan Kroon and available from the MathWorks
website (http://uk.mathworks.com/matlabcentral/
fileexchange/24409-hessian-based-frangi-vesselness-filter).
This gives a strong response for bright features where the
second-order derivative of the intensity image (Hessian) shows
a strong anisotropy. It can perform well for tubular elements
across a range of scales, but leaves holes at the junctions, and
only partially compensates for differences in intensity in the
original image, which can lead to breaks in the skeleton during
the subsequent segmentation step.

3. Ridge enhancement: Applies a version of the second-order
anisotropic Gaussian kernel originally proposed by Meijering
[28] as part of their “Neuriteness” detector. This uses a slightly
flattened second-order Gaussian kernel at a range of scales and
angles to give better discrimination of ridge-like structures, but
does not include any additional information related to the
anisotropy of the ridge.

4. Anisotropic ridge enhancement: This applies the multi-scale
ridge detector developed by Lopez-Molina [29] that uses
anisotropic second-order Gaussian kernels. These can be con-
figured flexibly in terms of size, orientation, and anisotropy.
This gives good ridge enhancement, but still retains the varia-
tion in local intensity along the tubules that can make
subsequent segmentation more difficult (see Notes 5 and 6).

3.1.6 Skeletonization The aim of the skeletonization step is to convert the enhanced
image to a one-pixel wide skeleton along the centerline of the
tubule ridges. Nevertheless, this is only an approximation to the
true centerline due to pixel discretization errors. There are two
main approaches that can be used, namely “hysteresis thresholding,”
that uses the intensity information and some degree of local pixel
connectivity to provide an initial binary image that is then thinned
to give a single pixel skeleton, and “watershed thresholding” which
follows connected ridges, irrespective of their absolute intensity,
and automatically generates a single-pixel skeleton.
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1. Hysteresis thresholding: This starts with seed pixels above a user-
defined upper threshold and then propagates the initial seg-
mentation as long as pixels remain above a user-defined lower
threshold. The resulting binary image is then thinned to give a
single-pixel wide skeleton. The value of the lower threshold is
critical—too high and the network becomes disconnected; too
low and large blocks of the image are included in the resultant
binary image that may fuse separate tubules into a single object.
Consequently, when this block is thinned, the skeleton does
not map onto the ridge centerlines. In addition, as the thinning
process is not guided by the intensities in the enhanced image,
the skeleton does not necessarily converge on the expected
pattern at junction points. Using an h-minimum transform
smooths out regions with low fluctuations in intensity, but
then sets these regions as local minima to ensure that the
surrounding ridges will be segmented individually and do not
spread into the basin, even if the absolute values are above the
lower hysteresis threshold.

2. Watershed thresholding: This applies a watershed segmentation
and then extracts the watershed lines as the pixel skeleton. The
watershed method is good at segmenting the centerline of the
ridges and can handle variations in intensity well. However, it
does not include any tubules that have a free end, and has a
tendency to over-segment regions with noise. Over-
segmentation can be avoided by including additional steps
that suppress regions with small intensity fluctuations using
an h-minimum transform. In addition, setting the local minima
to zero ensures that adjacent structures are separated (see Note
7).

3.2 Estimation of ER

Tubule Width

Once the pixel skeleton has been segmented satisfactorily, the first
step in the analysis is to estimate the tubule width.Unfortunately, the
average ER tubule diameter (50 nm) is below the theoretical resolu-
tion of most confocal microscopes and at the resolution of current
live-cell super-resolution techniques such as STED [3], so direct
physical estimates of the width are challenging. The methods
described here typically return a value of the true width convolved
with the point spread function (psf) of the microscope. In addition,
the typical pixel spacing leads to significant digitization errors, even
with over-sampling. A number of different approaches are available
that all provide some information on the tubule diameter including:

1. 50% threshold distance: This estimates the local FWHM from the
original tubule image for each pixel in the skeleton. The peak
height is estimated from the original intensity, while the distance
is estimated from the distance transform of the pixel skeleton.
The 50% threshold is estimated from where the pixel intensity
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falls below half the peak intensity, assuming a local background
of zero.

2. Maximum-gradient granulometry: The intensity image is sub-
ject to a series of image openings (erosion followed by dilation)
that successively remove structures as the size of the opening
kernel exceeds the underlying object. This results in an inter-
mediate (x,y,s) image, where s increases with the size of the disk-
shaped kernel to a maximum of FWHMmax. The intensity of
each pixel initially decreases slowly with s as the kernel samples
more of the object, but then reduces dramatically once the
boundary of the object is reached, and the kernel only samples
the background. The transition point for any pixel is deter-
mined from the maximum (negative) gradient of the granulo-
metry curve. This approach constrains the width to integer
pixels values and also suffers from the digital approximation
of small kernels to a true disk shaped kernel.

3. Integrated intensity granulometry: This approach follows the
same methodology as the maximum-gradient granulometry
method, but rather than extract a specific size threshold, the
integrated intensity under the granulometry curve is calcu-
lated. An additional option is available to use the FWHMmaxþ 1
kernel as a local background correction. The integrated inten-
sity provides a more nuanced interrogation of the local ER
structure, but cannot be directly related to the physical tubule
width without additional assumptions about the relationship
between fluorescence intensity and sampled volume, or full
deconvolution with an experimentally measured psf. Neverthe-
less, this approach does help with estimation of relative tubule
widths, even if they are sub-resolution objects, provided it is
assumed that the fluorescent probe is evenly distributed
throughout the ER, and the ER is within the sampling volume
of the confocal defined by the psf (Fig. 3). A conversion factor
can be estimated to convert relative fluorescence to width if it is
possible to correlate the physical width, measured from transect
profiles, with the intensity (see Notes 8–9).

The principle behind the integrated intensity measurements
can be illustrated empirically using a simulated model of ER tubules
with different widths (Fig. 3a and b) that are convolved with an
excitation and emission psf, modeled as anisotropic 3-D Gaussian
[30] blurring functions (Fig. 3c and d). The performance of the
three different width estimators can be assessed by analysis of a
single confocal plane to represent a single (x,y) image (Fig. 3e) and
shows that all measures perform well above about twice the theo-
retical lateral FWHM of the psf (0.14 μm for the Zeiss AiryScan),
but the 50% distance measure and the maximum-gradient granu-
lometry measure both converge to a fixed value close to the psf for
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Fig. 3 Estimation of sub-resolution tubule widths. A set of ER tubules with increasing width were simulated as
cylinders and viewed as an average (x,y) projection (a, c) or a single (x,z) section (b, d) before (a, b) and after
(c, d) blurring with simulated anisotropic 3-D Gaussian excitation and emission point spread functions (FWHM
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sub-resolution objects as expected (Fig. 3f). By contrast, the
integrated intensity measure provides near linear performance
even with sub-resolution objects (Fig. 3g).

3.3 Segmentation

and Measurement of

the Cisternal Regions

In addition to the tubular-reticulum, the ER may also include
sheet-like regions called cisternae, or regions of closely appressed
tubules that are difficult to separate. The methods used to segment
the tubular ER do not work with the cisternae, so a different set of
methods are available to segment these structures independently.
These include:

1. Automatic segmentation using an intensity-based threshold to
pick out the brightest structures. An automatic multi-threshold
is used to partition pixel intensities into three bins, and the
upper bin selected. This will extract the brightest objects, but it
does not usually give a good unique segmentation of cisternae,
as junctions or other bright features are also included.

2. Image opening calculates a modified image after grayscale open-
ing to remove all objects smaller than FWHMmax and then
converts the resultant image to a binary mask using an auto-
matic threshold. This is more effective at detecting larger sheet-
like regions of the ER, but the resultant binary image tends to
give blob-like features that extend beyond the original cisternal
region.

3. Active contour performs the same image opening step as
2 above, but then “shrinks” the features detected down to
match the underlying intensity profile using an active contour
algorithm. This performs better than a simple opening opera-
tion and is set as the default.

4. If no satisfactory segmentation of the features can be achieved
with the automatic settings, the cisternae can be defined man-
ually. If this option is selected, the image editing window opens
again to give access to the drawing tools. As with the boundary
mask, the edited binary image is automatically saved and can be
reapplied or edited further every time the image is processed.

�

Fig. 3 (continued) 0.14 μm � 0.14 μm � 0.42 μm in x, y, and z, respectively). The simulated result for
scanning a single confocal section is illustrated in (e). The intensity profile across the midsection of the original
tubules and after blurring is shown in (f). The reduction in intensity for sub-resolution tubules is apparent. (g)
shows the performance of the three different estimates of tubule width. The 50% distance measure (circle)
and the maximum-gradient granulometry (square) perform well above about twice the psf, but return a value
close to the expected FWHM of the psf for sub-resolution objects. The integrated intensity measure (asterisk)
gives a near linear response throughout the range of tubule widths examined unless the tubes overlap at large
diameters. Similar results are obtained using a faster granulometry method that includes decomposition of the
circular structuring element into linear approximations, along with an empirical correction of �1 pixel to
compensate for over-sampling by rectangular kernels (h)
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5. A number of morphological measurements of the cisternae are
provided including the area, major and minor axis lengths,
perimeter, and solidity.

6. The cisternal regions are punched out of the pixel skeleton so
that they do not contribute to analysis of the tubular elements.
During the subsequent analysis steps, each cisternal region is
represented as a set of linear connections radiating out from the
centroid of the cisterna to connect with the tubules incident on
the boundary. This ensures the overall connectivity of the
network is retained.

The results for the cisternal segmentation using image opening
and active contour refinement are shown in Fig. 4c. The modifica-
tion to the color-coded pixel skeleton is shown in Fig. 4d and the
graph representation in Fig. 4e, where the cisternae are represented
as a super-node connected to each of the tubules incident on the
cisternal boundary.

3.4 Measurement of

Enclosed Polygonal

Regions

The polygons enclosed by the ER network are automatically
extracted as the inverse of the pixel skeleton and various morpho-
logical measures calculated, including the area, major and minor
axis, perimeter, and solidity in a similar manner to the cisternal
measurements.

3.5 Analysis of ER

Organization Using

Graph-Theoretic

Metrics

Topological measures of the ER structure are calculated by con-
verting the pixel skeleton to a weighted graph representation. For
the tubular regions of the skeleton, the nodes are defined at the
junctions between the ER tubules, or the end-points of free
tubules, which are connected by straight edges that preserve the
topology of the network. If any ER cisternae have been identified,
they are represented as a “super-node” positioned at the intensity-
weighted centroid of the cisternae, which is connected to all the
tubules that are incident on the feature boundary by edges that are
given an arbitrary value equal to the average or maximum width
value.

A number of metrics are associated with each edge including
the Euclidean length of the underlying pixel skeleton, the average
width for the entire tubule, calculated using each of the three
methods above, and the average width of the tubule excluding
the region around the nodes (termed the “centre width”—see
Fig. 1), which provides a more accurate measure of the tubule
diameter itself.

3.6 Measurement of

Tubule Morphology

Under some conditions or in certain genetic backgrounds, such as
overexpression of reticulons [31], the ER tubules show fluctuations
in diameter along their length. The number, size, and distribution
of these bulges and constrictions can be analyzed using the graph
representation of the network to extract the intensity profile,
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Fig. 4 Stages in the analysis of the ER morphology. (a) Original single (x, y) image of GFP-HDEL targeted to the
ER and imaged with a Zeiss Airyscan confocal. (b) Pseudo-color coded representation of the tubule width
ranging from blue (FWHMmin) to red (FWHMmax), superimposed on the filtered image to visually inspect the
performance of the overall segmentation and width analysis method. (c) Automated segmentation of ER
cisternae (magenta) using image opening and active contours. (d) Cisternae are removed from the pixel
skeleton before graph conversion. (e) Conversion of the weighted pixel skeleton to a weighted graph.
Junctions and free ends are represented as nodes linked by edges that have a vector of properties associated
with them, including tubule width, length, and average intensity. Cisternae are represented as a “super-node”
connected to all the incident tubules on the boundary. (f) Automated characterization of ER tubule morphology.
The intensity profile along each ER tubule is scanned to detect peaks above a minimum intensity that are also
a minimum height above their neighbors. In addition, peaks have to be greater than a minimum separation
from each other, with the nodes set to one. (g) The location and width (in μm) for bulges (green) and
constrictions (red) are shown superimposed on the merged pixel skeleton and intensity image

ER Quantitation 57



integrated normal to the tube axis, from each individual tubule,
excluding the junctions. The method uses a peak-finding algo-
rithm, initially to find the bulges (peaks) on the original intensity
profile, and then the constrictions (troughs) on an inverted inten-
sity profile (Fig. 4f). The process operates as follows:

1. Scan the pixel intensities along the length of each tubule start-
ing at the nodes (which are set to 1). The position and intensity
of each peak that is greater than a user-defined minimum peak
height and minimum peak prominence is recorded. An addi-
tional minimum separation condition is imposed to prevent
noisy adjacent pixels from being considered as separate peaks.
This separation defaults to FWHMmin.

2. A similar scan is used on the inverted tubule profile to detect
the “constrictions.”

3. Once the location of the bulges and constrictions has been
determined, the width parameters at each point are extracted
along with the separation between the peaks.

4. The summary statistics for the bulges and constrictions for all
tubules are output to Excel.

3.7 Measurement of

the ER Environment

Using Transgenic

Reporters

Physiological measurements of the redox poise of the ER can be
made with roGFP reporters targeted to the ER. While the original
measurements used roGFP1 and roGFP2 [13, 19], newer variants
have been developed that are better suited to the oxidizing envi-
ronment within the ER [14]. The redox ratio analysis package [20]
has a number of programs that are useful to quantify single (x,y)
images, or 3-D (x,y,t) or 4-D (x,y,z,t) time series to capture ER
dynamics [20]. Each program can also store or access the proces-
sing and calibration parameters used in a corresponding probe
database, and have various output options to view animations of
the data, or generate publication-ready figures. The Advanced
Ratio Program covers 4-D (x,y,z,t) images with up to five fluores-
cence channels, and a parallel bright-field image, to allow correla-
tion of changes in autofluorescence-corrected ratio images with up
to two other parameters, and the (non-confocal) bright-field mor-
phology. The ROI Time Series is designed to allow segmentation of
objects, such as mitochondria, from a time-series image and analyze
fluctuations in signal or ratio for each object individually. Results
can be viewed for each object or as a population response with
various statistical fits to the data. Only the Batch and Basic Ratio
analysis are described here as these represent the minimum needed
for ER redox measurements.

3.8 Ratiometric

Analysis of ER Redox

Potential

1. Import a 3-D (x,y,t) image, with two wavelength channels
representing the protonated (oxidized) and deprotonated
(reduced) forms of the roGFP chromophore, and an additional
autofluorescence channel if there is significant autofluorescence

58 Mark Fricker et al.



bleed-through into the protonated channel. The default is the
Zeiss .lsm format, but it is possible to import files in a variety of
formats using the Bio-Formats package.

2. As the relationship between the order each channel was col-
lected and the physiological parameter of interest depends on
the precise configuration of the microscope for each experi-
ment, each of the three channels is assigned to the appropriate
parameter. Thus the default order for a roGFP-based redox
ratio experiment would be protonated (oxidized), deproto-
nated (reduced), and autofluorescence.

3. To improve the signal-to-noise ratio (S/N), the initial images
are typically smoothed in (x,y) with a spatial averaging filter,
using a 3 � 3 or 5 � 5 kernel, and/or a temporal filter.

4. Accurate visualization and quantitation require measurement
and subtraction of the background signal for each channel. The
background is measured from a user-defined ROI on the
image.

5. Pixels with intensity values close to background (typically less
than background þ2 � SD) or near saturation (typically 90%)
are also masked from the ratio image, as these give a misleading
impression of the real ratio value. These pixels are also excluded
from quantitative measurements.

6. The ratio is calculated on a pixel-by-pixel basis for all pixels that
meet the criteria above.

7. For pseudo-color display to visualize spatial and temporal pat-
terns of redox potential, the masked ratio is coded in HSV
color-space by hue on a spectral color scale ranging from
saturated blue (fully reduced) to saturated red (fully oxidized),
with the limits set by an in situ calibration or extrapolated from
an in vitro calibration. The intensity of the ratio image is
calculated as the mean intensity for each pixel in the two
channels. This effectively gives bright colors for regions with
good signals that fade to background for regions of low signal.

8. As the signal contributing to each pixel in a ratio image is very
noisy, it is preferable to make quantitative measurements from
user-defined regions-of-interest (ROIs) that average the signals
spatially or temporally from a larger number of pixels prior to
calculation of the ratio.

9. While relative changes in ratio values can provide a reasonable
amount of information for comparative studies, more precise
calibration may be possible with experimental treatments that
define the in vivo probe response. Thus perfusion with a reduc-
tant, such as 10 mM DTT (5 min), followed by an oxidant,
such as H2O2 (10–100 mM, 5 min), can be used to drive the
roGFP to a fully reduced or oxidized form, respectively. These
calibration values can be stored and applied to other data sets
collected under identical conditions.
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10. The degree of oxidation (OxD) of the roGFP sensor is calcu-
lated from Eq. 1, according to [10]:

OxDroGFP ¼ R �Rred

I 488ox
I 488red

Rox �Rð Þ þ R �Rredð Þ ð1Þ

where R is the ratio of excitation at 405/488 nm after back-
ground subtraction and autofluorescence correction,Rred is the
ratio of fully reduced form following perfusion with 10 mM
DTT, Rox is the ratio of the fully oxidized form following
perfusion with 10–100 mM H2O2, and I488ox and I488red are
the intensities at 488 nm for the fully oxidized and fully
reduced forms, respectively.

11. The redox potential is then estimated from Eq. 2:

E 0 ¼ E
00pH
roGFPð Þ �

2:303RT

zF
log10

1�OxDroGFP

OxDroGFP
ð2Þ

whereR is the gas constant (8.315 J/K/mol), T is the absolute
temperature (298.15 K), z is the number of transferred elec-
trons (2), F is the Faraday constant (9.648 � 104 C/mol), and

E
00pH
roGFPð Þ is the midpoint redox potential based on the standard

midpoint potential E00 at 30 �C and pH 7, adjusted for the
estimated compartment pH and experimental temperature
(20–25 �C) according to Eq. 3:

E 0 pH
0 roGFPð Þ ¼ E 0

0 roGFPð Þ �
2:303RT

zF
pH� 7ð Þ ð3Þ

Prominent examples are the SEC61 translocon mediating pro-
tein import into the ER [32], the ethylene receptor ETR1 [34],
SNARE proteins responsible for specific vesicle recognition by
membranes along the secretory pathway [18], or reticulons that
have been suggested to contribute to shaping the ER structure
[31]. For their function all these proteins need to adopt a distinct
topology which is often not predicted well by bioinformatics algo-
rithms. As an alternative approach, the steep gradient in the gluta-
thione redox potential (EGSH) across the ER membrane enables
simple and straightforward experimental analysis of membrane
protein topology in living cells through ratiometric visualization
of N- and C-terminal fusions with roGFP2 (Fig. 5e). After excita-
tion at 405 and 488 nm, the resulting Redox-based Topology
Analysis (ReTA) provides a binary readout with a four- to fivefold
difference in the fluorescence ratio, depending on which side of the
membrane the roGFP2 is located. With this large dynamic range
the difference can be easily detected from merge images and the
respective false-colored ratio image (Fig. 6).

ReTA is also applicable to the analysis of multi-spanning pro-
teins. Successive deletion of predicted transmembrane domains
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Fig. 5 Schematic diagram showing the main elements of the redox ratio analysis software. Single images (a)
or multichannel, multidimensional images (b) are loaded into the software, aligned, filtered and, if appropriate,
the dimensionality reduced using projection algorithms. Quantitative measurements of the redox potential in
the ER are made using manually defined regions-of-interest (ROIs) (c). Alternatively, the redox potential can be
visualized from pseudo-color coded ratio images, following background subtraction and autofluorescence
correction (d). Redox-based Topology Analysis (ReTA) can be used to determine the topology of membrane
proteins by exploiting the oxidizing environment within the lumen of the ER versus the reducing environment in
the cytoplasm to alter the signal from roGFP fused to either the N- or the C-terminus (e, f). Alternatively,
dynamics in ER redox potential can be visualized from movies (g) or kymograph analysis (h)
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from the C-terminus and fusion of roGFP2 to the new C-terminus
enables alternate orientation of roGFP2 to either the cytosol or the
ER lumen depending on the presence of even or uneven numbers
of transmembrane domains remaining [18]. Severe truncations
may prevent integration into the ER membrane. In this case,

Fig. 6 Redox-based Topology Analysis (ReTA) of ERO1. Soluble roGFP2 in either the cytosol (a, roGFP2) or the
ER lumen (b, sp::roGFP2:HDEL) provide reference values for the ratio values expected in each compartment.
Fusion of roGFP2 to the N- and the C-terminus reports the ER thiol oxidase ERO1 as a type II protein with the
N-terminus facing the cytosol (c) and the C-terminus being localized in the ER lumen (d). Images are shown as
maximum intensity projections of z-stacks of epidermal cells of Agrobacterium-infiltrated tobacco leaves with
excitation at 488 or 405 nm light and as a merged image. The pseudo-color coded ratio images were
generated from single z-planes of the depicted cells using the ratio analysis software
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internal tagging of the protein of interest by integrating roGFP2
into extramembrane loops may allow the visualization of these
loops with respect to their orientation.

3.9 Plant Growth and

Transient Transfection

Routine screening for membrane topology uses transient expres-
sion in tobacco leaf epidermis as a convenient experimental system.
Transformation of tobacco leaf epidermal cells is performed by
standard techniques [35] using Agrobacterium tumefaciens con-
taining binary vectors with roGFP2 or roGFP2 fusion proteins.
Epidermal cells from infected regions of the tobacco leaf epidermis
are imaged by confocal laser scanning microscopy (CLSM)
2–4 days after inoculation.

3.10 Targeting of

roGFP2 to the ER

Lumen

1. PCR-amplify roGFP2 using the primers 50-ACCATGGTGAG-
CAAGGGCGAGGAG-30 (forward; NcoI site underlined) and
50-TCTAGACTTGTACAGCTCGTCCAT-30 (reverse; XbaI
site underlined) to introduce appropriate restriction sites and
remove the start and stop codons.

2. Blunt end-ligate the amplified product into pCAPS (Roche,
http://www.roche.de).

3. Clone the NcoI/XbaI fragment into pWEN81 between the N-
terminal chitinase ER-signal peptide and the HDEL retrieval
signal.

4. Sub-clone the entire cassette consisting of roGFP2 with the N-
terminal chitinase targeting signal and the C-terminal HDEL
motif into the binary vector pWEN22 under the control of a
strong constitutive CaMV 35S promoter using XhoI and SacI
restriction sites.

3.11 Construction of

roGFP2 Fusions with

Transmembrane

Proteins

The objective is to splice the roGFP2 cDNA sequence in-frame
upstream or downstream of the N- or C-terminus, respectively, of
the target protein or in-frame after each putative transmembrane
domain (TMD) in truncated protein fragments. The orientation of
the TMD is inferred from the degree of oxidation of the roGFP2,
with the assumption that the addition of the roGFP2 moiety does
not alter the native target protein structure.

1. Fusion proteins can be generated by assembly PCR, using
appropriate primers, gateway cloning, or by replacement of
elements within a full length construct. A full set of gateway
compatible vectors for N- and C-terminal fusion of transmem-
brane proteins with roGFP2 plus control constructs are avail-
able from Addgene.

2. Constructs are introduced via Agrobacterium-mediated trans-
formation as in Subheading 5.1 and imaged with CLSM [35].

3. Data are analyzed using the redox ratio software (seeNote 10).

ER Quantitation 63

http://www.roche.de


4 Notes

1. The values of FWHMmin are used to calculate a resampling
factor needed to ensure that the minimum apparent tubule
width is at least 7 pixels wide to reduce pixelation errors later
on. This is based on a pixel size of 20 nm and an estimated
lateral FWHM for the Zeiss Airyscan psf of 140 nm. Likewise,
FWHMmax is used to determine the number of scales to use in
the subsequent steps to ensure both that the largest tubules are
correctly segmented and also that structures above this limit are
identified as cisternae.

2. Care is needed with this step as the automatic thresholding
operation may introduce breaks in some dim tubules, render-
ing those tubules unavailable for consideration in subsequent
processing and analysis steps.

3. CLAHE visually helps the user see detail across the whole
image, but is only needed if the subsequent segmentation
step is dependent on image intensities rather than phase
congruency.

4. The filtering and contrast adjustment are applied to aid seg-
mentation of the pixel skeleton. Quantitative measurements
always refer back to the original image intensities.

5. The result of the enhancement steps can also be smoothed
using coherence or guided filtering.

6. In each case, the number of scales is initially set by the ratio of
FWHMmax/FWHMmin with a minimum bound of 3. How-
ever, this can be overridden by the user. This may be necessary
to ensure that larger features are also processed prior to seg-
mentation. The number of orientations is fixed at 6. In the
case of the anisotropic Lopez-Molina filters, the anisotropy is
set at 1.3.

7. If the automated methods to delineate the pixel skeleton are
still incorrect, the skeleton can be edited manually.

8. An additional option is available to increase the speed of the
granulometry by using decomposition of the disk-shaped
structuring element into a set of linear elements. This requires
an empirically determined correction of �1 pixel to the esti-
mated width to compensate for the over-sampling with essen-
tially square kernel approximations (see for example Fig. 3h).

9. We have found that the simplest way to estimate the empirical
intensity calibration factor is to take the average intensity for a
cisternal sheet (using the profile tool). Typically this is about
0.3–0.5 and represents the signal expected for a sheet-like
structure completely filling the (x,y) plane of the psf with the
same thickness as the tubules.
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10. While roGFP2 in most fusions with membrane proteins will
provide a four- to fivefold difference in the 405/488 mm
fluorescence ratio depending on whether the probe faces the
cytosolic or the lumenal side of the ER membrane, there may
be cases in which roGFP2 thiols undergo formation of mixed
disulfides with lumenal proteins or even thiol residues of the
protein under investigation. Because the respective thiols of
roGFP2 would then not be available for internal disulfide
formation, this would effectively diminish the dynamic range
of the reporter. Nevertheless, the difference in ratio will be
large enough to get a binary readout (see for example Fig. 5f).
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Chapter 6

Long-Term Imaging of Endoplasmic Reticulum Morphology
in Embryos During Seed Germination

Natasha Dzimitrowicz, Emily Breeze, and Lorenzo Frigerio

Abstract

Imaging plant embryos at the cellular level over time is technically challenging, since the embryo, once its
protective seed coat is removed, must be kept viable and unstressed on a microscope slide for the duration
of the experiment. Here we describe a procedure and suitable apparatus for the visualization, over several
days, of changes in endoplasmic reticulum (ER) morphology associated with the process of germination in
Arabidopsis thaliana seeds. Moreover, we also present a user-friendly image analysis tool which enables
subtle perturbations in the ER network to be measured.

Key words Confocal microscopy, Imaging chamber, Embryo, Germination

1 Introduction

Seed germination can be defined as the series of events occurring
between the uptake of water by the dry seed (imbibition) and the
elongation of the embryonic axis which, in Angiosperms, culmi-
nates in the emergence of the radicle through the seed coat [1, 2].
Upon imbibition the seed rapidly commences metabolic activities
with a high concomitant demand for de novo protein and lipid
biosynthesis, thus placing a considerable burden on the endoplas-
mic reticulum (ER), which continues throughout germination [1,
3]. Since the time taken for germination and post-germination
growth can vary from hours to weeks, depending on the plant
species and/or environmental conditions, imaging changes in cel-
lular morphology associated with this process is challenging. More-
over, it is not possible to obtain confocal microscopy images
through the seed coat which must, therefore, be removed prior to
imaging. Here we describe a time series of ER morphology changes
associated with the germination of Arabidopsis thaliana embryos
over a period of 8 days, from seed imbibition through to fully
emerged seedling. By first removing the seed coat and then immo-
bilizing the embryos in sterile Murashige and Skoog (MS) media,

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_6, © Springer Science+Business Media LLC 2018
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containing appropriate antibiotics, in an imaging chamber, we were
able to obtain live confocal images of cellular events occurring
during germination. It is possible to embed several arabidopsis
embryos in a single imaging chamber, enabling multiple replicates
to be imaged under identical conditions; and also to apply the
described methodology to other plant species, depending on the
size of the embryos. We were further able to analyze the images
post-acquisition in order to assess the subtle temporal differences in
the ER network.

2 Materials

Prepare all solutions using sterile ultrapure water.

1. Murashige and Skoog (MS) medium: Weigh 0.44 g Murashige
and Skoog basal salt mixture and 1 g bacteriological agar into a
suitable, autoclavable container. Add water to a volume of
90 ml and mix. Adjust pH to 5.7 � 0.1 with KOH or HCl.
Add additional water to bring the total volume to 100 ml.
Sterilize the medium by autoclaving. Use immediately or
store at 65 �C. Appropriate antibiotics can be added immedi-
ately prior to use.

2. Arabidopsis seeds transformed with the desired fluorescent
markers or fusion proteins. Here we used stable lines carrying
the ER luminal marker GFP-HDEL [4].

3. CoverWell™ imaging chamber (1 � 20 mm) (supplier Grace
Biolabs). A reusable press-to-seal silicone chamber which forms
a removable enclosure designed to stabilize and support free-
flowing samples (Fig. 1).

3 Methods

All procedures should be carried out at room temperature unless
otherwise stated.

3.1 Preparation of

Embryos for Imaging

1. Add 50–100 dry seeds to a 2 ml round-bottomed Eppendorf
tube and carefully add 1 ml sterile water. Incubate tube at 4 �C
for 1 h in the dark.

2. Using a wide bore pipette tip (or a cut yellow tip), transfer
some of the seeds to a clean petri dish (see Note 1) and view
under a stereomicroscope with appropriate lighting and
magnification.

3. Hold an individual seed against its longitudinal axis with fine
forceps. Carefully cut the seed coat (including testa and endo-
sperm) along its length using a syringe needle (e.g., U100
insulin needle), starting at the end of the seed closest to
where the cotyledons join the radicle.
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4. Using forceps, gently and smoothly squeeze the seed at the end
furthest from the cut (i.e., closest to the tip of the cotyledons
and radicles) to release the intact embryo out of the seed coat
through the created opening (see Note 2).

5. Using a syringe needle, carefully transfer the uncoated embryo
to a 2 ml round-bottomed Eppendorf tube and store in a
minimal amount of sterile water while further embryos are
collected, for up to a maximum of 60 min.

3.2 Preparation of

Imaging Chamber

The following steps should be carried out inside a laminar flow
hood cabinet. For all stages, see Fig. 1.

1. Prior to use, thoroughly clean the imaging chamber with 70%
ethanol (Fig. 1a).

Fig. 1 Assembly of the imaging chamber. The clean imaging chamber (a) is filled with MS agar media
containing appropriate antibiotics (b) and allowed to set before carefully being turned out onto a sterile
microscope slide (c, d). Uncoated embryos, prepared previously and stored in water, are gently pipetted into
the chamber (e) and covered with the agar disk (f), and the chamber securely taped to the slide (g). The height
of the assembled apparatus is adjusted, as required with tissue and further tape (h, i). All steps should be
performed under sterile conditions. Arrow indicates position of uncoated embryo
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2. With a sterile pipette tip, add 900 μl MS agar at ~60 �C to a
CoverWell™ imaging chamber (or equivalent) and allow to set
(Fig. 1b).

3. Carefully transfer the disk of agar onto a clean, sterile, micro-
scope slide (Fig. 1c, d) (see Note 3).

4. Using a sterile wide-bore pipette, transfer 3–4 uncoated
embryos into the imaging chamber in a minimal amount of
water (Fig. 1e) (see Note 4).

5. Carefully invert the imaging chamber and place it onto the agar
disk on top of the embryos in the chamber (Fig. 1f) (see Note
5). Remove excess water with a tissue. Once mounted, the
embryos should not move freely under the agar.

6. Fix the prepared imaging chamber to a clean microscope slide
and secure with electrical insulation tape, or equivalent, ensur-
ing that the embryos are clearly visible (Fig. 1g). Fold two
suitably sized pieces of tissue paper and affix to the outer
edges of the slide with additional tape, to equalize the thickness
of the whole apparatus (Fig. 1g, h).

7. Place the assembled chamber into a growth cabinet under the
desired environmental conditions. Remove the apparatus at the
desired time points and image under a confocal microscope
with the appropriate settings for the desired fluorophores.
After imaging remove any residual immersion oil from the
slide with ethanol. Between imaging sessions, return the cham-
ber to the growth cabinet (Fig. 2).

3.3 Analysis The following macro is designed to estimate the proportion of ER
sheets to tubules from a confocal image (Fig. 3). The macro runs in
the freely available ImageJ-based open-source processing package
Fiji [5] using the Bio-Formats plugin [6] and so requires the latest
version of this software to be installed prior to use. It also requires a
representative image of the ER containing both sheets and tubules
in order to train the segmentation classifier.

1. Open the relevant confocal image file in Fiji (seeNote 6), and set
the background of the binary image to black (Edit >
Options > Colors. . .) (Fig. 3a).

2. Apply amedian filter (radius 2 pixels) to reduce the salt and pepper
noise (Process> Filters >Median) (Fig. 3b).

3. Normalize the image by setting the saturation levels to 0.5%
(Process > Enhance > Contrast. . .) (Fig. 3c).

4. Segment the image to create a binary image of the total ER
network by applying the Trainable Weka Classifier (v3.2.5)
function (Plugins > Segmentation > Trainable Weka Segmen-
tation) [7, 8] (Fig. 3d). Load a representative image of the ER
containing both tubules and sheets. Use the “Freehand line”
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selection tool to identify areas of ER and background and
assign them to either Class 1 (ER) or Class 2 (Background).
Use a minimum of five selections for each class to train the
classifier, and save as a “.model” file.

5. Load the classifier file and select Create Result to segment the
image (“Classified Image”). Convert this image into a binary
image (Process > Binary > Make Binary).

Fig. 2 Changes in ER morphology during germination. Confocal images of the ER, as labeled with the luminal
marker GFP-HDEL, obtained from a single germinating embryo in an imaging chamber with images obtained
daily for a total of 8 days, together with the corresponding images of the whole embryo. Confocal image scale
bars ¼ 10 μm. Whole embryo image scale bars ¼ 0.5 mm
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Fig. 3 A Fiji-based macro for the estimation of ER sheet abundance post-image acquisition. A confocal image
of the ER network in a germinating embryo was analyzed by a macro written for the open-source platform Fiji
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6. Duplicate the binary segmented image (a and b). Apply an
erode function to ImageA (iterations ¼ 3; count ¼ 1) to
remove thinner structures from the image such as tubules
(Process > Binary > Erode). Save eroded image file (ER sheets
only) (Fig. 3f) and unaltered binary image (total ER network)
(Fig. 3e).

7. Color Pixel Counter plugin [9] (see Note 7). Convert both
images to RGB Color (from 8-bit) (Image > Type > RGB
Color). Run the Color Pixel Counter to count green pixels in
the unaltered binary image (Fig. 3e) and red pixels in the
eroded image file (Fig. 3f) (cells ¼ 20; pixels ¼ 0.2100; mini-
mum ¼ 30) (Plugins > Color Pixel Counter) (see Note 7).

8. The proportion of sheets in the image can be calculated from
the ratio of pixels in the eroded image (Fig. 3f) to that in the
total binary image (Fig. 3e) (see Note 8) (Fig. 3g).

4 Notes

1. It may help to have a small piece of Whatman filter paper or
microscope lens cleaning tissue on the petri dish to absorb
excess water and limit movement of the seed during uncoating.

2. Uncoating embryos, and ensuring that they remain intact and
undamaged, is technically challenging and likely requires
extensive practice. The use of two syringe needles, in addition
to forceps, may help with both the manipulation of the seed
and the application of pressure to ease the embryo out of the
seed coat.

3. The imaging chamber is relatively flexible and so it is possible to
bend it slightly to allow the agar disk to become dislodged.

4. When transferring the uncoated embryos to the imaging cham-
ber, care should be taken to ensure that they don’t become
damaged. Once in the chamber it is beneficial to ensure that the
embryos are well-spaced and not clumped together to allow
them sufficient room to expand over the time course.

5. It is important to ensure that only a minimal amount of water is
used to transfer the embryos to the imaging chamber so that
when the chamber is inverted the surface tension of the water
keeps the embryos on the coverslip.

�

Fig. 3 (continued) [5]. (a) Original (unmanipulated) confocal image. (b) Median-filtered image. (c) Contrast-
enhanced image. (d) Trainable Weka Classified image. (e) Binary image (total). (f) Eroded binary image. (g)
Proportion of the total ER network identified as sheets by our image analysis macro from day 1 to 6 of embryo
germination
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6. If the image file is a Z-stack, then it must be converted into
single images, by either selecting an appropriate slide
(Image > Stacks > Stack to Image) or converting the stack to
a projection (Image > Stacks > Z-project. . ..).

7. The Color Pixel Counter plugin is not included in the standard
Fiji package and so must be downloaded separately and saved
to Program Files\Fiji.app\plugins (or equivalent location; NB
the filenamemust be altered so that each word is capitalized). It
is freely available from http://imagejdocu.tudor.lu/doku.php?
id¼plugin:color:color_pixel_counter:start.

The choice of red or green pixels for the eroded and binary
images, respectively, is arbitrary and simply allows the user to
identify which results were obtained from which image since
the Color Pixel Counter identifies the number of white pixels as
colored pixels.

8. Be aware that the zoom level applied in the images will impact
on the results obtained. This can be negated by converting the
pixel count to an area (microns). First identify the resolution of
the image (Image > Show Info. . .), and then calculate the
square root of the number of green or red pixels, divided by
the resolution. By squaring this result the area in microns can
be calculated, and used to determine the proportion of ER
sheets present in the image.

References

1. Bewley JD (1997) Seed germination and dor-
mancy. Plant Cell 9:1055–1066

2. Finch-Savage WE, Leubner-Metzger G (2006)
Seed dormancy and the control of germination.
New Phytol 171:501–523

3. Holdsworth MJ, Bentsink L, Soppe WJJ (2008)
Molecular networks regulating Arabidopsis seed
maturation, after-ripening, dormancy and ger-
mination. New Phytol 179:33–54

4. Boevink P, Cruz S, Hawes C, Harris N (1996)
Virus-mediated delivery of the green fluorescent
protein to the endoplasmic reticulum of plant
cells. Plant J 10:935–941

5. Schindelin J, Arganda-Carreras I, Frise E et al
(2012) Fiji: an open-source platform for

biological-image analysis. Nat Methods
9:676–682

6. Linkert M, Rueden CT, Allan C et al (2010)
Metadata matters: access to image data in the
real world. J Cell Biol 189:777–782

7. Arganda-Carreras I, Kaynig V, Rueden C et al
(2017) Trainable Weka Segmentation: a
machine learning tool for microscopy pixel clas-
sification. Bioinformatics. doi:10.1093/bioinfor
matics/btx180

8. Arganda-Carreras I, Kaynig V, Rueden C et al
Trainable_Segmentation: release v3.1.2 [data
set]. Zenodo. doi:10.5281/zenodo.59290

9. Pichette B (2012) Color pixel counter. Available
at http://imagejdocu.tudor.lu/doku.php?
id¼plugin:color:color_pixel_counter:start

74 Natasha Dzimitrowicz et al.

http://imagejdocu.tudor.lu/doku.php?id=plugin:color:color_pixel_counter:start
http://imagejdocu.tudor.lu/doku.php?id=plugin:color:color_pixel_counter:start
http://imagejdocu.tudor.lu/doku.php?id=plugin:color:color_pixel_counter:start
https://doi.org/10.1093/bioinformatics/btx180
https://doi.org/10.1093/bioinformatics/btx180
https://doi.org/10.5281/zenodo.59290
http://imagejdocu.tudor.lu/doku.php?id=plugin:color:color_pixel_counter:start
http://imagejdocu.tudor.lu/doku.php?id=plugin:color:color_pixel_counter:start
http://imagejdocu.tudor.lu/doku.php?id=plugin:color:color_pixel_counter:start


Chapter 7

Dancing with the Stars: Using Image Analysis to Study
the Choreography of the Endoplasmic Reticulum and
Its Partners and of Movement Within Its Tubules

Lawrence R. Griffing

Abstract

In this chapter, approaches to the image analysis of the choreography of the plant endoplasmic reticulum
(ER) labeled with fluorescent fusion proteins (“stars,” if you wish) are presented. The approaches include
the analyses of those parts of the ER that are attached through membrane contact sites to moving or
nonmoving partners (other “stars”). Image analysis is also used to understand the nature of the tubular
polygonal network, the hallmark of this organelle, and how the polygons change over time due to tubule
sliding or motion. Furthermore, the remodeling polygons of the ER interact with regions of fundamentally
different topology, the ER cisternae, and image analysis can be used to separate the tubules from the
cisternae. ER cisternae, like polygons and tubules, can be motile or stationary. To study which parts are
attached to nonmoving partners, such as domains of the ER that form membrane contact sites with the
plasma membrane/cell wall, an image analysis approach called persistency mapping has been used. To study
the domains of the ER that are moving rapidly and streaming through the cell, the image analysis of optic
flow has been used. However, optic flow approaches confuse the movement of the ER itself with the
movement of proteins within the ER. As an overall measure of ER dynamics, optic flow approaches are of
value, but their limitation as to what exactly is “flowing” needs to be specified. Finally, there are important
imaging approaches that directly address the movement of fluorescent proteins within the ER lumen or in
the membrane of the ER. Of these, fluorescence recovery after photobleaching (FRAP), inverse FRAP
(iFRAP), and single particle tracking approaches are described.

Key words Endoplasmic reticulum, Network flow, Network movement, Persistency mapping, Mem-
brane contact sites

1 Introduction

The endoplasmic reticulum (ER) is an extremely dynamic organelle
that ramifies throughout the cytosol of plant cells [1, 2]. One might
expect this, given that it is tethered to other dynamic organelles like
the Golgi body, the peroxisome, and the mitochondrion. Remark-
ably, it is also tethered to less dynamic organelles such as the
chloroplast, the nucleus, and the plasma membrane. How image
analysis is currently used and could be used in the future to analyze

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_7, © Springer Science+Business Media LLC 2018
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the choreography of this dance with still, slow, and fast partners is
the subject of the first part of this chapter. But there is another
dance going on as well: the dance of the proteins, lipids, ions, and
secondary metabolites in the endoplasmic reticulum itself. Some-
times these two dances are confused. As proteins move through the
ER, they are sometimes considered as the movement of the ER
itself. It is as if the movement of costume of the dancer were taken
to be the movement of the dancer herself. Although this is an easy
enough mistake to make, it is important to follow the movement of
the dancer, the ER, and the costume, the surface or luminal markers
of the ER, separately. It is important to keep in mind that both
forms of movement involve the complicated physics of the small
(the ER is about 60 nm in diameter) in a highly viscous, high
Reynold’s number, environment.

We approach this by deconstructing ER dynamics into two
broad categories: network movement, the movement and remodel-
ing of the tubules and cisternae, and network flow, the movement of
protein and lipid (and ions) within the ER lumen and the ER
membrane. Approaches to the analysis of network movement are
first described. The ER is made of network of tubules and cisternae,
and in special cases like brassicaceous plants, e.g., arabidopsis spe-
cies, the lozenge-shaped ER body. One quantifiable characteristic
of the network is the mesh size of the network (Sects. 3.3 and
3.4.2). Another quantifiable feature is the distribution of the
tubules and the cisternae, which can be separated using morpho-
logical image processing routines on binary images (Sects. 3.4.3
and 3.4.6). The ends and junctions of tubules can be quantified
(Sect. 3.4.5). These operations, when combined with image inter-
val subtraction, can be used to create separate persistency maps for
tubules and cisternae that identify the most and least persistent
tubules over the time period of observation and interval of analysis
(Sect. 3.4.7). Using persistency mapping, the movement and form
of the ER was shown to be differentially sensitive to dominant-
negative tail domain expression of the six (of 13 in arabidopsis)
paralogs of myosin XI that are involved in the motility of spheroid
organelles like peroxisomes, mitochondria, and Golgi [3–5]: XI-
2 (Myo11B2), XI-C (Myo11C1), XI-E (Myo11C2), XI-K
(Myo11E), XI-1 (Myo11F), and XI-I (Myo11G). Note that the
new nomenclature for these genes [6, 7] follows their old nomen-
clature in parentheses. While XI-C (Myo11C1) and XI-E
(Myo11C2) have their largest effects on ER tubulation, XI-K
(Myo11E), XI-1 (Myo11F), and XI-I (Myo11G) have their largest
effects on cisternalization. Of the latter, XI-I (Myo11G) localizes to
the nuclear envelope and is involved in forming or maintaining
tubules that are coextensive with the cisternal structure of the
nuclear envelope [8].

In a separate study examining insertional mutants of XI-K
(Myo11E), XI-1 (Myo11F), and XI-2 (Myo11B2) [9], XI-1
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(Myo11F) mutation was only found to have an effect on ER
dynamics if it was crossed with XI-2 (Myo11B2) or XI-K
(Myo11E) mutations. This contrasts with the work [4], where
XI-1 (Myo11F) tail domain expression alone caused an increase in
cisternal and tubule persistency, while XI-2 (Myo11B2) tail domain
expression alone shows no effect on tubule or cisternal persistency
[4], but has been shown to slow streaming rates of spheroid orga-
nelles. However, the way that dynamics were measured in [9] was
different from persistency analysis. LPX flow (originally called Kbi
flow, [9]) uses an optic flow approach and is described below
(Fig. 7). The reason for the difference between the two analyses is
that optic flow approaches do not distinguish network movement
from network flow and, using a mask, excludes the dynamics of the
fainter, tethered, polygonal ER, where much of the remodeling
occurs (Fig. 7).

The implementation of persistency mapping has identified per-
sistent junctions in the ER at which it remains tethered to the
plasma membrane (persistent cisternae less than 0.3 square μm in
area [2]). Originally called anchor points, they are now considered
ER/PM membrane contact sites (MCS) [5]. However, it is impor-
tant to note that the cortical ER probably has more than one
manner of tethering to the plasma membrane, with some tethers
more persistent than others. To date, persistency mapping has only
been used on cortical ER, but could be used for other organelles or
features of them. For example, if organelles need to be anchored to
the plasma membrane/cell cortex in order to divide, as occurs in
with mitochondria in yeast [10], the population of those mitochon-
dria becoming attached to the membrane/wall could be quantified
in plants and related to those events which accompany division. It
could map the choreography that leads to ER associating with the
mitochondria and then tethers to the plasma membrane as mito-
chondrial division is completed.

Just as the movement of the dancer’s costume is different from
the movement of the dancer, so the flow of the proteins and,
probably, lipids in the membrane and lumen of the ER network is
different from the movement of the network itself. As mentioned
above, optic flow approaches combine these two types of move-
ment into one measurement [9]. However, there is a remarkable,
directional network flow of membrane [3, 11] and luminal [12]
protein in plants that is not found in animal cells where network
flow in the ER is primarily by diffusion [13] and diffusional con-
straints imposed by glycosylation and the actin cytoskeleton [14].
When considering network flow in plants, the distinction is there-
fore made between advective flow (movement in a constant velocity
field), active flow (movement in changing velocity fields), and flow
by diffusion. The directional flow in the ER is dependent on the
actinomyosin cytoskeleton, but whether it is advective or active is
unknown. Directional flow of photoactivated GFP fused to the
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cytoplasmic domain of truncated calnexin (CNX-paGFP [3, 11])
can be inhibited with latrunculin b treatment or tail domain expres-
sion of XI-K (Myo11E). Directional flow can also be shown with
fluorescence recovery after photobleaching (FRAP) approaches
(see below, sect. 3.5.1), where the movement of the photobleached
GFP-HDEL can be studied. A similar kind of directional flow
also occurs in the tubules arising from chloroplasts, the stromules,
but it has been shown, using fluorescence correlation spectroscopy
(FCS), to be active and dependent of cellular ATP levels [12].
While myosin XI and the actin cytoskeleton have been shown
to associate with stromules and are involved in movement of stro-
mules [15], evidence for cytoskeletal involvement in stromule
directional flow is lacking.

Even though flow directionality in the plant ER is dependent on
the actinomyosin cytoskeleton, how the cytoskeleton modulates
flow rate is unknown. In fact, it is difficult to get consistent mea-
surements of flow rates in plant epidermal cells. Half-times of
fluorescence spread after photoactivation of CNX-paGFP vary by
50% in the same cell type, at the same developmental stage [3].
Half-times of fluorescence recovery after photobleaching (FRAP)
of CNX-GFP vary less, but by 30% [3]. In the face of this high
variability, no significant difference in the rate of flow has been
detected between control (untreated) cells and those with latrun-
culin b treatment and XI-K (Myo11E) tail domain expression [3].
A major contributor to this variability may be the different, chang-
ing geometries of the 3D structure of the ER [16–20]. In animal
cells, during diffusion-limited network flow, very different FRAP
half-times of recovery can be completely attributed to different 3D
geometries [16, 19]. In the last method in this chapter (see below,
sect. 3.5.2), it is shown how particle tracking of ER aggregates in
constitutively stressed cells in the mutant ceh-1 [21] can be used to
examine rates of flow in the ER after the cell, thereby overcoming
the problems of calculating diffusion constants from fluorescence
recovery rates and providing a means to examine rates in specific 3D
domains.

2 Materials

1. Medium: Murashige and Skoog basal medium (Cat # MSPO1-
1LT, Caisson Labs, Smithfield, UT, USA) with or without
0.25 (w/v) sucrose and 0.9% w/v agar (Plant cell culture
tested, Cat # A8678, Sigma-Aldrich, St. Louis, MO, USA).

2. VALAP: a 1:1:1 mixture of VAsaline, LAnolin, and Parafin (or
beeswax) [22].

3. 100 mM MES (Free Acid, Cat # 475893, Sigma-Aldrich, St.
Louis, MO, USA) Buffer, titrated to pH 5.8 with 100 mM
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KOH—as stock, diluted 1:10 for imaging and for treatment
with different fluorescent dyes.

4. Fluorescent dyes (see Note 1): Cell walls (and nuclei of dead
cells): Propidium iodide (Cat # P1470, Sigma, St. Louis, MO,
USA) used at a final concentration of 1 μg/ml. DiOC6 stains
the ER and mitochondria of the abaxial epidermis of onion
scales adequately [23], but there are problems with the gener-
ation of reactive oxygen species with exposure to light [24].
DiOC6 (DiOC6(3), 3,3

0-Dihexyloxacarbocyanine Iodide, Cat
# D273, ThermoFisher Scientific, Molecular Probes) 2 mM
stock solution dissolved in 100% ethanol (or acetone) as a stock
solution and used at 2 μM concentration (see Note 2). ER
Tracker red and green dyes (ThermoFisher Scientific) are not
recommended for arabidopsis, since the protein to which they
bind through the glibenclamide adduct, AtMRD5/AtABCC5,
the sulfonyl receptor portion of the ATP-sensitive potassium
channel that transports phytate, is on the plasma membrane in
guard cells [25] and the vacuole in other plant cell types [26].

5. Transgenic arabidopsis expressing GFP-HDEL [27],
mCherry-HDEL, or YFP-HDEL (plasmids and/or seed is
available through the arabidopsis Biological Resource Center,
www.arabidopsis.org), and transgenic Nicotiana benthamiana
expressing GFP-HDEL [28] orNicotiana tabacum leaves tran-
siently expressing the above fluorescent ER-labeling constructs
[29] and the fluorescent tail domains of myosin XI [4]. A
significant fraction of eGFP could be nonfluorescent and mis-
folded [30]. The relatively noninteractive mCherry-HDEL and
superfolded (sf)GFP-HDEL are good passive markers of the
ER lumen. mCherry constructs are reported to be “sticky”
when labeling oligomeric or membrane proteins [24], so
should probably only be used for studies on luminal proteins.
sfGFP [31] has the advantages of being monomeric, lacking N-
glycosylation sites, and being resistant to disulfide bond forma-
tion [24]. It should be fusion protein of choice for both lumi-
nal fusion proteins and membrane fusion proteins.

6. Laser Scanning Confocal Microscope with FRAP software. The
ones used for these analyses are the Zeiss LSM510 and the
Olympus Fluoview 1000.

7. In all of the following methods, implementation is described
using ImageJ (https://imagej.nih.gov/ij/) version 1.45 or
higher, and as it is used in the ImageJ version containing
many useful plugins, FIJI (www.fiji.sc), version 2.0.0. Addi-
tional plugins not part of the FIJI package are listed below. For
security reasons, it is recommended that Java version 1.8 jre or
higher is used (see Note 3).
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3 Methods

3.1 Microscopy of

Living Plant Tissue

1. Select relatively planar surfaces for imaging 25 square mm or
less (half a cm on a side or less) sections of mature tobacco
leaves in buffer under a 22 � 22 mm coverslip sealed with
VALAP.

2. Select relatively planar regions from epidermal cells of roots,
shoots, or cotyledons from 6–7-day-old seedlings of arabidop-
sis, whichfit entirely under a single coverslip (seeNotes4 and5).

3.2 Using ImageJ

Macros for Image

Processing Pipelines

1. In order to provide the methods of several approaches in this
chapter, an example imaging pipeline is included as a Macro
file, available for download at http://griffing.tamu.edu.

2. Copying these files, or following the sequence given below
while recording a Macro, saving them in ImageJ macro format
(as an .ijm file in the Macro folder), and editing them so that
they use file systems on the host computer of choice should
provide an easily accessible way to implement the approaches
described below.

3. Recording a Macro. ImageJ provides a useful Macro imple-
mentation that can be set up for processing pipelines using the
command, Plugins>Macro>Record. Command sequences
such as this one are described by the sequence of “pull down”
sub-commands from the menu bar (Fig. 1) which appears

Fig. 1 ImageJ menu structure and accessing macro commands. (a) Top menu
bar of ImageJ (or the FIJI version) with the Plugins command highlighted in blue.
The Plugins>Macros command is shown in the plugins pull-down menu. The
Plugins>Macros>Record command is shown in the macros pull-down menu.
(b) Macro recorder window. The top of the window is shown. The name of the
macro can be edited, but the recorder does not save the recorded actions until
the Create button is clicked. Closing the recorder without clicking on create loses
the macro
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when ImageJ or FIJI is started. To record a Macro, click on
(select) Plugin in the main menu bar. Select the top option
Macro. Select the Record option. Besides being useful for
processing image pipelines, the Macro feature can be used as
an imaging “lab book” to record the steps by which an image is
processed (see Note 6).

4. After recording the sequence of steps in the imaging pipeline,
the Create command on the Macro dialog box (Fig. 1) has to
be selected because just closing the Macro dialog box does not
save the recorded Macro and it will be lost.

5. For ImageJ to “see” the Macro, the Macro file (written in the
imagej macro or .ijm format) is saved or placed in the Macro
folder in the ImageJ folder.

3.3 Installing,

Running, and Editing

Macros

1. To install a Macro, use the Plugins>Macro>Install command
and the Macro comes up as a separate command in the Plu-
gins>Macro bar. This is very useful for shortcuts and for
making Macros that include other Macros.

2. To run a Macro, use the Plugins>Macro>Run command and
select the .ijm file manually.

3. To edit a Macro, use the Plugins>Macro>Edit command and
select the .ijm file for editing. This can then be text-edited in
the Macro dialog screen.

4. Using image stacks for measurement after processing using a
Macro:

(a) TheMacro saves a series of images for measurement under
a common name for each sample in a group of replicates.
For example, each replicate could have an image named
AND.tif. These are transferred to a new folder sequen-
tially and Windows automatically assigns them numbers if
they have the same name (e.g., AND.tif, AND(2).tif,
AND(3).tif). Measurements are assigned with the com-
mand, Analyze>Set Measurements.

(b) The separate images can then be stacked in sequence with
the command, Image>Stacks>Images to Stack.

(c) The different replicates of one treatment can be measured
in the stack with one Analyze>Analyze Particles com-
mand following selection with the Image>Adjust>Thres-
hold command.

3.4 Network

Movement

3.4.1 Removing the drift

1. Make a time series movie.

2. Check to see if reference points are moving, such as cell corners
or other external wall features that can be seen after treatment
with propidium iodide. This is done by mousing over the
precise points in the first and last frame in an imaging sequence
and noting if their coordinates have changed.
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3. If reference points are moving, use the optic flow-based stabili-
zation plugin by Kang Li using the Lucas–Kanade algorithm
with the command Plugins>Image_Stabilizer.

4. Another plugin that has more options in terms of template
matching and the implementation of cross-correlation is the
“Align slices in stack” plugin by Qingzong Tseng (seeNote 7).

3.4.2 Measuring average

mesh size (Fig. 2)

1. Make a time series movie, usually 80 frames at about a second
per frame for standard line-scanning confocal microscopes.

2. The in-focus region is selected for the entire time series (movie).
This can be done manually (Fig. 2a) with the polygon tool. This

Fig. 2 ImageJ commands for ER mesh counting. (a) ImageJ top menu bar
showing the Edit>Clear Outside command. This can be achieved after a
region of interest (ROI) is selected with the polygon tool that excludes out-of-
focus regions (right-hand panel). If the image has a black background, the out-
of-focus regions can be excluded with the Clear Outside command once the
background has been set to black using the color palette (center panel) accessed
by double-clicking the eye-dropper icon (arrow). (b) Analyzing the mesh. The
dialog box for the Analyze>Analyze Particles command is shown (left panel),
with the “Exclude on edges” option checked. The Threshold dialog box (center
panel) from the Image>Adjust>Threshold command is shown selecting the low
intensity regions (mesh openings). During thresholding, the selected region is
red (right panel)
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region of interest is saved as infocus.roi using the
File>SaveAs>Selection command. Those out-of-focus areas are
cleared by the Edit>Clear Outside command after the color
picker (CP) is set to white on a black background. The color
picker is accessed by clicking twice on the “eye dropper” icon.

3. Those regions not occupied by membrane, i.e., the mesh spaces
(low intensity values), are selected using manual or automatic
gray scale thresholding. If the intensity differences between
pixels with and without ER are large enough, many different
automatic thresholding routines that isolate the low values
from the majority of the high values could be used (e.g.,
Minimum, Otsu, or IsoData segmentation algorithms found
in the Image>Adjust>Auto Threshold), but if not, then the
image is thresholded manually with the Image>Adjust>Thres-
hold command (Fig. 2b)—they turn red.

4. The low value regions in each frame are then counted and
measured. The “Area” and the “Stack Position” are selected
in the Analyze>Set Measurements dialog box. The area of the
mesh spaces for each image in the stack is measured with the
Analyze>Analyze Particles command. To avoid counting very
small (single pixel) regions, a lower limit of mesh space is put in
the Size variable in the Analyze Particles dialog box. Also, make
sure to click the exclude edge regions (Fig. 1b) before clicking
OK. This will produce a results table with Area and Slice
values—this can be ported to a spreadsheet program, such as
Microsoft Excel.

5. The mesh number (counted or calculated by average area per
mesh space/total mesh space area measured) and the number
and average area of mesh space per cubic μm (derived from the
in-focus area imaged and the depth of field) of cytoplasm can
then be calculated in a spreadsheet program, such as Microsoft
Excel (using the Averageif command to specify that feature
areas are averaged if they are in a certain frame), or with a
simple separate script in Python or Matlab.

3.4.3 Identification of

tubules vs. cisternae

(Fig. 3)

1. Select the fluorescent membrane with a threshold command,
Image>Adjust>Threshold, either on 8 or 16 bit images. The
original bit depth (intensity range) of the acquired image
should be maintained. In the example image (Fig. 3b), an
8 bit image is used.

2. The out-of-focus region can be cropped away using the
instructions in step 2(b). This will make the choice in the
next step easier.

3. A manual threshold value is used that is a compromise between
eliminating the out-of-focus low intensity blur and eliminating
continuity between thin tubules. Once a manual threshold level
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Fig. 3 Separating tubules from cisternae using 8 bit (Image>Type>8bit) morphological image processing. (a)
Morphological procedures for binary images summarized using a 3 � 3 pixel structuring element. Squares
represent neighboring pixels. Squares with minus signs produced during erosion or skeletonization mean that
the pixel is removed. Squares with plus signs produced during dilation means the pixel is added. The center of



is set, it is generally not changed between samples of proce-
dures. Two different threshold values are shown in Fig. 3. One
is chosen to eliminate the out-of-focus low intensity values
(80–255 Fig. 3c) while the lower intensity values are chosen
(40–255 Fig. 3h) to preserve the continuity of tubules. Auto-
matic thresholding based on the histogram can be used as in
MorphoER (LPX plugin [32], Fig. 5) but in the current imple-
mentation of MorphoER the threshold is so low that much the
out-of-focus image is included if smoothing is not used (com-
pare Fig. 5b with Fig. 2m). Automatic minimum value thresh-
olding algorithms such as the Minimum, Otsu, and IsoData
(from the pull-down menu in the Image>Adjust>Threshold
dialog box or from the Image>Adjust>Auto threshold dialog
box) and WEKA trainable segmentation (Plu-
gin>Segmentation>WEKA trainable segmentation) could be
explored to make the initial threshold values less subjective.

4. Create a binary image with the Make Binary command, Pro-
cess>Binary>Make Binary. Morphological image processing
(Fig. 3a) takes a binary image (Fig. 3c and d).

5. Operate on the binary image with the Open command, Pro-
cess>Binary>Open. Morphological processing can either add
(dilation) or subtract (erosion) pixels from a binary object’s
periphery based on the shape of the structuring element.
Opening is erosion followed by dilation. The number of itera-
tions for opening (and closing, step 1) can be set in the
Process>Binary>Options dialog box. In Fig. 3a, two side-by-
side cisternal structures with emanating tubules are considered.
The distance between them is two pixels. Opening eliminates
the emanating tubules. After opening the cisternae are isolated,
but remain the same area (Fig. 3a and e) [2, 4]. The areas of all
of the cisternae in a frame can then be measured using the
Analyze>Measure Particles command, described above in

�

Fig. 3 (continued) the structuring element is put over the target pixel and if any of the structuring element
pixels don’t cover a neighboring pixel, the pixels underlying the structuring element are added (dilation) or
removed (erosion). (b) An image of the ER. Scale bar ¼ 10 μm. (c) Result of thresholding at a gray level of 80
and using the Binary>Make Binary command. (d) One iteration of a Process>Binary>Close command. (e)
The result of two iterations of the Process>Binary>Open command (number of iterations can be adjusted in
the Binary>Options command). (f) Skeletonization of (d) using the Process>Binary>Skeleton command. (g)
Subtracting the cisternal regions from the skeletons using the Process>Image Calculator command. (h)
Binary image resulting from thresholding at a gray value of 40 using the Process>Binary>Make Binary
command. (i) Euclidean distance map of (h) (pseudo-colored with the Cyan>Hot lookup table, LUT) using the
Process>Binary>Distance Map command. (j) Skeletonization of (h) after one closing operation. (k) Result of
thresholding (i) above a gray value of 3. (l) Result of combining (e) and (g), pseudocoloring (e) orange and (g)
white. (m) Result of combining (k) and (j) (k can be subtracted from j for analysis), pseudocoloring (k) orange
and (j) white. Arrows in (l) and (m) show a differently processed cisterna. Stars show region of low signal
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mesh measurement. The results table is saved as an .xls file,
opened in Excel, and converted to a worksheet format (.xlsx).

6. The Euclidean distance of each pixel from a background (0)
value can be calculated and mapped as an intensity map or
image (Fig. 3i) using the Process>Binary>Distance Map com-
mand. The image is adjusted so that the largest structures have
the brightest values in their center using the Ima-
ge>Adjust>Brightness and Contrast command. Fig. 3i also
has a Cyan Hot lookup table applied using the command,
Image>Look up tables>Cyan Hot. That image is then thre-
sholded using the Image>Adjust>Threshold command to
select only the cisternae; in the example in Fig. 3i, the tubules
can be eliminated by selecting values that have intensity values
of three or greater (i.e., are more than 3 pixels away from
background). This operation on the Euclidean distance map
removes all pixels a distance of three or less from the periphery
of the cisternae, as well as the tubules, unlike the open opera-
tion that preserves the area of the cisternae, but creates object
edges that are similar in shape to the structuring element.
MorphoER addresses this by increasing the cisternal size with
a manually applied Gaussian blur function (see below).

7. Operate separately on the binary image with the Close com-
mand, Process>Binary>Close. After closing (dilation followed
by erosion), the tubules that are separated by two pixels
become connected (Fig. 3a, d and h). This thresholding oper-
ation (either automatic or manual) is used to create the binary
image that may exclude faint tubule pixels (undesirable) as well
as faint noise pixels (desirable). If the condition, set by the size
of the structuring element, is met that two disconnected
tubules are separated by one or two pixels, then the closing
operation connects them and they are counted as a continuous
tubule. Faint noise is mostly eliminated with manual thresh-
olding. The closing operation also fills in pixels between two
side-by-side tubules that are separated by one or two pixels;
hence, if clusters of tubules are being examined, then the pixel
size should be at least twofold smaller than the diffraction limit
(the Nyquist criterion).

8. For tubules, the closed image is skeletonized (Fig. 3f) using the
Process>Binary>Skeletonize command. Skeletonize imple-
ments a 2D thinning algorithm [33].

9. Skeletonization is followed by subtraction of the regions that
contain cisternae (Figs. 3a and g) using the Process>Image
Calculator command. The 8 bit images need to be inverted
first, with the Edit>Invert command. This turns the skeletons
and cisternae to white on a black background instead of black
on a white background. In the Image Calculator dialog box,

86 Lawrence R. Griffing



the upper image selection should be the skeletonized image
and the lower image selection should be the opened cisternal
image. When cisternae are skeletonized, they give rise to mul-
tiple radiating skeletons, and depending on the skeletonization
algorithm these have diagnostic radiating or angular geome-
tries (Fig. 3f and j). Consequently, to eliminate this artifactual
data set from the tubule population, these regions are sub-
tracted from the tubule population:

3.4.4 Measurement of

cisternal areas and

numbers

1. Set the Analyze>Set Measurement dialog box for area and
stack location.

2. The opened binary image (Fig. 3e) or the thresholded Euclid-
ean distance map (Fig. 3i) can be analyzed using the Analy-
ze>Analyze Particles command.

3. The results table is saved as an .xls file.

4. The CountIf formula is used in Excel to count the number of
cisternae in each slice of the stack (stack location).

5. The AverageIf formula is used to get the average size of
cisternae.

6. These are normalized using the area of the membrane imaged,
which is the area of the original binary thresholded object
(Fig. 2c or h).

3.4.5 Measurement of

tubule numbers, lengths,

and junctions (Fig. 4)

1. The skeletonized region can be evaluated using the Analy-
ze>Skeleton>Skeleton 2D/3D command (Fig. 4). This pro-
cedure provides a list of the length of all of the separate
skeletonized tubules, with their number of junctions and the
type of junction.

Fig. 4 Analysis of skeletons representing tubules. (A) Skeletonized region of ER from a time-lapse series with
the cisternal component subtracted (see Fig. 6a for original image). (B) Result of the Analy-
ze>Skeleton>Skeleton 2D/3D command in FIJI. Inset is blow-up of region showing the blue single and end
pixels, orange-yellow slab pixels, and pink/purple junction pixels. (C) Identification of junctions as triple or quad
junctions: (a) is a triple junction because it has three neighboring pixels that are occupied (white). (b) is a quad
junction showing four neighboring pixels that are occupied. Gray pixels are unoccupied neighboring pixels
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2. To analyze the skeletons, they need to be white on a black
background (using the Edit>Invert command as above, if
that has not already been done) (Fig. 4B; see Note 8).

3. There are several images and tables that are produced by this
algorithm: A color-tagged skeleton image showing blind ends
as blue, junctional regions purple-pink, and tubule lengths
yellow-orange (Fig. 4B and inset); a gray-scale image (labeled
skeletons, shown for clarity with a color table in Fig. 4D) has a
different gray value for each identified skeleton; a results table
that includes a list of all of the independent skeletons with the
following: # branches, # junctions, # end-point voxels (blue in
Fig. 4B—they have less than two pixel neighbors), # junction
voxels (pink in Fig. 4B—they have more than 2 pixel neigh-
bors), # slab voxels (yellow in Fig. 4B—if they have exactly
2 pixel neighbors), average branch length, # triple points (a in
Fig. 4C), # quadruple points (b in Fig. 4C), and maximal
branch length. This can be saved as an .xls file; a branch
information table that includes the skeleton ID, the branch
length, the coordinates of the start and end of the branches,
and the Euclidean (straight line) distance between the start and
the end of the branches. Branch length divided by the Euclid-
ean distance is a measure of the complexity of the branch. This
can be saved as an .xls file (see Note 9).

3.4.6 Using MorphoER

for analysis of tubules and

cisternae (Fig. 5)

MorphoER (see LPX plugins above), accessed through LPX plugin
set with the command Plugin>LPX>LPX IjTool command
(Fig. 5a), can be opened from the IjTool dialog box by selecting
morphoER from the projects pull-down menu (Fig. 5c) once an
image for analysis is open (Fig. 5b).

MorphoER uses automatic thresholding/segmentation as
mentioned above, selecting as a threshold, the value which max-
imizes the distance between the histogram values to a line defined
by the histogram peak value and histogram blackest value [34].
However, it also has several user-defined variables (Fig. 5d): Gauss-
ian blur radius to reduce noise (σ1), ER body minimum size (for
arabidopsis ER body identification), the threshold value in the
Euclidean distance map for the width of tubules (τ), and the
Gaussian blur radius (σ2) that enlarges the cisternae after the
threshold operation on the Euclidean distance map. A tubule mini-
mum length value (λ) can also be specified that removes small
skeletonized isolated tubules from counting. In Fig. 5e–h, the
cisternae are colored orange and red, while the tubules are identi-
fied as white.

1. Effect of setting σ1: This blurs the initial image with a Gaussian
function of the radius set by the user. It has a large influence on
the region selected by automatic thresholding; compare Fig. 5e
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(σ1 ¼ 0.5) and h (σ1 ¼ 2.0). As shown in Fig. 5h, it will thicken
the tubules, changing the value needed for τ.

2. Effect of setting τ: This is the threshold of the Euclidean
distance map. Larger values will threshold away the tubules,
but with higher values, more of the cisternal area is lost
(Fig. 5f).

3. Effect of setting σ2: This is the radius of a Gaussian blur of the
selected cisternae. Larger values produce cisternae with differ-
ent areas and shapes (Fig. 5g).

Fig. 5 Separation of ER tubules and cisternae using the morphoER plugin from LPX. (a) Pull-down plugin menu
showing the LPX option and the LpxIjTools option. (b) Dialog box brought up by LpxIjTools. The nop “mode”
should be selected. The morphoEr “projects” should be selected. Other options can be run using the default
choices. (c) The first image in a time-lapse sequence of ER for analysis. Scale bar ¼ 10 μm. (d) After clicking
OK in (c), this dialog box comes up. The segmentAndMeasure option is shown. The target (in vivo as opposed
to in vitro) is shown. In order to segment (select) the tubules vs the cisternae, there are several user variables
that can be chosen. (e–h) show the results of different choices after clicking OK in (d). σ1 is the radius of the
Gaussian (blur filter) used to reduce noise. σ2 is the radius of the Gaussian used to “fill in” the cisternae eroded
by Euclidean distance subtraction. τ is the radius of the tubules in the image. λ is the minimum length of
skeletons shown, in order to remove skeleton fragments resulting from noise. Tubules are generated by the
same skeletonization as in Figs. 3j and f, but without binary closing. Cisternae are generated by the same
Euclidean distance subtraction shown in Fig. 3k. Tubules are white and cisternae are orange, with saturating
pixels red. Arrows show a cisterna that changes shape and area with different settings. All of the settings do
not show the hole in this cisterna shown in Fig. 3l. The stars show regions of low signal and the consequent
large proliferation artifactual skeletonization that occurs in these regions in (e)–(g) that is excluded with
manual thresholding (Figs. 3l and m)
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4. Clicking OK in the second dialog box produces a final image
that is a composite of three values, tubules with a value of 1
(white in Fig. 5e–h), cisternae with a value of 2 (orange in
Fig. 5e–h), and saturated pixels with a value of 3 (red in
Fig. 5e–h). These can be selected for measurement using a
thresholding command. Note that the arrows in Fig. 5b and
e–h show a cisterna with a fairly large hole or tubule loop. All of
the settings remove the hole or loop. The tubule loop is pre-
served in Fig. 3l (arrow), which uses a higher threshold and
opening instead of a Euclidean distance map (Fig. 3m). The
stars in Fig. 5b and e–h are in regions of low or out-of-focus
signal. These produce an array of tubules in the MorphoER
program, Fig. 5e and f, but they do not exist. These are
excluded in both thresholding approaches shown in Fig. 3
(stars in l and m). MorphoER produces a MorphoER results
table that has several aspects of tubules and cisternae measured,
but the nature of evaluation is not currently published or open
source. It is apparently done in pixel number values, but the
units are undefined in the software.

3.4.7 Persistency

mapping (Fig. 6)

1. In order to identify the regions that are moving rapidly, one can
subtract frames between defined intervals in an 80 s time series
of 50 frames. In the original approach [3], every fifth frame
subtracts an image taken 8 s earlier. This is done by making
substacks using the Image>Stacks>Tools>Make Substack
command twice; first to remove the first five in the stack leaving
a Substack of 6–50, and the second to remove the last five,
leaving a Substack of 1–45. Substack (6–50, Fig. 6b) subtracts
Substack (1–45, Fig. 6a) using the Process>Image Calculator
command and specifying the subtract option. Only those
regions which are moving have a value, so this is the “moving”
or SUB data set, (Fig. 6c; see Note 10).

2. The nonmoving data, or AND data set, is the result of a
Boolean AND operation between every fifth frame of Substack
(1–45, Fig. 6a), and Substack (6–50, Fig. 6d) using the Pro-
cess>Image Calculator command and specifying the AND
option. To generate the persistent data set, the moving data
set is subtracted from the nonmoving data set (Fig. 6e) by
using the Process>Image Calculator command and subtract-
ing the SUB data set from the AND data set. These operations
are done on 8 bit images and ImageJ truncates the results so
that negative-valued pixels are set to zero.

3. The persistent data set is then thresholded by a value that
includes the in-focus membrane (step 3(c), Fig. 3c or h)
using the Image>Adjust>Threshold command.

4. Total detected persistent membrane area can be measured at
this stage using the Analyze>Analyze Particles command,
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specifying stack location and area in the Analyze>Set Measure-
ments dialog box. In the Analyze Particles dialog box, if the
Masks option is taken, then a binary mask is generated that can
then be used instead of the next step (Fig. 6f).

5. A binary image is generated from this thresholded image using
the Process>Binary>Make Binary command (if a binary image
mask has not been generated in the prior step). Use the default
settings in the Make Binary dialog box—do NOT check the

Fig. 6 Persistency mapping. (a) Image of ER taken at 0 s. Scale bar¼ 10 μm. (b) Image taken 8 s later than (a).
(c) Result of subtracting image (a) from image (b) using the Analyze>Image Calculator command, pseudoco-
lored magenta-hot. This is done on the entire stack of images as a stack. So all of the following images
represent stacks of images every 8 s apart (0 and 8, 1 and 9, 2 and 10, etc.). (d) Result of the Boolean “And”
operation between (a) and (b) using the Process>Image Calculator command, pseudocolored orange-hot. (e)
Result of subtracting (c) from (d) using the Process. Image Calculator command, pseudocolored Cyan-hot. (f)
Result of converting (e) to a binary image with the Process>Binary>Make Binary command. (g) Closed version
of (f). (h) Skeletonized version of (g). (i) Tubule Persistency Map: The individual images in stack (h) are summed
using the Images>Stack>Z Project>Sum Images command, following subtraction of the cisternae. Pseudo-
colored red-hot, with the lighter regions being the more persistent. (j) Opened version of (f). (k) Cisternal
Persistency Map: The individual images in the stack (j) are summed using the Images>Stack>Z Project>Sum
Images command. Pseudocolored Green-Fire-Blue, with the more persistent cisternae being white-yellow. (l)
Composite image of (i) and (j) with the more persistent features being pseudocolored white-yellow
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option to have the threshold calculated for each image, or any
of the options.

6. The binary image stack is separately converted into the persis-
tent tubule stack using the closing (Fig. 6g) and skeletoniza-
tion (Fig. 6h) commands (steps 3(g) and (h)), followed by
inverting (Edit>Invert), subtracting the (inverted) persistent
cisterna stack and summing them, using the Ima-
ge>Stacks>ZProject command, specifying the Sum Slices
option, Fig. 6i.

7. The binary image stack is then converted into the persistent
cisternae stack using either the opening operation (step 3(d)),
Fig. 6j, or the Euclidean distance operation followed by thresh-
olding (step 3(e)), inverted (Edit>Invert) and summed as
above (Fig. 6k).

8. The Tubule Persistency Map (Fig. 6i) is the sum of all of the
skeletons and only those that persist the longest are the bright-
est. A colored ramp is made as above, but for tubules (Ima-
ge>Lookup Table>Red Hot). Because of the variation in
skeletonization that occurs with cisternae as they are changing
shape, this image can also be thresholded to eliminate these
skeletons, without subtracting the cisternae from tubules.

9. The Cisternal Persistency Map (Fig. 6k) is the sum of all of the
opened binary images, and has as its lowest value objects, the
least persistent cisternae, and as its highest value objects, the
most persistent cisternae (Fig. 6k). A colored ramp is made
with the Image>New>Ramp command and given the same
color table as the cisternae (Image>Lookup
Table>GreenFireBlue).

10. Both Cisternal Persistency Maps and Tubule Persistency Maps
are color coded to show the most and least persistent values
(Fig. 6l). Those that persist (are added together) in the same
position for 32 s (the first 8 s difference interval and then 24 s
thereafter, or 15 of the 45 difference frames) can be thre-
sholded, measured, and counted.

3.4.8 Analysis of network

movement using optical

flow with LPX flow (Fig. 7)

1. LPX flow (Plugin>LPX>LPXflow) starts by subtracting the
temporally averaged image from the data set. This is done by
checking the subtAvgT box in the first dialog box that comes
up (Fig. 7a). The temporally averaged image includes several of
the persistent features in the data set. This differentiates it from
the persistency map above and emphasizes the fact that it is the
change between frames that is being measured.

2. It then implements a cross-correlation function based on spa-
tiotemporal image correlation spectroscopy (STICA [35, 36]).
The motion is examined by the cross-correlation of pixel
blocks. The position of peaks produced by the cross-correlation

92 Lawrence R. Griffing



Fig. 7 Optic flow analysis of movement in ER using LpxFlow. (a) The dialog box that comes up with the
Plugins>LPX>LPXflow command. The settings are set so that there is 4 � 4 matrix being analyzed using
spatiotemporal image correlation over an interval of every two frames. Subtracting the average intensity over time
is selected. The mask option is not available. (b) Image of first frame of time series with background subtracted.
Scale bar¼ 10 μm. (c) First image of image stack resulting from clicking OK in (a) showing the position of vectors
having various directions and different colors representing different magnitudes. (d) Second dialog box that comes
after the Plugins>LPX>LPXflow command is re-enteredwith the image stack (c) open. DispVector (display vector)
is checked. The vector scale is derived by dividing pixel size in nmby the frame interval inmilliseconds. Vector type
is chosen as arrows. (e) Image 2S from [9] supplementary data showing fluorescence of the ER network in the
petiole tissue from arabidopsis. Scale bar¼ 10 μm. (f) The arrow vectors shown from one frame from a 16� 16
pixel matrix, pseudocolored to show speed. Arrows in (e) and (f) show masked region where polygonal network is
excluded. (g) Arrow vector display from (c). Bar¼ 10 μm. (h) Summed speed values from network from checking
the DispSpeed output setting in (d). (i) PersistencyMap of same region showingmore persistent tubules (magenta)
and more persistent cisternae (red). Note that in areas of high tubule persistence, the optic flow program shows
high speed (arrows g, h, and i). Also note that areas of low cisternal persistence are areas of low speed (circles
in g–i)
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is a measure of how well the two blocks in subsequent frames
match. These peaks, therefore, represent the amount and direc-
tion (a vector) by which the second image block has to be
moved in time and space in order to best match the first
image block. The variables defined by the user and the system
are:

l The spatial lag variables in the x and y direction, respectively,
ξ and η.

l The temporal lag variable, τ, or the time difference between
frames.

3. The above variables are entered in the interface (Fig. 7a) and
the space block and time difference (frame difference) over
which the optic flow operates is defined. In the case of the
example data set (Fig. 7b, also used in Figs. 3 and 5), the
time is 1.6 s per frame and the pixel size is 121 nm. In the
analysis between every second frame is chosen (widthT and step
T ¼ 2). A pixel block size of 4 pixels is chosen (widthXy and
step Xy ¼ 4). The output from clicking OK in the first dialog
box is shown in Fig. 7c. This shows the displacement or flow
vector calculated on all pairs of correlated time-successive 4� 4
blocks.

4. Once Fig. 7c is generated, other image plots of the data can be
produced by using the Plugin>LPX>LPXflow command while
this image is open. This second reiteration of the command
produces the dialog box in Fig. 7d. Figure 7e and f show part of
Supplemental Fig. S2 from [9], which has an image of the
cortical cytoplasm of petiolar tissue from arabidopsis labeled
with GFP-HDEL (Fig. 7e) and a flow map of the region in
Fig. 7f. Figure 7f has, however, been masked using the Mas-
kImg pull-down from the first LPXflow dialog box (Fig. 7a).
The mask applied to Fig. 7e is generated to remove the regions
containing “Error vectors.” These are regions which exclude
the relatively static polygonal regions of the ER, leaving areas
that include the fast flow rates of ER motion (Fig. 7f and inset).
As shown by the large white arrows in Fig. 7e and f, much of
the labeled network is removed from the image, but the region
containing bundles of dynamic ER remain has been rendered
using the vectType pull-down in Fig. 7d using the arrow_valid
choice. Figure 7g shows an arrow vector map of one of the
sequences in the data set starting with image Fig. 7b but with
no masking. Note that when the mask is not included in the
approach, the flow velocities do not correlate with persistency
mapping. Comparing circled regions in Fig. 7h (sum of speed
maps shown when dispSpeed is checked in Fig. 7d with i;
persistency map like that shown in Fig. 6i, but with different
color tables), it can be seen that areas of low persistency (circled
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region, Fig. 7i, high degree of remodeling) can show low flow
velocities (circled region, Fig. 7h), whereas in the persistent
tubule region indicated by the arrow in Fig. 7i, there can be
high flow velocities (arrow in Fig. 7h). This lack of correlation
is because network movement of the ER is not the same as
network flow within the ER. However, optic flow approaches
do not distinguish between these two types of network dynam-
ics. To assess network flow, the two following approaches are
described.

3.5 Network flow

3.5.1 Measurement of

directional vs.

nondirectional (diffusive)

flow in tubules using FRAP

and iFRAP (Fig. 8)

1. FRAP investigations on directional network flow can be carried
out on tubular branch networks that are persistent for about
30 s using persistency mapping. The example used has two
separate junctions, one on each side of the main branch
(Fig. 8a). Movement of tubules into or out of the region that
is being FRAP’ed will invalidate the results, so it is difficult to
measure the movement in regions of fast flow, where there are
many tubules moving as well as movement of materials within
the tubules.

2. The recovery of the region of interest (FRAP ROI—main
branch) exposed to the FRAP (Fig. 8b) is monitored using a
time window (in this case 150 ms per frame) that allows the
exponential curve to be drawn by the software in the FRAP
profile plugin (the plugin source is in methods). This time can
be entered into the FRAP plugin dialog box (Fig. 8c).

3. To distinguish between directional and nondirectional move-
ment of the photobleached GFP, similar ROIs (Fig. 8b) in
adjacent branches are monitored. This is a form of inverse
FRAP or iFRAP, so these are iFRAP ROIs (lower branch,
upper branch 1 and upper branch 2). These can be monitored
using the same FRAP profile plugin.

4. The FRAP profile plugin can compensate for the general
bleaching that occurs in the region outside the region contain-
ing the FRAP ROI before and after the photobleaching.
Because the iFRAP ROIs are also, in part, monitoring the
drop in fluorescence outside of the FRAP ROI, it is important
to use a region well outside of the FRAP influence, the back-
ground ROI (Fig. 8b).

5. The measurement of iFRAP with this technique gives a time of
maximal bleaching, followed by options for one or two expo-
nent exponential fit to the data.

6. This approach can identify gated or directional flow, as evidenced
by the differential movement of photobleached GFP out of the
FRAP ROI (main branch) and into the iFRAP ROIs, with very
little going into the lower branch, which recovers very quickly,
and with a definite lag in the appearance of maximal
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photobleachedGFPgoing into upper branch1 andupper branch
2. The role of the 3D organization of the ER network in this
differential flow [16, 18] has yet to be determined (seeNote 11).

3.5.2 Analysis of

advective and active flow

of aggregated YFP in

constitutively stressed ER

within the lumen of the ER

using the particle tracking

plugin, TrackMate (Fig. 9)

When the ER is constitutively stressed (ceh1 mutants [21]), aggre-
gates appear in the tubules (Fig. 9a). However, in regions of the
cortex with polygonal networks, these aggregates are usually at the
vertices of polygons that can be seen when all of the sequences are
summed (Fig. 9b). Other tubule aggregates are very dynamic and
move by active flow. This can be measured with TrackMate.

Fig. 8 Analysis of movement of photobleached GFP in ER tubules using FRAP and iFRAP (inverse FRAP). (a)
Persistent tubule network in the cortical cytoplasm of a cell. Scale bar¼ 2 μm. (b) Regions used for FRAP and
iFRAP. FRAP is conducted on the main branch which contained the region of photobleaching (smaller than ROI
shown). iFRAP is conducted on two upper branches, 1 and 2, and a lower branch. The background ROI is used
to normalize the data and account for any overall photobleaching that results from viewing. (c) FRAP Profile
dialog box from the Plugins>�FRAP profile command, with the frame time interval entered and a single
exponential used to model the data. (d) Normalized raw data output from main branch, showing the drawn
FRAP curve that is replotted in (e). Note that only the main branch and background ROIs are used in this
analysis, as shown in the ROI manager in the left-hand panel. (e) FRAP for main branch and iFRAP for
peripheral branches. Note the time lag in the appearance of upper branch 1, indicating slower movement of
the photobleached GFP into that tubule, compared with upper branch 2 and lower branch. The very fast
recovery in the lower branch is probably due to the small amount of photobleached GFP entering that branch,
indicating the GFP is flowing away from this branch into the upper branches via the main branch
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1. TrackMate uses a temporal optimization algorithm based on a
mathematical framework called the Linear Assignment Prob-
lem (LAP) that calculates the cost matrices for certain linkages
of the identified particles in frame 1 to frame 2 to etc. [37] and
the merging and splitting of particles (simple LAP ignores
merging and splitting).

2. The spatial and time characteristics of the image sequence need
to be carefully calibrated and entered. It is often best to do this
in the Image>Properties command which then defines the
metadata used for the TrackMate program (Fig. 9c).

3. The program uses a variety of filters to identify the particles,
including particle size, intensity thresholding, Laplacian of
Gaussian or Difference of Gaussian filters, and a median filter
to reduce noise (Fig. 9d). The spots can be previewed by
clicking the Preview button in the spot detector dialog box
(Fig. 9d). When the particles or spots are identified, they can be
displayed by intensity and confidence level. The confidence
level of particle assignment can then be used to further refine
the selection of particles.

4. The maximal distance between particles that are to be linked
and the maximal number of frames in which the particle dis-
appears are entered manually as part of the LAP program
(Fig. 9e).

5. The tracks are then calculated and displayed as overlays using
either the track index or other track properties (Fig. 9f). The
merging or splitting of particles is calculated after the tracks
have been assigned. Figure 9g and H compare the tracks in a
trimmed and untrimmed sequence. The trimming was done to
eliminate the several of the large ER bodies in the cytoplasm. In
the trimmed sequence, the distance for connection between
particles in subsequent frames was decreased from four times
the particle diameter (0.5 μm) to three times the particle diam-
eter. The track statistics are saved in data tables and can be
accessed by spreadsheet programs such as Microsoft Excel.
They can also be plotted by track length and time of entry
into the field of view or by simply plotting things like track
duration vs. track maximum speed, track median speed, or
track standard deviation. Track speed standard deviation gives
a measure of active flow because its value indicates the degree to
which the velocity field varies—high values being more active
than low values. By identifying the tracks with higher track
speed standard deviation, the regions within the network that
have more active flows can be determined.
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Fig. 9 Analysis of particle movement inside slightly stressed ER using TrackMate. (a) ER network as seen in a
single frame of a time series in ceh-1 mutant of arabidopsis which has a low level of constitutive ER stress.
Scale bar ¼ 5 μm. (b) Summed time sequence of ER dynamics of region in (a) showing that the tracks of the
ER aggregates move along a typical ER tubule network (low intensity, blue color). (c) Dialog box from
Image>Properties command in ImageJ showing that the sequence is a time interval (not a Z-stack), what
the time interval is between stacks, and how big the pixels are. It is important to set this up correctly before
running TrackMate. (d) Dialog box in TrackMate (Plugins>Tracking>TrackMate). Object identification dialog
box (right-hand side) allowing particle size and minimum intensity to be selected. Identified objects are
previewed as small purple circles (right-hand image). (e) Dialog box for user-entered calculation constraints
for the Linear Assignment Problem (LAP) algorithm in TrackMate, showing frame-to-frame linking and gap
closing variables in μm and frame to frame gap closing in time. (f) Output of track assignment showing
calculations and calculation steps (right-hand side) and tracks (left-hand side). (g, h) Comparison of tracks
using four frame, 3 μm particle gaps (g) and two frame, 2 μm particle gaps (h)
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4 Notes

1. Fluorescent dyes are not recommended for examining ER
dynamics in tobacco and arabidopsis.

2. The final preparation of the solvent should be equal to or less
than a 1:1000 dilution, this is particularly true with DMSO
which we do not recommend in arabidopsis.

3. There are Matlab (https://www.mathworks.com/products/
matlab.html) and Python (https://www.python.org/
downloads/) implementations of some of these algorithms,
but Matlab is proprietary (Octave is the open source project,
https://www.gnu.org/software/octave/) and many of the
useful Python implementations use Python as an interpreted
(non-compiled) wrapper for imaging libraries written in Cþþ
(https://www.visualstudio.com/vs/cplusplus/), e.g., VTK
and ITK (www.kitware.org). The great advantage of both the
Python and Matlab implementations is that a specific image
processing pipeline can be coded for larger data sets from
sequential files in sequential directories, but the syntax and
file management commands for these languages are beyond
the scope of these methods. The additional plugins used are
the Image Stabilizer plugin of Kang Li (http://www.cs.cmu.
edu/~kangli/code/Image_Stabilizer.html), the Align_slice-
s_in_stack plugin by Qingzong Tseng (https://sites.google.
com/site/qingzongtseng/template-matching-ij-plugin), the
FRAP plugin of Jeff Hardin (http://worms.zoology.wisc.
edu/research/4d/4d.html#frap)—for ImageJ 1.45 s—and
LPixel’s LPX plugin package (https://lpixel.net/ijp/lpx_iij_
plugins_s.jar).

4. Make sure to place the plant grown in 0.9% w/v washed agar in
half-strength Murashige–Skoog medium on a slide that already
has ~50 μl of buffer, 10 mM MES pH 5.8, on it so that it does
not dry out.

5. For young seedlings of arabidopsis and other species, growth
and streaming is inhibited by the pressure of the drying cover-
slip, so elevating the coverslip with two 2 mm � 10 mm single
folded strips of Kim Wipe tissues or single strips of filter paper
soaked in buffer (about 350 μm thick total) is recommended.

6. Recording Macros is a little tricky for the novice because every
click on each window is recorded, but those records can be
removed by editing the Macro file (Fig. 1) which appears as the
Macro is being recorded in the Macro dialog box.

7. Drift can be avoided (but not always eliminated) by putting
VALAP around the coverslip of the object being imaged, so
that drying doesn’t occur [22]. Drift can also be avoided with
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the use a perfusion vessel (however, there may be movement
during flow of the perfusion media). During osmotic shock,
where the tissue visibly shrinks during analysis (even prior to
plasmolysis) and image stabilization is therefore necessary.

8. This algorithm assumes that an image stack is a 3D stack of z-
dimensional optical sections. In order to evaluate the whole
stack, they can be simply made into a montage using the
command, Image>Stacks>Make montage. However, this
approach makes it difficult to get the information for each
image in the stack independently.

9. This algorithm implements a different 3D thinning algorithm
[38], written by Ignacio Arganda-Carreras, based on an imple-
mentation of the 3D thinning algorithm in ITK (Insight Reg-
istration and Segmentation Toolkit, http://itk.org).

10. Large moving cisternae may not be detected as moving within
the interval because they are large, i.e., a large region that
moves over another large region will be “subtracted out” and
not revealed as moving. This is a form of the standard aperture
problem, whereby some large object that takes up the region of
interest may move, but since its moving edges are outside of
the region of interest, the direction and magnitude of the
movement cannot be determined.

11. FRAP’ing a region repeatedly can produce ER stress, and
immediate ER stress is seen following photostimulation or
photobleaching of the chloroplast-ER nexus with 405 nm
laser [39]. Although photobleaching with laser lines at 456
and 488 nm does not induce a visible stress response, other
work has shown that blue light lasers can cause reorientation of
the cortical microtubules in hypocotyl cells [40].
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Chapter 8

Preparation of Highly Enriched ER Membranes
Using Free-Flow Electrophoresis

Harriet T. Parsons

Abstract

Free-flow electrophoresis (FFE) is a technique for separation of proteins, peptides, organelles, and cells.
With zone electrophoresis (ZE-FFE), organelles are separated according to surface charge. The ER is the
only remaining major cellular compartment in Arabidopsis not to have been isolated using density
centrifugation, immune-isolation, or any other method previously applied to purification of plant mem-
branes. By using continuous-flow electrophoresis ER vesicles of similar surface charge, which may have
been fragmented during cell lysis, can be focused. A large portion of these vesicles are of sufficiently
different surface charge that separation from the majority of Golgi and other contaminants is possible.
Here we adapt an earlier ZE-FFE Golgi isolation protocol for the isolation of highly pure ER vesicles and
for tracking the migration of peripheral ER vesicles. Isolating ER vesicles of homogenous surface charge
allows multi-’omic analyses to be performed on the ER. This facilitates investigations into structure–func-
tion relationships within the ER.

Key words Free-flow electrophoresis, Arabidopsis, Endoplasmic reticulum, Proteomics

1 Introduction

The endoplasmic reticulum (ER) is a dynamic, network-like, mem-
branous organelle that extends throughout the cell via tubules
connected by three-way junctions. It seemingly forms connections
with most cellular compartments between where it surrounds the
nucleus and extends out to tethering points at the plasma mem-
brane (PM). Functionally, it is an important site of protein, lipid,
and hormone synthesis, as well as protein quality control and
modification, calcium storage and stress responses. Despite its
essential biochemical roles, the ER remains one of the few locations
within the plant cell which has not been isolated. Proteins have
been localized to the arabidopsis ER by LOPIT [1] and fluorescent
tagging, rather than the typical organelle-purification route by
which most arabidopsis organelles proteomes have been obtained
[2, 3]. The ER is the least structurally discrete of all cellular

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_8, © Springer Science+Business Media LLC 2018
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compartments, as shown by recent advances in imaging [4, 5],
which no doubt contributes to the difficulty in capturing the ER
within a single location on a density gradient. In an earlier “Meth-
ods in Molecular Biology” chapter, the isolation of high purity
vesicles from the Golgi by free-flow electrophoresis was described
[6]. Dynamic and varied structural features make both these orga-
nelles difficult to purify using density centrifugation but domains
within each organelle that have uniform surface charge can be
focused on an electrophoretic gradient, after an initial enrichment.
This chapter builds on methods described previously for the Golgi
[6] but with specific adaptations for the ER. Recognizing the
increased diversity of tubular and cisternal structures within the
ER, the initial enrichment gradient is simplified. Membrane washes
are included before and after electrophoresis, as ribosomes and
abundant ER-lumen proteins released from any ruptured vesicles
may dominate proteomic analyses. The majority of ER proteins are
focused within approximately ten fractions but, like the Golgi, the
ER appears to show evidence of sub-domains with variable surface
charge. This is not likely to arise from migration differences of
rough vs. smooth ER, as ribosome migration resembles neither
group. Additionally, a subgroup of ER proteins has been observed
to co-migrate with the Golgi. Therefore particular emphasis is
placed on suitable ER markers and tracking ER migration after
electrophoretic separation and estimating purity. Instead of using
western blotting to monitor marker proteins in FFE generated
fractions, Selected Reaction Monitoring (SRM) offers an excellent
way of rapidly monitoring membrane migration [7, 8], otherwise
data-dependent acquisition and spectral counting can be used [9].

2 Materials

Prepare all solutions using ultrapure water and analytical grade
reagents. Prepare all reagents at room temperature. Perform all
centrifugation steps at 4 �C. Unless otherwise stated, prepare all
buffers the day before and store at 4 �C.

2.1 Arabidopsis

Protoplast Preparation

1. Arabidopsis cell suspension culture, temperature-controlled
shaking incubator (22 �C, 120 rpm) with constant light (see
Note 1).

2. Arabidopsis cell culture medium: 2% (w/v) glucose, α-
naphthalenacetic acid (0.5 mg/L), kinetin (0.05 mg/L), 1�
Murashige and Skoog basal salt mixture [10]. Prepare media
and adjust to pH 5.7–5.8 with potassium hydroxide (KOH),
autoclave for 20 min at 121 �C, and store at 4 �C.

3. Variable speed benchtop orbital shaker with wide orbital (see
Note 2).
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4. Protoplasting Buffer: 500 mM Sorbitol, 20 mM 2-(N-mor-
pholino) ethanesulfonic acid (MES), adjust to pH 5.7–5.8 with
KOH. Store at 4 �C. Just prior to use, add 1% (w/v) Cellulase
“Onozuka” R-10 and 0.05% (w/v) pectolyase Y-23 (Duchefa
Biochemie, Netherlands) by vortexing in 30 mL of Protoplast-
ing Buffer.

5. Large capacity preparative centrifuge with 2 � 250 mL tube
capacity, e.g., Sorvall SLA-1500.

2.2 Cell Rupture and

Crude Membrane

Enrichment

1. Homogenization Buffer: 1% (w/v) dextran (Mw 200,000),
0.4 M sucrose, 20 mM disodium hydrogen phosphate
(Na2HPO4), 3 mM ethylenediaminetetraacetic acid (EDTA),
0.1% (w/v) bovine serum albumin (BSA), 5 mM dithiothreitol
(DTT) and one cOmplete EDTA-free protease inhibitor tablet
(Roche) (see Note 3), pH to 7.1 with sodium hydroxide
(NaOH).

2. Glass-Teflon Dounce homogenizers (30–50 mL capacity),
cooled on ice.

3. Preparative centrifuge with 4 � 50 mL tube capacity capable of
5000 � g, e.g., Sorvall SS-34.

4. Ultracentrifuge and swing-out rotor with 40 mL tube capacity
capable of 100,000 � g for gradients, e.g., Beckman SW-32.

5. Gradient Buffer 1: 25% iodixanol, 20 mM Na2HPO4, 3 mM
EDTA, pH 7.1 with NaOH (see Note 4).

6. Gradient Buffer 2: 1.0 M sucrose, 20 mM Na2HPO4, 3 mM
EDTA, dextran Mw 200,000 (1% w/v), 5 mM DTT (see Note
3), pH 7.1 with NaOH, can store at �20 �C.

7. Gradient Buffer 3: 0.2 M sucrose, 20 mM Na2HPO4, 3 mM
EDTA, dextran Mw 200,000 (1% w/v), 5 mM DTT (see Note
3), pH 7.1 with NaOH, can store at �20 �C.

2.3 Focusing of ER

Membranes Using FFE

1. Free-Flow Electrophoresis System: BD™ FFE System (BD
Diagnostics, NJ, USA for model years 2006–2010) or FFE
System (FFE Service GmbH, Germany, http://www.
ffeservice.com/ for model years 2011–present).

2. Spacers and filters for ZE-FFE including 0.5 mm spacer and
0.8 mm electrode filter papers for ZE-FFE (FFE Service
GmbH, Germany).

3. 96-Well deep-well plates (2 mL).

4. UV-transparent 96-well plates, e.g., UV-Star (Greiner Bio
One, NC, USA).

5. Microplate reader capable of reading absorbance at 280 nm,
e.g., Single-ModeMicroplate Readers (Molecular Devices, CA,
USA).
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6. FFE Buffer 1: 280 mM sucrose, 10 mM acetic acid, 10 mM
triethanolamine, 1 mM EDTA, pH to 7.0 with NaOH (see
Note 5).

7. FFE Buffer 2: 200 mM sucrose, 100 mM acetic acid, 100 mM
triethanolamine, 10 mM EDTA, pH to 6.5 with NaOH (see
Note 5).

8. FFE Buffer 3: 100 mM acetic acid, 100 mM triethanolamine,
10 mM EDTA, pH to 6.5 with NaOH (see Note 5).

9. Ultracentrifuge and fixed angle rotor with 10–15 mL tube
capacity, capable of 100,000 � g for sample concentration.

10. 50 mM tris(hydroxymethyl)aminomethane (Tris–HCl),
pH 8.0, stored at 4 �C.

2.4 Post-FFE Sample

Analysis

1. High grade trypsin, e.g., Trypsin, from porcine pancreas
(Sigma-Aldrich, MO, USA).

2. SpeedVac concentrator.

3. Ultra-micro Spin Columns with C18 (Harvard Apparatus, MA,
USA).

4. ACN1 solution: 80% acetonitrile (v/v) with 0.1% trifluoroace-
tic acid (v/v).

5. ACN2 solution: 2% acetonitrile (v/v) with 0.1% trifluoroacetic
acid (v/v).

6. LC-MS/MS Buffer A (98% water, 2% acetonitrile, 0.1% formic
acid).

7. LC-MS/MS Buffer B (98% acetonitrile, 2% water, 0.1% formic
acid).

8. Optional—Agilent Technologies (Santa Clara, CA) 6460QQQ
mass spectrometer operating in SRM mode, with a Sigma (St.
Louis, MO) Ascentis Peptide Express C-18 column
(2.1 mm � 50 mm) or similar (see Note 6).

9. Tandem mass spectrometer (MS/MS) with online liquid chro-
matography (LC) capabilities (nanoflow or capillary flow rates)
capable of data-dependent acquisition. Data in Fig. 1 was
generated on a nano-ESI-Q-TOF (TripleTOF 5600 System,
AB SCIEX) coupled to an Eksigent nano LC system (AB Sciex)
and an Acclaim Pepmap100 C18 column (75 μm � 150 mm,
Dionex-LC Packings) at 300 nL/min flow rate.

10. Search engine for analyzing mass spectrometry data to identify
proteins, e.g., Mascot (Matrix Science, UK).

11. Optional—Targeted proteomics software, e.g., Skyline (freely
available online at http://skyline.maccosslab.org) and Scaffold
4 (Proteome Software, OR, USA).
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Fig. 1 Distribution of proteins along electrophoretic gradient, after ZE-FFE. (a) Total protein distribution was
estimated by measuring the absorbance at 280 nm of 250 μL aliquots of fractions after electrophoresis. (b)
Using the transitions and collision energies given in Table 1, the distribution of the ER was estimated using
SRM measurements averaged from six proteins, each protein being averaged from two peptides. Peptide
signal intensities were calculated by summing the two highest transition intensities, as described in [11]. (c)
Spectra were summed for the proteins in each fraction that could be unambiguously assigned to subcellular
compartments (based on experimental data housed at SUBA), and presented as a proportion of the total
spectra for each fraction to give an estimation of ER migration relative to other organelles. (d) Spectral counts
from all other organelles were summed and compared to summed spectral counts for ER-localized proteins, to
give an estimate of the purity of the most ER-rich fractions. A pie chart gives an overview of protein numbers in
ER-enriched fractions, showing that ER abundance is calculated from over 100 proteins in fraction 38*, from a
total of 500 proteins with >5 spectra
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3 Methods

3.1 Protoplast

Preparation of

Arabidopsis Cell

Suspension Cultures

1. Maintain growing arabidopsis cells in 100 mL aliquots, subcul-
ture weekly at 1:10 ratio (see Note 1). Harvest cells from 4–6
flasks by centrifugation 800 � g, 20 �C for 5 min using a
250–500 mL capacity rotor and weigh pellet (see Note 7).

2. For up to 50 g cells (fresh weight), make 400 mL of Proto-
plasting Buffer. To 150 mL of Digestion Buffer add 1.0% (w/
v) cellulase and 0.05% (w/v) pectolyase in a 4 L wide-
bottomed, conical flask. Add cells, ensuring they are adequately
suspended in the buffer. Place on an orbital shaker and rotate
slowly in the dark for 2.5 h (see Note 8).

3. Protoplasts are harvested by centrifugation at 800 � g for
5 min, the supernatant discarded, and cells gently resuspended
in the remaining 250 mL of Protoplasting Buffer without
enzymes (see Note 9).

4. Centrifugation at 800 � g is repeated, the supernatant dis-
carded, and cells resuspended in Homogenization Buffer
using a ratio of 1:1 (w/v) using the original fresh weight of
cells to buffer volume.

3.2 Homogenization

of Protoplasts and pre-

FFE Enrichment

1. Working at 4 �C, homogenize the protoplasts in Homogeniza-
tion Buffer using 4–5 strokes at even pressure with a Dounce
homogenizer (see Note 10).

2. Compare pre- and post-homogenized protoplasts under a light
microscope to ensure adequate disruption (see Note 10).

3. Centrifuge homogenate at 5000 � g for 15 min (rotor with
capacity for 50 mL samples, e.g., Sorvall SS-34).

4. Transfer the supernatant to thin-wall polypropylene tubes suit-
able for use in an SW-32 rotor, such that tubes are two-thirds
full and underlay with 6mL of Gradient Buffer 1 (seeNote 11).

5. Ultracentrifuge at 100,000 � g for 1.5 h (see Note 12).

6. Remove the supernatant such that the cushion surface is dis-
turbed as little as possible, then remove membranes from the
cushion, gently mix in the same volume of homogenization
buffer as previously, and repeat steps 4 and 5 (see Note 13).

7. After removing the supernatant for a second time, gently layer
15–20 mL of Gradient Buffer 2 on to the membrane cushion,
then 12–15 mL of Gradient Buffer 3, or until tubes are at least
two-thirds full.

8. Ultracentrifuge samples at 100,000 � g for 1.5 h.

9. A single band should be present at the boundary between
Gradient Buffer 2 and 3 (see Note 14).
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10. Measure the protein concentration of the collected sample and
dilute so the sucrose concentration is as close to FFE Buffer 1
as possible, although a total protein concentration less than
0.75 μg/μL is not recommended. Keep the desired band in a
15 mL tube on ice (see Note 15).

3.3 Separation of ER

Membranes Using

ZE-FFE

1. Ensure the FFE system is correctly set up for ZE-FFE, as
detailed in Fig. 1 in [6], the temperature set to 8 �C, the
media pump has been calibrated, and all necessary quality
control tests have been undertaken (see Note 16).

2. Load FFE Buffer 1 (inlet tubes 2–6), FFE Buffer 2 (inlets 1 and
7), FFE Buffer 3 (electrodes) and slowly fill chamber with
buffers avoiding air bubbles. Set the media flow rate to
250 mL/h. Switch on electrode circuits, set the voltage, cur-
rent, and power to 700 V, 150 mA, and 100 W, respectively,
and switch on the voltage (see Note 17). Allow the system to
equilibrate and stabilize for 20–30 min prior to use.

3. Load the sample at a flow rate of 2500–3000 μL/h. The sample
should appear homogenous and be visible in the lower half of
the separation chamber but is usually too dilute to be seen in
the upper half (see Note 18).

4. After about 10 min, start collecting samples in the precooled
2 mL deep-well plates (see Note 19).

5. Throughout the ZE-FEE process, monitor protein distribu-
tion by removing 150–250 μL from plates and measuring at
280 nm using UV-transparent 96-well plates (Fig. 1a). Protein
peak positions and profiles should remain constant throughout
separation.

6. Assuming successful enrichment of membrane by density cen-
trifugation, the main peak at 280 nm will constitute a mixture
of cis-Golgi and ER membranes (Fig. 1c). The proportion of
ER proteins will increase at the cathodic edge of this main peak,
and the cis-Golgi to the anodic edge (Fig. 1b and c).

7. After electrophoretic separation, pool fractions from multiple
plates and centrifuge at 100,000 � g for 60 min (seeNote 20).

8. Remove the supernatant and rinse pellets gently in chilled
water (see Note 21). Resuspend in 50 mM Tris–HCl
(pH 8.0), then sonicate for 15 min at 30 s pulse intervals.
Measure protein concentration using the Bradford’s assay and
store resuspended pellets at �80 �C.

3.4 Tryptic Digestion

of Samples and

Analysis by Mass

Spectrometry

1. Reduce, alkylate, and digest at least 10 μg of protein overnight
(37 �C) at a 1:40 trypsin:protein ratio in 50% (v/v) ACB.

2. Remove ACN in a SpeedVac concentrator, then resuspend in
50 μL ACN2.
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3. Clean and concentrate samples in Ultra-micro SpinColumns
(10–25 μL capacity), after washing columns once in ACN1 and
priming twice in ACN2. Elute peptides in 50 μL ACN1.

4. Remove ACN in a SpeedVac concentrator, then resuspend in
ACN2 to give a concentration of 1 μg/μL, assuming complete
protein digestion.

5. Optional analysis using SRM: This method was developed
using a 6460QQQ mass spectrometer operating in SRM
mode (see Subheading 2.4, item 8), although other possibilities
exist (see Note 6). Five micrograms of peptide were injected
and separated at a flow rate of 400 μL/min over the following
gradient: 95% Buffer, 5% Buffer B for 2 min, increased to 40%
Buffer B over 15 min, rapidly increase to 90% B over 5 min,
held at 90% B for 5 min, decreased rapidly to 5% B, and held for
2 min before the next run. Eluting peptides were ionized by
using an Agilent Jet Stream source (sheath gas flow: 11 L/min,
sheath gas temperature: 350 �C, nozzle voltage: 1000 V, neb-
ulizing pressure: 30 psi, chamber voltage: 4500 V) operating in
positive-ion mode. ER peptide transitions are given in Table 1.
These parameters delivered the ER peptide-profiles shown in
Fig. 1b.

6. If targeted proteomics analysis is not possible, then peptide
samples can be analyzed by liquid chromatography tandem
mass spectrometry (LC-MS/MS) using software such as Mas-
cot (Matrix Science, UK). Organelle profiles in Fig. 1c and d
were produced using instrumentation as detailed (see Subhead-
ing 2.4, item 9), with a gradient starting at 5% buffer B,
increasing to 35% B over 60 min. Over 3 min Buffer B was
increased to 90%, held for 15 min, then decreased to 5% Buffer
B over 3 min and held for 15 min to re-equilibrate the column
(see Note 22).

7. With sufficient protein of known localization to the ER and
other cellular compartments, it is possible to monitor the
migration of organelles (see Note 23). Information on all pre-
dicted and previous experimental localizations for proteins can
be found at SUBA3 (suba3.plantenergy.uwa.edu.au). By asses-
sing the proportion of proteins within a fraction that have a
majority consensus to a given cellular location, the migration of
the ER and other organelles can be mapped along the gradient,
as in Fig. 1c and d. This proportion can be assessed by simply
counting identifications, emPAI values, or the number of spec-
tra associated with each protein [9] (see Note 23).

3.5 Summary and

Future Uses of this

Technique

In summary, this method describes how ER proteins can be
enriched to approximately 50% of an endomembrane fraction.
Some proteins identified in ER-rich fractions may have been sub-
strates transiting the ER, so ER vesicles may comprise more than
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50% of some fractions. Although this technique does not yield
completely pure ER fractions, it is an appreciable increase on the
purity achieved by density gradient centrifugation. As ER vesicles
can be pelted from enriched fractions, this technique offers much
interesting potential for lipidomic and metabolomic, as well as
proteomic, investigation.

4 Notes

1. This protocol uses a L. erecta line similar to MMd2 cells [12]
and tolerates a range of light levels. Whichever cell line is used,
it is essential that it is a fine suspension culture which readily
forms protoplasts.

2. A variable speed benchtop orbital shaker with a large orbital
throw is optimal (at least 2 cm); this allows slow rotation while
maintaining the cells in solution. This permits efficient enzy-
matic digestion of the cell wall.

3. DTT and protease inhibitors are added immediately prior to
use and can be quickly solubilized by vortexing in 1.0 mL of
buffer.

4. 25% iodixanol is prepared by diluting the stock solution two-
fold with 2� homogenization buffer (without BSA) to give a
30% solution, then diluting to 25% with homogenization
buffer. This results in less osmolality extremes than the 1.6 M
sucrose cushion used in previous protocols [6].

5. All FFE buffers must be used within 24 h and can be stored at
4 �C. Triethanolamine should be weighed. A generous volume
of FFE Buffer 3, e.g., 800 mL for a 1–2 h run, is recommended
so the electrode buffers are not exhausted. For FFE Buffer 1,
about 1.5 L is required for a run using the conditions
described.

6. Start with a minimum of 50 g fresh pellet weight. Before
protoplasting, the cell pellet can be spooned out and weighed
without damaging cells.

7. Rotate at the lowest possible speed at which cells remain in
suspension. Enzymes should be added to the Protoplasting
Buffer immediately before use. Enzymes are easily solubilized
by vigorous shaking in a 30 mL aliquot of Protoplasting Buffer
prior to their addition to the main solution.

8. The pellet/protoplasts are delicate; decant supernatent and
resuspend gently to avoid breaking cells.

9. The idea is to rupture protoplasts while minimizing organelle
rupture. This is dependent on the number of strokes, the force
applied to each stroke, and the fit between the Teflon plunger
and glass wall. It is recommended that this step be carefully
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optimized, by examining the number of intact protoplasts
under a light microscope and the efficiency with which chlor-
oplasts can be pelleted at low speeds to leave a pale, beige but
not green, supernatant.

10. Ideally, use around 15–20 g fresh weight starting material per
gradient.

11. This step should result in a yellow-white colored band about
2 mm thick (assuming starting with 60 g fresh weight cells).
Green coloration implies organelle rupture during protoplast
homogenization. Elimination of green should be possible if
starting from cell suspension culture but otherwise may not
be possible if, e.g., liquid-grown plantlets are used as the start-
ing material. Cytosolic contamination can be decreased by
resuspending the band in homogenization buffer, then repeat-
ing this centrifugation step.

12. Complete removal of the supernatant is a compromise between
quality of step gradient formation and disturbance of the cush-
ion, with ensuing loss of yield.

13. A distinctly formed yellow-white band 1–3 mm thick at the
1.0 M/0.2 M interface will give optimize results obtained after
FFE.

14. Ideally, steps 1 and 2 (Subheading 3.2) should be completed as
fast as practicably possible. Tubes containing Gradient Buffer 1
can be prepared in advance. Setup of the FFE and stabilization
of the current should have been completed so as to coincide
with step 9. The current normally takes not more than
20–30 min to stabilize. The conductivity may increase as the
sample buffer enters the chamber. This can be rectified by
lowering the voltage by, e.g., 20–30 V and waiting approxi-
mately 5 min before starting to collect samples.

15. This is a nontrivial task and some previous experience or
instructions in the setup of the system for ZE-FFE has been
assumed. Use of fresh filters, membranes, and electrode gaskets
can improve separation performance considerably. Great care
should be taken that the plastic spacer is exactly centered.
Tubing sections under the peristaltic pumps should be checked
thoroughly for hairline cracks prior to setup and changed if
necessary. The sample inlet tubing should be exchanged if any
kinks are present. Excessive indentation from the spacer or inlet
tube on the lower, temperature cooled plate indicates a change
of plastic cover sheeting is required for optimal separation. All
FFE buffers should be made up precisely to the stated pH
otherwise the conductivity will be too high and the current
will not stabilize as desired. Much useful material, including
references, is available at http://www.ffeservice.com.
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16. Media flow rate and voltage are the two principal parameters
that affect sample migration. For different types of sample
preparation a ratio between the two should be optimized;
however, below 200 MFR diffusion between streams of sub-
cellular compartments may occur. The effect of changing para-
meters on protein distribution can be instantaneously verified
by measuring protein content at 280 nm in UV-transparent
96-well plates.

17. If particulates are present in the sample, pass the sample once
through a glass Pasteur pipette.

18. At a flow rate of 250 mL/h, plates will fill in approximately
17 min although shorter fill times will prevent sample warming
if a plate cooling device is not available. Store plates at 4 �C and
work at 4 �C for steps 6 and 7 (Subheading 3.3).

19. Assuming eight plates at approximately 1.5 mL per well have
been collected, pellets will be visible in all fractions above 0.15
A280 (measuring 250 μL at A280), otherwise it may be necessary
to pool fractions.

20. If only proteomic analysis of membrane proteins is required,
pellets can be resuspended in 100 mM NaCO3, shaken for
30 min at 4 �C and re-pelleted at 100,000 � g for 1 h. This
will remove soluble proteins sticking to membranes but may
result in vesicle rupture.

21. If analyzing ERmembrane migration over many fractions, then
analysis by a targeted proteomics technique such as SRM is
recommended, using the transitions in Table 1. Using a QQQ
mass spectrometer using microflow rates is ideal, as short gra-
dients of 30 min or less can be used, dramatically reducing
analysis time. Targeted analysis is also possible using a Triple-
TOF running at microflow rates. Use of a Q-Exactive
operating in PRM mode is also possible but as this must be
conducted at nanoflow rates, there is little gain in analysis time.

22. When separating organelles by free-flow electrophoresis using
the described methods, variations in instrument setup, buffer
conductivity, and cell growth may combine to give a shift in
absolute migration distances of about five fractions between
experiments. This shift can be up to ten fractions when differ-
ent instruments are used. However, the relative distribution of
organelles should not change. It is therefore recommended
that users carefully monitor organelle migration and relate to
the total protein profile for several experiments, as in Fig. 1,
until users are familiar with their experimental setup.

23. Software such as Scaffold 4.0 facilitates spectral counting but is
not essential.
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Chapter 9

ER Microsome Preparation in Arabidopsis thaliana

Verena Kriechbaumer

Abstract

Microsomes are vesicles derived from the endoplasmic reticulum (ER) when cells are broken down in the
lab. These microsomes are a valuable tool to study a variety of ER functions such as protein and lipid
synthesis in vitro.
Here we describe a protocol to isolate ER-derived microsomes Arabidopsis thaliana seedlings and

exemplify the use of these purified microsomes in enzyme assays with the auxin precursors tryptophan
(Trp) or indole-3-pyruvic acid (IPyA) to quantify auxin synthetic capacity in microsomal and cytosolic
fractions.

Key words Endoplasmic reticulum, Microsomal fraction, Enzyme assays, Arabidopsis

1 Introduction

Microsomes are generally described as vesicle-like structures with a
diameter of 100–200 nm that are formed from pieces of the endo-
plasmic reticulum (ER) after eukaryotic cells are broken down
experimentally (Fig. 1); hence microsomes are not found in healthy
living cells. Microsomes are still capable of ER functions such as
protein synthesis, protein glycosylation, Ca2+ uptake, and lipid
synthesis and can be used to study all these functions in a test
tube [1]. Therefore microsomes have found use in a plethora of
experimental approaches and studies (Fig. 2).

Microsomes are purified from other cell compartments and
membranes by differential centrifugation at 1,000,000 � g.
Whole cells, nuclei, and mitochondria pellet at 10,000 � g [2]
and chloroplasts already at 1000 � g [3, 4].

In his publication on the “constitution of protoplasm” Albert
Claude named microsomes in 1943 [5] to distinguish these “small
granules of undefined nature.” He then used this fractionation
technique to determine the localization of nucleic acid in leukemic
cells [6]. Current applications and use of microsomes for research
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are for example the areas of lipid secretion [7], P450 assays [8], or
auxin biosynthesis [9–11].

A common source for microsomes are dog pancreas cells [12]
or rabbit reticulocyte lysate [13]. For plant microsomes wheat germ
is a good source [14] or they can be purified from soybeans [15].

Here I describe the isolation of microsomes from Arabidopsis
thaliana seedlings (adapted from [9–11]).

2 Materials

2.1 Stock Solutions

(See Note 1)

2.1.1 For Microsomal

Preparation

1. M TEA-HOAc, pH 7.5.

2. 2 M KOAc, pH 7.5.

3. 0.1 M Mg(OAc)2.

4. 1 M Sucrose.

Fig. 1 Schematic representation of microsome purification

Fig. 2 Subcellular compartmentation of auxin biosynthesis in Arabidopsis
thaliana. (a) YUC-route of auxin biosynthesis in arabidopsis. ER-located
enzymes are labeled in blue, cytosolic enzymes in green. (b) Confocal
localization for two enzymes in the first step of IAA biosynthesis. TAA1 is
present in the cytosol, whereas TAR2 shows ER-location
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5. 1 M DTT.

6. 0.5 M EDTA.

2.1.2 For IAA

Quantification

1. 1 M Tris–HCl, pH 8.0.

2. 1 M Na2CO3.

3. 0.1 M NADPH.

4. 0.1 M FAD.

5. 0.1 M indole-3-pyruvic acid (IPyA).

6. 1 M Tryptophan (Trp).

2.2 Buffers 1. Buffer A: 25 mM TEA-HOAc (pH 7.5), 50 mM KOAc,
(pH 7.5), 5 mM Mg(OAc)2, 0.25 M Sucrose, 4 mM DTT.

2. Buffer B: 100 mM TEA-HOAc (pH 7.5), 20 mM EDTA.

3. Buffer C: 25 mM TEA-HOAc (pH 7.5), 25 mM KOAc
(pH 7.5), 2 mM Mg(OAc)2, 0.5 M Sucrose, 4 mM DTT.

4. Buffer D: 25 mM TEA-HOAc (pH 7.5), 0.25 M Sucrose,
1 mM DTT.

2.3 Equipment 1. Porcelain mortar and pestle.

2. Glass bottles for buffers.

3. Cheese cloth.

4. Refrigerated table centrifuge.

5. Ultracentrifuge with swing-out rotor (e.g., SW41, Beckman
Coulter).

6. Ultracentrifuge corex tubes.

7. 2 ml Potter–Elvehjem homogenizer with glass rod.

8. Water bath (37 �C).

9. Speed-vac.

10. Nanodrop spectrophotometer, or equivalent, to determine
protein concentration.

3 Methods

3.1 Endoplasmic

Reticulum (ER)

Microsome

Preparation

(This part of the procedure will take between 3 and 4 h depending
on sample size.)

1. All steps are carried out on ice or at 4 �C unless indicated
otherwise.

2. All buffers, tubes, etc. used in the procedure should be pre-
cooled (see Note 2).

3. 5 g of arabidopsis seedling tissue (7 days after germination, see
Notes 3–5) are ground to fine powder in liquid nitrogen using
a pre-cooled mortar and pestle.
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4. The powder is then homogenized in 4 ml of ice-cold buffer A
and transferred into a 50 ml falcon tube.

5. 4 ml of ice-cold buffer B are added to the tube and the suspen-
sion is incubated on ice for 10 min. Then the homogenate is
centrifuged at 1000 � g for 10 min at 4 �C. The resulting
supernatant is poured over four layers of cheese cloth into a
fresh falcon tube. At this step, the resulting extract is consid-
ered total plant extract for later enzymatic assays. The extract is
centrifuged again at 4500 � g for 25 min at 4 �C.

6. A 4 ml sucrose cushion (buffer C) is layered on the bottom of
ultracentrifuge corex tubes.

7. The 8 ml of plant suspension is layered on top of this sucrose
cushion by slightly angling the tube and carefully and slowly
pipetting the suspension at the side of the tube. The tube is
centrifuged for 90 min at 93,000 � g (ultracentrifuge with
swing-out rotor, e.g., SW41).

8. The resulting pellet is removed from the ultracentrifuge tube if
necessary with 20 μl of buffer D and transferred to a 2 ml
Potter–Elvehjem homogenizer. The supernatant is kept and
used as cytosolic extract in later IAA quantifications.

9. The final pellet was resuspended in 200 μl of buffer D using a
glass rod and a 2 ml Potter–Elvehjem homogenizer. Protein
content is measured using a Nanodrop spectrophotometer.
Freshly prepared microsomes should be used for enzymatic
assays straight away (see Note 6).

3.2 Purity of

Microsomes

To check for the purity of the microsomal fraction both the micro-
somal and the cytosolic fraction can be probed with an anti-HSP70
antibody detecting cytosolic heat shock protein 70 (Fig. 3). The

Fig. 3 Immunoblot analysis for purity of microsomal fractions. Microsomal (M)
and cytosolic (C) fractions were tested for heat shock protein 70 (HSP70) using
immunoblot analysis. 100 μg of protein from each fraction were probed with
anti-HSP70 antibodies (1:1000) recognizing the cytosolic HSP70
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HSP70 band is only detected in the cytosolic fraction indicating a
rather pure microsomal fraction.

Further purity tests using immunoblot analysis could include
testing for the presence of plasma membrane or mitochondrial
proteins in the microsomal fraction.

3.3 Example for

Microsomal Enzymatic

Tests

The YUC-route of auxin biosynthesis is a two-step process (Fig. 2):
In arabidopsis TAA-proteins (Tryptophan Aminotransferase of Ara-
bidopsis), TAA1, TAR1, and TAR2 are converting tryptophan
(Trp) to indole-3-pyruvic acid (IPyA) [16] which is then converted
by YUC proteins to IAA (YUC1-11) [17]. It was shown that
TAR2, YUC4.2, 5, 7, 8, and 9 are located on the ER, whereas
TAA1 and YUC1, 2, 3, 6, and 11 are located in the cytosol [10].

Enzymatic activity tests (100 μl total volume) with microsomal
and cytosolic fractions were carried out in the following manner:

1. In 2 ml Eppendorf tubes mix carefully: 20 μl of microsomal or
cytosolic extract, 1 mMNADPH, 100 μM FAD, 100 μM IPyA
or Trp (depending on experimental interest).

2. 100 mM Tris–HCl (pH 8.0) up to a total volume of 100 μl.
3. The assays are incubated for 1 h in a 37 �Cwater bath and snap-

frozen in liquid nitrogen straight after the incubation time.

4. At this stage the assays can be stored at �20 �C before the IAA
analysis is carried out.

3.4 Auxin

Biosynthetic Capacity

in Arabidopsis

Microsomes

Representative data for the conversion of tryptophan and IPyA to
IAA in arabidopsis seedlings is shown in Fig. 4 [10].

Fig. 4 Auxin biosynthetic capacity in arabidopsis seedlings. Enzymatic
conversion of tryptophan to IAA by microsomal (Microsome) fractions or
cytosolic (Cytosol) fractions from arabidopsis seedlings 7 days after
germination. Standard errors are indicated. n ¼ 3

Microsome Preparation 121



4 Notes

1. Filter buffers 1–4 through 0.45 μm syringe filters. Add DTT
from 1 M stock fresh prior to use.

2. Pre-chill tubes, glassware, buffers, centrifuges, etc. and keep
your samples on ice as much as possible.

3. Tissue: depending on the biological question instead of using
whole seedlings for the microsomal preparation it can, e.g., be
distinguished between root and shoot or other ages and devel-
opmental stages can be used.

4. This preparation has also been successfully used for maize [9]
and tobacco tissues (unpublished).

5. Collect plant material straight into a chilled falcon tube that is
kept on ice and try to collect the material as quickly as possible.

6. Where possible timewise freshly prepared microsomes should
be used for enzyme assays. Freezing in 20% glycerol for later
assays is possible but not recommended.
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Chapter 10

ERMembrane Lipid Composition and Metabolism: Lipidomic
Analysis

Laetitia Fouillen, Lilly Maneta-Peyret, and Patrick Moreau

Abstract

Plant ER membranes are the major site of biosynthesis of several lipid families (phospholipids, sphingoli-
pids, neutral lipids such as sterols and triacylglycerols). The structural diversity of lipids presents consider-
able challenges to comprehensive lipid analysis. This chapter will briefly review the various biosynthetic
pathways and will detail several aspects of the lipid analysis: lipid extraction, handling, separation, detection,
identification, and data presentation. The different tools/approaches used for lipid analysis will also be
discussed in relation to the studies to be carried out on lipid metabolism and function.

Key words Ceramides, GC-FID, GC-MS, Glucosylceramides, HPTLC, LC-MS, Long chain bases
(LCB), Phospholipids, Phytosterols, Triacylglycerols

1 Introduction

ER membranes are known to be involved in many key cellular
functions and understanding more precisely their role, being able
to analyze their lipid composition and metabolism/homeostasis is
as crucial as it is for ER proteins.

Of course to be able to perform such lipid analysis, we must
handle highly purified ER membranes devoid of other membrane
contaminants, something which is not so obvious as it will depend
on the plant material considered. According to the starting mate-
rial, different methodologies with various efficiencies in isolating
highly purified ER membranes (differential ultracentrifugation,
free-flow electrophoresis, two phase partition systems, affinity puri-
fication) alone or in combination have to be used ([1–3] and
references therein).

Table 1 details the lipid composition of the ER membranes
from different plant species and tissues, that have been combined
from the literature to give a simplified view of the different lipid
families/species and their relative abundance. The corresponding
biosynthetic pathways of the different lipid classes of the ER
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membranes are presented in Fig. 1 for phospholipids, in Fig. 2 for
glucosylceramides, and in Fig. 3 for sterols.

The pretty large variations in lipid amounts which can be
observed (Table 1) can be due of course to the differences in the
plant species/tissues but also to some extent to the purity of the ER
membranes according to the isolation procedures used. Anyway,
Table 1 indicates that the major lipid families/species are repre-
sented by the phospholipids, followed by the sterols (free and
conjugated) and the glucosylceramides (GluCer). Other lipid spe-
cies such as phosphoinositides (PIP, PIP2), acyl-CoAs, and cera-
mides (precursors of GluCer) are also present but in lower
amounts. The levels of diacylglycerol in ER membranes (precursors
of phospholipids and also of triacylglycerols for lipid bodies) are not
mentioned because their levels can even be more variable.

The purpose of this chapter is not to give an extensive overview
of the various lipid methodologies because this has already been
done by well-recognized lipid experts in exhaustive set of publica-
tions such as in the AOCS Lipid Library (http://lipidlibrary.aocs.
org) or in the arabidopsis book [4], but to select some lipid tech-
nologies that were, are and will be relevant for studying several
aspects of plant ER membranes lipid metabolism.

2 Materials

2.1 Technologies/

Equipment

1. Lipid extraction-preparation/Bench centrifuge, 110 �C dry
bath incubator, 110 �C resistant screwed glass tubes, bench
vortex.

2. Densitometric analysis/TLC sampler Linomat 5 (Camag,
Muttenz, Switzerland), TLC scanner 3 (CAMAG, Muttenz,
Switzerland).

3. HPTLC (High Performance Thin Layer Chromatography)/
ADC2 automatic developing chamber (Camag,Muttenz, Swit-
zerland), HPTLC plates F254 (Merck, Darmstadt, Germany).

Table 1
Lipid composition of plant ER membranes in mol%a

PA� lPC PC PE PG PI PS GlcCer
Free
sterols

Conjugated
sterols

0.5–7 0.8–1.7 36–65 11–23 3.5–5 2.5–17.5 1–7 2–8 3–14 1–4

�Generally, PA is considered and found to be low/very low in the ER membranes and in most plant cell membranes

because it is an intermediary metabolite and a signaling phospholipid. So most of the time, high amounts of PA are
probably due to Phospholipase D activation during material handling and/or lipid extraction
aData combined from several plant species and tissues ([12–14] and references therein, and unpublished results). PA
Phosphatidic Acid, lPC lysoPhosphatidylCholine, PC PhosphatidylCholine, PE PhosphatidylEthanolamine, PG Phos-

phatidylGlycerol, PI PhosphatidylInositol, PS PhosphatidylSerine, GlcCer Glucosylceramides. Conjugated sterols: sum
of sterol glycosides þ steryl esters
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4. GC-FID (Gas Chromatography-Flame Ionization Detector)/
Agilent 7890 gas chromatograph equipped with flame ioniza-
tion detection (Santa Clara, CA, USA), Agilent GC Column
DB-Wax 15 m � 0.53 mm � 1.0 μm.

5. GC-MS (Gas Chromatography-Mass Spectrometry)/Agilent
6850 gas chromatograph coupled with a MS detector MSD
5975-EI (Santa Clara, CA, USA), HP-5MS capillary column
(5% phenyl-methyl-siloxane), 30-m, 250-mm, and 0.25-mm
film thickness (Agilent, Santa Clara, CA, USA).

6. LC-MS (Liquid Chromatography-Mass Spectrometry)/QTRAP
5500 (ABSciex) mass spectrometer coupled to a liquid chroma-
tography system (Ultimate 3000,Dionex). LunaC8150� 1mm
columnwith 100-Å pore size and 5-mmparticles (Phenomenex).

7. Radiolabeling analysis/PhosphorImager (such as STORM or
TYPHOON from GE Healthcare).

G3P
Acyl-CoA

Acyl-CoA

CoA

CoA

CTP

G3P

CMP

H2O

H2O

Pi

Pi

CMPInositol

DAG PE, PC PS

PI

CMP Serine
PPi

PS

Lyso-PA

PA

GPAT

LPAAT

CDS

PAH BE

PISI/PIS2

PGS

PGPP

PSS CDP-DAG

PGP

PG

Fig. 1 Simplified phospholipid biosynthetic pathways in the ER. CDP-DAG
cytidine diphosphate diacylglycerol, CoA coenzyme A, CMP cytidine monopho-
sphate, CTP cytidine triphosphate, DAG diacylglycerol, G3P glycerol-3-phos-
phate, Lyso-PA lysophosphatidic acid, PA phosphatidic acid, PC
phosphatidylcholine, PE phosphatidylethanolamine, PG phosphatidylglycerol,
PGP phosphatidylglycerol phosphate, PI phosphatidylinositol, PS phosphatidyl-
serine. Enzymes: CDS cytidine-diphosphate diacylglycerol synthase; GPAT glyc-
erol-3-phosphate acyltransferase, LPAAT lysophosphatidic acid acyltransferase;
PAH phosphatidic acid phosphohydrolase; PGPP phosphatidylglycerol phosphate
phosphatase; PGS phosphatidylglycerol phosphate synthase; PIS phosphatidyli-
nositol synthase; PSS phosphatidylserine synthase
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2.2 Lipid Standards 1. Lipid standards are purchased from Avanti Polar Lipids (Ala-
baster, AL, USA), Nu-Chek-Prep (Elysian, MN, USA),
Matreya, (State College, PA, USA), and/or Sigma (St. Louis,
MO, USA). See Note 1.

2. For HPTLC analysis, all the phospholipid standards (PC, PE,
PI, PG and PS) are from soybean extracts excepted PA which
can be from any other source, DAG (for example di-18:1),
TAG (for example tri-18:1), ceramides (bovine extract), gluco-
sylceramides (soybean extract), sterol (plant extract). See also
Note 2.

Fig. 2 Simplified GlcCer biosynthetic pathway in the ER. GCS glucosylceramide
synthase, LOH1–3 ceramide synthases 1, 2, and 3, SPT serine palmitoyl
transferase. The dotted arrow indicates several enzymatic steps. All the enzymes
involved in the biosynthesis of glucosylceramides and its precursors are located
in the ER
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3. For GC-FID or GC-MS analysis, C17:0, h14:0, d20:0, t17:0,
d14:14(E), and cholestanol.
For LC-MS analysis, PC, 17:0/17:0; PI, 17:0/14:1; PE,
17:0/17:0; PG, 17:0/17:0; PS, 17:0/17:0, TAG 17:0/
17:0/17:0, DAG 17:0/17:0.

2.3 Solutions 1. Eluent A: isopropanol/methanol/H2O 5/1/4, v/v contain-
ing 0.2% formic acid and 0.028% NH3.

2. Eluent B: isopropanol containing 0.2% formic acid and 0.028%
NH3.

Fig. 3 Simplified sterol biosynthetic pathway in the ER. The two successive
arrows indicate two or more enzymatic steps. The biosynthesis of the precursor
mevalonate by the HMG-CoA reductase is the first step of the sterol biosynthetic
pathway which is located in the ER
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3. Eluent C: acetonitrile/methanol/H2O (19/19/2, v/v) con-
taining 0.2% formic acid and 0.028% NH3.

4. Eluent D: isopropanol containing 0.2% formic acid and 0.028%
NH3.

3 Methods

3.1 Lipid Extraction Whatever the isolation procedure of the purified ER membranes
(differential ultracentrifugation, free-flow electrophoresis, two
phase partition systems, affinity purification), the ER fraction will
be generally obtained as a pellet after centrifugation in order to
concentrate the membranes.

Analyzing lipids requires extraction using organic solvents.
Extraction should be rapid in order to avoid lipid modifications
during treatment. In the case of ER membranes, extraction should
be carried out immediately after recovering the ER membranes;
otherwise the membranes can be stored at �80 �C (but there is a
risk of changes to the lipids).

1. The pellet should be suspended in a small volume (100–300 μl)
of distilled H2O (if protein activity is not necessary to be
measured) or in buffer, by gentle grinding rather than vortex-
ing, and transferred into glass tubes (with Teflon protected
screw caps) for lipid extraction (plastic apparatus and containers
(other than Teflon) should be avoided). One part (5%) of the
aliquot should be conserved for protein measurement.

2. Then extract the lipids with chloroform/methanol 2/1, v/v
[5] (see Note 3 for acyl-CoAs), using a ratio of chloroform,
methanol, and aqueous phase in the final mixture close to 8/4/
3, v/v to be efficient.

3. The solution is vortexed or shaken for 5 min, at room temper-
ature. Centrifuge the solution (10 min 3000 rpm) and discard
the upper phase (as well as interphase).

4. This organic phase is washed with ¼ of volume of H2O or 0.9%
NaCl; after vortexing for 1 min, the solution is centrifuged
(10 min, 3000 rpm (3000 � g)) and the lower phase recovered
in a new glass tube.

5. The organic solvent is evaporated under air (or nitrogen if
particular protection of unsaturated fatty acids is needed).
Resuspended the lipids into appropriate solvents required for
the subsequent analysis.

The principal methods for lipid class analysis are HPTLC and
LC-MS/MS, and for their fatty acid content are GC-FID or GC-
MS. Long chain bases of sphingolipids and sterols can be analyzed
by GC-MS (a general scheme of lipid analysis is given in Fig. 4).
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3.2 HPTLC Analysis

of Phospholipids and

Acyl-CoAs

1. For analysis of phospholipids with HPTLC plates, the lipids
should be resuspended into 50–200 μl of chloroform/metha-
nol 2/1, v/v. Close the cap until use to prevent solvent loss and
changes in lipid concentration.

2. Phospholipids may be analyzed by loading the extract, using a
CAMAG Linomat IV, onto 10 � 10 or 10 � 20 cm HPTLC
plates, which are developed in methyl acetate/n-propanol/
chloroform/methanol/0.25% aqueous KCl (25/25/25/10/
9, v/v) according to Heape et al. [6].

3. External phospholipid standards (10 μg per standard; see Note
2) are loaded on the same plates as the samples to be analyzed.

4. The migration may be carried out into a simple developing
chamber (20 min saturation/45 min migration/45 min dry-
ing; developing solvent volume 20 ml) or into an ADC2 auto-
matic developing chamber (developing solvent volume 10 ml;
program: migration distance 85 mm; drying time 5 min; satu-
ration time 0 min).

5. Lipids can be detected by dipping the plates into a 3% copper
acetate (w/v) in 8% aqueous phosphoric acid solution [7, 8],
followed by heating at 110 �C during 30 min.

6. Densitometric analysis of phospholipids must then be per-
formed in the following hour (stability of coloration), using
for example a TLC scanner 3 at 366 nm. Lipids are quantified
(μg of lipids) by comparing lipids and standard lipids peak areas
(see Note 2).

7. If analysis of the fatty acid content is needed, the lipids from the
HPTLC plates are only labeled by iodine vapors. Place the
chromatogram 5–15 min into a strong iodine atmosphere
(into a covered beaker in which some iodine resublimed

Fig. 4 Different steps of lipid analysis processes. The principal methods for lipid
class analysis are HPTLC and LC-MS, and for their fatty acid content are GC-FID
or GC-MS. Long chain bases of sphingolipids, and sterols, can be analyzed by
GC-MS. GC-FID gas chromatography-flame ionization detector, GC-MS gas
chromatography-mass spectrometry, SPE solid phase extraction, HPTLC high
performance thin layer chromatography
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crystals have been placed); double bonds containing lipids will
be stained in yellow over a few minutes. The desired lipid bands
are scraped off and transferred into glass tubes (with Teflon
covered screw caps) for further analysis by GC-FID or GC-MS.

8. For HPTLC analysis of acyl-CoAs, the lipids should be resus-
pended into 50–200 μl of chloroform/methanol/H2O, 3/3/
1, v/v.

3.3 GC-FID Analysis

of Fatty Acids from

Phospholipids

1. Fatty acid methyl esters (FAMEs) are prepared by resuspending
the scraped lipid bands in 1 ml of 2.5% H2SO4 (v/v) in metha-
nol using heptadecanoic acid 2 μg/ml as internal standard.

2. Tubes are heated at 80 �C for 1 h and cooled to room
temperature.

3. Then 400 μl hexane and 1.5 ml H2O are added to extract fatty
acid methyl esters.

4. The tubes are vortexed vigorously for at least 1 min and cen-
trifuged 10 min at 2000 rpm (2000 � g) with a bench centri-
fuge and the organic (upper) phase is transferred (preferentially
with a syringe) to injection GC vials.

5. GC-FID can be performed using an Agilent 7890 gas chro-
matograph equipped with an Agilent GC Column DB-Wax
15 m � 0.53 mm � 1.0 μm and flame ionization detection,
with Helium as carrier gas at a flow rate of 3 ml/min (4 psi).

6. The temperature gradient conditions can be: 160 �C for 1 min,
increase to 190 �C at 20 �C/min, increase to 210 �C at 5 �C/
min and then remaining at 210 �C for 5 min.

7. FAMES are identified by comparing their retention times with
commercial fatty acid standards and quantified using ChemSta-
tion to calculate the peak areas, and then comparing them with
the response of an internal standard (C17:0).

3.4 Phospholipi-

domic Analysis

by LC-MS

1. For the analysis of phospholipids by LC-MS, phospholipid
extracts were dissolved in 100 μl eluent A.

2. Synthetic internal lipid standards (PE, 17:0/17:0; PS, 17:0/
17:0; PC, 17:0/17:0; PI, 17:0/14:1; and PG, 17:0/17:0)
were added at different amounts adapted for the detection.

3. LC-MS/MS (multiple reaction monitoring mode) analysis can
be performed with a model QTRAP 5500 mass spectrometer
coupled to a liquid chromatography system Ultimate 3000.
Analysis was performed in the negative (PE, PS, PI, and PG)
and positive (PC) modes with fast polarity switching (50 ms);
nitrogen was used for the curtain gas (set to 15), gas 1 (set to
20), and gas 2 (set to 0). Needle voltage was at �4500 or
þ5500 V without needle heating; the collision gas was also
nitrogen. The multiple reaction monitoring mode is based on
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the loss of the fatty acid part for the negative analysis (PE, PS,
PI, and PG), and on the loss of the polar head in positive mode
for PC analysis. The declustering potential was adjusted at
�160 V for PE, �130 V for PG, �90 V for PS, �85 V for
PI, and þ40 V for PC; collision energy is set to �48 eV for PE
and PG, �60 eV for PS, �62 eV for PI, and þ47 eV for PC.
The dwell time was set up to 3 ms. Reverse-phase separations
are performed at 50 �C on a Luna C8 150 � 1 mm column
with 100-Å pore size and 5-mm particles. During the run, the
proportions of eluent A and eluent B vary: 0 min, 30% B;
5 min, 50% B; 30 min, 80% B; 31–41 min, 95% B;
42–52 min, 30% B. The flow rate is set up at 40 μl/min, and
3 μl sample volumes are injected. The areas of LC peaks are
determined using the MultiQuant software for phospholipid
quantification.

3.5 Long Chain

Bases (LCB) Analysis

by GC-MS

The long chain bases (LCB) are extracted from sphingolipids by
basic hydrolysis. The free LCB are chemically oxidized in their
aldehyde form to be analyzed in GC-MS [9].

Add 1 ml of 10% (w/v) of barium hydroxide (dissolved in
H2O) to the ER membrane lipid extract. Be sure that the aqueous
solution was well shaken before pipetting and place the samples in
tubes of about 8 ml (see Note 4). Add 1 ml of dioxane with
standards (d20:0, t17:0, and d14:14(E), see Note 5). Incubate at
110 �C overnight, then, after cooling add 6 ml of distilled H2O,
and transfer the content in a new bigger tube (approximate volume
of 12 ml). Add 4 ml of ether 100%. Shake vigorously and centrifuge
at 700 � g for 5 min. Pick up the upper phase and place it in a new
tube of about 8 ml. Add another 4 ml of ether 100% in the previous
12 ml tube, and shake vigorously and centrifuge at 700 � g for
5 min. Pick up the upper phase and place it in the previous 8 ml
tube. Evaporate with N2 gas flow. Do not warm in a H2O bath, as
LCBs are quite labile. After complete evaporation, add 1 ml of
methanol. Add 100 μl of a 0.2 M metaperiodate (NaIO4) solution
in H2O (seeNote 6). Incubate at room temperature in the dark for
1 h sharp and shake slightly. Add 1 ml of hexane 99% and 1 ml of
distilled H2O and shake vigorously. Centrifuge at 700 � g for
5 min. Pick up the upper phase. Transfer to a new tube (8 ml)
and evaporate with N2 gas flow at room temperature (do not warm
in a H2O bath for evaporation as fatty aldehydes might be unstable
in this condition). Suspend in 100 μl of hexane 99% and vortex.
Transfer to GC vials and run GC-MS.

GC-MS can be performed using an Agilent 6850 gas chro-
matograph coupled to a MS detector MSD 5975-EI. An HP-
5MS capillary column (5% phenyl-methyl-siloxane, 30-m, 250-
mm, and 0.25-mm film thickness) can be used with Helium carrier
gas at 2 ml/min; injection is done in splitless mode; injector and
mass spectrometry detector temperatures are set to 250 �C; the
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oven temperature is held at 50 �C for 1min, then programmed with
a 25 �C/min ramp to 150 �C (2-min hold) and a 10 �C/min ramp
to 320 �C (6-min hold).

3.6 Ceramide and

Glucosylceramide

Analysis by HPTLC

and GC-MS Analysis

of Their Fatty Acids

Under the conditions of polar lipid (phospholipids) separation
described above, glucosylceramides and sterylglucosides do not
separate. These lipids are separated on HPTLC plates using the
solvent system chloroform/methanol (85/15, v/v) [10]. In this
elution system, ceramides can also be isolated on HPTLC plates.
Quantification by densitometry using ceramide and glucosylcera-
mide standards (10 μg per standard) can be performed as explained
for phospholipids in 3.2.

For acyl-chain characterization of ceramides and glucosylcera-
mides by GC-MS, scraped lipid bands (after iodine vapor revela-
tion, see Subheading 3.2) are directly incubated with 1 ml of 5%
sulfuric acid solution in methanol (implemented with standards:
5 μg/ml of C17:0 and 5 μg/ml of h14:0) for transesterification
which is made overnight at 85 �C to produce FAMEs. Those are
then washed by adding 1 ml of NaCl 2.5% and 1 ml of hexane 99%.
After vigorous shaking and centrifugation at 700 � g for 5 min at
room temperature, the higher phase is harvested, placed in a new
tube and buffered with 1 ml of 100 mM Tris, 0.09% NaCl, pH 8
with HCl. After vigorous shaking and centrifugation at 700 � g for
5 min at room temperature, the higher phase is harvested, placed in
a new tube and evaporated with needles evaporating pan. Then,
200 μl of N,OBis(trimethylsilyl)trifluoroacetamide þ 1% trimethyl-
silyl (BSTFA þ 1% TMCS) are added and incubated at 110 �C for
20 min. After evaporation, FAMEs are resuspended in 100 μl of
99% hexane and run on GC-MS with the same program described
in Subheading 3.3.

3.7 Neutral Lipid

Analysis by HPTLC

and GC-FID

To isolate and quantify neutral lipids (including phytosterols, DAG,
FFA, TAG, and steryl esters), the lipids, resuspended into
50–200 μl of chloroform/methanol 2/1, v/v, are loaded onto
10 � 10 or 10 � 20 cm HPTLC plates developed with hexane/
ethylether/acetic acid (90/15/2, v/v) as described [8, 11]. Exter-
nal neutral lipid standards (10 μg per standard; see Note 2) are
loaded on the same plates than the samples to be analyzed. The
migration may be carried out into a simple developing chamber
(10 min saturation/20 min migration/30 min drying; developing
solvent volume 20 ml) or into an ADC2 automatic developing
chamber (developing solvent volume 10 ml; program: migration
distance 85 mm; drying time 5 min; saturation time 0 min). Quan-
tification by densitometry can be performed as explained for phos-
pholipids in Subheading 3.2.

For GC-FID analysis of fatty acids from fatty acid-containing
neutral lipids, FAMEs are analyzed and quantified as described in
Subheading 3.2.
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3.8 Phytosterol

Analysis by GC-MS

Phytosterols are prepared by resuspending the corresponding
scraped lipid bands in 1 ml of ethanol containing the internal
standard α-cholestanol (25 mg/ml) in screwed glass tubes. For
saponification, add 100 μl of 11 N KOH (56.11 g/mol, 12.3 g/
20 ml H2O), close the tube(s) under nitrogen, incubate in a dry
bath incubator at 80 �C for 1 h, add 1 ml of hexane, vortex for 15 s,
add 2 ml of distilled H2O, vortex for 15 s, centrifuge 5 min at
2000 rpm in a bench centrifuge, and recover the phytosterol-
containing upper phase in a new screwed glass tube and evaporate
the solvent under an N2 gas stream. For silylation of phytosterols,
add 200 μl of BSTFA/TMCS, incubate 15 min at 110 �C in a dry
bath incubator, evaporate the solution to dryness under nitrogen.

GC-MS analysis: add 200 μl of hexane before injection on GC-
MS and use the same program as described in Subheading 3.3.

3.9 LC-MS Analysis

of DAG and TAG

For the analysis of DAG and TAG by LC-MS, phospholipid extracts
were dissolved in 100 μl of eluent C; synthetic internal lipid stan-
dards (DAG 17:0/17:0; TAG, 17:0/17:0/17:0) were added at
different amounts adapted for the detection.

LC-MS/MS (multiple reaction monitoring mode) analysis is
performed with a model QTRAP 5500 mass spectrometer coupled
to a liquid chromatography system Ultimate 3000. The multiple
reaction monitoring mode is based on the loss of the fatty acid part
during the fragmentation.

Analysis was achieved in positive mode and nitrogen was used
as curtain gas (set to 30), gas1 (set to 25) and gas2 (set to 0).
Needle voltage was at þ5500 V without needle heating. The colli-
sion gas was also nitrogen. The multiple reaction monitoring mode
is based on the loss of the fatty acid part of the TAG or DAG
molecules. The declustering potential was set at þ40 V for TAG
and þ86 V for DAG; collision energy was adjusted at þ34 V for
TAG and DAG. The dwell time was set to 3 ms. Reversed phase
chromatography was carried out at 30 �C using a Luna 3u C8
150 � 1 mm column, with 100-Å pore size, 3-μm particles. Eluent
C and eluent D were then used as follows. The gradient elution
program was 0–5 min, 15% D; 5–35 min, 15–40% D; 35–50 min,
55% D; 51–58 min, 80% D; 59–70 min, 15% D. The flow rate was
40 μl/min and injection volume was 3 μl. The relative levels of
DAG and TAG species were determined using MultiQuant and
normalizing to the area of the DAG or TAG internal standards
(Yuan et al., submitted).

3.10 Radiolabeling

In Vivo

Radiolabeled lipid precursors can be used for incubation with plant
cells/tissues to investigate ER membrane lipid metabolism in vivo.
According to the starting material, ER membranes can be isolated
through different methodologies (see Subheading 1). Subse-
quently, ER membrane lipids are then extracted and washed as
detailed in Subheading 3.1. Polar and neutral lipids can then be
separated onto HPTLC plates as described in the corresponding
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paragraphs. Their radiolabeling can then be determined using a
PhosphorImager equipment. HPTLC plates are generally exposed
to the adapted screens for 24–48 h and then the screens are scanned
with the PhosphorImager. The ImageQuant software translates the
radioactivity on HPTLC plates into peaks and gives a surface area
for each. Then, from a calibrating curve (made with any radioactive
standard) defining the correspondence between peak surface area
and labeling amount, we can calculate for each lipid the level of
labeling, and from the specific radioactivity of the lipid precursor
used, we can determine the amount of each lipid in moles.

3.11 Radiolabeling

In Vitro

Radiolabeled lipid precursors can also be used for incubation with
ER membranes to investigate in vitro the enzymatic activity of ER
membrane enzymes involved in lipid metabolism. According to the
starting material, ER membranes can be isolated through different
methodologies (see Subheading 1). Subsequently, ER membrane
lipids are then extracted and washed as detailed in Subheading 3.1.
Polar and neutral lipids can then be separated onto HPTLC plates as
described in Subheading 3.2. Their radiolabeling can then be deter-
mined using a PhosphorImager equipment. The procedure deter-
mining the formed products amounts in moles is described above.

4 Notes

1. All chemicals and solvents were either of analytical or mass
spectrometric grades. Prepare all solutions using deionized
H2O (18.2 MΩ cm at 25 �C), for example produced using a
Synergy UV Millipore System. Follow all disposal regulations
when disposing waste material.

2. For HPTLC analysis, each of the lipid classes should be cali-
brated with appropriate standards, i.e., with a similar fatty acid
degree of unsaturation to the samples because the revelation
with both cupric acetate/phosphoric acid or iodine vapor solu-
tions is sensitive to the degree of fatty acid unsaturation.

3. If acyl-CoAs are required, lipids should be extracted with six
times the sample’s volume of chloroform/methanol 1/1 in
order to obtain a homogeneous phase permitting to conserve
the more polar molecules such as the acyl-CoAs.

4. Be extremely careful that all tube caps contain a Teflon disk.

5. Standards (for example, d20:0, t17:0, and d14:14(E)) should be
added in the dioxane. Each standard initial concentration (1 g/
L in methanol) should be added at 5 μg/ml final, i.e., 10 μl in
the 2 ml of barium hydroxide þ dioxane.

6. The NaIO4 stock concentration should be prepared only
freshly.
Equivalent instrumentation can be used.
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Chapter 11

2in1 Vectors Improve In Planta BiFC and FRET Analyses

Dietmar G. Mehlhorn, Niklas Wallmeroth, Kenneth W. Berendzen,
and Christopher Grefen

Abstract

Protein–protein interactions (PPIs) play vital roles in all subcellular processes and a number of tools have
been developed for their detection and analysis. Each method has its unique set of benefits and drawbacks
that need to be considered prior to their application. In fact, researchers are spoilt for choice when it comes
to deciding which method to use for the initial detection of a PPI, and which to corroborate the findings.
With constant improvements in microscope development, the possibilities of techniques to study PPIs
in vivo, and in real time, are continuously enhanced, and expanded. Here, we describe three common
approaches, their recent improvements incorporating a 2in1-cloning approach, and their application in
plant cell biology: ratiometric Bimolecular Fluorescence Complementation (rBiFC), FRET Acceptor
Photobleaching (FRET-AB), and Fluorescent Lifetime Imaging (FRET-FLIM), usingNicotiana benthami-
ana leaves and Arabidopsis thaliana cell culture protoplasts as transient expression systems.

Key words Protein–protein interaction, rBiFC, FRET, Acceptor photobleaching, FLIM, Gateway,
SEC61, 2in1

1 Introduction

Core cellular processes such as signal perception and transduction,
vesicle trafficking, transport activities, and metabolic pathways rely
on formation of complex protein networks. Analysis of the bio-
chemical mechanisms at the molecular level requires a fundamental
understanding of the protein–protein interactions (PPIs) involved.
Over the past decades, a number of techniques such as Co-
immunoprecipitation (CoIP), the Yeast Two-Hybrid (Y2H), the
Split Ubiquitin System (SUS), Förster Resonance Energy Transfer
(FRET) and related methods, as well as Bimolecular Fluorescence
Complementation (BiFC) have become routine laboratory techni-
ques to dissect PPIs (reviewed in [1]). Technological advancements
in microscope development have enhanced possibilities further by
facilitating real/life-time imaging of PPIs. Even techniques that
were thought to be predominantly in vitro techniques such as

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_11, © Springer Science+Business Media LLC 2018
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CoIP are now applicable for microscopy analysis at the single-
molecule level [2].

Recently, our lab has introduced 2in1 cloning, a gateway-
compatible approach to simultaneously clone two genes-of-interest
into two independent expression cassettes on the same T-DNA/
plasmid [3] (Fig. 1a). This cloning system is well suited for PPI
techniques that rely on transient transfection systems, as a mixture
of two (or more) independentAgrobacteria each carrying their own
plasmid can lead to unequal gene dosage resulting in high varia-
bility of coexpression [4]. We have combined the 2in1-cloning
system with Bimolecular Fluorescence Complementation [3] as
well as with a range of suitable fluorophores for enhanced FRET/
FLIM analysis [4].

This chapter describes the application of the optimized 2in1
vector sets that can be used for ratiometric Bimolecular Fluores-
cence Complementation (rBiFC), FRET-Acceptor Photobleaching
(FRET-AB), and Fluorescent Lifetime Imaging (FRET-FLIM),
using either Nicotiana benthamiana leaves or Arabidopsis thaliana
cell culture protoplasts as expression system [3, 4].

1.1 Ratiometric

Bimolecular

Fluorescence

Complementation

(rBiFC)

Bimolecular Fluorescence Complementation (BiFC) is a protein
fragment complementation analysis whose first application was in
bacteria [5]. The principle of BiFC is straightforward: a previously
split fluorescent protein (FP) reconstitutes due to an interaction of
two proteins of interest that are fused to the complementary nonflu-
orescent fragments (Fig. 1b). One major advantage of BiFC is the
applicability of the system to almost all types of proteins (cytosolic,
nuclear, organellar, or membrane-bound), and the detection of
interaction in an in vivo context. It also allows visualization of PPIs
at their site of first interaction—which should not be confused with
the subcellular position where these proteins normally reside or are
trafficked to—a misconception that is often inferred. Nevertheless,
the flaws of the technique almost match the advantages. Overexpres-
sion of fusion proteins as well as their FP fragment tag can lead to
mis-localization and alter the likelihood of a positive readout. Reas-
sembly of the FP is irreversible, promoting and stabilizing weak or
transient interactions, but thereby also causing artifactual results
even in the absence of a true interaction [1, 6]. However, the biggest
disadvantage in conventional BiFC systems used in the plant field is
the use of two individual plasmids and their co-infiltration in tran-
sient transformation. This leads to very high variability in gene
dosage and only about 70–80% of coexpression ratios [4]. In other
words, out of four or five cells analyzed, one does not contain both
fusion proteins present making a meaningful interpretation of the
results very hard. In addition, classical BiFC constructs do not
contain concurrent reference markers making quantification against
presumed negative controls (which could be non- or unequally
transformed cells) a cherry-picking exercise (Fig. 2).
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Fig. 1 Concepts of 2in1 cloning, Bimolecular Fluorescence Complementation and Förster Resonance Energy
Transfer. (a) Site-specific BP recombination of PCR products and Entry vectors generates Entry clones. A
subsequent one-step LR reaction recombines the two genes-of-interest (GOI) simultaneously in a 2in1
Destination vector. Depicted are the “2in1” vectors used in this chapter. See Table 1 for details. 35S
cauliflower mosaic virus 35S promoter and omega translational enhancer sequence, pUC ORI origin of
replication, CmR chloramphenicol acetyltransferase resistance gene, ccdB gyrase inhibitor gene, lacZ lacZ
expression cassette. (b) Cartoon depicting the concept of bimolecular fluorescence complementation (BiFC).
Two proteins (grey and red) are tagged with nonfluorescent YFP fragments, nYFP and cYFP, respectively.
Interaction of both proteins leads to reconstitution of fluorescent YFP. (c) Simplified Jablonski diagram
depicting the excitation of an electron in a cyan-fluorescing protein (CFP). After internal conversion (black
wavy arrow) to the S1 ground state (cyan solid arrow) a crossing of the energy barrier between S1 and S0 can
cause the emission of a photon at a longer wavelength (red shifted, Stokes shift; i.e., fluorescence). If an
acceptor molecule is in close enough proximity (here, YFP attached to a red-colored interacting protein), the
energy can be transferred non-radiatively to the acceptor molecule. (d) Absorbance/fluorescence spectrum of
mTurquoise2 and mVenus. The dark grey surface depicts the λ4 weighted overlap integral. Acceptor and donor
spectral bleed through are shown in magenta and green, respectively. (e) Example of a FRET acceptor
photobleaching experiment. A nucleus expressing two interacting proteins attached to a donor and an
acceptor fluorophore. After bleaching (right), the acceptor fluorescence is almost completely lost, but an
increase in donor fluorescence can be detected. (f) Exemplary fluorescence lifetime decay curve of a putative
donor molecule when FRET is occurring (red solid curve; t1) or in the absence of FRET (cyan solid line; t2).
Fluorescence lifetime t is the average time that a fluorescent protein resides in the excited state and at which
fluorescence intensity decreased to 1/e of its initial value. (b–f) modified from [1, 4]
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Contrary to classical BiFC, the ratiometric BiFC (rBiFC)
approach addresses most of these issues and provides means for
internal, ratiometric quantification of results [3]. Placing both FP
fragments on the same T-DNA guarantees equal gene dosage of
both nonfluorescent fusion proteins and the inclusion of a soluble
RFP marker provides a readout for ratiometric analysis and trans-
formation control of the cell under study [3] (Fig. 3). The tech-
nique has since been used in a number of studies for the detection
of PPIs or their structure-function analysis [7–13, 24] (seeNote 1).

1.2 Förster

Resonance Energy

Transfer-Acceptor

Bleaching (FRET-AB)

An alternative, more reliable, yet sophisticated technique exploits
the physical phenomenon of resonance energy transfer which was
first postulated by Theodor Förster in 1946 and has been named
after him as commemoration [14] (Fig. 1c–f). The principle of
FRET is a non-radiative energy transfer from an excited donor
fluorophore to an acceptor molecule—often, but not

Fig. 1 (continued)
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necessarily—fluorescent itself. Prerequisite is an overlap of the
donor emission with the excitation spectrum of the acceptor.
FRET only occurs if donor and acceptor are in close enough prox-
imity of 10 nm or less [15, 16]. Such resolution of molecular
distances is more than a magnitude lower than the diffraction
limit of light microscopy at 200 nm, allowing distinction of protein
co-localization from interaction.

Fig. 2 Method handling. (a) Infiltration of 3–4-week-old N. benthamiana leaves using a syringe as described in
Subheading 3.2. (b) White arrows point at areas of infiltration at the abaxial side of the leaves. (c) The first two
youngest (top) leaves of a 4–6-week-old N. benthamiana plant should not be used for infiltration. Instead,
slightly older leaves (white arrows) are ideal with respect to suitability for injection and transgene expression
[23]. (d) “Tapping method” for gentle mixing of protoplasts with DNA. (e) Preparation of a N. benthamiana leaf
disc for microscopic analysis. The syringe is filled with water, which – by application of a vacuum – replaces
the air in the intercellular space of the leaf epidermis enhancing image quality

Table 1
Available 2in1 expression vector sets for rBiFC and FRET experimentsa

Origin of replication Resistance marker

Name E. coli A. tumefaciens Bacteria Plant Promoter FPsa Reference

pBiFC-
2in1

ColE1 pVS1 Spectinomycin None CaMV35S nYFP, cYFP, RFPb [3]

pFRETcg-
2in1

ColE1 pVS1 Spectinomycin Basta CaMV35S mCherry, mEGFP [4]

pFRETvt-
2in1

ColE1 pVS1 Spectinomycin Basta CaMV35S mVenus, mTRQ2 [4]

aPlasmids exist in all possible tag combinations of fluorescent proteins (FPs)
bRFP fluorescence serves as transformation control and ratiometric marker
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In fluorescence microscopy, the FRET phenomenon can be
detected using different approaches. Classical FRET approaches
simply measure fluorescence of the acceptor when the donor is
excited. However, this can lead to artifactual results due to spectral
bleed through, a phenomenon deriving from an overlap of excita-
tion spectrum of the donor with the emission spectrum of the
acceptor, which—unfortunately—is a common property with
most current FRET FP couples.

Fig. 3 rBiFC analysis of putative Arabidopsis SEC61 subunits in N. benthamiana leaves and A. thaliana
protoplasts. (a) Cartoon of the “2in1” rBiFC destination constructs used in this experiment [3]. (b) Represen-
tative images of N. benthamiana leaves expressing SEC61α1-nYFP (At2g34250), RFP, and either cYFP-
SEC61β1 (At2g45070), cYFP-SEC61γ (At5g50460), or, cYFP-VAMP723 (At2g33110), respectively. (d) At least
40 images were recorded per construct, and YFP/RFP mean fluorescence intensity calculated. Box plot depicts
the median with outer limits at the 25th and 75th percentile, respectively. Notches indicate the 95%
confidence intervals; Tukey whiskers extend to the 1.5� IQR and outliers are depicted as black dots. Red
crosses mark sample means of each dataset. Exemplary p-values (t-test) are indicated in graph. (d)
Representative images of Arabidopsis protoplasts expressing the same constructs. (e) At least ten protoplasts
were recorded per construct, and YFP/RFP mean fluorescence intensity calculated. Boxplot as before. (f)
Immunoblot analysis of HA-tagged SEC61α1, MYC-tagged proteins of interest and soluble RFP expressed in
Arabidopsis protoplasts used for rBiFC analysis. Asterisks indicate expected protein size. Scale bar in (b,
d) ¼ 10 μm
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An alternative, more credible method based on FRET is
“Acceptor Photobleaching” (FRET-AB). Here, the intensities of
the donor fluorophore before and after photobleaching of the
acceptor are measured in a specified region of interest (ROI).
Bleaching of the acceptor leads to an increase in donor fluorescence
in the ROI as the energy that would have been transferred to the
acceptor remains within the donor, leading to increased fluores-
cence of the latter.

AB does not require high-end microscopes and can be carried
out at any fluorescence microscope which is an advantage compared
to Fluorescence Lifetime Imaging Microscopy (FLIM) measure-
ments [15] (see below). However, photobleaching in AB can poten-
tially photo-damage the samples and is therefore not suitable in
prolonged time-lapse experiments. Other pitfalls are concomitant
bleaching of acceptor and donor, as well as movement of the
cytoplasm, both of which may lead to unfeasible results.

Fig. 3 (continued)
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1.3 Fluorescence

Lifetime Imaging

Microscopy (FLIM)

Classical FRET and FRET-AB are both intensity-based methods
and—as such—can be compromised by suboptimal fluorophore
concentration ratios. Measurement of fluorescence lifetime, how-
ever, might overcome this issue [16, 17]. Briefly, irradiation leads to
raising of the FP to an excited—S1—state before relaxation to the
ground—S0—state. The average time the fluorophore resides in the
excited state represents its fluorescence lifetime and is unique for
each FP [18]. When an acceptor molecule is in close enough range
(<10 nm), it can serve as energy sink, resulting in a lifetime “decay”
of the donor molecule. Such reduction in lifetime can be compared
to negative controls or “donor only” samples which inform on the
original lifetime of an FP—the difference between the two informs
on PPI (Fig. 4).

Still, while small imbalances in concentration of donor and
acceptor do not affect FLIM measurements, the lifetime of fluor-
ophores is affected by other factors such as for example changes in
redox state, pH, or temperature. Yet, FRET-FLIM delivers more
credible results as it is almost unaffected by concentration differ-
ences and spectral properties compared to FRET-AB; but it
requires sophisticated and expensive equipment as well as consider-
able training and experience of the scientist who handles it.

2 Materials

2.1 Bacteria and

Plants

For transient transformation of Nicotiana benthamiana leaves via
infiltration,Agrobacterium tumefaciens strain GV3101 pMP90 car-
rying the selection markers for growth on rifampicin and gentami-
cin was chosen [19, 20].

2.2 Media and

Reagents (Tobacco

Leaf Infiltration)

1. Luria-Bertani (LB) medium: 1% tryptone, 0.5% yeast extract,
0.5% NaCl, pH 7.0–7.5 (for solid media add 2% agarose).

2. Antibiotics (1000� stock solution): gentamicin (20 mg/mL in
distilled water), spectinomycin (100 mg/mL in distilled
water), and rifampicin (50 mg/mL in DMSO).

3. AS medium: 10 mM MgCl2, 10 mM MES-KOH, pH 5.6,
150 μM acetosyringone.

4. Sterile distilled water.

2.3 Media and

Reagents (Protoplasts)

2.3.1 Sterile Filtration

The most economic sterile filtration method is to acquire a peristal-
tic pump and use membrane filters with a Swinnex Filter Holder
(Millipore).

2.3.2 Sterile Erlenmeyer

Flasks for Cell Culture

250 mL Erlenmeyer flasks are stoppered with Rotilabo®-culture
plugs and covered well by aluminum foil. Sub-culturing is per-
formed under highly sterile conditions and the flasks are flamed
when opened to prevent contamination.
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Fig. 4 FRET-FLIM analysis of putative Arabidopsis SEC61 subunits in A. thaliana protoplasts. (a) Cartoon of the
“2in1” FRET destination constructs used in this experiment [4]. (b) Representative images of A. thaliana
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2.3.3 Pipetting of

Protoplasts

We use 200 μL, cut tips to handle protoplasts and try to aim for a
diameter of 2–3 mm. Protoplasts are extremely sensitive to shearing
stress and larger tip pore sizes circumvent this.

2.3.4 Cell Culture

Maintenance Media

1. MS Col Medium (for 1 L): 4.3 g/L Murashige and Skoog
Basal Salt Mixture (MS), 5 mL of NPT-Vitamin Stock,
100 mg/mL myo-Inositol, 30 g/L Sucrose, pH 5.8 with
KOH. After autoclaving and before use, add 2,4-D to 1 mg/
L. Store at 4 �C in the dark.

2. NPT-Vitamin Stock: 1 mg/mL Nicotinic acid, 1 mg/mL
Pyridoxine-HCl, 10 mg/mLThiamine-HCl in dH2O. Sterilize
by filtration (0.22 μm) and store at �20 �C.

3. 2,4-D Stock (for 100 mL): Dissolve 100 mg in 10 mL absolute
ethanol and bring to 100 mL with dH2O. Concentration is
1 mg/mL. Sterilize by filtration (0.22 μm) and store at
�20 �C.

2.4 Media for

Protoplast Generation

1. Wall digestion solution without enzymes: 8 mM CaCl2·2H2O,
0.4 M Mannitol, pH 5.5 with KOH. Sterilize by filtration
(0.22 μm).

2. Wall digestion solution: 1% Cellulase, 0.25% Macerozyme,
8 mM CaCl2·2H2O, 0.4 M Mannitol, pH 5.5 with KOH.
Sterilize by filtration (0.22 μm), use immediately or store at
�20 �C.

3. W5: 154 mM NaCl, 125 mM CaCl2, 5 mM KCl, 5 mM
Glucose, pH 5.8–6.0 with KOH. Sterilize by filtration
(0.22 μm) or autoclave.

2.5 Media for

Protoplast

Transfection

1. 40% PEG-1500: 10 g w/v PEG (1500), 1.275 g Mannitol,
0.413 g Ca(NO3)2·4H2O, 4 mM MES, pH 6 with KOH.
Dissolve mannitol and calcium nitrate in 17.5 mL ddH2O
first and then add the PEG. Thereafter, adjust the pH with
KOH. Sterilize by filtration (0.45 μm) and prepare aliquots and
store at �20 �C. After defrosting make sure that all salts are

�

Fig. 4 (continued) protoplasts expressing SEC61α1-eGFP with either mCherry-SEC61β1, mCherry-SEC61γ,
mCherry-VAMP723, or, mCherry, respectively. Line histograms to the right show normalized intensities of
either eGFP or mCherry fluorescence along yellow arrows in merged images. a.u. arbitrary units. Scale
bar¼ 10 μm. (c) Box plot of SEC61α1-eGFP donor lifetime in ns of at least seven independent measurements
for each of the various acceptor samples. Center lines of boxes represent the median with outer limits at the
25th and 75th percentile, respectively. Notches indicate the 95% confidence intervals; Tukey whiskers extend
to the 1.5� IQR and outliers are depicted as black dots. Red crosses mark sample means of each dataset.
Exemplary p-values (t-test) are indicated in graph
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dissolved, if not, shake vigorously until they are; slightly warm-
ing of the solution helps.

2. MM: 0.4 M Mannitol, 5 mM MES, pH 6.0 with KOH. Steril-
ize by filtration (0.22 μm) or autoclave.

3. K3 (for 100 mL): 10 mL macro stock, 0.1 mL micro stock,
0.1 mL vitamin stock, 0.5 mL EDTA stock, 1 mL Ca-
Phosphate stock, 10 mg myo-Inositol, 25 mg D(þ)-Xylose,
13.7 g Sucrose, pH 5.6 with KOH. Sterilize by filtration
(0.22 μm), prepare aliquots (15–40 mL) and store at �20 �C.

4. Macro stock (for 1 L): 1.5 g NaH2PO4·H2O, 9 g CaCl·2H2O,
25 g KNO3, 2.5 g NH4NO3, 1.34 g (NH4)2SO4, 2.5 g
MgSO4·7H2O, add H2O up to 1 L and autoclave.

5. Micro stock (for 100 mL): 75 mg KI, 300 mg H3BO3, 1 g
MnSO4·7H2O (or 0.6 g MnSO4·H2O), 200 mg
ZnSO4·7H2O, 25 mg Na2MoO4·2H2O, 2.5 mg
CuSO4·5H2O, 2.5 mg CoCl2·6H2O, add H2O up to
100 mL. Sterilize by filtration (0.22 μm) and store at �20 �C.

6. Vitamin stock (for 100 mL): 100 mg Nicotinic acid, 100 mg
Pyridoxine-HCl, 1 g Thiamine-HCl, add H2O up to 100 mL.
Sterilize by filtration (0.22 μm) and store at �20 �C.

7. EDTA stock (for 1 L): dissolve 7.46 g EDTA in 300 mL pre-
warmed H2O (approx. 30 �C), separately, dissolve 5.56 g Fe
(II)SO4·7H2O in 300 mL pre-warmed H2O (approx. 30 �C).
Combine and addH2O up to 1 L. Autoclave, aliquot, and store
in the dark at 4 �C. Protect from light.

8. Ca-Phosphate stock (for 200 mL): 1.26 g CaHPO4·2H2O,
add H2O up to 200 mL, pH 3 with 25% HCl. Autoclave and
keep in the dark at 4 �C. Protect from light.

3 Methods

3.1 Agrobacteria

Preparation

1. Select a single colony of transformed Agrobacteria which con-
tains the 2in1-vector plasmid or any other plasmid of choice.

2. Inoculate 5 mL LB medium containing the appropriate anti-
biotics (rifampicin 50 μg/mL, gentamicin 20 μg/mL, and the
plasmid specific antibiotic) with the Agrobacterium colony and
grow it overnight (28 �C, 200–230 rpm) (see Note 2).

3. Transfer 500 μL of the overnight culture into 4.5 mL of fresh
LB medium supplied with rifampicin, gentamycin, and specific
antibiotic and grow for another 3–4 h (28 �C, 200 rpm) to an
OD595 of approximately 0.2–0.8.

4. Determine the OD595.
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5. Centrifuge at 4000 � g for 15 min at 4 �C and wash the pellet
once or twice with 5 mL of 4 �C cold water.

6. Adjust to a final OD595 of 0.5 with 4 �C cold AS medium.
(Calculation: OD595/0.5 � 5 mL ¼ Volume (in mL) of AS
medium needed.)

7. Before proceeding with transient transformation of Nicotiana
benthamiana leaves, incubate samples at least 1 h on ice.

3.2 Transient

Transformation

of Nicotiana

benthamiana Leaves

1. Water 3–4-week-old (8th–10th leaf stage) Nicotiana
benthamiana plants 4–6 h prior to infiltration.

2. Start preparation of Agrobacteria as mentioned in Subheading
3.1.

3. Inject with a 1 mL syringe (without cannula) Agrobacterium
suspension into the abaxial side of the third to fifth youngest
leaves. For this purpose, position the syringe between leaf-veins
and support injection by gentle counter pressure with a finger
on the adaxial side (Fig. 2a–c).

4. After infiltration, cover and return plants to the growth
chamber.

5. After approximately 36–72 h post-infiltration, proceed to Sub-
heading 3.6.

3.3 Cell Culture

Maintenance

(Protoplasts)

The particular cell culture in this protocol (Arabidopsis thaliana,
Col-0, root derived) was generated and donated by Mathur and
Koncz [21].

1. Cell cultures are maintained in 250 mL Erlenmeyer flasks
under constant shaking (120 rpm) in the dark at
23.5 �C � 1 �C.

2. The cell culture is propagated by reinoculation every 7 days by
transferring 10 mL of a one-week-old (7-day-old) culture to a
fresh, sterile 250 mL Erlenmeyer flask with 50 mL MSCol
medium. The final, total volume is 60 mL.

3.4 Generation of

Protoplasts

1. Protoplasts should be generated from cells 3 days after sub-
cultivationwhen they are in their peak growth phase (seeNote3).

2. Aliquot 10 mL of cells into 12 mL Poly-Propylene (PP) round-
bottom tubes and collect them at 400 � g for 5 min (4–25 �C
okay).

3. Wash cells by resuspension with 10 mL “wall digestion solution
without enzymes” and spin down at 400 � g for 5 min
(4–25 �C okay).

4. Re-suspend pellet in 7 mL “wall digestion solution” and dis-
pense into a 90 mm diameter Petri dish.
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5. Incubate by shaking at 50 rpm for 6 h at 23.5 �C � 1 �C in the
dark.

6. Collect protoplasts from one Petri dish in a 12 mL PP tube.
Centrifuge at 100 � g for 5 min at 4 �C. Discard the
supernatant.

7. Wash protoplasts by resuspension in up to 10 mL “wall diges-
tion solution without enzymes” and spin down at 100 � g for
5 min at 4 �C. This is Wash #1.

8. Remove supernatant and dissolve pellet in remaining solution.
Add up to 10 mL with W5 solution slowly and mix slowly. This
is Wash #2. Spin down the cells at 100 � g for 5 min at 4 �C.

9. Re-suspend cells in 10 mLW5 solution as in step 8. This counts
as Wash #3. Take 20 μL (use cut 200 μL tips to handle proto-
plasts) to determine cell concentration with a hemocytometer.

10. Adjust the cells to 1.5 � 106 cells/mL. Leave cells in the
refrigerator (4 �C) for at least 20 min; overnight is also okay.

11. Determine the protoplast concentration you will use. Transfec-
tion will occur in ranges of 1.5 � 106 cells/mL up to
6.7 � 106 cells/mL. Our standard concentrations are
6.6 � 106 cells/mL and 3.5 � 106 cells/mL. Use higher cell
concentrations when working with multiple plasmid species
(�3) and the lower concentration for �2 plasmids. It is recom-
mended that you test this for each experimental condition.

12. Collect the protoplasts under 50 � g at room temperature
(RT).

13. Decant the supernatant (some W5 will remain, �500 μL) and
adjust to the determined cell concentration with MM and
incubate cells for 10–30 min (but not longer) at RT.

14. The cells are ready for transfection.

3.5 Protoplast

Transfection

This protocol was designed to transfect protoplasts in 96-well plate
format (2.2 mL, round-bottom, deep-well) using the “Liquida-
tor™ 96 Manual Pipetting System” (Mettler-Toledo) but it can
also be executed using 8- or 12-channel pipettes. It is recom-
mended to mix after each row as soon as you add PEG. A small
set of reactions can be performed in 2 mL round-bottom Eppen-
dorfs; mix as soon as you add PEG.

1. Prepare up to 16 μg of high-quality DNA in 20 μLH2O in each
reaction-well.

2. Add 60 μL of cell suspension to the DNA and mix the plate
from every side by tapping the plate against your forearm (Fig.
2d) until no cell clumps are visible. Make sure that the DNA is
evenly mixed in the total volume.
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3. Add 60 μL of PEG and start a timer to a 5min countdown.Mix
the plate from every side by tapping the plate against your
forearm until the PEG is evenly dispensed. This will take
approximately 1 min. You can see the solution mixing if you
hold the plates or tubes against the lighting in your laboratory
so that you see light diffraction through the liquid. After 3 min,
mix again.

4. Add 60 μL of MM solution and mix as before.

5. Add 500–700 μL of K3 medium, mix gently, and cover the
plate with a film that allows gas exchange (e.g., AeraSeal™ film,
SIGMA) (see Note 4).

6. Incubate the cells in the dark at 25 �C from 3 to 24 h depend-
ing on your assay (see Note 5).

3.6 Mounting for

Microscopy (Tobacco

Leaf Infiltration)

1. Cut a leaf section of approximately 1 cm2 and transfer it to a
20 mL syringe half filled with water. Use your finger to stop
water loss at the syringe’s exit, insert the plunger, and carefully
remove the remaining air in the syringe (Fig. 2e).

2. Close the tip of the syringe again and pull the plunger back.
This will produce a partial vacuum in the syringe.

3. Releasing the plunger gently will replace air space within the
leaf slice with water.

4. Repeat steps 3 and 4 several times until the tissue appears
translucent.

5. Take out the slice and mount it upside down on a slide. Drop a
bit of water on the slide and place a coverslip over the tissue.

6. Tap coverslips gently to remove air bubbles.

3.7 Mounting for

Microscopy

(Protoplasts)

Tightly wrap two stripes of tape around a microscope slide with a
gap of around 5 mm between them. These will serve as spacers. Put
approx. 50–100 μL of cell suspension between the stripes and place
a coverslip on top (see Note 6).

3.8 Confocal

Imaging

Our studies are done using the Leica TCS SP8 confocal microscope
with laser lines diode 405, pulsed 440, pulsed 470, Argon 488,
496, 514, DPSS 561, HeNe 594, and HeNe 633, respectively. The
microscope is equipped with a fast 8 kHz resonant scanner, HyD
detectors, and FLIM unit (PicoQuant). Leica Application Suite
(LAS) X software was used for image acquisition.

3.8.1 rBiFC 1. Set up the confocal microscope for YFP fluorescence with
514 nm excitation and 520–560 nm emission range and for
RFP fluorescence with 561 nm excitation and 570–630 nm
emission range. To avoid spectral overlap, sequential scanning
should be applied. Include a bright field channel for guidance
from transmission of either laser line.
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2. Use a 40�/0.75 NA water-immersion objective to focus on
epidermal cells. A zoom factor between 3 and 4 is
recommended.

3. Start with a positive control and collect several images while
adjusting gain and—if necessary—offset, for an optimal
dynamic range. Settings should be adjusted to yield a mean
fluorescence intensity ratio between YFP and RFP of one (see
Note 7). Once the parameters are adjusted, select and save for
quantification of 20–40 images of randomly selected areas (see
Note 8).

3.8.2 Image Analysis For image analysis, we use the ImageJ software (freely available at
http://imagej.net/Downloads) with the Bio-Formats plugin
which must be installed separately before using it for the first time.

1. Open the *.lif file with the ImageJ software. Using the Bio-
Format tool the first time, choose “view stack with: Hyper-
stack” and set a mark in the “split channels” box. Select all
series.

2. Close brightfield images.

3. Select the first RFP image and press button M, or STRG-M
(measure). A table with different values (Area, Mean, Min,
Max) will appear.

4. Select the corresponding YFP image and measure again.

5. Proceed for all images as described in steps 2–4. Afterwards
you can copy the data table into Microsoft Excel.

6. Calculate the ratio between the mean fluorescence intensity
values of YFP and RFP for each image and use for graphical
display after/including statistical analysis.

3.8.3 FRET-AB 1. Set up the confocal microscope for eGFP fluorescence with
488 nm excitation and 490–530 nm emission range, and for
mCherry fluorescence with 561 nm excitation and
565–610 nm emission range. To avoid spectral overlap,
sequential scanning should be applied. Include a bright field
channel for guidance from transmission of either laser line.

2. Use a 40�/0.75 NA water-immersion objective.

3. Adjust gain and offset settings for your sample exploiting the
full dynamic range.

4. Switch to the FRET-ABmode from the dropdown menu in the
LAS X software and adjust donor and acceptor settings as
before. Set acceptor-excitation-laser intensity in the “bleach”
tab to 100% and frames between 300 and 500.

5. Search an area where both proteins of interest are sufficiently
expressed, set up an ROI, and start the bleaching procedure.
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LAS X software automatically captures images before and after
bleaching and calculates the FRET efficiency (see Note 9)
according to the following formula:

FRETeff ¼ Dpost �Dpre

� �
= Dpost

� �

with Dpre and Dpost as mean fluorescence intensities prior and
after bleach, respectively.

3.8.4 Image Analysis Note the values provided by the LAS X software under the “Quan-
tification” tab for further statistical evaluation and graphical display.

3.8.5 FLIM For FLIM applications, LAS X software and SymPhoTime 64 (from
PicoQuant) software are used.

1. Switch the microscope to FLIM-mode. Start SymPhoTime,
and create a new workspace.

2. Start lasers, and set the laser combining unit to 0.

3. Click on the tab “Setup Imaging” in the Leica software, and
choose your appropriate laser and detectors.

4. Go to the tab “Setup FLIM”, and choose the detector that is
connected to the time-correlated single photon counting
(TCSPC) module. Choose the wavelength to excite the donor.

5. Under “Acquisition” set resolution to 256 � 256, and scan-
ning speed to 20–50 MHz while adjusting pixel dwell time to
approximately 20 μs.

6. Set up the pulsed laser.

7. Choose the number of photons per pixel that should be
counted. We recommend 500–1000. Pick a region of interest
(ROI), and run a FLIM test. The kilo counts/s should not
exceed 10% of the excitation frequency (e.g., 2 kilo counts/
s for 20 MHz). If necessary, close the shutter of the laser
combining unit to get less counts/s.

8. Run FLIM measurements at 7–10 different positions/cells/
protoplasts. Zoom in and define ROIs for measurement. We
recommend performing at least three independent biological
replicates for FLIM measurements.

9. Measure donor-only samples, as well as a meaningful noninter-
acting candidate as negative controls.

3.8.6 Measure

Instrument Response

Function (IRF)

Since the microscope, objective, coverslip, and the pulse type of the
laser do have an influence on the detection, the IRF must be
measured for later evaluation.

1. Put only a coverslip on the objective without sample.

2. Set the mode from xyz to xzy, the laser to 5%, and the required
wavelength of the donor (e.g., for GFP: 488 nm). Choose one
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PMT detector for emission at the same wavelength as the
excitation (e.g., GFP: 488 nm).

3. Set the donor fluorescence to reflexion in the tab “AOBS.”

4. Set up FLIM as before in Subheading 3.8.5 but use the PMT to
detect exactly at the same wavelength as the pulsed laser.

5. Search the upper edge of the coverslip (Fig. 5a).

6. In the tab “fluorifier disc setting,” deselect the autoselect and
choose an empty position for the filters.

7. Close the laser combining unit.

8. Run a FLIM test with kilo counts per second at approximately
2000.

9. Measure IRF once and save it.

3.8.7 Evaluation 1. Open SymPhoTime and load your data. Choose one “.ptu”
file, click Analysis ! Imaging ! FLIM ! Start.

Fig. 5 Comparison between the edge of (a) the upper coverslip which is needed for measuring the IRF and (b)
the edge of the microscope slide which should not be measured. (c) Section of SymPhoTime 64 software for
evaluation of FRET-FLIM data. (1) The “Fitting Model” should be “n-Exponential Reconvolution” while the (2)
“Decay” should be “Overall Decay.” (3) The experimentally measured IRF (Subheading 3.8.6) has to be
imported here (4). “Model Parameters � n” have to be set up according to the decay variant of the donor.
Calculation is started with (5) “Initial Fit” and (6) Fit (7). If χ2 is in the range of approximately 1–2, the
fluorescence lifetime τ in [8] can be copied for further evaluation
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2. Set up “n-Exponential Reconvolution,” overall decay and load
your measured IRF sample in the designated tab. Choose the
“Model Parameter – n” according to the decay variant of your
donorfluorophore (e.g.,mono-orbi-exponentialdecay) (Fig.5).

3. We recommend decreasing the front border-width (e.g.,
0.55 ns).

4. Press “Initial FIT” and afterwards “FIT.” The χ2 should be
approximately between 1 and 2. Higher values indicate that the
measured decay does not correlate to the calculated ideal decay
(Fig. 5).

5. Lifetime values for further statistical evaluations are: “τ av. int
(ns)” (Fig. 5).

6. Note these values in a .txt file or excel and use them for
statistical evaluation and graphical display.

4 Notes

1. For structure-function analysis using alanine-scanning muta-
genesis, we routinely design primers using our SDM-assist
program that allows—in addition to the desired mutation—
introduction of a silent restriction site to distinguish different
point mutants via endonuclease digest [22].

2. We recommend construct verification of Agrobacteria clones
used for transfection through plasmid rescued in E. coli fol-
lowed by restriction analysis [20]. Even antibiotic resistant
Agrobacteria colonies sometimes do not carry the recombinant
plasmid, and we had cases, where plasmid restriction digests
revealed significant alterations in plasmids. Verified Agrobac-
teria clones should be stored at �80 �C in 7% DMSO.

3. To gain more Arabidopsis protoplasts, it is possible to subcul-
ture 10 mL of a 3-day-old culture into 50 mL fresh MSCol
medium. Cells for protoplast generation are taken 3 days after
this second subculture. These cells are nicknamed “Turbo
Cells” and produce finer and smaller protoplasts. You must
not use these Turbo Cells for your main culture though, oth-
erwise, the culture will outgrow itself too fast.

4. It is not necessary to wash out the PEG (1500) as its effective
concentration is diluted in subsequent steps; alternatively, addi-
tion of a washing step with MM or W5 can be included.

5. Reporter assays benefit from shorter incubation times as they
have better signal-to-noise ratios when applying treatments,
whereas an overnight incubation is sufficient for localization
or interaction assays.
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6. Living cells will float on the top of the solution when they are in
K3. Alternative incubation buffers found in the literature can
also be used: for example, WI or TEX.

7. The ratio needs to be set up for a positive control and should be
examined on several different epidermal cells. A ratio of 1 is
preferred but not always feasible due to overall low expression.
It is important that once the parameters are adjusted, there will
be no change in settings over the complete set of samples to
assure comparability.

8. Even though RFP acts as an expression and transformation/
transfection control, verification of protein expression via
immunoblot is recommended. The 2in1 plasmid used contains
a 3xHA tag as well as a MYC tag fused to the proteins of
interest for antibody detection (Fig. 3f).

9. Due to temporal delay in recording caused by the bleaching
step, cellular movement leads to a shift of the region of interest
out of the focal plane making measurements meaningless. To
avoid this issue, we fixed samples in 4% (w/v) paraformalde-
hyde (PFA) in microtubule stabilization buffer (MTSB)
(50 mM PIPES, 5 mM EGTA, 5 mM MgSO4·7H2O, pH ~7
(KOH)).
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Chapter 12

Metabolons on the Plant ER

Verena Kriechbaumer and Stanley W. Botchway

Abstract

Metabolons are protein complexes that contain all the enzymes necessary for a metabolic pathway but also
scaffolding proteins. Such a structure allows efficient channeling of intermediate metabolites from one
active site to the next and is highly advantageous for labile or toxic intermediates. Here we describe two
methods currently used to identify metabolons via protein–protein interaction methodology: immunopre-
cipitations using GFP-Trap®_A beads to find novel interaction partners and potential metabolon compo-
nents and FRET-FLIM to test for and quantify protein–protein interactions in planta.

Key words Endoplasmic reticulum, Metabolon, Enzymes, Protein complex, Protein–protein interac-
tion, Co-immunoprecipitation, GFP-trap, FRET-FLIM

1 Introduction

The plant ER has been shown to be dynamic and constantly remo-
deling [1]. Specific ER microdomains with unique lipid composi-
tion are suggested to direct proper anchoring of proteins and to
facilitate and stabilize the subsequent assembly of components
required to form a specific protein complex capable of carrying
out a complete metabolic pathway [2]. These so-called metabolons
enable metabolic processes to take place in the necessary highly
coordinated and regulated processes in an efficient manner. Meta-
bolons contain sequential enzymes plus scaffolding proteins allow-
ing for efficient channeling of metabolic intermediates from one
active site directly to the next [2]. The concept of these so-called
metabolons was introduced in 1985 by Paul Srere in the context of
glycolytic and Krebs cycle enzymes [3]. Sequential enzymes of a
specialized biosynthetic pathway are transiently linked together by
noncovalent binding typically stabilized by membrane or cytoskel-
etal anchoring [4]. Such a mechanism increases substrate concen-
tration and turnover rates, prevents unwanted diffusion and
metabolic interference, and is beneficial for containment of labile
or toxic intermediates. Such complex organization has been shown
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for protein translocases in the endoplasmic reticulum, in chloro-
plasts and mitochondria [5–7] allowing coordinated and efficient
transport potentially also preventing back-flux.

Metabolons will typically be comprised of sequential enzymes
in the pathway together with scaffolding proteins allowing for
efficient channeling of metabolic intermediates from one active
site to the next [2]. Candidate proteins for such scaffolding are
chaperones as well as membrane-anchored cytochrome P450
enzymes that can serve as nucleation points and platforms for
metabolon formation [2]. In addition to this TA proteins were
shown to have the potential to localize metabolons to specific
organelle surfaces, for example in the TOM complex where the
tail-anchors operate as assembly signal [8]. This can also stabilize
proteins compared to their cytosolic versions as shown for tobacco
expression of the HIV gene product Nef which has been researched
in the context of HIV vaccination [9].

Also membrane-structural proteins have been suggested to play
a role in metabolon formation, e.g., P450 enzymes involved in a
lignin biosynthetic metabolon were co-purified with reticulon pro-
teins (RTN) [10] which contribute to ER tubule shaping [11].

In plants, metabolons have been shown for several enzymatic
pathways in secondary and primary metabolism [12]. Most meta-
bolons involved in secondary metabolism involve less stable inter-
actions than described for metabolons in primary metabolism
demanding refined microscopy methods and computational analy-
sis to prove their interactions [13].

Metabolons have been shown, e.g., for the production of
flavonoids [14] and sporopollenin [15] in arabidopsis and the
glucoside dhurrin [16] in sorghum. Recently a soybean isoflavo-
noid metabolon tethered to the ER has been reported [17]. An ER-
localized metabolon for the biosynthesis of the auxin indole-3-
acetic acid (IAA) has been suggested [18].

The metabolon complexes producing phenylpropanoids [19]
and flavonoids [14, 20] seem to cater for specific metabolites made
from shared intermediate products. The enzyme composition in
the flavonoid pathway complex can change, resulting in varying end
products [12, 14]. Membrane-anchored cytochrome P450
enzymes are reported to serve as nucleation points and platforms
for the metabolon formation. Most P450 monooxygenases are
membrane-bound to the ER via an N-terminal tether, enhancing
metabolon formation on this membrane system [2, 21].

Metabolons for the glucoside dhurrin in sorghum are formed
in specific ER domains [22] and metabolon formation between
the three enzymes involved in dhurrin biosynthesis is suggested
to be highly advantageous as the dhurrin precursor p-
hydroxymandelonitrile is very unstable. Another ER-localized
metabolon is the biosynthesis of sporopollenin in tapetal cells.
Colocalization and protein–protein interaction of these enzymes
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indicate the existence of a sporopollenin metabolon on the ER
[15]. This benefits a coordinated and quick production of pollen
cell wall components allowing for rapid pollen development.

Molecular distances (1–10 nm) can be measured using energy
transfer processes. Förster or fluorescence resonance energy trans-
fer (FRET), first described by Theodor Förster over 50 years ago
[23], relies on the non-radiative energy transfer from an excited
fluorescent donor molecule to a different non-excited fluorescent
acceptor molecule in its vicinity. The very short distances required
for this process to occur (<10 nm) means the twomolecules, in this
case two proteins, needs to be physically close to one another. For
FRET to occur, the donor emission spectrum must overlap suffi-
ciently with the acceptor absorption spectrum; the donor and
acceptor dipoles display a mutual molecular orientation. The rate
of the energy transfer kT is described and calculated using Eq. 1:

kT ¼ 1

τD

� �
R0

R

� �6

ð1Þ
where τD is the donor excited-state lifetime in the absence of the
acceptor, R is the distance between D and A, and R0 is the Förster
radius. At the Förster radius, 50% of the donor molecules will emit
fluorescence while the rest will undergo energy transfer. Since the
energy transfer process is strongly distance dependent with 1/R6,
FRET can be used to measure distance and examine molecular
interactions on an nm spatial scale. During FRET, the rate of decay
is reduced by a quenching process that depletes the excited state of
the donor fluorophore, i.e., the donor fluorescence lifetime is short-
ened. Bymeasuring changes in the excited-state lifetime of the donor
at each pixel making up an image, steady-state FRET is enhanced.
This is described as fluorescence lifetime imaging microscopy or
FRET-FLIM. Generally the two proteins under investigation are
tagged with GFP and its variants. We have used GFP and RFP as
the donor and acceptor respectively in our work. We describe here
two methods that have been used in metabolon work: Immunopre-
cipitations using GFP-Trap®_A beads to find novel interaction part-
ners and potential metabolon components and FRET-FLIM to test
for and quantify protein–protein interactions in planta.

2 Materials

2.1 Buffers and

Media for

Immunoprecipitations

1. Murashige and Skoog (MS) medium: 4.4 g/L Murashige and
Skoog basal salts, pH 5.7, 10 g/L agar.

2. Lysis buffer: 10 mM Tris–HCl pH 7.5, 150 mM NaCl,
0.5 mM EDTA, 0.5% NP-40, 1 mM PMSF, protease inhibitor
according to manufacturers’ instructions.

3. Equilibration buffer: 10 mMTris–HCl pH 7.5, 150mMNaCl,
0.5 mM EDTA.
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2.2 Buffers and

Media for FRET-FLIM

For plant infiltration and expression in tobacco, see protocols in
chapter “Labeling the ER for light and fluorescence microscopy.”

2.3 Equipment for

Immunoprecipitations

1. Petri dishes (large, with lid L � W � H: 245 mm � 245 mm
� 25 mm).

2. 50-ml Falcon tubes.

3. Glass bottles for buffers.

4. Cheese cloth.

5. Refrigerated table centrifuge.

2.4 Equipment for

FRET-FLIM

1. At least two-channel confocal and one-channel FLIM setup.

2. Becker and Hickl SPC 830 or SPC150 time-correlated single-
photon counting card.

3. SPCImage analysis software version 5.1 (Becker and Hickl).

3 Methods

3.1 Immuno-

precipitation Using

GFP-Trap®_A Beads

(This part of the procedure will take between 4 and 5 h depending
on sample size.) This protocol uses GFP-Trap®_A beads (Chromo-
tek, Martinsried, Germany) and the procedure is carried according
to the company’s protocol with slight modifications (see Note 1):

Arabidopsis thaliana seedlings expressing the protein of interest
fused to a fluorescent tag (see Protocol “Labeling the ER for light
and fluorescence microscopy” for preparation of stable arabidopsis
transformants) are grown for 2 weeks on MS plates (see Note 2).

1. Approximately 5 g of whole seedling plant material are ground
first in liquid nitrogen to a fine powder and then in 5-ml lysis
buffer until liquid. The extract is then distributed into three 2-
ml Eppendorf tubes.

2. The extracts are incubated on ice for 30 min and then centri-
fuged at 10,000 � g for 10 min at 4�C.

3. The supernatant (about 4 ml) is poured into fresh 50-ml Fal-
con tubes via two layers of cheese cloth.

4. 100 μl of GFP-Trap®_A beads per sample are equilibrated in
500 μl equilibration buffer and centrifuged at 2500 � g for
2 min. The supernatant is being discarded and this wash is
repeated twice.

5. 100 μl of the washed beads are added to the plant extract and
the mixture is shaken on ice for 2 h with the tubes being placed
horizontally in the ice.

6. After this, tubes are centrifuged at 2500 � g for 2 min at 4�C
and the supernatant is being carefully discarded without dis-
turbing the agarose pellet.
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7. The resulting agarose pellet is then washed twice with dilution
buffer.

8. This pellet can be used straight away for tryptic peptide digest
and mass spectrometry analysis for containing proteins [24].

3.2 Real-Time

Imaging of Metabolon

Protein–Protein

Interactions Using

Two-Photon

FRET-FLIM

Potential interaction candidates resulting from the immunoprecip-
itation are tested for interactions in planta with the bait protein.
This procedure is done using agrobacterium-mediated transient
expression in tobacco leaf epidermal cells (see Protocol “Labeling
the ER for light and fluorescence microscopy” for transient expres-
sion in tobacco).

1. Epidermal samples of infiltrated tobacco leaves are excised, and
both confocal and multiphoton FRET-FLIM data capture is
performed by a two-photon microscope [25] (see Note 3).

2. The two-photon microscope built around a Nikon TE2000-U
inverted microscope is used with a modified Nikon EC2 con-
focal scanning system to allow for near-infrared laser wave-
length for FLIM [26].

3. Laser light at a wavelength of 920 nm is produced by a mode-
locked titanium sapphire laser (Mira; Coherent Lasers), with
200-fs pulses at 76 MHz, pumped by a solid-state continuous
wave 532-nm laser (Verdi V18; Coherent Laser).

4. The laser beam is focused to a diffraction limited spot using a
water-immersion objective (Nikon VC; 360, numerical aper-
ture of 1.2) to illuminate specimens on the microscope stage.

5. Fluorescence emission is collected without descanning (no
pinhole), bypassing the scanning system, and passed through
a BG39 (Comar) filter to block the near-infrared laser light.
Line, frame, and pixel clock signals are generated and synchro-
nized with an external detector in the form of a fast micro-
channel plate photomultiplier tube (Hamamatsu R3809U).

6. Linking these via a time-correlated single-photon counting PC
module SPC830 (Becker and Hickl) generated the raw FLIM
data. Prior to FLIM data collection, the GFP and mRFP
expression levels in the plant samples within the region of
interest are confirmed using a Nikon EC2 confocal microscope
with excitation at 488 and 543 nm, respectively.

7. A 633-nm interference filter is used to significantly minimize
the contaminating effect of chlorophyll autofluorescence emis-
sion that would otherwise obscure the mRFP as well as GFP
emission.

8. Data are analyzed by obtaining excited-state lifetime values first
on a pixel by pixel basis then of a region of interest on the
nucleus, and calculations are made using SPCImage analysis
software version 5.1.
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9. The distribution of lifetime values within the region of interest
is generated and displayed as a curve. Only values with a
χ2 between 0.9 and 1.4 are taken.

10. The median lifetime, minimum and maximum values for one-
quarter of the median lifetime values from the curve are taken
to generate the range of lifetimes per sample.

11. The ER associated with at least three nuclei from a minimum of
three independent biological samples per protein–protein com-
bination are analyzed, and the average of the ranges is taken.

Fig. 1 FRET-FLIM analysis of TAR2 without an interaction partner (a–e) or with YUC8 (f–j). (a, f) Raw FRET-
FLIM data; (b, g) pseudocolored lifetime maps showing the lifetime values for each point within the region of
interest; (c, h) distribution of lifetimes across the image. Blue shades represent longer GFP fluorescence
lifetimes than green ones. (d, i) Representative decay curves of a single point with an optimal single
exponential fit, where χ2 values from 0.9 to 1.2 were considered an excellent fit to the data points (a binning
factor of 2 was applied). The confocal images for the analysis in (e, j) show the GFP construct in green and the
mCherry construct in red. This example of FRET-FLIM analysis shows TAR2-GFP alone as a negative control
and YUC8 for protein–protein interaction. The fluorescence lifetime values for TAR2-GFP + YUC8-mCherry are
2.8 � 0.02 ns and therefore statistically lower than the lifetime values for the TAR2-GFP fusion alone
(3.04 � 0.03 ns)
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12. The degree or efficiency of energy transfer (E), from one
protein to the other, may be determined using Eq. 2:

E% ¼ 1� τDA

τD

� �� �
� 100 ð2Þ

where τD and τDA are the measured excited-state lifetime of the
donor and acceptor, respectively.

Example data is shown in Fig. 1.

4 Notes

1. Gloves have to be worn for the whole procedure to reduce
contamination.

2. This protocol can also be carried out with tobacco transiently
expressing the protein of interest but will result in reduced yield
of interacting proteins and will of course only show interactors
in tobacco.

3. Best measurement results for the ER have been shown for the
nuclear envelope and associated ER. Latrunculin B can be
applied to the leaf disks to depolymerize the actin cytoskeleton
and therefore inhibit any movement of the ER. This may not be
necessary with high expression levels of the donor protein
which result in shorter time for data capture and therefore
movement is less critical.
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Chapter 13

Using Optical Tweezers Combined with Total Internal
Reflection Microscopy to Study Interactions Between
the ER and Golgi in Plant Cells

Imogen Sparkes, Rhiannon R. White, Benjamin Coles,
Stanley W. Botchway, and Andy Ward

Abstract

Optical tweezers have been used to trap and micromanipulate several biological specimens ranging from
DNA, macromolecules, organelles to single celled organisms. Using a combination of the refraction and
scattering of laser light from a focused laser beam, refractile objects are physically captured and can be
moved within the surrounding media. The technique is routinely used to determine biophysical properties
such as the forces exerted by motor proteins. Here, we describe how optical tweezers combined with total
internal reflection fluorescence (TIRF) microscopy can be used to assess physical interactions between
organelles, more specifically the ER and Golgi bodies in plant cells.

Key words Optical trap, ER, Golgi, Tweezers, GFP

1 Introduction

Trapping and micromanipulation for biological samples using opti-
cal tweezers has a wide range of applications from DNA, macro-
molecules, organelles to single celled organisms (reviewed in [1]).
The basic premise of optical traps is that only microscopic particles
that display a significantly different refractive index to the sur-
rounding medium will be trapped in the focused infrared laser
beam (Fig. 1). Infrared laser beams are routinely used as they
generally result in the lowest sample absorbance and therefore
cause the least photon damage. Optical traps can either be fixed
in position, and therefore require lateral stage movement to move
the sample relative to the trapped object, or the system can use
mirrors, acousto-optic deflectors, or spatial light modulation to
move the position of the trap and therefore the object [2]. Here,
we present our system which utilizes a single beam gradient trap
that is fixed in position combined with TIRF microscopy. Readers

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_13, © Springer Science+Business Media LLC 2018
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are directed to Ketelaar et al. [3] for discussion of integrating
optical traps with confocal microscope systems.

Optical trapping has been used to probe several aspects of
subcellular architecture in plant cells (reviewed in [3]). For exam-
ple, the effects of nuclear positioning on root hair growth [4],
interactions between several organelle pairings including
peroxisome-chloroplasts [5], ER-Golgi [6] and ER-chloroplasts
[7], and cytoskeletal organization [8]. We have used optical twee-
zers to characterize interactions between several organelles in plants
(ER-Golgi and peroxisome-chloroplast), where the measurement
of such interactions is only possible if one of the organelles is
preferentially trapped. The efficiency with which organelles are
trapped is related to a number of factors including refractive
index, size, shape, and laser wavelength. For example, unlike the
endoplasmic reticulum (ER), Golgi bodies in leaf epidermal cells
are amenable to being trapped and moved within the confines of
the cell. Since the ER and Golgi are functionally linked through the
secretory pathway, this raised the question as to whether they were
also physically linked. Using optical tweezers, we were able to show
that lateral movement of trapped Golgi bodies resulted in the
remodeling of the ER indicative of a physical association between
the two organelles [6]. These studies provided a qualitative analysis
of the interaction between the two structures. Here, we provide an
overview of our current optical trapping platform which enables the
user to quantify interactions between organelles. We have used this

Fig. 1 Mechanism of action of a gradient optical trap. (A) Scattering and gradient forces are balanced in a
tightly focused laser beam using a high numerical aperture objective lens to form a stable three-dimensional
trap. (B) Gradient restoring forces (Fa, Fb) result from the refraction of the laser beam as it passes through the
trapped object, with rays of light (a and b) depicting the paths taken by the edges of the beam
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system successfully to characterize the physical interaction between
peroxisomes and chloroplasts, which are functionally linked
through the photorespiratory pathway [5]. We will discuss impor-
tant considerations relating to system calibration, sample genera-
tion, developing a quantifiable platform for measuring interactions
and post-acquisition analysis. We also include caveats to force mea-
surement calculations in plant cells. Of course, variations will apply
subject to the optical trap system available to the user, but the
general premise and pitfalls herein are universal.

2 Materials

2.1 System Setup

and LabVIEW Interface

An optical trap with a two-channel TIRF microscope (TIRF-M) was
constructed around a Nikon Ti-U inverted microscope. The near
infrared (NIR) trapping laser at 1090 nm was delivered to the
trapping objective (100�, oil immersion, NA 1.49 with both tem-
perature and cover glass correction ring) using a commercial Elliot
Scientific optical trapping platform. Fluorescence excitation for the
TIRF-M imaging was obtained from an Omicron laser hub fiber
coupled to a manual Nikon TIRF-M unit. For GFP and RFP chro-
mophores fused to the proteins of interest, 488 and 561 nm were
used, respectively. Fluorescence emissions were detected using two
electronmultiplying charge-coupled device (EMCCD, iXon, Andor)
cameras. These are connected via a twin-cam (Cairn) unit (Fig. 2).
This allowed the flexibility of full field of view per imaging channel as
well as the ability to further magnify the image without restricting
the observation area. A single camera may be used for a dual channel
imaging (requiring technologies such as the Cairn OptoSplit II).
This leads to restricted field of view but has the advantage of reduced
cost and no need for synchronization of two separate cameras.

2.2 Microscopy

Consumables

1. Standard glass slides (76 mm � 26 mm, 1 mm thick) to fit the
stage.

2. Borosilicate No. 1 coverslips (see Note 1).

3. Electrical tape.

4. Polystyrene beads (1 μm diameter) are commercially available.

3 Methods

Carry out all procedures at room temperature unless otherwise stated.

3.1 Calibrating the

Optical Trap Against

Known Standards

The trap position, optical trapping force, and laser power transmis-
sion at the microscope objective are measured daily and compared
for consistency to ensure the laser trapping setup is performing to
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specification. You are referred to Note 2 for a critical evaluation of
objective lenses for tweezers and TIRF microscopy.

3.2 Nominal Laser

Power Transmission

at the Sample

Using a power meter set to the wavelength of the trapping laser
(1090 nm), a range of power readings of the optical trap laser
transmission (0–130 mW) at the objective are measured on a daily
basis. Large fluctuations of these readings (i.e., >5% change)
between daily experimental runs could be indicative of changes in
laser performance and stability or changes in laser alignment affect-
ing the percentage transmission at the objective.

3.3 Trap Position

and Force

Trap position is determined by trapping a 1 μm diameter polysty-
rene bead dispersed in water and imaging the position under bright
field illumination or directly observing a significantly attenuated
laser using the EMCCDs with the infrared filter removed.

To assess the trap strength, the escape force of spherical poly-
styrene beads is calculated. This is a relationship between the power
of the optical trap that is required to maintain beads in the trap at a
given stage speed, and is carried out as follows:

Fig. 2 Schematic of the microscope and optical trap system setup. The infrared trapping laser and visible-
wavelength imaging lasers are fiber-coupled to independent microscope ports. The TIRF angle is tuned by
adjusting the position of the fiber aperture in relation to the collimating lens using a micrometer. A computer-
controlled mechanical shutter is placed in the trapping laser beam path which provides fast shuttering of the
optical trap. The sample is mounted on a computer-controlled variable speed (M€arzh€auser) stepper motor
stage. The fluorescence is imaged through a (Nikon)�100 1.49 NA objective and�2.5 magnification adapter
on two (Andor) EMCCD cameras, filtered for GFP and RFP fluorescent dyes, respectively. The associated
computer-controlled hardware is interfaced using National Instruments LabVIEW which provides full automa-
tion for each trapping routine
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1. Place a drop of polystyrene beads on a coverslip and leave to
settle for ~30 min.

2. Trap a polystyrene bead at the upper end of the optical trap
power spectrum (see Note 3).

3. Move the stage back and forthwith a preset velocity of 100 μm/s.

4. Repeat step 3 after decreasing the power incrementally.

5. Note down the trap laser power at which the bead escapes the
trap at 100 μm/s stage oscillation.

6. Repeat steps 2–5 using 200, 300, 400, and 500 μm/s stage
speeds.

7. Using the equation for Stokes viscous drag, calculate the escape
force at which the bead escapes the trap (i.e., is no longer
trapped) for each of the five different stage speeds.

F drag ¼ 6πμrv

where Fdrag is the viscous drag force acting on the bead, μ is the
fluid viscosity (water, 0.00089 Pa s), r is the object radius
(bead), and υ is the velocity measured.

8. Plot laser power against escape force for each stage speed (i.e.,
calculate the Fdrag for the given velocity at which the bead
escapes the trap). For beads, the relationship is linear as there
are no constraints on moving the bead other than viscosity
(Fig. 3).

Comparison between escape force profiles between different
experimental runs enables the user to determine whether the trap
“strength” has altered, i.e., is it “easier” or “harder” to maintain
beads in the trap at a given stage speed. Similar bead trapping

Fig. 3 Calculation of the optical trap escape force of a 1 μm polystyrene bead.
Example plot of laser power (mW) against bead escape force (pN) for a range of
indicated stage speeds (100–500 μm/s). Data displayed was collected on 4
consecutive days
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profiles ensures that the system is behaving in a consistent manner
and therefore allows results from biological samples to be directly
compared.

3.4 Sample

Preparation

To be able to specifically trap Golgi bodies, fluorophores need to be
introduced which are specifically targeted to, and highlight the
Golgi. Similarly, fluorophores for ER, or other organelles are
required if monitoring the effects of interaction between two orga-
nelles. Genetically encoded fusions to targeting sequences, or func-
tional proteins can be introduced into the plant material through
agrobacterium-mediated transformation. Integration and expres-
sion can either be stable or transient. Readers are referred to stan-
dard protocols for these transformation procedures [9, 10]. Note, a
bank of fluorescent organelle markers generated by the Nebenf€uhr
lab [11] are available either as plasmids or stable transgenic Arabi-
dopsis lines through public repositories (ABRC or NASC).

Plant leaf material expressing the relevant fluorescent markers
to be subjected to optical trapping is prepared in the following
manner:

1. Pieces of tissue (~5 mm2) are cut from the plant leaves and
immersed in latrunculin b (25 μM for 1 h) to depolymerize
actin and prevent organelle movement (see below).

2. The leaf samples are carefully mounted on the microscope slide
and a No. 1 coverslip secured over the top using thin strips of
electrical tape at either end of the slide.

3. Slides are mounted coverslip down onto the microscope stage
and secured with spring clips. We are aiming to minimize the
working distance between the coverslip and leaf to enable
efficient trapping and uniform TIRF illumination. If the sam-
ples are incorrectly mounted, then trapping efficiency and
imaging can be compromised.

4. To this end, a metal plate with a hole to allow imaging of the
sample is placed under the slide and the spring clips of the slide
holder placed over the top. The metal plate allows equal pres-
sure to be applied evenly over the slide to help minimize the
distance between sample and coverslip (i.e., plane of optimal
trap force). Note, the level of pressure does not affect cell
viability as evidenced through cytoplasmic streaming in samples
which have not been treated with latrunculin b.

5. Regions of the sample are imaged ensuring the level of excita-
tion lasers for the fluorophores is minimal so as to reduce any
effects from fluorophore bleaching.

We have been able to trap Golgi bodies in both Arabidopsis
thaliana [6] and Nicotiana tabacum leaf epidermal cells (Figs. 4
and 5). Both ER and Golgi are highly motile and so to be able to
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carefully dissect interaction the movement of both organelles needs
to be inhibited [6]. Any subsequent motion is therefore due to the
trapping and micromanipulation of the trapped object. Figure 4
highlights trapping of Golgi in a motile system. Comparisons
between image frames highlight dynamic rearrangement of the
ER making it difficult to observe the resulting changes in the ER
as a result of trapping and moving a Golgi body which is physically
associated with the ER. Figure 5 clearly shows trapping and move-
ment of Golgi which are not attached to the ER.

3.5 Developing an

Automated Trapping

Routine

Qualitative analysis of interaction between ER and Golgi can be
carried out by trapping and manually moving the Golgi and observ-
ing the effects on the ER [6]. To quantify interactions, the relation-
ship between trap strength and organelle trapping efficiency and
behavior is required (see Note 3).

1. Prior to data acquisition, a live image is displayed on the
computer monitor and a potential organelle of interest is

Fig. 4 Optical trapping and movement of an ER-associated Golgi body in tobacco leaf epidermal cells.
Micrographs showing sequential frames of a movie of a Golgi (d–f) that is trapped under the force of the
optical trap as the microscope stage is moved a distance of 6 μm at 6 μm/s. This movement is referred to as
the stage translation. Panels (a)–(c) show the same frames of the trapped Golgi (cyan) in relation to the
position of the surrounding ER (magenta). The ER is observed to be attached to and to move with (behind) the
trapped Golgi. The yellow arrow indicates the position of the trapped Golgi and the white arrow indicates the
direction of movement of the ER behind the trapped Golgi body. Scale bar, 3 μm
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located manually using a joystick and aligned with the optical
trapping position.

2. The organelle then undergoes a recorded trapping routine such
as that highlighted in Fig. 5. Here, the trap is turned on, stage
moved laterally at a fixed speed over a fixed distance (referred to
as stage translation), trap turned off, and the movement of the
organelle post trapping monitored.

Fig. 5 Automated trapping routine applied to a Golgi body in tobacco leaf epidermal cells. Schematic
representation of the position of the optical trap as considered radially from the starting point of the trapping
routine (a). The TIRF image is recorded from 0 s, the trap is turned on after 1 s, the stage movement
(translation) of 6 μm at 6 μm/s begins at 5 s and ends at 6 s, the trap is turned off after 7 s, and the image
recording ends at 10 s. Images taken from a representative movie where the trapping routine (a) was used to
trap a Golgi (cyan) and record the event in relation to the surrounding ER (magenta) are depicted; the moment
the trap is turned on (c), the midpoint of the translation (d), and the end of the translation before the trap is
turned off (e). The yellow arrow indicates the position of the trapped Golgi and the white arrow indicates the
direction of movement of the stage. In this case, the Golgi is not attached to the ER and as it is moved the ER
does not follow (d). Merged frames of the Golgi signal that correspond to 5.4–6.0 s of the routine are provided
(b). The trapped Golgi (yellow arrow) does not change position relative to the field of view as the stage moves
relative to the trapped object. Merged image therefore shows the trapped organelle as a single point (yellow
arrow), whereas an organelle which was not trapped appears to be moving in the merged composite (white
arrow) as its position changes relative to the field of view as the stage moves. Scale bar, 3 μm
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3. Organelles are scored as either being stably trapped (i.e.,
remaining in the trap during stage translation), or escaping
the trap during the stage translation, or are not trapped during
the procedure.

4. Distribution of trapping outcomes among these three cate-
gories can serve to determine the relative differences in
trapping efficiency between different conditions, and can be
compared when optical trapping power is changed [5]; teth-
ered organelles will tend to require greater force to trap and
move them a fixed distance than organelles which are not
tethered. This procedure was followed for characterizing inter-
actions between peroxisomes and chloroplasts [5].

5. The major considerations are the laser power used to trap the
organelle, and the distance and speed at which to move the
surrounding environment relative to the trapped organelle. If
the trapping force is too strong, it will simultaneously trap
several refractile objects, and if it is too weak, then the object
will not be trapped. Similarly, if the object is moved too quickly,
or too far (i.e., beyond the cell boundary), it will escape the
trap.

Through development of the experiment we have built a cus-
tom system to allow the interface between imaging and optical
trapping to be integrated. The major benefit of an integrated
system is that customized scripts can be written in LabVIEW® to
control the stage lateral motion (i.e., speed and distances tra-
versed), the timing of trap activation, and the subsequent data
capture [5]. The essential components are therefore:

1. An optical trap.

2. A means of turning the trap on and off (we use a shutter that
can be automated).

3. A microscope stage that can be moved at the sub-micron
resolution scale at controlled velocity.

4. A means of imaging the organelles of interest in a real-time
(TIRF).

3.6 Setting the

Optical Trap Laser

Power

If the optical trap is too strong, it will likely trap the majority of
organelles it is centered over (which includes organelles which do
not contain fluorophores). If the goal is to determine whether
trapping efficiency is affected by molecular perturbation, then it is
important that not all organelles can be trapped under control
conditions. Therefore, trapping 20 organelles and assessment of
whether they remain in the trap during the micromanipulation
procedure (see above) is deemed necessary. In practice, we classify
organelles that have undergone the trapping routine into three
categories: stably trapped (i.e., stay in the trap over the entire
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movement), escape the trap (i.e., “fall out” of the trap during the
stage movement), or are not trapped at all. Once this distribution
has been ascertained, a full characterization can be carried out with
at least five samples from each condition where at least ten orga-
nelles are trapped per sample.

3.7 Optimizing

Distance and Speed at

Which to Move the

Trapped Organelle

Determining the distance to move the trapped organelle is an
important consideration, too far and organelles may escape the
trap due to opposing force components encountered (e.g., moving
it into cytoplasmic streams if working in a motile system or encoun-
tering other subcellular structures), too short and it will be difficult
to assess whether the trapped organelle is still attached to the ER.

3.8 Post-Acquisition

Data Analysis

Analysis of data generated from the integrated TIRF-M optical
tweezer setup requires certain META data to be assigned to each
data set. The META data enables the user to determine the coor-
dinates of the optical trap, to overlay trails of trapping events for
ease of initial analysis and indicates the crucial time points during
the trapping routine (e.g., trap on/off).

3.9 META Data

Output for Post-

Acquisition Analysis

For each recorded trapping event, five data files are generated based
on post-acquisition analysis requirements:

1. and 2. Raw images acquired from the synchronized EMCCDs
as 16-bit TIFF stacks, one for each fluorescent channel.

3. An 8-bit false-color (RGB) TIFF stack containing overlaid
channels for quick reference.

4. A txt file containing the lateral (x/y) trap (shutter) position at
the start of the routine and any additional META data (e.g.,
optional notes).

5. A csv file containing lateral (x/y) positions as measured in μm
relative to the top-left stage limit. These positions are
measured at the end of each frame but could be measured
more often if required.

3.10 Data Analysis Data can be analyzed based on the distribution of organelles into
the three categories (stable, escaped, not trapped classification),
and how this changes with optical trap power or under molecular
perturbation. In addition, the distance and rate at which stably
trapped organelles move back towards their original pre-trap posi-
tion after the trap has been turned off can be measured. These
measurements enable the user to understand the nature of physical
interaction or the surrounding environment of the organelle.
Assuming constant viscosity, differences in recoil rate can be used
to model the physical tethering process [5]. Statistical analysis
undertaken is dependent on the hypothesis under test and the
nature of the material. Keeping sample sizes constant over experi-
mental runs allows for less complicated downstream statistical anal-
ysis. Commercial or free software such as ImageJ can be used to
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analyze the TIFF stacks post acquisition, and using python or
similar programming language the lateral stage positions can be
used to map and subtract the movement of the stage for auto-
matic/batch analysis of the relative movement (e.g., speed, dis-
tance, recoil) of the trapped organelle. Determination of precise
force components in vivo is difficult owing to variability in the
biological specimen; slight variations in organelle size and mor-
phology, changes in microenvironments within the cell such as
viscosity, cytoplasmic streaming events and potential shear forces
from boundary layers generated in the constrained cytoplasmic
environment. Due to these inherent complications generating vari-
ation of trapping efficiencies across the cell environment, a large
number of interaction events need to be probed to obtain statisti-
cally significant data; we routinely trap at least 50 organelles in total
taken from several samples from at least three independent plants
from independent transformations.

4 Notes

1. Some batches or individual coverslips can have aberrations in
the glass making trapping difficult. A manifestation of these
issues is a significant change in Z focus upon trapping. If this
occurs, move to another area on the slide or make a fresh
sample.

2. Using a high numerical aperture TIRF objective lens to create a
single beam gradient trap (laser tweezers) requires some care.
The TIRF objectives with oil immersion have aberration when
used in aqueous environments such as plant cells which reduces
the effective numerical aperture for trapping from 1.49 to a
value between 1.0 and 1.1. This both reduces the efficiency of
trapping from a focusing perspective but also means that not all
the laser power entering the objective is used for trapping.
While we have used the TIRF objective in a conventional
manner by slightly overfilling the input pupil, other researchers
have found more efficient trapping by underfilling the objec-
tive. The transmission of laser light at 1090 nm of our TIRF
objective was determined to be 70% using the double objective
method suggested by Mahamdeh et al. [12].

3. Beads which have settled and adhered to the coverslip cannot
be trapped and moved laterally. Beads which are “free floating”
can undergo the trapping routine.
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Chapter 14

Protein Biosynthesis and Maturation in the ER

Emanuela Pedrazzini and Alessandro Vitale

Abstract

The endoplasmic reticulum takes care of the folding, assembly, and quality control of thousands of proteins
destined to the different compartments of the endomembrane system, or to be secreted in the apoplast.
Here we describe how these early events in the life of all these proteins can be followed biochemically by
using velocity or isopycnic ultracentrifugation, metabolic labeling with radioactive amino acids, and
immunoprecipitation in various conditions.

Key words Protein synthesis, Endoplasmic reticulum, Chaperones, Protein folding, Protein
oligomerization, Protein–protein interactions, Pulse-chase, Immunoprecipitation, Ultracentrifugation

1 Introduction

In a given plant cell, thousands of different polypeptides are synthe-
sized by ribosomes bound to the endoplasmic reticulum (ER)
membrane, to be introduced into the ER lumen or integrated in
its limiting membrane. Most of these proteins will then proceed
along the secretory pathway, to reach the correct destination within
the endomembrane system or to be secreted. Before starting their
journey, all these polypeptides undergo folding and in many cases
assembly into oligomers, with the assistance of ER resident folding
helpers and, if these events fail, the same helping machinery directs
the defective polypeptides to degradation [1–3]. The extent of
interactions with the folding machinery is often predictive of
whether folding defects can explain observed effects in activity,
intracellular sorting, or turnover, resulting from natural mutations
or protein engineering [4–8].

Here we describe biochemical techniques to determine protein
localization and structural maturation in the ER, and interactions
with the Binding Protein (BiP), the ER member of the heat shock
protein 70 family and the most promiscuous chaperone of the ER
[2]. These techniques can be used to define the steady-state situa-
tion or, when coupled with pulse-chase radioactive labeling, to
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analyze the time-course dynamics of events. Protein radioactive
pulse-chase was developed several decades ago and has been used
in plant biology since the end of 1950s [9], but it still remains the
major approach of choice for subsequent fine biochemical analysis
of a given protein regarding its in vivo time-course of assembly,
interactions with folding helpers, and traffic.

2 Materials

2.1 Protein

Extraction from Leaves

or Protoplasts (See

Note 1)

2.1.1 Leaf

Homogenization

1. Leaf Homogenization Buffer (HB): 200 mM NaCl, 1 mM
EDTA, 50 mM Tris–Cl, 0.2% Triton X-100, pH 7.8. Store at
�20 �C in small aliquots and supplement with protease inhibi-
tors cocktail immediately before use.

2. Reducing HB: same as HB, but supplemented with 4% (v/v) 2-
mercaptoethanol (see Note 2).

3. Ice-cold mortar.

2.1.2 Protoplast

Homogenization

1. 15 or 1.5 mL polypropylene tubes.

2. Protoplast Homogenization Buffer (ptsHB): 150 mM NaCl,
1.5 mM EDTA, 1.5% Triton X-100, 150 mM Tris–Cl pH 7.5.
This is a 1.5� stock. Store at �20 �C in small aliquots and
supplement with protease inhibitors cocktail immediately
before use.

3. Reducing protoplast homogenization buffer: same as
ptsHB but supplemented with 4% (v/v) 2-mercaptoethanol
(see Note 2).

2.2 Subcellular

Fractionation on

Isopycnic Sucrose

Gradients

1. Buffer A: 10 mMKCl containing either 2 mMMgCl2 or 1 mM
EDTA (seeNote 3), 100 mMTris–Cl, pH 7.8. Store at�20 �C
if not autoclaved.

2. 12%, 16%, 55%, 65% (w/w) sucrose buffer: dissolve sucrose in
buffer A (with 2 mM MgCl2 or 1 mM EDTA) to 12%, 16%,
55%, 65% (w/w). To dissolve 55% or 65% sucrose heat the
solution to 40–50 �C, because sucrose is at the limit of solubil-
ity. Once dissolved, it will not precipitate even upon freezing.
Do not autoclave (the solution will turn yellowish-brown,
indicating sucrose alterations). Store at �20 �C, otherwise it
gets easily contaminated: sucrose is very good for bacterial and
fungal contamination.

3. 13 mL polypropylene ultracentrifuge tubes.

2.3 Velocity Sucrose

Gradient

Centrifugation

1. Sucrose gradient buffers: 5% sucrose (w/v) in 150 mM NaCl,
0.1% Triton X-100, 25 mM Tris–Cl, pH 7.5; 25% sucrose (w/
v) in 150 mM NaCl, 0.1% Triton X-100, 50 mM Tris–Cl,
pH 7.5. Store at �20 �C.

2. Molecular mass markers: prepare a mixture with 0.33 μg/μL
each of cytochrome c (12.4 kDa), ovalbumin (43 kDa), bovine
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serum albumin (67 kDa), aldolase (161 kDa), and catalase
(232 kDa) in HB.

3. 13 mL polypropylene ultracentrifuge tubes.

2.4 Metabolic

Labeling with

Radioactive Amino

Acids

1. K3 medium: 3.78 g/L Gamborg’s B5 basal medium with
minimal organics, 750 mg/L CaCl2 2H2O, 250 mg/L
NH4NO3, 136.2 g/L sucrose, 250 mg/L xylose, 1 mg/L 6-
benzylaminopurine (from a 5 mg/mL stock in 1 N NaOH),
1 mg/L 1-naphtalenacetic acid. Bring to pH 5.5 with a few
drops of 1 M KOH, filter sterilize and store at �20 �C.

2. W5 medium: 9 g/L NaCl, 0.37 g/L KCl, 18.37 g/L CaCl2
2H2O, 0.9 g/L glucose. Filter sterilize, aliquot, and store at
�20 �C.

3. 35S Met/Cys mix.

4. Unlabeled Met/Cys (10� stock): 15 mg/mL Met, 6.05 mg/
mL Cys in K3. Store at �20 �C (see Note 4).

5. Bovine serum albumin, 4 mg/mL stock in K3. Store at�20 �C
in aliquots.

6. 1/2MS10 medium: half the normal concentration of Mura-
shige and Skoog medium, 10% sucrose. Bring to pH 5.6 with
KOH.

2.5 Protein

Immunoselection

1. Gelatin stock: 2% gelatin from porcine skin in distilled water.
Autoclave and, when at around 30–40 �C but before it starts
forming the gel, add NaN3 to 0.02% to avoid microorganism
growth and store at 4 �C. Melt in microwave oven before use.
It can undergo many melting cycles without deteriorating.

2. Immunoselection gelatin buffer (Nonidet-EDTA-Tris-gel
buffer, NET-gel): 50 mM Tris–HCl, pH 7.5, 150 mM NaCl,
1 mM EDTA, 0.1% octylphenoxy poly(ethyleneoxy)ethanol,
branched (Nonidet P-40 or IGEPAL® CA-630), 0.25% gela-
tin, 0.02% sodium azide.

3. Washing buffer (NET buffer): same as NET-gel buffer, but
without gelatin.

4. Protein A-Sepharose 10% suspension: work at room tempera-
ture. Swell Protein A-Sepharose in NET buffer for at least 3 h
with occasional agitation, in a graduated 50 or 15 mL polypro-
pylene tube, and wait until it sediments. Discard the superna-
tant using a pasteur pipette connected to a water pump. Add
1 M Tris–HCl pH 7.5. Allow to stand for 1 h with occasional
agitation. Spin down the bead at 5000 � g, 5 min at room
temperature, and discard supernatant. Wash the bead 1� with
NET buffer. Spin down and note volume occupied by the bead
(1 g of dry powder should give about 3.5 mL of bead). Discard
supernatant and add 9 bead volumes of NET buffer. Store at
4 �C for up to several months.
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3 Methods

3.1 Total Protein

Extraction from Leaves

or Protoplasts

(See Note 5)

3.1.1 Leaf

Homogenization

1. Collect arabidopsis rosette leaves or small (4–7-cm long) leaves
from tobacco grown in axenic conditions or in soil, weight
them, and transfer them (see Note 6) to an ice-cold mortar
kept on ice and containing 5–7 v/w of ice-cold HB supple-
mented, immediately before use, with protease inhibitor cock-
tail. Rapidly homogenize the leaves keeping the mortar on ice.
Alternatively, use reducing HB and follow the same procedure
(see Note 7).

2. Transfer the homogenate to an appropriate tube (depending
on the volume) and clarify the homogenate by centrifugation at
1500 � g, 10 min at 4 �C. Collect the supernatant and discard
the pellet (seeNote 8). The clarified homogenate can be stored
frozen at �20 �C for several months.

3.1.2 Protoplast

Homogenization

1. Add to protoplasts two volumes of ice-cold ptsHB, by pipet-
ting 4–5 times through a 200 μL tip and freeze-thawing the
suspension in liquid nitrogen. Alternatively, use reducing
ptsHB and follow the same procedure (see Note 7).

2. Clarify the homogenate by centrifugation at 1500 � g, 10 min
at 4 �C (see Note 9). Protoplast homogenate can be stored at
�20 �C for several months.

3.2 Subcellular

Fractionation to

Determine Protein

Localization

3.2.1 Subcellular

Fractionation on Isopycnic

Sucrose Gradients

1. To prepare linear 16–55% or 16–65% (w/w) (see Note 10)
sucrose gradients, gently stratify with a micropipette 6 mL of
16% sucrose buffer (with magnesium or EDTA) onto 6 mL of
55% (or 65%) sucrose buffer (with magnesium or EDTA) in a
13 mL ultracentrifuge tube. Seal the tube with Parafilm™ and
gently turn it to a perfectly horizontal position. Keep it in this
position for 4 h at room temperature, then gently turn it back
to a vertical position and store for at least 10 h at 4 �C before
using it.

2. For leaves: homogenize small leaves (3–8-cm long) in an ice-
cold mortar with ice-cold 12% (w/w) sucrose buffer (with
magnesium or EDTA) supplemented with protease inhibitor
cocktail, using 4–7 mL of buffer per gram of fresh leaf tissue.

3. For protoplasts: homogenize pelleted protoplasts in ice with
ice-cold 12% sucrose buffer supplemented with protease inhib-
itor cocktail, using the same buffer/protoplast pellet ratio as
above. With a 200 μL micropipette tip, pipette the suspension
up and down about 20 times, to break protoplasts. Do not let
the material warm up.
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4. With a micropipette, load the homogenate (up to 600 μL) on
top of the gradient. Keep everything in ice (see Note 11).

5. Ultracentrifuge at 150,000 � g (rav), in a swinging rotor at
4 �C for 2 h.

6. Collect fractions (usually of about 500–600 μL each) (seeNote
12). A pellet will be visible at the bottom of the tube: do not
discard it. Fractions and the tube with its pellet can be stored at
�20 �C.

7. Take an equal aliquot of each fraction and add 0.5 volumes of
3� SDS-PAGE denaturation buffer. Solubilize the pellet at the
bottom of the centrifuge tube with a volume of 1� SDS-PAGE
corresponding to the same volume of each original fraction.

8. Denature the aliquots from the gradient and the solubilized
pellet at 90 �C, 5 min. Analyze by SDS-PAGE and protein blot
or fluorography each fraction and an equal aliquot of the
solubilized pellet. Remember to load an aliquot of denatured
total 12% sucrose homogenate, as a control (see Note 13).

3.2.2 Rapid Isolation of

Microsomes

1. Homogenize leaves or protoplast in 12% sucrose buffer and
clarify as described above.

2. Load the clarified homogenate on a cushion made of 17% (w/
w) sucrose buffer. Ultracentrifuge in a swinging rotor 90min at
100,000 � g (rav), 4

�C (see Note 14).

3. Collect the supernatant, resuspend the pellet, and analyze both
fractions by SDS-PAGE and protein blot (or fluorography).

3.3 Determination of

the Assembly Grade of

Proteins

3.3.1 Velocity

Centrifugation on Sucrose

Gradient

1. Prepare linear 5–25% (w/v) sucrose gradients following the
procedure described in Subheading 3.2.1, step 1, but using
the buffers for velocity sucrose gradient centrifugation.

2. Homogenize leaves or protoplast as described in Subheading
3.1.1 or 3.1.2.

3. Load the clarified lysate on the top of the 12 mL linear 5–25%
(w/v) sucrose gradient.

4. In parallel, load an additional gradient with 600 μL of the
molecular mass marker mixture.

5. Centrifuge at 200,000 � g (rav) for 25 h at 4 �C in an ultracen-
trifuge swinging rotor.

6. Fractionate the gradients from the top into 18–22 fractions of
about 500–600 μL each (see Note 12).

7. Solubilize equal volumes of each fraction with 0.5 volumes of
3� SDS-PAGE loading buffer. The pellet at the bottom of the
centrifuge tube is solubilized with 500–600 μL of 1� SDS-
PAGE loading buffer.
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Take equal aliquots of fractions and pellet, denature at
90 �C, 5 min and analyze by SDS-PAGE and protein blot (or
fluorography). Remember to load an aliquot of denatured total
homogenate, as a control. Similarly denature 40 μL of each
fraction from the molecular mass marker gradient, analyze by
SDS-PAGE and stain the gel with Coomassie Blue. The easily
detected bands will serve as size markers along the gradients.

3.4 Protein

Metabolic Labeling

with Radioactive

Amino Acids

3.4.1 Pulse-Chase

Labeling of Protoplasts

1. Pulse: Label protoplasts in K3 medium using 100 μCi/mL of
35S-label Met/Cys mixture. Incubate for 1 h at 25 �C
(tobacco) or 20 �C (arabidopsis) in the dark. A workable
concentration of protoplasts for the subsequent steps is 1–2
millions/mL.

2. Stop pulse labeling by diluting protoplasts with four volumes
of ice-cold W5 solution; centrifuge at 100 � g for 5 min at
4 �C.

3. Chase: Resuspend the pelleted protoplasts in K3 medium sup-
plemented with unlabeled Met/Cys to a final concentration of
10 and 5 mM, respectively, using the Met/Cys 10� stock (see
Note 15). Incubate at 25 �C (tobacco) or 20 �C (arabidopsis)
in the dark for the desired chase time points.

4. Collect an aliquot of protoplasts (usually 100–250 μL) at each
chase time point, add three volumes of ice-cold W5, and cen-
trifuge 10 min at 60� g. Remove the supernatant (and save it if
secretion needs to be studied), leaving about 50 μL covering
the protoplast pellet.

5. Quickly freeze in liquid nitrogen and store at �80 �C until
homogenization. Alternatively, homogenize immediately using
the buffer required according to subsequent analysis that will
be performed.

3.4.2 Pulse-Chase

Labeling of Intact Leaves

1. Pulse: Put 150 μL of 1/2MS10 medium supplemented with
150 μCi/mL 35S-label Met/Cys mixture in a conical 10 or
15 mL plastic tube.

2. Cut one leaf (not longer than 5 cm) from axenic plant and
insert it into the tube, so that the petiole touches the bottom of
the tube.

3. Incubate under vacuum for 1 min, to favor entrance of the
labeling medium into the vascular system.

4. Incubate for 1–3 h or longer at 25 �C (tobacco) or 20 �C
(arabidopsis) in the dark, covering the tube with its unscrewed
cap.

5. Carefully remove the incubation medium with a micropipette
and replace it with 150 μL 1/2 MS10. Incubate 1 h as above,
to favor as much as possible incorporation of the radioactive
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amino acids before starting the chase. You can homogenize
leaves now (as described above) or continue with the chase.

6. Chase: Remove the medium and replace it with 1/2 MS10
supplemented with unlabeled Met/Cys to 10 and 5 mM,
respectively, using the Met/Cys 10� stock (see Note 16).

7. At the desired time points, homogenize leaves as described
above.

3.5 Immunoselection 1. Add NET-gel buffer to protoplast or leaf homogenates
prepared as in Subheadings 3.1.1 and 3.1.2, or to aliquots
from isopycnic or velocity gradient fractions (no more than
400 μL of sample), up to a final volume of 1 mL. Mix well by
vortexing. Use 1.5 mL polypropylene tubes.

2. Spin twice (4 min at 4 �C at maximum speed in minifuge) to
pellet any insoluble material. Transfer supernatant to a new
tube each time.

3. Add the appropriate antibody or antiserum. The final concen-
tration of immunoglobulins depends on the affinity of each
antibody/antiserum and must be previously determined, but
the volume should be limited to a few microliters. Incubate 2 h
on ice (see Note 17).

4. Add 100–150 μL of a 10% suspension of Protein A-Sepharose.
Incubate for 1 h at 4 �C under gentle agitation (the resin must
be in continuous movement).

5. Pellet the resin (30 s to 2 min at maximum speed in minifuge),
and discard supernatant.

6. Wash the resin three times with 1 mL of NET-gel buffer. Spin
as above and discard supernatant after each wash. Leaving each
time about 1 mm of buffer over the resin.

7. Add to the bead equal volume of 2� SDS-PAGE buffer (bead is
usually 30–40 μL).

8. Mix well, denature 5 min at 90 �C, spin and load the solution
on SDS-PAGE. If you use a Hamilton syringe, this is easy
because the bead will not enter the needle.

9. Radioactive polypeptides can be revealed by fluorography or
autoradiography of the dried gel.

3.6 Analysis of

Protein Interaction

with BiP

1. Protoplast or leaf homogenate is immunoselected as describe
above with anti-BiP antiserum (commercially available or
prepared in the investigator’s laboratory).

2. After washing three times with NET-gel buffer, split the beads
into three aliquots: one aliquot is washed again twice for
30 min with 500 μL of NET-gel buffer only, one with NET-
gel buffer containing 6 mM MgCI2 and one with NET-gel
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buffer containing 6 mMMgCI2 and 3 mM ATP (seeNote 18).
Treatments are performed on ice.

3. The material still bound to the beads after these treatments is
directly analyzed by SDS-PAGE.

4. The ATP-released material is re-immunoselected using antise-
rum or antibody against the protein of interest, following the
procedure described above, steps 3–9 of Subheading 3.5.

5. As a further control, repeat the entire procedure from step 1 in
reverse order, that is using first the antiserum or antibody
against the protein of interest and then selecting the ATP-
released material with anti-BiP antiserum.

4 Notes

1. The described methods can be used to analyze samples
both from Nicotiana tobacum and from Arabidopsis thaliana
[5, 8, 10].

2. 2-Mercaptoethanol is volatile and highly toxic. Avoid breath-
ing vapors or skin contact. Always work under a ventilated
hood when working with the stock chemical or any solution
containing it. Discard solutions, tubes and pipet tips in appro-
priate containers, separated from other disposed material.

3. Magnesium will preserve ribosomes, and therefore the ones
attached to the ER will remain there. EDTA dissociates the
ribosome subunits and releases them from the ER membrane.
As a result, the density of the ER is higher in the presence
of magnesium (because the ratio protein/lipid is higher) [6,
10, 11 ].

4. When melting the unlabeled aminoacid mix, check it for pre-
cipitates: after several freezing and melting, the solution may
become cloudy. If this occurs, discard and prepare a new stock.

5. The methods in this section are used to prepare proteins for all
subsequent analysis described in this chapter, with the excep-
tion of the analysis of protein subcellular localization: nonionic
detergents dissolve membranes and therefore destroy the
integrity of subcellular compartments. As described in Sub-
heading 2.2, the homogenization buffers to analyze subcellular
localization therefore do not contain ionic detergents.

6. If you start from frozen leaves, work fast and do not allow them
to warm up before homogenization, because freezing breaks
membranes and thus vacuolar proteases will have access to all
proteins as the tissue is defrosted.

7. HB contains salts and ionic detergent sufficient to bring into
solution the vast majority of soluble and integral membrane
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proteins. However, certain proteins are not solubilized unless
their disulfide bonds are reduced. The most striking examples
are constituted by many prolamins of cereal seeds [12]. There-
fore, if their recombinant forms are expressed in leaves of
transgenic plants or transiently in protoplasts, the use of reduc-
ing HB or reducing ptsHB is mandatory for their solubilization
[13, 14]. Other proteins that fold in the ER oxidizing environ-
ment may also require reducing conditions to be solubilized.
When working on a new protein introduced in the secretory
pathway, it is thus recommended to first compare its solubility
in reducing and nonreducing homogenization buffers.

8. The pellet mainly contains cell wall polysaccharides and starch
from plastids. Unbroken cells may also be present, as well as
insoluble proteins that may require reducing conditions to
enter into solution (see Note 7), or even strong denaturing
agents such as SDS or urea. However, the use of strong dena-
turants will preclude further analysis of assembly or interactions
with chaperones.

9. The pellet of protoplast homogenates may be not easy to see,
especially if you are homogenizing less than 30,000 proto-
plasts. Proceed anyway to collect the supernatant, taking care
of avoiding touching the bottom of the tube.

10. 16–65% sucrose is recommended to fractionate highly dense
organelles, such as ER protein bodies [10].

11. Remember to load each gradient with homogenate made in the
SAME buffer (magnesium or EDTA)!

12. Use a 1 mL micropipette. Slowly and carefully collect each
fraction by remaining as close as possible to the top of the
gradient. Unavoidably, a very low amount of the top of the
gradient will remain in the tube as you remove the different
fractions. Due to the increasing difference in density, this will
not contaminate the other fractions, until it will remain at the
bottom of the tube where it will slightly contaminate the last
fraction.

13. In the presence of MgCl2, the plant ER has a density
corresponding to 1.17–1.18 g/mL sucrose. When Mg2+ is
chelated by EDTA, ribosomes are detached from the ER mem-
brane, which thus becomes less dense, with a consequent shift
in migration along the gradient [6, 10, 11].

14. Microsomes derived from Golgi and ER, tonoplast and plasma
membrane fragments, vesicles, mitochondria, and chloroplasts
will precipitate at the bottom of the tube. Cytosolic proteins as
well as soluble proteins of vacuoles (vacuoles break during
homogenization) will remain in the 12% supernatant [6].
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15. If proteins secreted by protoplasts into the incubation medium
are the object of study, 150 μg/mL of bovine serum albumin
(from the 4 mg/mL stock) should be added to the K3
medium. This will constitute a very abundant substrate for
secreted proteases, thus strongly lowering the probability of
degradation of the newly secreted polypeptides.

16. Upon the addition of nonradioactive amino acids to protoplast
samples, the incorporation of radioactive ones into protein
rapidly drops to almost undetectable levels. This occurs within
a few minutes from the starting of chase. Do not expect the
same to occur when leaves are labeled, because of the much
slower incorporation in intact tissue and the variability between
different leaves. This makes very difficult to analyze the time
course of events occurring within relatively short times (1–2 h)
when leaves are labeled. Keep this in mind when you interpret
your results.

17. Immunoprecipitation works also if homogenization is per-
formed in reducing conditions, such as in the presence of 4%
2-mercaptoethanol [14, 15]. The immunoglobulin tetramer
contains interchain disulfide bonds, but its assembly depends
mainly on other types of interactions and therefore it is not
disrupted by 2-mercaptoethanol in the absence of strong dena-
turants such as SDS.

18. Like the other members of the heat shock 70 protein family,
BiP is an ATPase and releases its bound ligands upon ATP
hydrolysis. Because ATPase activity requires magnesium, the
presence of EDTA during homogenization and immunoselec-
tion ensures that ligands are not released from the chaperone.
Subsequent treatment with buffer supplemented with ATP and
magnesium, but not with magnesium alone, promotes the
release of polypeptides that have been immunoselected because
BiP is acting on them as a molecular chaperone, rather than
because of unspecific interactions [5, 6, 14, 16].
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Chapter 15

ER Membrane Protein Interactions Using the Split-Ubiquitin
System (SUS)

Lisa Yasmin Asseck, Niklas Wallmeroth, and Christopher Grefen

Abstract

Protein–protein interactions (PPIs) play fundamental roles in all cellular processes. Especially membrane
proteins facilitate a range of important biological functions in stimuli perception, signaling, and transport.
Here we describe a detailed protocol for the yeast mating-based Split-Ubiquitin System (mbSUS) to study
PPIs of ER membrane proteins in vivo. In contrast to the prominent Yeast Two-Hybrid, mbSUS enables
analysis of full-length membrane proteins in their native cellular context. The system is based on the
ubiquitin proteasome pathway leading to the release of an artificial transcription factor followed by
activation of reporter genes to visualize PPIs. The mating-based approach is suitable for both small- and
large-scale interaction studies. Additionally, we describe protocols to apply the recently established SUS
Bridge assay (SUB) which is optimized for the detection of ternary protein interactions.

Key words Protein–protein interaction, Ternary interaction, Yeast, Split Ubiquitin, mbSUS, SUB,
Membrane proteins, Gateway

1 Introduction

Protein–protein interactions (PPIs) are prerequisite for a wide
range of cellular functions. A large number of biophysical and
biochemical techniques have been developed to unravel PPI net-
works for a better understanding of cellular complexities (for
review, see [1]). For example, a technique such as the yeast two
hybrid is often applied for their ease of use and applicability to
large-scale approaches. One downside of this particular technique,
however, is the obligatory nuclear localization of the interaction
partners which imposes truncation of membrane or large proteins
to facilitate their nuclear (mis-)localization. Truncation and artifi-
cial nuclear localization in turn might cause artifacts and misinform
on interactions among—for example—membrane proteins. Yet,
many key processes in cell signaling and vesicle trafficking are
mainly coordinated by interactions between or with membrane

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_15, © Springer Science+Business Media LLC 2018
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proteins, which due to their natural environment and hydrophobic
composition has remained experimentally difficult.

The mating-based Split-Ubiquitin System (mbSUS, [2])
described in this chapter is an approach well-suited to elucidate
full-length membrane protein interactions in vivo. The system relies
on reassembly of the N- (Nub) and C-terminal (Cub) ubiquitin
moieties that reconstitute a functional molecule when brought into
close proximity by interacting proteins fused to these fragments
[3]. To prevent spontaneous reassembly, Nub is mutated at residue
Ile13 to either glycine or alanine that reduces its affinity for Cub [4]
(see Note 1). Upon reconstitution, ubiquitin is recognized by
cytosolic ubiquitin-specific proteases (USPs), which cleave off the
artificial transcription factor PLV (ProteinA-LexA-VP16) fused to
the C-terminus of Cub [5]. The released transcription factor then
translocates into the nucleus to mediate activation of reporter genes
allowing auxotrophy selection (ADE2,HIS3) and quantification of
the relative interaction strength (lacZ). Thus, split ubiquitin as
interaction sensor circumvents the use of mis-localized or truncated
versions of fusion proteins significantly reducing artifacts associated
with such protein modifications.

The mating-based strategy can be used not only to assay the
interaction between two known proteins but is particularly adapted
for large-scale interaction tests to screen a multitude of potential
binding partners (seeNote 2). In such screens, the mating approach
simplifies and accelerates the experimental procedure compared to
sequential transformations or co-transformations. Experimentally
verified, binary interactions represent an idealized condition of the
real-world biological complexity of multi-protein complexes. How-
ever, only a few methods have thus far been established to study
multimeric interactions, an increasingly important task for our
understanding of the cellular interactome. The SUS Bridge assay
(SUB) is adapted from the classical Split-Ubiquitin System with the
addition of a third (tagged or untagged) protein being expressed that
can either facilitate, enhance, or inhibit a nonexistent, weak, or
previous interaction between bait and prey, respectively [6, 7].

In this book chapter, we detail the application of both thembSUS
and SUB technique, respectively, to detect interactions between
membrane proteins. As textbook example of an ER-membrane com-
plex we choose the subunits of the heterotrimeric SEC61 translocon
complex of Arabidopsis. Via Blastp analysis we identified the Arabi-
dopsis orthologues of the mammalian SEC61 translocon subunits.
Assembly of the three α, β, and γ SEC61 subunits yields the ER-
membrane localized channel, which mediates translocation of secre-
tory proteins across and integration of membrane proteins into the
lipid bilayer [8]. Here we show that the Sec61 subunit isoform α1 of
Arabidopsis thaliana (At2g34250) directly interacts with Sec61β1
(At2g45070) and γ1 (At5g50460), respectively (Fig. 1).
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2 Materials

2.1 Vectors and

Strains

The Gateway-compatible (exception: pNubWt-Xgate) mbSUS and
SUB vectors which are necessary for interaction analysis are listed in
Table 1. Maps and sequences of the vectors can be downloaded
from http://www.zmbp.uni-tuebingen.de/dev-genetics/grefen/
resources/yeast-vectors.html. The yeast strains that are used in
this book chapter are listed in Table 2.

Fig. 1 mbSUS analysis of the Arabidopsis Sec61 subunit α1 with Sec61β1 and Sec61γ1. (a) Schematic
depiction of the SUS principle. Upon interaction of bait (red) and prey (grey) NubG and Cub reassemble to
ubiquitin which is recognized by ubiquitin-specific proteases (USPs) that cleave off the LexA-VP16 transcript
activator. Diffusion of this construct into the nucleus activates reporter genes ADE2, HIS3, and lacZ which can
be monitored by growth or colorimetric assays. (b) Western blot analysis of haploid yeast prior mating and
used in (c) with antibodies detecting the VP16 domain of the chimeric PLV and the HA-tag fused between NubG
and GOI, respectively. (c) Growth assay of diploid yeast expressing the indicated fusion proteins. Yeast was
dropped in serial dilutions (of OD600 from 1.0 to 0.01) on vector-selective (CSM-Leu�, Trp�, Ura�) and
interaction-selective (CSM-Leu�, Trp�, Ura�, Ade�, His�) media with increasing methionine concentrations.
NubWt was used as positive control, and NubG as well as VAMP723 as negative controls (see Note 3).
Sec61α1-Cub-PLV (~106 kDa), NubG-2xHA-Sec61β1 (~16 kDa), NubG-2xHA-Sec61β1 (~15 kDa), NubG-
2xHA-VAMP723 (~32 kDa)
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2.2 Media and

Solutions for Growth

and Transformation of

Yeast

1. YPD media: 2% peptone, 2% glucose, 1% yeast extract; adjust
pH to 6–6.3 with KOH before adding 2% oxoid agar.

2. Sterile deionized water (ddH2O).

3. 1M lithium acetate (LiAc): dissolve LiAc in ddH2O. Adjust pH
to 7.5 with acetic acid, sterilize by filtration.

4. 50% polyethylene-glycol 3350 (PEG 3350): dissolve PEG 3350
in deionizedwater to a final concentration of 50% (w/v), sterilize
by filtration. Avoid water loss through autoclaving or during
storageasthis significantlydecreasesthetransformationefficiency.

5. Single-stranded carrier DNA (ssDNA): dissolve 10 mg/ml
ssDNA in deionized water, sonicate, and/or boil for 10 min
following cooling on ice before use.

Table 1
Destination vectors for mbSUS and SUB analysis

Origin Selection

Plasmid name Promoter E. coli Yeast E. coli Yeast Function Reference

pMetYC- Dest Met25 pUC ARS/
CEN

Amp,
Cm

LEU2 Met-repressible fusion protein
with C-terminal Cub-PLV

[9]

pNX35-Dest ADH1 pUC 2μ Amp,
Cm

TRP1 Constitutive expression with
N-terminal NubG-2xHA

[7]

pXNubA22-
Dest

ADH1 pUC 2μ Amp,
Cm

TRP1 Constitutive expression with
C-terminal NubA-3xHA

[10]

pNubWt-
Xgate

ADH1 pUC 2μ Amp,
Cm

TRP1 Positive control vector,
NubWt peptide; not a
Gateway vector

[2]

pMZU-Dest ADH1 pUC 2μ Spec,
Cm

URA3 Constitutive expression with
N-terminal myc

[7]

pZMU-Dest ADH1 pUC 2μ Spec,
Cm

URA3 Constitutive expression with
C-terminal myc

[6]

Table 2
Yeast strain genotypes

Name Organism Genotype Function Reference

THY.
AP4

S. cerevisiae MATa; ade2�, his3�, leu2�,
trp1�, ura3�; lexA::ADE2,
lexA::HIS3, lexA::lacZ

Reporter strain, used for
transformation of Cub-clones,
used for SUB assay

[2]

THY.
AP5

S. cerevisiae MATα; ade2�, his3�, leu2�,
trp1�

Used for transformation of Nub-
clones; mate with THY.AP4 for
binary interactions

[2]
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6. CSM-Ade�, His�, Leu�, Met�, Trp�, Ura� as dropout.

7. Chemicals for auxotrophy selection, each dissolved in 100 ml
water and sterilized by filtration; store in darkness at 4 �C:

ADE: 0.4 g of adenine sulfate (add 5 ml per liter media).

HIS: 0.4 g of L-histidine HCl (add 5 ml per liter media).

LEU: 2.0 g of L-leucine (add 5 ml per liter media).

TRP: 1.0 g of L-tryptophane (add 5 ml per liter media).

URA: 0.4 g of uracil (add 5 ml per liter media).

MET: 1.5 g of methionine (equals a 100 mM stock; add
appropriate amount to obtain 0.5, 5, 50, and 500 μM
final concentrations).

8. Selection media: 0.17% YNB (without amino acids), 0.5%
ammonium sulfate, 2% glucose, 0.056% CSM-dropout mix;
adjust pH to 6–6.3 with KOH before adding 2% oxoid agar;
add appropriate auxotrophy selection chemicals before or after
autoclaving, e.g., ADE, HIS, TRP, and URA for transforma-
tion of THY.AP4 in the mbSUS assay (see Note 4).

2.3 Solutions for

Western Blot Analysis

1. Lyse and load (LL-) buffer: 50 mM Tris (pH 6.8), 4% SDS,
4 M urea, 30% glycerol, 0.1 M DTT, 0.005% bromophenol
blue; store at �20 �C.

2. Acid-washed glass beads (0.25–0.5 mm).

3. 20 ml SDS-PAGE resolving gel (12.5%): 6.2 ml H2O, 8.4 ml
acrylamide mix (30%), 5.0 ml 1.5 M Tris (pH 8.8), 0.2 ml SDS
(10%), 0.2 ml (NH4)2S2O8 (10%), 0.008 ml TEMED.

4. 5 ml SDS-PAGE stacking gel (5%): 3.4 ml H2O, 0.83 ml
acrylamide mix (30%), 0.63 ml 1 M Tris (pH 8.8), 0.05 ml
SDS (10%), 0.05 ml (NH4)2S2O8 (10%), 0.005 ml TEMED.

5. 10� SDS running buffer: 250 mM Tris, 1.9 M glycine, 0.15%
SDS.

6. 100% methanol.

7. PVDF membrane.

8. 10�TBS: 250mMTris, 1.5MNaCl, 20mMKCl; adjust pH7.4
(HCl).

9. Washing buffer, 1� TBS-Tween: 100 ml 10� TBS, 900 ml
H2O, 0.1% Tween20.

10. Blocking buffer: 1� TBS-Tween, 5% milk powder.

11. Antibodies (dilute 1:1000 in 1� TBS-Tween, add 0.1% NaN3).

(a) Primaries: α-VP16, α-HA, α-myc.

(b) Secondaries: anti-rabbit IgG alkaline phosphatase, anti-
mouse IgG alkaline phosphatase.
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12. Staining buffer: 100 mM Tris (pH 9.5), 100 mMNaCl, 5 mM
MgCl2.

13. NBT-solution: 50 mg/ml Nitro blue tetrazolium chloride in
70% DMF; aliquot and store at �20 �C.

14. BCIP solution: 50 mg/ml 5-Bromo-4-chloro-3-indolylpho-
sphate-p-Toluidin in 100% DMF; aliquot and store at �20 �C.

15. Staining solution: 66 μl NBT-solution, 33 μl BCIP solution in
10 ml staining buffer; always prepare freshly.

3 Methods

The mbSUS technique allows fast screening of PPIs in vivo. The
flowchart in Fig. 2 should provide a detailed overview of the steps
necessary for execution of the methods and includes their approxi-
mate duration to aid in planning of the experiment.

3.1 Yeast

Transformation

3.1.1 mbSUS

Transformation

1. Streak THY.AP4 and THY.AP5 yeast strains out on YPD plates
and incubate for 2 days at 30 �C.

2. Pick one colony and inoculate into 5 ml YPD liquid media
each. Grow overnight at 30 �C while shaking (200 rpm).

Fig. 2 Flowchart of mbSUS analysis. (a) Timeline listing the necessary steps of an mbSUS analysis in
consecutive order. (b) Cartoon depicting the different ploidy states of the yeast at the different stages of an
mbSUS protocol
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3. Add 2 ml of the overnight culture to 100 ml of fresh YPD and
incubate for 3–5 h at 30 �C while shaking (200 rpm) until the
OD600 reaches 0.5–0.8.

4. Harvest cells by centrifugation (5 min at 2000 � g) in sterile
50 ml tubes. Discard the supernatant.

5. Wash with 20 ml of sterile ddH2O and centrifuge again (5 min
at 2000 � g). Discard the supernatant.

6. Resuspend the pellet in 1 ml of 0.1 M LiAc and transfer to a
2 ml tube. Spin down (2 min at 1000 � g) and discard the
supernatant.

7. Resuspend the cells in an appropriate amount of 0.1 M LiAc
(20 μl per transformation) and incubate at room temperature
for 30 min.

8. Meanwhile prepare sterile PCR stripes with 10 μl ssDNA and
5 μl of plasmid DNA for each transformation (see Note 5).

9. Prepare a master mix by mixing 70 μl of 50% PEG, 10 μl 1 M
LiAc, and 20 μl of competent yeast (step 7) for each
transformation.

10. Distribute 100 μl of the master mix into each PCR tube and
mix carefully with the prepared DNA-mixture.

11. Incubate for 20 min at 30 �C using a PCR cycler. Mix the
reactions by gently pipetting up and down several times with a
multichannel pipette.

12. Incubate an additional 10 min at 30 �C.

13. Heat shock at 43 �C for 15 min.

14. Spin down briefly. Carefully remove the supernatant using a
pipette.

15. Optional: Wash the pellet with 100 μl of sterile ddH2O.

16. Resuspend the cells in 100 μl of sterile ddH2O.

17. Plate the entire volume on appropriate selective minimal media
(THY.AP4: CSM-Leu�, THY.AP5: CSM-Trp�, Ura�).

18. Seal the plates and incubate for 3 days at 30 �C.

3.1.2 Bridge Assay

Transformation

The transformation protocol is the same as that in Subheading
3.1.1 with the following exceptions:

1. Use haploid THY.AP4 cells exclusively.

2. Prepare DNA-mix with only 9 μl ssDNA and 2 μl each of the
three different plasmid DNAs. For efficient transformation use
more highly concentrated plasmid DNA (see Note 5).

3. Plate on CSM-Leu�, Trp�, Ura� media. Incubate for 3 days at
30 �C.
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3.2 Mating 1. Pool several colonies per transformation and grow shaking
overnight in 5 ml of appropriate selective media at 30 �C.

2. Harvest 2 ml each for western blot analysis. Store the pellet at
�20 �C.

3. Harvest 2 ml each by centrifugation (5 min at 1000 � g) and
resuspend the pellet in 200 μl YPD. Scale up the volume for a
higher number of crossings (20 μl per mating).

4. Mix 20 μl each, bait (THY.AP4) and prey (THY.AP5) of any
desired combination in sterile PCR stripes.

5. Drop 5 μl of each mating onto a YPD plate.

6. Incubate (right side up) for 6–8 h at 30 �C.

7. Transfer mated yeast on CSM-Leu�, Trp�, Ura� plates using
sterile pipette tips or a replicator stamp. Be careful NOT to
transfer YPD medium with the cells.

8. Incubate overnight at 30 �C (see Note 6).

3.3 Screening

Approach

1. Transform bait construct in THY.AP4 as described in Subhead-
ing 3.1.1 (see Notes 7 and 8).

2. Inoculate 5–10 colonies in 50 ml selective media (CSM-Leu�)
and incubate shaking overnight at 30 �C until an OD600 of
~108 is reached. Determine the total number of cells using a
Neubauer Chamber.

3. Harvest cells by centrifugation (5 min at 1000 � g). Discard
the supernatant.

4. Resuspend the cells in 1 ml of YPD (pH 4.5).

5. Simultaneously, transform prey library in THY.AP5 in ten
small-scale approaches.

6. Collect cells from the plates with selective media (CSM-Trp�,
Ura�).

7. Harvest cells by centrifugation (5 min at 1000 � g). Discard
the supernatant.

8. Resuspend the pellet in 10 ml of CSM-Trp�, Ura�. Determine
the total cell number.

9. Mix both transformations 1:1. Fill up to 2 ml with YPD
(pH 4.5).

10. Incubate 2 h at 30 �C, shaking at 35 rpm.

11. Plate in 300 μl aliquots on complete medium (YPD pH 4.5) on
square plates (12 � 12 cm).

12. Incubate 5 h at 30 �C.

13. Wash cells with 15 ml ddH2O.

14. Harvest cells by centrifugation (10 min at 1000 � g). Discard
the supernatant.
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15. Resuspend the cells in 5 ml ddH2O.

16. Plate in 100 μl aliquots on CSM including 500 μMmethionine
and incubate for 3 days at 30 �C.

17. A total of ~106 colonies should be obtained.

18. Transfer colonies using sterile pipette tips on fresh CSM
including 500 μM methionine and incubate for 3 days at
30 �C. Be careful NOT to transfer too much yeast material to
avoid growth of false-positives.

19. Analyze by colony PCR (Subheading 3.6) and sequencing.

3.4 Detection Assay 1. Inoculate in 2ml selective media (CSM-Leu�, Trp�, Ura�) and
grow shaking overnight at 30 �C.

2. Pipette 100 μl in a 1.5 ml tube and 100 μl into a cuvette
containing 900 μl H2O.

3. Determine 1:10 diluted OD600. Note the values.

4. Harvest cells in the tubes by centrifugation (2 min at
2000 � g). Carefully remove the supernatant by pipetting.

5. Add appropriate volume of sterile ddH2O to reach a final
OD600 of 1.0 (e.g., 1:10 dilution has an OD600 value of
0.450; resuspend yeast pellet in 450 μl sterile H2O).

6. Make tenfold serial dilutions (1:10, 1:100): Prepare tubes with
900 μl of sterile ddH2O. Add 100 μl of the appropriate yeast
(OD600 ¼ 1.0) and mix well by shaking by hand. For the 1:100
dilution, transfer 100 μl of the 1:10 dilution into another tube
containing 900 μl ddH2O.

7. Drop 7 μl yeast of each dilution on selective plates containing
increasing methionine concentrations as well as on vector-
selective media (CSM-Leu�, Trp�, Ura�) as growth control.
Allow the drops to dry (see Notes 9 and 10).

8. Seal the plates and incubate for 1–3 days at 30 �C. Remove the
vector-selective growth control after 24 h of incubation to see
the gradient of the yeast ODs.

9. Document results by scanning or photography using a black
background.

3.5 Western Blot 1. Harvest 2 ml of overnight yeast culture or use deep-frozen
aliquots.

2. Add ~50 μl glass beads.
3. Resuspend cells in 200 μl LL-buffer by vortexing for approx.

2 min.

4. Incubate shaking for 10 min at 65 �C.

5. Centrifuge at 16,500 � g for 10 min.

6. Transfer the supernatant to a fresh tube.
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7. Load 10–20 μl on a SDS-PAGE gel.Optional: Store at�80 �C.

8. Run gel with appropriate conditions.

9. Run western blot (e.g., semidry transfer on PVDF membrane).

10. Block membrane in blocking buffer on a shaker for 1 h at room
temperature. Optional: overnight at 4 �C.

11. Wash three times, 10 min each with 1� TBST.

12. Transfer membrane into primary antibody solution. Incubate
at least 1 h at room temperature. Optional: overnight at 4 �C.

13. Wash three times, 10 min each with 1� TBST.

14. Transfer membrane into secondary antibody solution. Incubate
at least 1 h at room temperature. Optional: overnight at 4 �C.

15. Wash three times, 10 min each with 1� TBST.

16. Equilibrate membrane in staining buffer for 1 min.

17. Transfer membrane into staining solution. Incubate until clear
signals can be monitored. Stop substrate reaction by washing
with H2O.

3.6 Yeast Colony

PCR and Sequencing

1. Prepare sterile PCR tubes, strips, or plates with 50 μl ddH2O
(see Note 11).

2. Add small amount of yeast material using a sterile pipette tip.

3. Boil the samples at 100 �C for 10 min using a PCR cycler.

4. Cool and spin down briefly to avoid cross-contaminations
when opening.

5. Prepare fresh tubes with 20 μl PCR master mix.

6. Use 10 μl of supernatant as sample and add into each well.

7. Run the following PCR program:

(a) 95 �C—2.00 min

(b) 95 �C—0.30 min

(c) 58 �C—0.30 min

(d) 72 �C—1.30 min

(e) 72 �C—3.00 min

(f) Repeat steps (b)–(d) 37 times.

8. Run 5 μl on a 1.5% agarose/TAE gel to determine successful
amplification and insert size. Use the remainder for sequencing.

4 Notes

1. Depending on the presence of signal peptides or transmem-
brane domains, prey proteins can be tagged with either N-
terminal NubG or C-terminal NubA. As mentioned in the
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introduction, mutating the isoleucine at position 13 prevents
spontaneous reassembly with Cub. Replacement by alanine
shows a slightly increased affinity towards Cub [4] and can
hence be used in the C-terminal Nub vectors that usually
perform weaker compared with the N-terminal Nubs [1, 10].

2. The mbSUS is ideally suited for structure function analysis of
proteins [12, 13] since the mating-based approach allows
biased screening of many different mutants against the same
interaction partner. Generation of mutants can best be done by
including a point mutation together with a silent mutation that
introduces a restriction site as identifier for each mutation [14].

3. In order to correctly interpret your data, it is crucial to always
include the whole set of controls, comprising both NubWt as
positive control and “empty” vectors as negative controls.
Moreover, biological negative controls might provide addi-
tional evidence for the specificity of an interaction.

4. For solid media, add a magnetic stir bar before autoclaving. To
give uniform growth conditions, measure 80 ml medium per
square plate (12 � 12 cm) or 30 ml into round plates (diam.
9 cm), respectively. Try to avoid air bubbles.

5. Efficient (co-)transformation of yeast depends on the cell con-
centration as well as on the amount of carrier and plasmid
DNA. Therefore we recommend to use at least 1 μg of plasmid
DNA. However, it is important to note that transforming three
plasmids at once results generally in lower transformation effi-
ciency which can be counterbalanced through upscaling of the
transformation mixture.

6. Red/white selection of diploid yeasts can be used as a prelimi-
nary tool to estimate positive/negative interactions. The effect
is based on theADE2 reporter gene, which encodes an enzyme
involved in the de novo synthesis of adenine. If ADE2 is not
activated due to the lack of interaction between bait and prey
peptides, cells accumulate a red colored intermediate, whereas
cells expressing interacting proteins become white.

7. The native structure and topology of an integral membrane
protein are important parameters that have to be considered to
determine tag orientation of bait proteins. It should always be
taken into account that the Cub-PLV tag has to reside in the
cytosol (not in the lumen of the ER or other compartments), as
the USPs are cytosolic enzymes and the cleaved PLV needs to
be able to diffuse into the nucleus. Also, the bait protein should
be large, and attached or integrated into a membrane to pre-
vent leakage of the fusion protein into the nucleus. Tools for
the prediction of membrane protein topology and signal pep-
tides such as “TMHMM” (http://www.cbs.dtu.dk/services/
TMHMM/) and “SignalP” (http://www.cbs.dtu.dk/
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services/ SignalP/) might be helpful to decide which bait
should be used.

To determine the interaction with soluble baits, we recom-
mend “cytoSUS” using a vector with an N-terminal OST4
transmembrane domain to artificially anchor the protein to
the ER membrane [11, 15]. Otherwise the construct itself
might diffuse into the nucleus and activate reporter genes due
to its PLV fusion, leading to false-positive results.

8. Before starting an experiment, yeast expressing the bait/Cub-
fusion proteins should be mated with soluble NubG and
NubWt peptides, respectively, to verify functionality/stability
and excluding self-activation (see Note 12). This includes
growth assays as well as immunoblots of the bait proteins
(Subheadings 3.4 and 3.5).

9. Increased assay stringency is achieved by expressing bait fusions
in low-copy ARS/CEN vectors under the control of the
methionine-repressible Met25 promoter. To identify both
strong and weak interactions, we usually apply methionine
concentrations of 0.5 μM–500 μM. However, methionine
above 500 μM should be avoided as yeast growth becomes
negatively affected by such concentrations.

10. It is helpful to print a dropping scheme and stick it under the
media plates to guide pipetting. To avoid satellite colonies, the
yeast drops should be placed carefully, and under no circum-
stances should the second pressure point of the pipette be used.
The surface of the media should be relatively dry to prevent
dispersion of the spots. Also, high (500 μM) levels of methio-
nine seem to break the surface tension of the solid media
causing carefully placed yeast drops to disperse on the surface.
For this reason, we recommend not to place more than eight
by eight yeast drops on a 12 cm square plate.

11. Contrary to our previous protocol [6], we repeatedly found in
the evaluation of colony PCR results since that DMSO seems
to inhibit the PCR reaction and should hence be omitted from
the PCRmix. Also, addition of 0.2 MNaOHwhich should aid
in lysis of yeast cells seems to negatively affect PCR fidelity.
Instead, boiling the yeast colonies in water should suffice to
extract an appropriate amount of template DNA for
subsequent PCR amplification.

12. If one of your fusion proteins is not expressing well, it might be
related to protein instability due to the tagging and thereby
masking of signal peptides or other recognition/processing
sites, especially in the N-terminal region. Also codon bias has
a crucial role in heterologous gene expression and nonoptimal
codon usage can limit the expression. Prior to codon optimi-
zation, we recommend to verify single colonies by western blot
(Subheading 3.5).
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Chapter 16

Analysis of Protein Glycosylation in the ER

Jennifer Schoberer, Yun-Ji Shin, Ulrike Vavra, Christiane Veit,
and Richard Strasser

Abstract

Protein N-glycosylation is an essential posttranslational modification which is initiated in the endoplasmic
reticulum. In plants, the N-glycans play a pivotal role for protein folding and quality control. Through the
interaction of glycan processing and binding reactions mediated by ER-resident glycosidases and specific
carbohydrate binding proteins, the N-glycans contribute to the adoption of a native protein conformation.
Properly folded glycoproteins are released from these processes and allowed to continue their transit to the
Golgi where further processing and maturation of N-glycans leads to the formation of more complex
structures with different functions. Incompletely folded glycoproteins are removed from the ER by a highly
conserved degradation process to prevent the accumulation or secretion of misfolded proteins and maintain
ER homeostasis. Here, we describe methods to analyze the N-glycosylation status and the glycan-
dependent ER-associated degradation process in plants.

Key words N-glycosylation, Glycoprotein, Oligosaccharyltransferase, Quality control, ERAD

1 Introduction

Glycosylation is a ubiquitous modification of newly synthesized
proteins in the endoplasmic reticulum (ER). Dependent on the
linkage of the oligosaccharide to the amino acid side chain of the
protein, there are two major types of glycosylation: N- and O-
glycosylation. O-glycosylation is quite diverse and various types of
O-glycans have been described for secretory proteins in eukaryotes
including mucin-type O-linked N-acetylgalactosamine (GalNAc)
or O-mannosylation [1, 2]. These O-glycosylation reactions are
initiated by the transfer of a single monosaccharide to serine or
threonine residues of proteins. While the O-glycan biosynthesis can
already be initiated in the ER, the majority of the O-glycan mod-
ifications take place in the Golgi. In plants, it has been proposed
that the plant-specific serine O-galactosylation of extensins or ara-
binogalactan proteins is initiated in the ER while further matura-
tion of glycans takes place in the Golgi [3].

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_16, © Springer Science+Business Media LLC 2018
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In contrast to O-glycosylation, N-glycosylation and early N-
glycan processing steps are highly conserved in all eukaryotes [4]. A
hallmark of N-glycosylation is the en bloc transfer of a common
preassembled oligosaccharide (Glc3Man9GlcNAc2) from the lipid
carrier dolichol pyrophosphate to selected asparagine residues in
the sequence Asn-X-Ser/Thr (X 6¼ P) within nascent polypeptides
[5] (see Note 1). The transfer of the oligosaccharide takes place at
the luminal side of the ER and is catalyzed by the oligosaccharyl-
transferase (OST) complex. In the ER, the attached N-glycans are
crucial for protein folding and for quality control processes. Nota-
bly, by exposing defined motifs the N-glycans orchestrate the fate of
glycoproteins in the ER [6]. In contrast to the conserved role of
ER-type oligomannosidic structures, complex N-glycans are gen-
erated in the Golgi and serve different protein-specific roles that are
not well understood in plants (Fig. 1a) [7–9].

1.1 N-Glycosylation The biosynthesis of the lipid-linked oligosaccharide starts on the
cytosolic side of the ER membrane by a number of different glyco-
syltransferases that have been initially characterized in yeast
(asparagine-linked glycosylation proteins—ALGs) [10]. The
synthesized Man5GlcNAc2-PP-Dol is flipped through the ER
membrane (Fig. 1b) and further elongated in the lumen of the
ER by three α-mannosyltransferases (ALG3, ALG9, and ALG12)
and three α-glucosyltransferases (ALG6, ALG8, and ALG10)
(Fig. 1b). Putative orthologs of these enzymes are present in the
plant genome and mutants with defects in the assembly of the
oligosaccharide precursor have been described [4]. For example,
knockout of the Arabidopsis thaliana ALG10 gene results in an
incomplete synthesis of the oligosaccharide precursor leading to
reduced glycosylation efficiency of proteins [11]. The observed
underglycosylation defect affects different glycoproteins and results
in a leaf growth phenotype.

The fully assembled oligosaccharide precursor is transferred by
OST to asparagine resides within the consensus sequence. In yeast,
OST is a heteromeric membrane-bound protein complex [12]
consisting of one catalytically active subunit (STT3) and several
different non-catalytic subunits that contribute to N-glycosylation
by regulation of the substrate specificity, stability, or assembly of the
complex [12]. Mammals harbor two different catalytic isoforms
(STT3A and STT3B) that are present in distinct OST complexes
and differ in their catalytic activity and acceptor substrate selectivity
[13]. While STT3A is predominately involved in co-translational
glycosylation, STT3B displays a preference for posttranslational
glycosylation [14]. The transfer of the preassembled oligosaccha-
ride in plants involves a similar OST multi-subunit complex, which
is still poorly characterized. In A. thaliana, two proteins (STT3A
and STT3B) with homology to yeast and mammalian catalytic
subunits have been identified [15]. STT3A-deficient plants are
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viable, but display a protein underglycosylation defect that impairs
the biogenesis of different heavily glycosylated proteins, such as the
pattern recognition receptor EF-TU RECEPTOR (EFR) or the
endo-β1,4-glucanase KORRIGAN1 [7, 16, 17]. By contrast, much
less is known about STT3B function and its substrates. Notably,

Fig. 1 (a) Schematic representation of two major N-glycan structures in plants: ER-type oligomannosidic and
Golgi-processed complex N-glycans. (b) N-glycosylation and N-glycan processing in the ER of plants. The
dolichol-linked Man5GlcNAc2 intermediate is translocated from the cytosol into the lumen of the ER (the
preceding cytosolic biosynthesis steps are not shown). In the lumen of the ER, mannose residues are
sequentially added by the α-mannosyltransferases ALG3, ALG9, and ALG12. Further elongation of the
oligosaccharide is carried out by the α-glucosyltransferases ALG6, ALG8, and ALG10. The fully assembled
Glc3Man9GlcNAc2 oligosaccharide is transferred to selected asparagine residues by the oligosaccharyltrans-
ferase (OST) complex. Upon transfer, terminal glucose residues are trimmed by α-glucosidase I (GCSI) and II
(GCSII). A terminal glucose residue is required for the interaction with calnexin (CNX) and calreticulin (CRT) that
support folding of the glycoproteins. Properly folded proteins may be further processed in the ER by the α-
mannosidase MNS3 [22] and are allowed to exit to the Golgi which is the site for complex N-glycan formation.
In the ER, terminally misfolded proteins are subjected to processing by the α-mannosidases MNS4 and MNS5
which results in the degradation by the OS9-SEL1L-HRD1 complex [24]. The symbols for representation of the
glycan structures follow the style of the Consortium for Functional Glycomics (www.functionalglycomics.org)
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A. thaliana stt3a stt3b double knockouts are gametophytic lethal
[15] highlighting the importance of the catalytic OST subunit for
protein N-glycosylation in plants. Other subunits that have been
characterized include DGL1 andOST3/6 [18, 19] (Fig. 2a). While

Fig. 2 (a) Schematic representation of the OST subunits and their predicted topology [4]. Subunits which likely
interact (based on co-IP experiments) [19] are depicted in red, orange, and yellow. Other subunits are shown
in grey. (b) Protein extracts from A. thaliana leaves were analyzed by immunoblotting with anti-TGG1 or anti-
tubulin (non-glycosylated control) antibody. The shift in mobility indicates underglycosylation of TGG1 in the
ost3/6 and alg10 mutants. The ConA lectin blot shows an overall weaker signal in the alg10 mutant and some
bands display an altered migration which is consistent with the underglycosylation defect. (c) OST4A-mRFP
interacts with STT3A-HA. Proteins were transiently co-expressed in N. benthamiana leaves and extracts were
analyzed 2 dpi. OST4A-mRFP was purified by RFP-Trap®_A beads and co-isolated STT3A-HA was monitored
by immunoblotting with anti-HA antibodies. Note: due to the presence of numerous transmembrane helices
STT3A-HA displays anomalous gel mobility. (d–g) Analysis of fluorescent proteins was done by confocal
microscopy. Bars ¼ 20 μm. The indicated constructs were transiently expressed in N. benthamiana leaves
and analyzed 2 dpi
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DGL1 appears essential for plants, OST3/6-deficient plants do not
display any growth phenotype but are compromised in their immu-
nity. In addition, it has recently been shown that OST3/6 is
required for the interspecific gametophyte recognition in A. thali-
ana [20].

1.2 N-Glycan

Processing in the ER

Specific processing of N-glycans in the ER generates distinct oligo-
saccharide structures that expose signals for quality control pro-
cesses or degradation. Upon transfer of the preassembled
oligosaccharide to the polypeptide chain, glucosidase I (GCSI)
and II (GCSII) remove the two outermost glucose residues. The
resulting monoglucosylated N-glycan can interact with the lectins
calnexin (CNX) and calreticulin (CRT) to promote folding. In the
current models, release from the CNX/CRT interaction requires
the trimming of the remaining glucose by GCSII. Re-addition of
the single glucose by the folding sensor UDP-glucose:glycoprotein
glucosyltransferase (UGGT) facilitates prolonged interaction with
CNX/CRT [21]. Several rounds of glucose trimming, re-
glucosylation, and interaction with CNX/CRT are possible until
proteins attain their final conformation and are released from this
glycan-dependent quality control process.

The N-glycans from properly folded proteins or from folding
intermediates may be subjected to further processing in the ER
which is catalyzed by the α-mannosidase MNS3. Analysis of the
substrate specificity revealed that MNS3 displays the typical ER-α-
mannosidase I activity that has been described in mammals and
yeast [22]. In contrast to yeast, however, MNS3 is mainly located in
small punctate structures resembling Golgi bodies. Whether this
characteristic subcellular localization of MNS3 is linked to its func-
tion in N-glycan processing is currently unclear. The processed
glycoproteins typically carry the oligomannosidic N-glycans Man7-
GlcNAc2, Man8GlcNAc2, or Man9GlcNAc2. Further processing
takes place in the Golgi and is initiated by Golgi α-mannosidase I
(MNS1/MNS2)-mediated trimming of mannose residues resulting
in the formation of Man5GlcNAc2.

1.3 N-Glycan-

Dependent Quality

Control and ER-

Associated

Degradation

Tomaintain protein homeostasis in the ER, all eukaryotic cells have
a conserved machinery that selects aberrant or incompletely assem-
bled proteins for degradation. In mammals and yeast, this ER-
associated degradation (ERAD) pathway involves recognition of
the misfolded protein, retro-translocation from the ER to the
cytoplasm, ubiquitination of the protein and its subsequent dis-
posal by the 26S proteasome [23]. While the latter steps have not
been characterized in detail in plants, the selection and delivery
reactions that take place in the lumen of the ER appear highly
conserved. If folding attempts are unsuccessful, the α-mannosi-
dases MNS4 and MNS5 cleave a terminal mannose residue from
the C-branch of the oligomannosidic N-glycan [24]. The exposed
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α1,6-linked mannose residue is recognized by the lectin-like pro-
tein OS9 and delivered to the SEL1L-HRD1 ERAD complex
resulting in the degradation of the aberrant glycoprotein [25]
(Fig. 1b).

Here, we provide protocols to address different aspects of
protein N-glycosylation, N-glycan processing, and glycan-
dependent ERAD that take place in the lumen of the ER.

2 Materials

1. A. thaliana seeds with characterized underglycosylation
defects can be purchased from the European Arabidopsis
Stock Center (alg10-1: NASC ID: N874475) [11, 15]. Seeds
with defects in glycan-dependent ERAD are available from
NASC (os9-1: N529413; mns4 mns5: double mutant can be
obtained by crossing of N656907 and N162962) [24, 26].
The bri1-9 seeds were kindly provided by Frans E. Tax. The
ost3/6-1 seeds can be requested from the Strasser group [19].

2. Mixer mill with steel beads.

3. Container with liquid nitrogen.

4. Refrigerated benchtop centrifuge with a relative centrifugal
force of 9400 � g or higher and a rotor for 1.5/2 mL micro-
centrifuge tubes.

5. Thermo block.

6. Orbital shaker.

7. Vertical electrophoresis system.

8. Tank transfer system.

9. Power supply with at least 100 V and 400 mA.

10. SDS-PAGE (10–12%) gels.

11. Tris/glycine/SDS-PAGE running buffer: (25 mM Tris,
192 mM glycine, 0.1% (w/v) SDS.

12. 3� Laemmli sample buffer: 187.5 mMTris pH 6.8, 30% (w/v)
glycerol, 6% (w/v) SDS, 15% (v/v) β-mercaptoethanol, 0.15%
(w/v) bromophenol blue.

13. Prestained protein standard.

14. Tris/glycine/methanol transfer buffer: 25 mM Tris, 192 mM
glycine, 20% (v/v) methanol.

15. Blotting paper.

16. Nitrocellulose blotting membrane.

17. 1� PBS: phosphate buffered saline: 137 mM NaCl, 2.7 mM
KCl, 10 mM Na2HPO4, 2 mM KH2PO4, pH 7.4.

18. PBST: 1� PBS + 0.1% (v/v) Tween 20.

210 Jennifer Schoberer et al.



19. 1� TBS: Tris buffered saline (25 mM Tris, pH 7.5, 150 mM
NaCl, 2 mM KCl).

20. TBST: 1� TBS + 0.1% (v/v) Tween 20.

21. Blocking solution for immunoblots: TBST + 5% (w/v)
skimmed milk powder or PBST + 3% (w/v) BSA.

22. Western blotting detection reagent: as an example, we use
SuperSignal West PICO Chemiluminescent Substrate or ECL
Prime Western Blotting Detection Reagent.

23. Sensitive films for detection: for example, we use Amersham
Hyperfilm ECL (GE Healthcare).

24. Film developer and fixer solutions.

25. Rat monoclonal HA antibody (Roche 11867423001): 1:2000
diluted in TBST + 1% (w/v) BSA.

26. Polyclonal TGG1 antibody: custom-made antibody against the
TGG1 peptide (AQNNQTIVPSDVHT): 1:10,000 diluted in
PBST + 3% (w/v) BSA.

27. Polyclonal BRI1 antibody (Agrisera: AS12 1859): 1:5000
diluted in TBST + 5% (w/v) skimmed milk powder.

28. Rat monoclonal RFP antibody (ChromoTek: 5F8): 1:1000
diluted in PBST + 1% (w/v) BSA.

29. Mouse monoclonal GFP antibody (Roche: 11814460001):
1:2000 diluted in PBST + 3% (w/v) BSA.

30. Mouse monoclonal α-tubulin antibody (Sigma-Aldrich:
T6074): 1:5000 diluted in PBST + 1% (w/v) BSA.

31. Concanavalin A-peroxidase (ConA-HRP, Sigma-Aldrich:
L6397): ConA solution: 0.5 μg/mL Con A-HRP in PBST
containing 1 mM MnCl2, 1 mM CaCl2, 1 mM MgCl2.

32. Anti-rabbit IgG-peroxidase (such as Sigma A0545): 1:5000
diluted in TBST + 5% (w/v) skimmed milk powder for BRI1
detection and 1:50,000 diluted in TBST for TGG1 detection.

33. Anti-mouse IgG-peroxidase (such as Sigma A9044): 1:10,000
diluted in TBST for detection of GFP and α-tubulin.

34. Anti-rat IgG-peroxidase (Jackson): 1:10,000 diluted in
PBST + 0.5% (w/v) BSA for detection of RFP and HA-tagged
proteins.

35. Endoglycosidase H (Endo H, we use 500,000 units/mL, New
EnglandBiolabs) +GlycoBuffer 3 (NewEnglandBiolabs) + 10�
Glycoprotein Denaturing Buffer (New England Biolabs).

36. Empty micro spin chromatography columns.

37. Nonidet P-40 (10% solution).

38. Kifunensine (Santa Cruz Biotechnology): class I α-mannosi-
dase inhibitor, dissolved in ultrapure water.
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39. RIPA buffer: 150 mM NaCl, 1.0% (v/v) Nonidet P-40, 0.5%
(v/v) sodium deoxycholate, 0.1% (w/v) SDS, 50 mM Tris,
pH 8.0.

40. RFP-Trap®_A beads (ChromoTek) for purification of RFP-
tagged proteins.

41. Protein A Sepharose (such as rProtein A Sepharose Fast Flow
from GE Healthcare).

42. Coomassie Brilliant Blue staining solution: 0.25% (w/v) Coo-
massie Brilliant Blue R-250, 10% (v/v) acetic acid, 50% (v/v)
methanol.

43. Infiltration buffer: 0.5% (w/v) D-glucose, 50 mM 2-(N-mor-
pholino)ethanesulfonic acid (MES), 2 mM Na3PO4, 0.1 mM
acetosyringone.

44. Agrobacterium tumefaciens strain UIA143 pMP90 [27].

45. LB Broth (Lennox): 10 g/L tryptone, 5 g/L NaCl, 5 g/L
yeast extract. Sterilize by autoclaving, supplement with 50 mg/
L kanamycin 25 mg/L gentamicin.

46. MS medium: 0.5� Murashige and Skoog (MS) medium
including MES buffer supplemented with 0.8% (w/v) agar
and 1% (w/v) sucrose.

3 Methods

3.1 Monitoring of

Protein

Underglycosylation

N-glycosylation efficiency can be monitored by comparison of
differences in mobility upon SDS-PAGE and immunoblotting of
glycoproteins (see Note 2). Reduced N-glycosylation efficiency
causes underglycosylation of glycoproteins which typically results
in a faster migrating protein due to the reduced molecular weight
(seeNote 3). As a result, a single faster migrating band representing
a partially or non-glycosylated variant can be detectable (Fig. 2b) or
several bands might appear representing a mixture of differentially
glycosylated proteins (fully glycosylated, partially glycosylated, and
unglycosylated variants) (see Note 4). Protein underglycosylation
has been described in several A. thaliana mutants which can be
used as controls (e.g., mutants with defects in one of the OST
subunits such as stt3a-2 (15) or ost3/6-1 [19] or mutants with
defects in the assembly of the oligosaccharide precursor like alg10
[11] (seeNote 5).A. thaliana beta-thioglucoside glucohydrolase 1
(TGG1) is a heavily glycosylated protein that is expressed in high
amounts in leaves [28] and has been used in several studies to show
a reduction in protein glycosylation efficiency [11, 15]. In addition,
protein underglycosylation can also be detected by an overall
reduced signal with the lectin ConA that recognizes terminal α-
linked mannose residues from oligomannosidic N-glycans (see
Notes 6 and 7).
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1. Harvest 10–100 mg of plant material (e.g., rosette leaves) from
mutants and Columbia (Col-0) wild-type and transfer to 2 mL
Eppendorf Safe-lock microcentrifuge tubes containing two
steel beads (5 mm diameter) per tube.

2. Submerge 2 mL tubes with plant material in container with
liquid nitrogen.

3. Mount 2 mL tubes in mixer mill and run mixing for 2 min at
50–60 amplitude.

4. Add 4 μL extraction buffer such as PBST per mg of plant
material, vortex shortly, transfer mixture into a 1.5 mL tube.

5. Incubate on ice for 15 min, invert tube every 3 min.

6. Centrifuge two times 15 min, 9600 � g at 4 �C, transfer
supernatant each time to a new tube.

7. Mix samples with 3� Laemmli sample buffer and heat to 95 �C
for 5 min.

8. Load SDS-PAGE gel with 20 μL and run protein separation for
1.5 h at 100 V.

9. Soak nitrocellulose membrane, sponges, and blotting paper in
transfer buffer.

10. Perform the gel-membrane assembly according to the user
manual.

11. Blot for 1 h at 100 V, disassemble gel-membrane sandwich, and
carefully rinse the membrane with ultrapure water.

12. Incubate in blocking solution for 1 h at room temperature.

13. Rinse briefly with PBST and incubate membrane on a shaker
for 1.5 h at room temperature in the antibody solution (in our
example, use a TGG1 antibody to detect changes in N-
glycosylation and an antibody against a non-glycosylated pro-
tein like α-tubulin as a control).

14. After incubation, wash four times 5 min with TBST and add
secondary antibody solution to the membrane, incubate 1.5 h
at room temperature on a shaker. Omit this step for ConA
detection, because the used ConA protein is covalently linked
to horseradish peroxidase.

15. Wash four times 5 min in TBST, perform detection using the
chemiluminescent substrate, and develop the film.

3.2 Co-IP

and Subcellular

Localization

of OST Subunits

Agroinfiltration of Nicotiana benthamiana leaves is a fast proce-
dure for protein expression and subsequent co-localization studies
by confocal laser scanning microscopy or for monitoring of com-
plex formation by co-immunoprecipitation (co-IP). These proto-
cols have, for example, been used to characterize unknown subunits
of the A. thaliana OST complex [19] (Fig. 2a and c).
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1. Grow A. tumefaciens in LB liquid culture supplemented with
the appropriate antibiotics for 16 h at 29 �C.

2. Spin down 500 μL of the overnight culture containing the
construct for expression of the glycan-modifying enzyme and
wash pellet twice with infiltration buffer. Dilute the agrobac-
teria suspension with infiltration buffer to an OD600 (optical
density at 600 nm) of 0.1.

3. For co-localization of GFP and mRFP fusion proteins, mix two
or more agrobacteria suspensions and co-infiltrate the whole
mixture into fully expanded leaves of 5–6-week-old N.
benthamiana plants using a 1 mL syringe without a needle.
The analysis of subcellular localization by confocal microscopy
has been described in detail previously [29].

4. Briefly, sections of infiltrated leaves are analyzed 1–3 days post-
infiltration (dpi) on a Leica TCS SP5 confocal microscope
equipped with �63 and �100 oil immersion objectives using
appropriate spectral selections. Post-acquisition image proces-
sing is performed in IMAGEJ and ADOBE PHOTOSHOPCS
(Fig. 2d–g).

5. For co-IP, harvest 500 mg of leaves and extract the proteins
with RIPA buffer following the grinding steps as described in
Subheading 3.1.

6. Per sample equilibrate 50 μL RFP-Trap®_A bead slurry in
500 μL of dilution buffer (RIPA buffer without detergents).

7. Centrifuge at 2500 � g for 2 min, discard the supernatant and
repeat wash twice.

8. Add 2 mL of the clear protein extract to equilibrated RFP-
Trap®_A beads and incubate for 1 h at 4 �C using an orbital
shaker.

9. The RFP-Trap®_A beads with the bound proteins are washed
four times with dilution buffer and proteins are eluted by
incubation at 95 �C for 10 min in 50 μL 1� Laemmli buffer.

10. To collect the bound proteins, perform centrifugation at
2500 � g for 2 min using micro spin columns.

11. The protein extracts and the eluate are subjected to SDS-PAGE
and immunoblotting with anti-HA and anti-mRFP antibodies
as described above for monitoring of protein underglycosyla-
tion (see Note 8) (Fig. 2c).

3.3 Characterization

of ER-Type

Oligomannosidic

N-Glycans

ER-resident proteins typically carry oligomannosidic N-glycans
because these proteins are not in contact with the Golgi-located
machinery for complex N-glycan processing (Fig. 1b). Such oligo-
mannosidic N-glycans are sensitive to digestion by endoglycosidase
H (Endo H) which cleaves between the chitobiose core to release
the majority of the oligosaccharide (Fig. 3a). As a consequence,
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Endo H digestion of oligomannosidic N-glycans will result in a
reduced molecular weight that can be monitored by SDS-PAGE
and immunoblotting. Proteins with complex N-glycans are resis-
tant to Endo H digestion and do not cause a similar change in the
molecular weight (Fig. 3a). Endo H treatment has been used to
show that a misfolded variant of the brassinosteroid receptor BRI1
accumulates in the ER in the bri1-9 mutant [30]. By contrast,
correctly folded BRI1 is secreted and carries primarily Golgi-
processed complex N-glycans (see Note 9).

Fig. 3 (a) Endo H digestion and detection of BRI1 glycosylation in protein extracts from Col-0 wild-type and the
bri1-9 mutant. BRI1 in Col-0 is only partially deglycosylated (few oligomannosidic N-glycans are present) as
visible by the minor shift in mobility (band >130 kDa). Endo H treatment of BRI1 in the mutant results in
complete deglycosylation (band <130 kDa). The cartoon illustrates the cleavage specificity of Endo H. For
description of sugar symbols, see Fig. 1. (b) Transiently expressed SP-Fc-GFP-HDEL was purified and the
glycopeptide (peptide sequence: TKPREEQYNSTYR—N-glycosylation site is underlined) from the Fc domain
was subjected to LC-ESI-MS analysis. Peak labels were made according to the ProGlycAn system (www.
proglycan.com)
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1. Incubate 22.5 μL protein extract with 2.5 μL 10� Glycopro-
tein Denaturing Buffer for 10 min at 50 �C, transfer to ice and
cool for 5 min.

2. Mix 22.5 μL of the denatured glycoproteins with 3 μL 10�
GlycoBuffer 3, 3 μL ultrapure water, and 1.5 μL Endo H.

3. For the control reaction, replace the 1.5 μL Endo H with
ultrapure water.

4. Incubate for 90 min at 37 �C and stop the reaction by heating
to 50 �C for 5 min.

5. Subject samples to SDS-PAGE and perform immunoblotting,
for example with anti-BRI1 antibody (Fig. 3a) to distinguish
between ER-retained and secreted BRI1 variants.

6. To confirm the presence of oligomannosidic N-glycans, glyco-
proteins can be purified and subjected to mass spectrometry.

The attachment of the HDEL or KDEL ER-retrieval pep-
tide sequence to the C-terminal end leads to the steady-state
accumulation of proteins in the ER. An example for such a
protein is a chimeric protein consisting of an N-terminal signal
peptide, the Fc domain region from human IgG, GFP and the
HDEL peptide (SP-Fc-GFP-HDEL). This protein can be
expressed transiently in N. benthamiana leaves as described in
Subheading 3.2 and ER accumulation can be monitored by
confocal microscopy. Efficient one-step purification of this pro-
tein is achieved by affinity chromatography using binding of
the Fc domain region to bacterial Protein A (see Note 10).

7. Harvest 1 g of leaves 2 dpi and extract proteins in RIPA buffer
as described in Subheading 3.2.

8. Add 50 μL protein A sepharose that has been washed several
times with 1� PBS.

9. Incubate for 1.5 h at 4 �C using an orbital shaker, spin down
briefly, and discard the supernatant.

10. Wash the sepharose three times with 250 μL 1� PBS using
micro spin columns.

11. Elute the Fc domain-containing protein from the column by
adding 50 μL 1� Laemmli buffer.

12. Elute as described for the RFP-Trap®_A purification and sepa-
rate by SDS-PAGE.

13. Stain the gel with Coomassie Brilliant Blue and excise the
glycoprotein band from the gel. Perform S-alkylation,
digestion with trypsin (see Note 11) and analyze the resulting
glycopeptides by liquid chromatography-electrospray
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ionization-mass spectrometry (LC-ESI-MS) (Fig. 3b). The
detailed procedure for this MS-based glycopeptide analysis
has been described recently [31].

3.4 Monitoring of

Glycan-Dependent

ERAD

Glycan-dependent ERAD is a major pathway for disposal of mis-
folded glycoproteins from the ER. To monitor whether a protein is
subjected to glycan-dependent ERAD the class I α-mannosidase
inhibitor kifunensine can be used. Kifunensine blocks the trimming
of terminal α-linked mannose residues which is mediated by class I
α-mannosidases [32]. The exposure of an α1,6-linked mannose
residue (Fig. 1b) to the ERAD machinery (including proteins like
OS9, SEL1L, and HRD1) is a highly conserved hallmark of glycan-
dependent ERAD in different species [24, 33–35]. Kifunensine
blocks the formation of the exposed α1,6-linked mannose
residue and thus blocks the degradation of ERAD substrates
(Fig. 4a) (see Note 12).

Fig. 4 (a) Illustration of the processing by MNS4/MNS5 which generates the N-glycan that serves as
degradation signal for misfolded glycoproteins. The class I α-mannosidase inhibitor kifunensine (Kif) blocks
the mannose trimming and leads to accumulation of misfolded glycoproteins (ERAD substrates) in the ER.
Likewise, OS9 or MNS4/MNS5 deficiency blocks the degradation. MNS3 may act on the Man9GlcNAc2 N-
glycan but is not necessary for glycan-mediated ERAD [24]. (b) The ERAD substrate SUBEX-C57Y-GFP
consisting of a misfolded variant of the glycosylated extracellular domain from STRUBBELIG fused to GFP is
degraded in Col-0 wild-type and accumulates in the os9 or mns4 mns5 mutants as well as in the presence of
Kif [42]. A non-glycosylated variant of the misfolded protein is not degraded by the same pathway highlighting
the glycan dependency of the protein disposal pathway
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1. Detach leaves from 4-week-oldA. thaliana plants, cut them into
small pieces (alternatively whole seedlings can be used in the
same way), and submerge in 0.5� MS medium supplemented
with 20 μM kifunensine.

2. Incubate at 22 �Cwith gentle shaking under long day conditions
(16 h light/8 h dark) for 24 h.

3. Harvest seedlings, remove excess liquid and extract protein as
described under Subheading 3.1. To monitor the accumulation
of the ERAD substrate, perform immunoblotting with appro-
priate antibodies (Fig. 4b).

4. An increased signal in the presence of the inhibitor indicates the
involvement of a glycan-dependent degradation pathway.

5. To substantiate the finding, the fate of the misfolded glycopro-
tein can be analyzed in different mutants with distinct defects in
glycan-dependent ERAD [24, 26].

4 Notes

1. Apart from Asn-X-Ser/Thr, there is the rare possibility for the
use of noncanonical glycosylation sites like Asn-X-Cys [36, 37].
The sequon is necessary but not sufficient for N-glycosylation.
N-glycosylation efficiency is dependent on many factors involv-
ing the amino acid sequence close to the N-glycosylation site,
the secondary structure, the positioning of the site within the
protein [13], and organism-specific difference in the composi-
tion and function of the OST subunits [12].

2. A shift in mobility can also be caused by other posttranslational
modifications including proteolytic processing. Digestion of
protein extracts with endoglycosidases that remove oligoman-
nosidic or complex N-glycans is a way to support the observa-
tion of underglycosylation. However, complex N-glycans
carrying core α1,3-fucose cannot be efficiently removed from
whole proteins using endoglycosidases which can complicate
the interpretation of the results. Additional blots with antibo-
dies against complex/paucimannosidic N-glycans and lectins
that bind to mannose residues can be used to further support a
protein underglycosylation defect (see also the procedure for
detection of glycoproteins that are recognized by ConA). Apart
from the described immunoblot-based protocols, purification
of the protein with subsequent mass spectrometric (MS) analy-
sis and quantification of glycosylated versus non-glycosylated
peptide should be used to confirm the underglycosylation
defect [31].

3. In some cases, a clear protein band cannot be detected anymore
in a protein underglycosylation mutant (e.g., KORRIGAN1 in
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stt3a-2) [7]. Most likely, the absence of distinct N-glycans
interferes with proper folding leading to degradation or aggre-
gation (exposure of hydrophobic sequence stretches that are
otherwise shielded by N-glycans) of these proteins.

4. These differences depend on the number of N-glycans and
other protein intrinsic features that are involved in N-
glycosylation. For example, some of the noncatalytic OST
subunits have accessory function and can slow down protein
folding to keep the polypeptide in a glycosylation-competent
state [13].

5. Additional approaches can be used that suggest a possible
reduction in glycosylation efficiency. These approaches involve
treatment of seedlings with tunicamycin. Tunicamycin is an
inhibitor that blocks N-glycosylation by interfering with one
of the early steps of the lipid-linked oligosaccharide biosynthe-
sis pathway. Plants with defects in N-glycosylation are typically
more sensitive to tunicamycin [38].

6. An altered signal with ConA could also result from changes in
complex N-glycan formation (e.g., increased signal in the cgl1
mutant that lacks complex N-glycans). It is therefore recom-
mended to combine the ConA lectin blot with immunoblots
using antibodies against complex N-glycans [39].

7. In an alternative approach, protein underglycosylation can be
detected in A. thaliana by restoration of complex N-glycan
formation in the cgl1 mutant. This approach has been
described in detail recently [39].

8. While co-IP can be helpful to identify the components of a
protein complex, it does not provide spatiotemporal informa-
tion on direct interactions of the investigated proteins. There-
fore, alternative approaches like FRET-FLIM should be applied
for monitoring of real-time protein–protein interactions in cells
[40].

9. Oligomannosidic N-glycans can also be found on secreted
proteins that are not trafficking through the Golgi (e.g., due
to direct ER-to-vacuole protein trafficking). In addition, some
N-glycans are not accessible for Golgi-mediated N-glycan pro-
cessing (e.g., steric hindrance of N-glycan processing) resulting
in the presence of oligomannosidic N-glycans on some secreted
or plasma-membrane anchored proteins (see also Endo H
digestion of BRI1 in Col-0 in Fig. 3a). It is therefore necessary
to perform additional experiments (e.g., confocal microscopy
of fluorescent fusion proteins) to confirm ER localization.

10. Purification with an immobilized antibody against GFP could
also be used instead of binding to Protein A. While such pro-
tocols work equally well with our fusion proteins, there are
more suppliers for Protein A-related reagents than for reagents
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that can be used for purification of GFP-tagged proteins. Con-
sequently, Protein A-based purification is typically less expen-
sive than purifications based on GFP-binding proteins.
Alternatively, an antibody specific for an (ER-resident) glyco-
protein can be used for purification and subsequent N-glycan
analysis. Due to the low expression levels, such protocols typi-
cally require extensive optimization.

11. The choice of the protease is dependent on the amino acid
sequence. Separate or sequential digestion with alternative
enzymes, such as Glu-C, Asp-N, or chymotrypsin, is sometimes
necessary to improve the detection of glycopeptides [31].

12. Although the components of the glycan-dependent ERAD
pathway are already well known, the steps that lead to the
recognition of aberrant glycoproteins as well as the down-
stream steps that lead to their disposal are currently unclear.
In mammals and yeast, the ERAD degradation pathway
involves translocation into the cytoplasm, ubiquitination, and
proteasomal degradation. In plants, the involvement and role
of the proteasome in degradation of glycoprotein ERAD sub-
strates is unclear [41, 42].
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Chapter 17

The Unfolded Protein Response

Kazuki Tabara, Yuji Iwata, and Nozomu Koizumi

Abstract

Under the unfolded protein response (UPR), transcripts encoding the endoplasmic reticulum (ER)
chaperones are increased and those encoding proteins synthesized in the ER are decreased. To reproducibly
detect such changes of an expression profile, homogeneous growth of plants is desired. In addition, uniform
treatment with drugs inducing the UPR is also necessary. Here we describe our methods of plant culture
and drug treatment, and procedure to detect gene expression by quantitative RT-PCR.

Key words Quantitative RT-PCR, Tunicamycin, Dithiothreitol, L-Azetidine-2-carboxylic acid,
Arabidopsis

1 Introduction

The unfolded protein response (UPR) or the endoplasmic reticu-
lum (ER) stress response is a cellular response highly conserved
among eukaryotes [1, 2]. In general, accumulation of misfolded or
unfolded proteins induces transcription of genes encoding the ER
chaperones during the UPR. Even though several environmental
stresses may cause the UPR, effects of any of those stresses are not
obvious especially in plants. Then, drugs that disturb folding of
proteins are often used to induce the UPR not only in plant cells
but also in other organisms such as yeast and animals. In addition to
induction of genes encoding the ER chaperones and folding
enzymes, degradation of mRNA encoding a wide range of proteins
translated in the ribosomes attached to the ER membrane is
observed during the UPR in plants as well as in other organisms
with some exception [3–5]. This phenomenon has been known as
regulated IRE1-dependent decay of mRNA (RIDD). Drugs are
also used to observe RIDD. Popular drugs inducing the UPR are
tunicamycin, a potent inhibitor of asparagine-linked glycosylation
[6], dithiothreitol (DTT), a reducing agent disturbing disulfide
bond formation [7], and L-azetidine-2-carboxylic acid (AZC), a
proline analog that is incorporated to polypeptides and disturbs
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protein folding [8]. Treatment of yeast cells or cultured animal cells
is considered to be easier than plant cells since they are mostly
uniform cells. If cultured plant cells are available, it would be also
useful. However, inducing cultured cells from plants such as arabi-
dopsis is somewhat laborious and limits the use of a number of
mutants to be tested. Then, a culture method of more or less
homogeneous arabidopsis plantlets suitable for drug treatments is
desired.

Here we describe our routine protocol of cultivation and drug
treatment of arabidopsis plantlets [9–12]. Detection of induction
of representative chaperone genes and degradation of RIDD target
by quantitative RT-PCR (qRT-PCR) are also described [13].

2 Materials

Analytical grade reagents and pure water are used for preparation of
medium and solution unless indicated otherwise. Medium and
solution can be stored at room temperature also unless indicated.

2.1 Sterilized

Plantlets

1. 70% ethanol: Dilute 99.5% EtOH with water.

2. 1% Hypochlorous acid (NaClO) solution: Dilute 5% NaClO
with water.

3. 0.1% agar: Dissolve 0.1 g of agar in 100 mL of water and
autoclave.

4. 1/2 MS medium with 1% sucrose: Dissolve premixed MS
(Murashige and Skoog) salt (for 1 L) in 100 mL of water
(this is 20� MS stock). Take necessary amount for the experi-
ment, fill up with water, and add sucrose at a final concentra-
tion of 1% (see Note 1). Adjust pH to 5.6 with KOH and
autoclave.

5. Sterilized 12- or 24-well titer plates.

2.2 Drugs Inducing

the UPR

1. Tunicamycin stock solution (5 mg/mL): Dissolve 10 mg of
tunicamycin in 2 mL of dimethyl sulfoxide (DMSO). Store at
�20 �C (see Note 2).

2. DTT stock solution (1M): Dissolve 154mg of DTT in 1mL of
sterilized ultrapure water. Store at �20 �C.

3. AZC stock solution (2 M): Dissolve 101 mg of AZC in water.
Store at �20 �C.

2.3 Extraction of RNA 1. 1.5 and 2 mL microtubes.

2. Aluminum oxide beads (Φ4 mm) (Nikkato Ltd.) (see Note 3).

3. Bead mill: TissueLyser II System (QIAGEN) (see Note 4).

4. RNA extraction buffer: 38% (V/V) of buffer saturated phenol,
0.8 M of guanidine thiocyanate, 0.4 M ammonium
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thiocyanate, 0.1 M sodium acetate, and 5% glycerol (V/V).
Ultrapure water is used for preparation of solution.

5. High salt buffer: 0.8 M sodium citrate and 1.2 M sodium
chloride. Ultrapure water is used for preparation of solution.

6. 3 M sodium acetate.

7. Chloroform.

8. Isopropanol.

2.4 qRT-PCR 1. DNase (see Note 5).

2. Applied Biosystems™ High Capacity cDNA Reverse Tran-
scription Kit.

3. THUNDERBIRD® SYBR qPCR Mix (TOYOBO LIFE
SCIENCE).

4. 7300Real Time PCR System, Applied Biosystems™ (seeNote 6).

5. qRT-PCR primers: (see Note 7).

Housekeeping gene (internal standard):

Act8-F TCAGCACTTTCCAGCAGATG

Act8-R ATGCCTGGACCTGCTTCAT

UPR genes:

BiP1-F TCAGTCCTGAGGAGATTAGTGCT

BiP1-R TGCCTTTGAGCATCATTGAA

BiP3-F CGAAACGTCTGATTGGAAGAA

BiP3-R GGCTTCCCATCTTTGTTCAC

RIDD target genes:

MBL1-F CTTTGATTCTCCCACCGACA

MBL1-R CTTGGCTTCCATCACGAGAC

PR-4-F GTGGGATGCTGATAAGCCGTA

PR-4-R TGCAGCATTTGTTCTTGTGTTCT

3 Methods

3.1 Cultivation of

Arabidopsis Plantlets

in Sterilized Condition

1. Take arabidopsis seeds in a 1.5 mL microtube (see Note 8).

2. Add 1mLof 70%EtOHandmix by vortex for 1min (seeNote 9).

3. Centrifuge briefly and discard 70% EtOH.

4. Add 1 mL of 1% hypochlorous acid (NaClO) solution.

5. Vortex for 5 min.

6. Centrifuge briefly and discard NaClO solution as much as
possible.
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7. Add 1 mL sterilized water in a laminar flow hood and mix with
vortex.

8. Centrifuge briefly and remove sterilized water in a laminar flow
hood.

9. Repeat washing step by sterilized water four more times (see
Note 10).

10. Discard sterilized water; add 1 mL of 0.1% sterilized agar and
mix gently to disperse seeds.

11. Keep seeds in 0.1% agar at 4 �C for 2 days (see Note 11).

12. Prepare sterilized 24-well plates and add 1 mL of 1/2 MS
medium with 1% sucrose (see Note 12).

13. Sow three to five seeds into each well using the micropipette
(see Notes 13 and 14).

14. Incubate at 22 �C under 16-h light and 8-h dark condition
with gentle shaking (90–100 rpm) until drug treatment and
harvest (Fig. 1) (see Note 15).

3.2 Drug Treatment 1. Add stock solution of Tm, DTT, or AZC into culture medium
directly. As mock treatment, add the same volume of the sol-
vent (see Note 16).

2. Continue incubation for appropriate period (see Note 17).

3. Harvest plantlets into 2 mL microtube containing a bead and
immediately freeze with liquid nitrogen.

Fig. 1 Arabidopsis plantlets grown in a 24-well titer plate for 10 days under the condition described in
Subheading 3.1
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3.3 RNA Extraction

and DNase Treatment

1. Disrupt the plantlets with a bead mill (see Note 18).

2. Add 1 mL of RNA extraction buffer and vortex.

3. Leave at room temperature for 5 min.

4. Centrifuge at 20,000 � g for 10 min at 4 �C.

5. Transfer supernatant to a new tube, and add 200 μL of chloro-
form and vortex.

6. Leave at room temperature for 10 min.

7. Centrifuge at 20,000 � g for 10 min at 4 �C.

8. Transfer supernatant to a new tube, and add 250 μL of iso-
propanol and 250 μL of high salt solution.

9. Vortex and leave at room temperature for 10 min.

10. Centrifuge at 15,000 rpm for 15 min at 4 �C.

11. Discard supernatant and add 1 mL of 70% EtOH.

12. Vortex and centrifuge at 15,000 rpm for 5 min at 4 �C.

13. Discard 70% EtOH and dry up (see Note 19).

14. Dissolve RNA in 89 μL of ultrapure water.

15. Add 10 μL of 10� DNase buffer II (see Note 20).

16. Vortex and add 1 μL of DNase.

17. Incubate for 15 min at 37 �C.

18. Add 10 μL of Stop solution and incubate for10 min at 70 �C
(see Note 20).

19. Add 11 μL of 3 M Na acetate and mix.

20. Add 300 μL of 99.5% EtOH and mix.

21. Centrifuge at 20,000 � g for 10 min at 4 �C.

22. Discard supernatant and add 1 mL of 70% EtOH.

23. Centrifuge at 15,000 rpm for 5 min at 4 �C.

24. Discard supernatant, air-dry EtOH, and dissolve in 50 μL
ultrapure water.

3.4 cDNA Synthesis 1. Measure RNA concentration by an UV spectrophotometer.

2. Prepare 5 μL of RNA solution at a concentration of 20 ng/μL
in PCR tubes.

3. Incubate for 5 min at 65 �C.

4. Using RNA solution, prepare reaction solution for reverse
transcription according to the manufacturer’s protocol of
Applied Biosystems™ High Capacity cDNA Reverse Tran-
scription Kit (see Note 21).

5. Perform reverse transcribe reaction as follows. Incubate for
10 min at 25 �C, 120 min at 37 �C, and 5 min at 85 �C.

6. Dilute cDNA solution with 20 μL of ultrapure water.
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3.5 Quantitative PCR 1. Prepare 20 μL of reaction solution as follows (see Note 22).

THUNDERBIRD® SYBR qPCR Mix 10.4 μL

PrimerA (20 μM) 0.3 μL (0.3 μM)

PrimerB (20 μM) 0.3 μL (0.3 μM)

cDNA 2–4 μL

Ultrapure water 7–5 μL

Total 20.0 μL

2. Conduct real-time PCR as follows. 95 �C for 2 min and (95 �C
15 s, 60 �C 50 s) � 40 cycle. Dissociation stage (95 �C 15 s,
60 �C 30 s, 95 �C 15 s) (see Note 23).

3. Examples of qRT-PCR to detect BiP3 mRNA, which is
increased by Tm treatment, and MBL1 mRNA, which is
decreased by Tm treatment, were shown in Fig. 2. Reproduced
from [13] with permission from Bioscience Biotechnology and
Biochemistry. In this case, RNA was prepared from cultured cells.

4 Notes

1. In most cases, medium up to 100 mL is more than enough.
Then, we keep medium as 20� solution at �20 �C.

2. If tunicamycin was purchased as 10 mg of vial, DMSO can be
directly added to the vial. It is recommended to store the stock
solution as aliquots in the �20 �C freezer to avoid repeated
freezing and thawing. This is also applicable to storage of DTT
and AZC stock solutions.

3. Aluminum oxide beads can be substituted to zirconia or other
equivalent beads.
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Fig. 2 Quantification of transcripts by qPCR after mock or Tm treatment. RNA was extracted from 10-day-old
plantlets of wildtype (WT) and ire1a ire1b mutant treated with mock (0.1% DMSO) or 5 μg/mL Tm for 5 h.
Quantitative RT-PCR for BiP3 and MBL1 was performed as described in Subheading 3 (reproduced from Ref.
13 with permission of Bioscience Biotechnology and Biochemistry)
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4. The bead mill (QIAGEN) consists of a mixer and two tube
holders. 24 of 2 mL microtubes can be set in each holder.
Similar equipment can be substituted with the bead mill and
in this case, follow manufacture’s manual.

5. Although we purchase DNase from NIPPON GENE, any
RNase-free DNase can be used instead.

6. Any other real-time PCR machine can be applicable.

7. PCR primers are dissolved in sterilized ultrapure water.

8. We do not recommend too much seeds in the tube from two
reasons. First, too much seeds in a tube would result in ineffi-
cient sterilization. Second, as mentioned below, only 3–5 seeds
are sown in each well and then small amount is sufficient for
gene expression analysis.

9. Tapping the tube can be substituted for vortex.

10. It is important to remove NaClO thoroughly, otherwise seeds
will not germinate.

11. This step serves as vernalization treatment to uniform
germination.

12. 12-well plates are often used as well as 24-well plates. In this
case, 2 mL of medium is added in each well.

13. Head of tips of micropipette are cut with sterilized razor blade
or scissors to make seeds enter to the tips.

14. For qRT-PCR, we conduct at least three biological repeats.
Since plantlets in each well do not necessarily grow equally, we
usually prepare six wells for one treatment.

15. Usually we grow plantlets for 10 days after sowing. At this
stage, the growth almost saturates as shown in Fig. 1.

16. Since plantlets absorb some of culture medium during cultiva-
tion, it is difficult to estimate the exact volume of the medium.
On the assumption that the same amount of culture medium is
present in each well, we add the same volume of drugs. Alter-
natively, culture medium can be discarded and 1/2 MS
medium with 1% sucrose containing each drug can be added.
Although we use different concentrations of drugs depending
on experiments, we often use 5 μg/mL of tunicamycin, 2 mM
of DTT, and 5 mM of AZC.

17. Treatment period also depends on experiments. We expose
plantlets to drugs for 1–5 h to detect gene expression. In
general, longer treatment is necessary when changes at protein
level need to be observed. Treatment for long time such as
more than 2 days is supposed to be meaningless since cell death
started after 12 h when plantlets treated with 5 μg/mL of
tunicamycin.

18. Tube holders of the bead mill are precooled in �80 �C freezer
to prevent thawing the sample. Attach tubes in the holder and
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begin shaking immediately at 30 times/s for 1 min. Subse-
quently, tubes are cooled by liquid nitrogen to avoid thawing
and shake again for 1 min. A compatible bead mill can be used
according to manufacturer’s protocol.

19. Alternatively EtOH residue can be dried up by DNA110
SpeedVac Concentrator (Savant) or equivalent equipment.

20. 10� DNase buffer II and Stop solution are accompanied with
DNase (NIPPON GENE).

21. If other kit was used, follow the manufacturer’s protocol.

22. When other kits are used, follow the recommended protocol by
the kit’s manufacturer.

23. Calculation depends on real-time PCR equipment and reaction
reagent. We performed at least three biological replicates to
obtain results.
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Chapter 18

Unfolded Protein Response in Arabidopsis

Cristina Ruberti and Federica Brandizzi

Abstract

The unfolded protein response (UPR) is a highly regulated signaling pathway that is largely conserved
across eukaryotes. It is essential for cell homeostasis under environmental and physiological conditions that
perturb the protein folding in the endoplasmic reticulum (ER). Arabidopsis is one of the outstanding
multicellular model systems in which to investigate the UPR. Here, we described a protocol to induce the
UPR in plants, specifically arabidopsis, and to estimate their ability to cope with ER stress through the
quantification of physiological parameters.

Key words Unfolded protein response, Endoplasmic reticulum stress, Temporary ER stress,
Prolonged ER stress, Tunicamycin, Arabidopsis

1 Introduction

Adverse environmental changes and physiological conditions of
growth can interfere with crucial biosynthetic processes and disturb
proper protein folding in the endoplasmic reticulum (ER), leading
to a potentially lethal condition generally termed “ER stress” [1,
2]. To overcome ER stress, the unfolded protein response (UPR), a
highly regulated signaling pathway largely conserved across eukar-
yotes, is actuated [3]. The UPR activates a network of pathways,
which generally promote cell adaptation and restore ER homeosta-
sis; however, under unmitigated stress conditions they also can
ignite programmed cell death (PCD) both in animals [1, 4] and
plants [5, 6]. Despite the relevance of the UPR in cell growth and
stress adaptation and the abundant information on the function of
the canonical stress sensors and transducers in the UPR [5, 7, 8],
we lack a complete understanding of the molecular players involved
in the temporally distinct UPR-related events (i.e., UPR initiation,
recovery from temporary ER stress, survival from mild and pro-
longed ER stress, and ignition of PCD under unmitigated ER
stress), especially in plants [9].

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
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Depending on the duration of ER stress, three main experi-
mental approaches have been implemented to investigate the con-
tribution of the UPR players in ER stress resolution. The
downstream transcriptional initiation of the adaptive UPR signal-
ing response can be monitored at a molecular level by assaying the
expression levels of the UPRmarker genes in time-course treatment
with ER stress-inducing agents (for detailed methods, see [3, 10]).
The plant ability to recover after temporary ER stress or to cope
with prolonged and mild ER stress is evaluated at phenotypic level
on seedlings transferred or germinated and grown on ER stress
inducer-containing media [5, 6]. Finally, ER stress-induced cell
death can be evoked by growing seedlings under prolonged and
severe ER stress conditions and quantified by standard methods to
test for PCD (e.g., ion leakage and TUNEL staining) [6, 11].

Common chemical agents used to experimentally induce ER
stress and activate the UPR in plants are tunicamycin (Tm) or
dithiothreitol (DTT) [5, 12, 13]. Tm inhibits the N-
acetylglucosamine phosphotransferases; this prevents N-linked gly-
cosylation of nascent polypeptides in the ER lumen. DTT is a
potent reducing agent that prevents disulfide bond formation dur-
ing folding of polypeptides in the ER (see Note 1). Here, we
describe phenotypic analyses most commonly adopted to evaluate
ER stress sensitivity of arabidopsis seedlings after a short ER stress-
inducing treatment or during prolonged ER stress.

2 Materials

1. Basic equipment for plant sterile tissue culture.

2. Plant growth chamber conditions: continuous white light at
21 �C, 100 μEinstein/m2 s, 65% humidity.

3. Plant growth medium: half-strength (1/2) Linsmaier and
Skoog (LS) medium, 1% sucrose, pH 5.7.

4. Tunicamycin (Tm) from Streptomyces sp. (see Note 2): prepare
10 mg/mL of Tm stock solution by dissolving 0.005 g Tm in
0.5 mL of DMSO yielding a clear solution (seeNotes 3 and 4).

5. Dimethyl sulfoxide (DMSO).

6. 70% ethanol.

7. 5% commercial bleach freshly prepared.

8. Acetone: 80% solution in water.

9. Petri dishes, square with grids, 100 mm � 100 mm, sterile,
polystyrene.

10. Micropore gas-permeable surgical tape.

11. Sterilized toothpicks.

12. Razor blades.
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13. Analytical balance.

14. Microplate, 96 well, flat bottom, clear.

15. Microplate reader equipped with 663 and 645 nm
wavelengths.

3 Methods

3.1 Recovery After

Temporary ER Stress

Treatment

Carry out all procedures at room temperature and if aseptic condi-
tions are required, work in a laminar flow hood.

1. Surface-sterilize the arabidopsis seeds (see Note 5): in a micro-
centrifuge tube, soak the seeds in 1 mL 70% ethanol for 1 min,
suspend them by turning the tube or vortex, pour out the
liquid, rinse two times in distilled sterile water, suspend the
seeds in 1 mL 5% commercial bleach for 1 min, then rinse three
times in sterile distilled water (see Note 6). Store the seeds at
4 �C for 2 days to synchronize them.

2. Autoclave for 25 min the plant growth medium with 12 g/L
agar (see Note 7) and pour 40 mL into each square Petri dish.

3. Use a sterile toothpick to sow the arabidopsis seeds on the solid
plant growth medium placing each seed at an equally spaced
distance (Fig. 1a).

Fig. 1 Arabidopsis Col-0 growth phenotype after recovery from short-term Tm
treatment. (a) Arabidopsis seeds sown at an equally spaced distance on ½ LS
solid medium for vertical growth. Scale bar: 0.65 mm. (b) 5-day-old seedlings
were transferred to ½ LS solid medium plates containing Tm or DMSO for short-
term ER stress treatment. (c) 8-day-old seedlings were transferred from Tm-
plates to ½ LS solid plates and the root tips were marked on the back of the plate
using a black extra-fine point marker. (d) Root growth inhibition of Tm-treated
seedlings compared to untreated seedlings after 3 days of recovery from short-
term Tm treatment. Red lines show the primary root tip. (e) Close-up view of the
shoot of seedlings shown in (d)
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4. Seal the plates with one layer of micropore gas-permeable
surgical tape to allow gaseous exchange.

5. Germinate and grow the seeds in vertical position in a plant
growth chamber for 5 days.

6. Autoclave for 25 min the plant growth medium and store it at
room temperature.

7. Prepare Tm stock solution (see Notes 3 and 4).

8. Freshly prepare 0.075, 0.15, and 0.30 mg/mL Tm stock
solutions by 133, 66, and 33� dilution, respectively, of the
10 mg/mL Tm stock solution using 1/2 LS liquid medium.

9. Autoclave for 25 min the plant growth medium with 12 g/L
agar (seeNote 5). Cool down themedium until 50 �C (seeNote
8) and keep it homogeneously mixed with a magnetic stir bar.

10. Add 0.075, 0.15, and 0.30 mg/mL Tm stock solutions,
respectively, to the cooled down ½ LS medium by 1000 dilu-
tion to make plant growth medium containing 0.075, 0.15,
and 0.30 μg/mL Tm (see Notes 9 and 10).

11. As mock control, the same preparation procedure is carried out
replacing the Tm in the ½ LS medium with 0.0005% DMSO.

12. Transfer the 5-day-old seedlings using a sterile toothpick to
plant growth medium plates containing DMSO, 0.075, 0.15,
or 0.30 μg/mL Tm (Fig. 1b). Seal the plates with one layer of
micropore gas-permeable surgical tapes to permit gaseous
exchange and place them on vertical position into the plant
growth chamber.

13. After 3 days, use a sterile toothpick to transfer the seedlings to
plant growth medium plates without Tm (or DMSO). Mark
the root tip on the back of the plate using an extra-fine point
permanent marker and place the plates on vertical position into
the plant growth chamber (Fig. 1c).

14. After 3 days, observe the growth phenotype (Fig. 1d and e) and
quantify the plant growth parameters as described below.

15. If using Col-0 ecotype wild-type arabidopsis, the plants show
growth defects already at 0.15 μg/mL Tm (Fig. 1d and e).

3.2 Prolonged ER

Stress Treatment

Carry out all procedures at room temperature and if aseptic condi-
tions are required, work in a laminar flow hood.

1. Autoclave for 25 min the plant growth medium and store it at
room temperature.

2. Autoclave for 25 min the plant growth medium with 12 g/L
agar (see Note 5).

3. Freshly prepare 0.04, 0.06, and 0.08 mg/mL Tm stock solu-
tions by 250, 166, and 125� dilution of 10 mg/mL Tm stock
solution, respectively, using 1/2 LS liquid medium.
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4. Add 0.04, 0.06, and 0.08 mg/mL Tm stock solutions, respec-
tively, to the cooled down ½ LS medium by 1000 dilution to
make plant growth medium containing 40, 60, and 80 ng/mL
Tm (see Notes 9 and 11). As mock control, the same prepara-
tion procedure is carried out replacing the Tm in the ½ LS
medium with 0.0005% DMSO.

5. Surface-sterilize the arabidopsis seeds (see Note 3) and store
them at 4 �C for 2 days.

6. Use a sterile toothpick to sow the surface-sterilized seeds on
the ½ LS medium containing DMSO, 40, 60, and 80 ng/mL
Tm. Place each seed at an equally spaced distance (Fig. 1a)

7. Seal the plates with one layer of micropore gas-permeable
surgical tape to allow gaseous exchange.

8. Germinate and grow the seeds in vertical position in a plant
growth chamber.

9. After 5 days, mark the root tip on the back of the plate using an
extra-fine point marker (Fig. 2a) and place the plates back on
vertical position into the plant growth chamber.

10. Observe the growth phenotype 7–14 days after germination
(Fig. 2b and c), but check the plant growth each day during the
assay to precisely monitor the ER stress sensitivity of the

Fig. 2 Arabidopsis Col-0 growth phenotype after prolonged Tm treatment. (a)
Root tips of 5-day-old seedlings were marked on the back of the plate using a
black extra-fine point marker. Scale bar: 0.65 mm. (b) Root growth inhibition of
Tm-treated seedlings compared to untreated seedlings grown for 10 days
vertically. Red lines show the primary root tip. (c) Close-up view of the shoot
of seedlings shown in (b)
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seedlings. Quantify the plant growth parameters as described
below.

11. If using Col-0 ecotype wild-type arabidopsis, the plants show
growth defects starting from 40 ng/mL Tm (Fig. 2b and c).

3.3 Plant Growth

Parameters

1. The effect of the prolonged ER stress on arabidopsis seeds can
be quantified through the quantification of emergence of the
true leaves (Fig. 2c). Count the number of seedlings having
true leaves on Tm-containing plates and normalize this value
with respect to the total number of all sown seeds. Similarly,
count the number of seedlings having true leaves on DMSO-
containing plates and normalize this value on the total number
of all sown seeds [12].

2. Fresh shoot weight is an easy readout of plant sensitivity of
both short-term ER stress and prolonged ER stress. Using a
razor blade, cut the plant shoots at a consistent cut-position on
the hypocotyl. Gently dry the shoots on a paper towel and
measure the weight with an analytical balance. To quantify
the relative growth values, the shoot weight of the seedlings
grown on Tm is divided by the shoot weight of the seedlings
grown on DMSO-plates. For each measurement, use a pool of
6–10 shoots for each of the at least six technical replicates for
each of the three biological replicates.

3. Chlorophyll (Chl) content of the leaves can be used as an
indicator of overall plant health after short-term or prolonged
Tm treatment. After measuring fresh shoot weight, place the
pool of leaves into a microcentrifuge tube and extract chloro-
phyll using 1 mL cold 80% acetone at 4 �C for 24 h (see Note
12) in the dark (see Note 13). Quickly transfer 0.3 mL of the
supernatant to a flat-bottom 96-well microplate and use
0.3 mL 80% acetone blank as reference. Measure the absor-
bance (A) of the chlorophyll content using a microplate reader
at 663 and 645 nm wavelengths. The chlorophyll concentra-
tion is calculated as follows: Chl (mg/g) ¼ [8.02 �
A663 + 20.20 � A645] � V/1000 � W, where V ¼ volume of
the extract (mL) and W ¼ weight of fresh leaves (g) [13, 14].

4. The primary root elongation declines as the concentration of
the ER stress inducer increases into the growth media in a dose-
dependent manner (Figs. 1d and 2b) [15]. For this reason, ER
stress sensitivity can be quantified measuring the primary root
length of seedlings grown on Tm-plates. Take pictures of the
plants treated as described in Subheading 3.1, steps 1–14 or
3.2, steps 1–10 (see Note 14). Measure the root length from
the root tip to the mark made in the Subheading 3.1, step 13
or 3.2, step 9. To quantify the relative root elongation value,
the root length of the seedlings grown on Tm is divided by the
root length of the seedlings grown on DMSO-plates.
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4 Notes

1. Even if DDT is commonly used to cause protein misfolding in
the ER, it is not a specific ER stress inducer, since it blocks
disulfide bond formation both in the ER and in the cytosol,
and causes oxidative stress and the expression of defense genes
[12, 15].

2. The hazard category for Tm is acute toxicity, oral (category 2)
H300 (fatal if swallowed). Tm is light sensitive.

3. To avoid formation of aerosols, directly inject the DMSO
solvent using a 1-mL syringe with a needle through the lid of
the tube containing the solution and mix.

4. To avoid freezing and thawing, aliquot the 10 mg/mL stock
solution into relatively small amounts (0.01 mL aliquots) and
store them at �20 �C freezer in the dark.

5. ER stress sensitivity is highly affected by the seeds quality. Use
seeds with high germination quality and freshly collected from
healthy plants.

6. Do not leave seeds in ethanol or bleach for too long because
the treatment may be toxic to the seeds.

7. Mix homogeneously the solution with a magnetic stir bar
before and after to autoclave, to avoid settling of unmelted
agar at the bottom of the bottle.

8. Tm is sensitive to high temperature.

9. Prepare the Tm-containing medium plates right before using
them.

10. The optimal range of concentration of Tm has to be experi-
mentally determined. As initial screen, use 0.075 and 0.15 μg/
mL Tm and then decrease or increase the Tm concentration
depending on the degree of Tm sensitivity of the analyzed
arabidopsis ecotype.

11. The optimal range of concentration of Tm has to be experi-
mentally determined. As initial screen, use 20 and 40 ng/mL
Tm and then decrease or increase the Tm concentration
depending on the degree of Tm sensitivity of the analyzed
arabidopsis ecotype and on the purpose of your assay. To
evaluate Tm sensitivity under mild ER stress conditions, use
low Tm concentration that can be increased to get unmitigated
ER stress conditions and consequent cell death.

12. Complete chlorophyll extraction is fulfilled when the shoots
are completely white. If the leaves are still partially green, keep
the tissues at 4 �C in the darkness for longer time.
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13. During chlorophyll extraction and analyses, keep the samples
in the dark, because chlorophylls are light-sensitive pigments.

14. To better distinguish the roots, take pictures of the back of the
plates.
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Chapter 19

Fluorescence Imaging of Autophagy-Mediated
ER-to-Vacuole Trafficking in Plants

Hadas Peled-Zehavi and Gad Galili

Abstract

Macroautophagy (hereafter referred to as autophagy) is a conserved mechanism in eukaryotic cells that
delivers unneeded cellular components for degradation in the lytic organelle. In plants, as in other
eukaryotes, autophagy begins in the formation of cup-shaped double membranes that engulf cytosolic
material. The double membrane closes to form autophagosomes that are then transported to the vacuole
for degradation. Autophagy can function as a bulk nonselective process or as a selective process targeting
specific proteins, protein aggregates, organelles, or other cellular components for degradation. The endo-
plasmic reticulum (ER) is linked to autophagy-related processes in multiple ways. The ER was suggested as
a possible site for the nucleation of autophagosomes, and as a source for autophagosomal membranes.
Furthermore, autophagy has an important role in ER homeostasis, and the ER is a target for a selective type
of autophagy, ER-phagy, in response to ER stress. However, the detailed molecular mechanisms, especially
in plants, are only now starting to be revealed.
In this chapter, we describe the use of confocal imaging to follow the delivery of fluorescently tagged ER-

associated proteins to the vacuole. We also describe the utilization of fluorescent protein fusions to look at
the co-localization of a protein of interest with the autophagosome marker protein ATG8, a core autophagy
machinery protein that is essential for selective autophagy processes.

Key words Autophagy, ATG8, Concanamycin A, Confocal microscopy, Endoplasmic reticulum,
Fluorescence, Vacuole

1 Introduction

Autophagy is a conserved eukaryotic endomembrane trafficking
process that is essential for development, cellular homeostasis, and
stress tolerance [1–3]. Autophagy involves the sequestration of
cargo in double-membrane bounded autophagosomes that are
further transported to the lytic organelle (the vacuole in plants)
for degradation. Upon arrival of the autophagosomes to the
vacuoles, their outer membranes fuse with the tonoplast, creating
single-membrane vesicles inside the vacuole, termed autophagic
bodies. The autophagic bodies and their contents are then
degraded, providing recycled materials to build new
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macromolecules [1, 2, 4]. In plants, autophagy is one of the central
cellular machineries required to survive biotic and abiotic stresses
such as limiting light levels, nutrient deficiency, drought, and path-
ogen attack [2, 5, 6]. Autophagy was classically defined as a bulk
nonselective process. However, in recent years it became evident
that autophagy-related routes are more varied and also involve the
selective transport of specific proteins, protein aggregates, orga-
nelles, or organelles components to the vacuole, thus regulating
the steady-state levels of these specific components in response to
specific cues [4, 6].

The core mechanism of autophagy is mediated by AuTophaGy-
related or ATG

Genes [1, 2, 4, 7]. Though these genes were originally discov-
ered in yeast, many of them are conserved in evolution, and homo-
logs have later been found in many organisms including mammals
and plants [8, 9]. A central protein of both bulk and selective
autophagy is ATG8, which in plants exists as a gene family. ATG8
is synthesized as a proprotein and goes through several processing
events that result in its covalent attachment to phosphatidyletha-
nolamine (PE) at the autophagosomal membrane [10–13]. ATG8-
PE located on the outer membrane of the autophagosome is
cleaved off during autophagosome deposition by ATG4. ATG8-
PE located on the inner membrane of the autophagosome enters
the vacuole with the autophagic body [14, 15]. As ATG8 is found
on the autophagosome from its formation to its lytic destruction in
the vacuole, a green fluorescent protein (GFP) fusion of ATG8 is
the most commonly used marker for autophagosomes [1, 2].
ATG8 is involved in autophagosome formation and membrane
extension and is also essential for selective autophagy. It has been
shown to mediate target recognition by specific binding to protein
targets or adaptor proteins [1, 3, 4, 6]. Therefore, the demonstra-
tion of a specific interaction between ATG8 and a protein of interest
strongly supports the involvement of this protein in selective autop-
hagy processes.

The involvement of the ER in autophagic processes is multifac-
eted. The ER was suggested as a possible site for the nucleation of
the cup-shaped phagophores that elongate and fuse to form autop-
hagosomes, and as a source for autophagosomal membranes [7,
16–18]. The ER is also the target of a selective type of autophagy,
termed reticulophagy or ER-phagy. ER-phagy was shown to be
involved in ER degradation in response to induced ER stress in
animals and yeast [19–22]. Similarly, treating Arabidopsis thaliana
plants with ER stress agents was shown to trigger autophagy and to
result in the appearance of autophagic bodies containing ribosome-
decorated ER membranes within the vacuole lumen [23]. Interest-
ingly, selective autophagy was also reported to act as a biogenesis-
mediating process in special trafficking routes delivering vacuolar
resident proteins to function in this organelle. The best known
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example being the cytosol to vacuole targeting (Cvt) pathway of
yeast [24]. Recently, it was suggested that analogous types of
autophagy-dependent trafficking routes may exist also in plants in
the form of a direct ER-to-vacuole, Golgi-independent, trafficking
route [25].

The use of fluorescently tagged proteins and fluorescence
microscopy to study the involvement of specific proteins in selective
autophagy processes has proven to be a powerful research tool in
the autophagy field [26]. In this chapter, we describe procedures
utilizing confocal imaging to look at the in vivo co-localization of
stably expressed fluorescently tagged ER-associated proteins with
the autophagosome marker ATG8, and to follow their delivery to
the vacuole. These procedures are combined with the use of Con-
canamycin A (conA). ConA inhibits the vacuolar H+-ATPase,
resulting in an increase in vacuolar pH and inhibition of vacuolar
enzymes activity [1]. Under these conditions, autophagic bodies
accumulate in the vacuole and there is an increase in the amount of
autophagosomes in the cytoplasm [27], facilitating the visualiza-
tion of autophagy processes.

2 Materials

2.1 Plant Growth

Materials

1. Half-strength Murashige and Skoog (MS) medium: dissolve
2.15 g of MS basal salt mixture in 0.8 L of distilled water.
Check and adjust pH to 5.6–5.8 using 1 M KOH and add
distilled water to a final volume of 1 L. Add 8 g plant agar.
Autoclave for 20 min at 121 �C and cool down to 45–50 �C
before pouring into petri dishes under sterile conditions (lami-
nar flow hood).

2. Arabidopsis thaliana seed surface sterilization solutions: 75%
(v/v) ethanol, 3% sodium hypochlorite (v/v), sterile deionized
or reverse osmosis purified water.

3. Sterile petri dishes.

2.2 Seedlings

Treatment

1. Concanamycin A 100x: 100 μM conA (Santa Cruz) in DMSO.
Aliquot and store at �20 �C protected from light.

2. Liquid half-strength MS medium: prepare as in Subheading
2.1, item 1, but do not add the plant agar.

3. Aluminum foil.

2.3 Confocal

Imaging and Analysis

1. Glass microscope coverslips. We use 0.13–0.17 mm thick
24 � 60 mm and 18 mm coverslips.

2. Confocal laser scanning microscope. The images presented
here were acquired using an inverted Nikon A1 microscope
and the NIS-Elements AR imaging software.
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3. Software: Imaris image processing and analysis software (Bit-
plane inc.) or ImageJ freeware with the coloc_2 plug-in
(imagej.net/imagej), MS Excel.

3 Methods

3.1 General

Considerations

Several vector systems for the generation of fluorescent protein
fusion constructs in plant binary plasmids exist, utilizing both
restriction enzyme based and recombination based cloning techni-
ques. Examples of vectors available through the Arabidopsis
Biological Resource Center (ABRC) include the pSAT/pZP and
pMDC vector systems [28, 29]. In choosing the appropriate sys-
tem, it is important to take into consideration the appropriate
fusion orientation (see Note 1), the promoter that will be used to
drive the expression (see Note 2) and the desirable fluorescent
protein used for the fusion (see Note 3). Following Arabidopsis
thaliana transformation with Agrobacterium, several lines with
differing levels of fluorescence expression should be propagated
for further characterization (see Note 4).

3.2 Plant Material

and Growth Conditions

1. Sterilize arabidopsis seeds by washing them twice with 75%
ethanol solution, followed by soaking for 5 min in 3% bleach
solution. Wash 3–4 times in sterile water.

2. Plate the sterilized seeds on solid half-strength MS medium.
Seal with micropore paper tape or parafilm and place the plates
at 4 �C for 2 days for stratification.

3. Grow under long day conditions (16 h light) at 22 �C.

3.3 Treating Plants

with conA

1. Transfer 6-day-old seedlings of each of the examined genotypes
(5–10 seedlings will suffice) to a 24-well plate with 0.5 mL
liquid half-strength MS medium complemented with 1 μM
conA (see Note 5). For control treatment, transfer seedlings
into liquid medium with the same volume of DMSO (used to
dissolve the conA). The seedlings should be removed from the
growing plate carefully using tweezers to prevent tearing the
roots (see Note 6).

2. Seal the plates with parafilm and cover in double layered alumi-
num foil. Incubate with gentle shaking (80 rpm) for 20 h
before imaging (see Note 7).

3.4 Co-Localization

with Fluorescently

Labeled ATG8 Marker

To look at co-localization with autophagosomes, Agrobacterium
tumefaciens mediated transformation or crossing is used to gener-
ate transgenic lines co-expressing fluorescently tagged ATG8 and
protein of interest (see Note 8).
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3.5 Confocal

Microscopy Imaging

1. Place 1–3 seedlings on a microscope glass coverslip, add a drop
of distilled water, and cover with a second coverslip (we rou-
tinely use 0.13–0.17 mm thick 24 � 60 mm rectangular cover-
slip with a round 18mm coverslip on top). Place on the stage of
the confocal microscope for imaging.

2. Select the 20� objective, adjust the focus, and find the hypo-
cotyl under bright field illumination (see Note 9).

3. Choose a suitable excitation laser and emission filter for image
acquisition. For GFP or YFP fluorescence, use 488-nm laser
excitation and a 525-nm emission filter. For mRFP or mCherry
fluorescence, use 561-nm laser excitation and a 595-nm emis-
sion filter. For chlorophyll autofluorescence, use a 640-nm
laser and a 700-nm emission filter (see Note 10).

4. Image the sample. Focus on different layers of the tissue to get
an estimation of the fluorescence signal and a general view of
the level of autophagy (see Note 11).

5. Switch the objective lens to 60�/1.2NA water immersion lens
(or similar). Water immersion lens is preferable to oil immer-
sion lens since the refractive index of water most closely
matches that of live cells. Determine image acquisition para-
meters such as laser intensities, gain, and scan speed, and keep
them constant for all images taken (see Note 12). Save the
image in a file format that preserves the maximal amount of
image data.

6. To look at transport of the protein of interest to the vacuole
following conA treatment, capture Z-stacks of the sample and
look for a focal plane through the vacuole. A focal plane
through the vacuole will show a central space—the vacuole—
surrounded by chloroplasts (as evident from the chlorophyll
fluorescence). This is demonstrated in Fig. 1 using a GFP-
labeled ATG8-interacting protein 1 (ATI1). ATI1 was charac-
terized as an ATG8 binding protein in Arabidopsis thaliana
that is partially associated with the ER under normal growth
conditions. Following carbon starvation, ATI1 is localized on
ER-associated bodies and on bodies associated with chloro-
plasts (ATI-bodies). These bodies are delivered to the vacuole
in a process that requires active autophagy [30, 31]. As demon-
strated in Fig. 1, untreated ATI1-GFP expressing plants show
no or very few fluorescent puncta in the vacuole (Fig. 1a).
However, in conA-treated plants, multiple fluorescent puncta
are clearly visible in the vacuole (Fig. 1b) as a result of inhibited
vacuolar degradation. A view through the cytoplasmic focal
plane shows ATI1 fluorescence associated with a typical ER
network-like structure (Fig. 1c).

7. Autophagic bodies in the vacuole typically move in a rapid and
random manner [32]. To capture this typical movement, use
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time-lapse imaging (for an example, see Fig. 1d and e). The
confocal microscope requires relatively long acquisition time.
Therefore, to capture the dynamic movement of autophagic
bodies with minimal blurring, it might be necessary to increase
the scan speed and eliminate frame averaging.

8. To look at the co-localization of the protein of interest with
ATG8, sequential scanning (multitracking) should be used to
avoid as much as possible bleed-through artifacts and to more
accurately separate emission spectra. Depending on the protein
of interest, different autophagy-inducing stress treatments can
be used to enhance the co-localization. An example is shown in
Fig. 2 using mRFP-ATG8f and ATI1-GFP. Following 24 h
carbon starvation, ATI1 is partially localized to spherical bodies
(green and yellow arrows). ATG8f is found on autophago-
somes (red and yellow arrows), but also shows diffuse cytoplas-
mic distribution. ATG8f and ATI1 are co-localized on
autophagosomes (yellow arrows), but there are some autopha-
gosomes that do not carry ATI1 (red arrows). On the other
hand, some spherical bodies are labeled by ATI, but not by
ATG8f (green arrows).

Fig. 1 Imaging of conA-treated Arabidopsis thaliana seedlings. Arabidopsis seedlings stably expressing ATI1-
GFP driven by its endogenous promoter were exposed to 1 day of carbon starvation. ATI1-GFP fluorescence is
shown in green and chlorophyll autofluorescence is shown in magenta. When viewed through the vacuolar
plane of the cell, DMSO-treated control hypocotyl cells show no fluorescent puncta (a), while conA-treated
hypocotyl cells accumulate multiple ATI1-GFP labeled bodies in the vacuole (b). A view through the cytoplas-
mic plane of conA-treated cells shows ATI1-GFP labeling typical ER structures (c). Time-lapse images, taken
every 12 s, illustrate the random movement of ATI1-GFP labeled bodies in the vacuole (d)–(f) as illustrated by
the GFP-labeled bodies highlighted by white and yellow circles. Scale bars ¼ 5 μM
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9. ConA treatment can be combined with ATG8 co-localization
studies to verify the identification of the protein of interest
labeled puncta in the vacuole as autophagic bodies.

3.6 Quantification

and Analysis

1. As the variability between imaged cells is considerable, reliable
quantitative analysis requires sufficient sample size. It is advis-
able to quantitate about 50 images taken from several seedlings
for each genotype/treatment.

2. The Pearson’s correlation coefficient is widely used as a measure
for the co-localization of two fluorescently tagged proteins and
can be calculated using commercial software such as the Imaris
image analysis software or co-localization plug-ins of the open
source java application ImageJ/Fiji such as Coloc_2. However,
when co-localization between an ER-associated protein and
ATG8 is examined, calculating the Pearson’s coefficient over the
whole image can be misleading. If the protein of interest is asso-
ciated with autophagy processes, it is expected to be co-localized
with ATG8 on autophagosomes, but some of it will likely be
localized to the ER. Similarly, ATG8 often shows a diffused
cytoplasmic pattern besides its autophagosomal localization (see
example in Fig. 2). Therefore, when quantitatively analyzing co-
localization, there may be a significant difference between overall
co-localization and co-localizationon autophagosomes. Toquan-
titatively analyze co-localization on autophagosomes, the spot
detection and co-localizationmodule of the Imaris image analysis
software is very useful. Alternatively, it is possible to use ImageJ
co-localization plug-ins and define the puncta visible in the
images as regions of interest (ROI) (seeNote 13).

Fig. 2 Co-localization of ATI1 and ATG8f. Confocal images of hypocotyl cells of Arabidopsis thaliana seedlings
stably co-expressing GFP-fused ATI1 (ATI1-GFP, left panel) and mRFP-fused ATG8f (mRFP-ATG8f, middle panel)
were imaged following 24 h carbon starvation. Images of ATI1-GFP and mRFP-ATG8f fluorescence were
combined (merged, right panel) to illustrate the relative localization of ATI1 and ATG8f. Chloroplasts autofluor-
escence is shown in magenta. ATI1 is partially co-localized with ATG8 on vesicles (yellow arrows). Vesicles
containing ATI1 alone (green arrows) or ATG8f alone (red arrows) are also evident. Scale bars ¼ 5 μM
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3. Quantitative analysis of conA-treated samples is quite straight-
forward, as most of the fluorescence will be associated with
autophagic bodies in the vacuolar plane (Fig. 1b). The number
of autophagosome/autophagic bodies in each frame can be
counted manually or using the spot detection module of the
Imaris software. Proper statistical tools, such as standard devia-
tion calculation, student’s t-test, or one-way ANOVA, should
be employed to compare different stress treatments or genetic
backgrounds.

4 Notes

1. GFP (or other fluorescent proteins) can be fused at either the
N-terminus or the C-terminus of the target protein. To deter-
mine the best fusion orientation, it is crucial to take into
account possible targeting signals or known processing sites
in the protein sequence. As N-terminal fusions can disrupt
targeting to the ER, prediction software and literature search
should be used to help determine the best fusion orientation. If
possible, it is advisable to try both fusion orientations and
validate expression and correct localization of the construct
using transient transformation to Nicotiana benthamiana.

2. Using the Cauliflower mosaic virus 35S promoter to drive the
expression of the fusion proteins is common and effective.
However, excess protein can saturate the target compartment
and cause mislocalization. Furthermore, overexpression of a
protein might by itself cause cellular stress and the recruitment
of the autophagic machinery. Therefore, where feasible, i.e.,
when the endogenous level of expression allows detection, it is
prudent to verify the results using the target protein native
promoter (see Note 4).

3. The GFP signal is sensitive to the acidic and/or proteolytic
conditions of the vacuolar lumen, whereas mRFP or mCherry
is more stable. Hence, mRFP or mCherry fusions might allow
easier visualization of the target protein in the vacuole. For co-
localization experiments with an ATG8 marker, fluorescent pro-
teins that can be distinguished from one another should be
chosen, for example GFP and mRFP or mCherry (see Note 8).

4. It is advisable to avoid using plant lines with very high expression
levels, especially when using the strong 35S promoter, as these
are more prone to silencing in later generations (see Note 2).

5. Use gloves when handling conA or conA-containing samples,
as it is a carcinogen.

6. The same treatment can also be applied to detached mature
rosette leaves.
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7. Sealing the plates with parafilm prevents evaporation of the
liquid during the incubation. As carbon starvation induces
autophagy, we use liquid medium without sucrose and incu-
bate the plates in the dark. This is also useful as conA is light
sensitive. The gentle shaking of the plates allows mixing with-
out damaging the seedlings.

8. Arabidopsis thaliana has nine ATG8 isoforms, all of which are
thought to associate with the autophagosome membrane and
can potentially be used as markers. GFP (or any other fluores-
cent protein) has to be fused to the N-terminus of the ATG8
protein, as ATG8 lipidation occurs at the C-terminus during
autophagosome formation [10–13]. Different GFP-ATG8
transgenic seeds are currently available from the ABRC. These
include two kinds of GFP-ATG8a transgenes that have differ-
ent promoters. One transgene is under the control of the
stronger Cauliflower mosaic virus 35S promoter (stock #
CS39996) [12] while the other uses a promoter of the arabi-
dopsis ubiquitin10 gene (stock # CS68819) [33]. Also avail-
able are 35S promoter driven GFP-ATG8e transgenic plants
and constructs (stock # CS66943) [34]. Our lab has constructs
of GFP- as well as mRFP-ATG8f under the control of the 35S
promoter as well as transgenic lines expressing them [30].

9. We routinely image the hypocotyl as it is easy to detect the
vacuole and autophagosomes in the elongated hypocotyl cells.
It is of course possible to image other tissues as needed.

10. To prevent photodamage to the tissue, the laser intensity used
for excitation should be kept low. If necessary, the pinhole can
be opened to increase signal at the expense of Z-axis resolution.
Alternatively, the detector gain can be increased and frame
averaging can be used, at the cost of temporal resolution in
time-lapse studies.

11. Plants contain a variety of autofluorescent compounds. While
the most commonly encountered is the chlorophyll fluores-
cence from the chloroplast, we experience a lot of wide spec-
trum autofluorescence in stressed and damaged plant cells.
This autofluorescence is typically present in multiple channels,
and might be mistaken for co-localization of ATG8 and the
protein of interest. Therefore, it is very important to image
non-expressing and single expressing control plants that grew
under the same conditions and went through the same treat-
ments, to avoid artifacts.

12. To assure meaningful quantitative analysis of the images, it is
imperative to adjust acquisition parameters such as laser inten-
sities, gain, and exposure times, so that the fluorescence signal
will be collected in the linear range of the detector system
without saturating the signal.
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13. Be careful not to change the original image while utilizing
image analysis software. The image analysis should be per-
formed on a copy of the original image.
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Chapter 20

Imaging the ER and Endomembrane System
in Cereal Endosperm

Verena Ibl, Jenny Peters, Eva Stöger, and Elsa Arcalı́s

Abstract

The cereal endosperm is a complex structure comprising distinct cell types, characterized by specialized
organelles for the accumulation of storage proteins. Protein trafficking in these cells is complicated by the
presence of several different storage organelles including protein bodies (PBs) derived from the endoplas-
mic reticulum (ER) and dynamic protein storage vacuoles (PSVs). In addition, trafficking may follow a
number of different routes depending on developmental stage, showing that the endomembrane system is
capable of massive reorganization. Thus, developmental sequences involve progressive changes of the
endomembrane system of endosperm tissue and are characterized by a high structural plasticity and
endosomal activity.
Given the technical dexterity required to access endosperm tissue and study subcellular structures and

(seed storage protein) SSP trafficking in cereal seeds, static images are the state of the art providing a bulk of
information concerning the cellular composition of seed tissue. In view of the highly dynamic endomem-
brane system in cereal endosperm cells, it is reasonable to expect that live cell imaging will help to
characterize the spatial and temporal changes of the system. The high resolution achieved with electron
microscopy perfectly complements the live cell imaging.
We therefore established an imaging platform for TEM as well as for live cell imaging. Here, we describe

the preparation of different cereal seed tissues for live cell imaging concomitant with immunolocalization
studies and ultrastructure.

Key words Cereal endosperm, Endomembrane system, Electron microscopy, Live cell imaging,
Fluorescent organelle markers

1 Introduction

The endosperm of cereal seeds is a highly differentiated tissue
containing specialized cells that are responsible for the synthesis
and storage of proteins. The high specialization of the tissue is
reflected in the endomembrane system. Storage protein synthesis
requires a well-developed endoplasmic reticulum (ER) and involves
different storage organelles that will form de novo during seed
development [1, 2]. ER-derived protein bodies contain prolamin
aggregates while the protein storage vacuole, far from being a plain

Chris Hawes and Verena Kriechbaumer (eds.), The Plant Endoplasmic Reticulum: Methods and Protocols,
Methods in Molecular Biology, vol. 1691, DOI 10.1007/978-1-4939-7389-7_20, © Springer Science+Business Media LLC 2018
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post-Golgi compartment, accumulates different storage protein
classes and often incorporates the content of ER-derived storage
bodies in an autophagy-like process [3–6]. At the peak of storage
protein production (as soon as 16 days after pollination [dap] in
maize seeds), endosperm cells undergo programmed cell death
(PCD) and generate a starchy endosperm core [7]. This sequence
of intracellular changes in developing seeds challenges the endo-
membrane system that is a plastic and dynamic system capable of
rapid morphological and functional adaptation (Fig. 1a). The mas-
sive reorganization of the endomembrane system during seed
development involves significant morphological changes to the
storage organelles and also affects the trafficking and distribution
of storage proteins [5, 8–12].

The study of such a dynamic system can be approached by
different, complementary imaging methods. Live cell imaging com-
bined with fluorescent membrane markers can be used to follow the
morphological changes in situ. This was reported in the context of
barley endosperm development, comparing PSVs in the aleurone,
subaleurone, and central starchy endosperm layers [10]. The use of
TIP3-GFP marker lines, together with the use of fluorescent organ-
elle dyes such as ER Tracker®, allowed the visualization of morpho-
logical changes in the PSVs along development and a spatiotemporal
pattern could be established [10]. ER Tracker® and neutral red, as
well as other organelle dyes such as FM4-64 and BCECF, are very
convenient tools to identify and track organelles in cereal endo-
sperm. It should be noted, however, that the staining patterns may
be unexpected, due to the specialization of the endomembrane
system and results should be interpreted with some caution and
considering appropriate controls (Fig. 1e–m).

Protein trafficking and organelle reshaping can also be investi-
gated by looking at the behavior of recombinant proteins, includ-
ing storage proteins fused to fluorescent tags [5, 13–15].
Endogenous glycoproteins are rarely found in the endosperm
[16] and are difficult to follow due to the lack of appropriate
detection antibodies, so recombinant glycoproteins produced in
the context of molecular farming are particularly useful because
they can be traced by immunolocalization and by characterizing
their glycan modifications. Accordingly, a significant reduction in
the number of PSVs was observed during maize seed development
and the fate of the recombinant glycoprotein phytase and the
endogenous vacuolar maize proteins corn legumin-1 and α-globu-
lin were found to change during endosperm development. All three
proteins were found to locate to the PSVs in early development
while closer to maturity they were found at the periphery of the ER-
derived protein bodies [17]. This example reflects the flexibility and
dynamics of a system, where interactions between organelles and
changes in protein trafficking fulfill distinct developmental func-
tions [18].
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Fig. 1 Imaging the endomembrane system of the cereal endosperm. (a) Electron microscopy. Outer layers of
maize endosperm (mid-developmental stage). See the changes in the ultrastructure of maize endosperm,
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Cereal endosperm can be accessed by various imaging techni-
ques, which differ from each other and offer specific advantages and
disadvantages. With live cell imaging for example it has become
possible to monitor dynamic endomembrane processes in real time,
however at limited resolution. Electron microscopy on the other
hand provides high resolution, but requires sample fixation and the
information must be derived from static images. A combination of
approaches, as here described, is therefore the best choice for
obtaining maximum information.

2 Material

2.1 Plant Material Maize plants (Zea mays L.), cv. Hi II (A188XB73) are grown in a
climate-controlled growth chamber at 28 �C/24 �C day/night tem-
perature with a 14 h photoperiod. Barley (Hordeum vulgare L., cv.
Golden Promise) is grown at 16 �C and 70% relative humidity under
a 16 h photoperiod. After tillering, cultivation should be continued
at 22 �C. Seeds are collected at different developmental stages, prior
to desiccation, typically from 8 days after pollination (daps) on.

2.2 Cereal

Transformation for

Endosperm ER and

Endomembrane

System Visualization

2.2.1 Reporter Gene

Constructs

1. OsTIP3::PDIL1;1-GFP (ER lumen marker) [19].

2. OsTIP3::CherrySec61 (ER membrane marker) [10, 19].

3. OsTIP3::TiP3-GFP (tonoplast marker) [19].

2.2.2 Stable Maize

Transformation

See Rademacher et al. [20] and information and notes therein.

1. Particle accelerator gun and accessories.

2. Temperature-controlled light incubator.

3. Vortexer.

�

Fig. 1 (continued) younger cells (left) contain a nucleus (n) and a few starch grains (s), while the older cells
(right) are packed with starch grains (s) and zein bodies (arrowheads). Cw cell wall. (b–m) CLSM. (b) Maize
endosperm. Transient expression of OsTIP3::PDIL1;1-GFP. See the fully developed ER network. (c) Maize
endosperm. Immunolocalization of corn legumin-1 in a young endosperm cell (arrow). As counterstain, ER
Tracker® green stains the zein bodies (pb). (d) Barley endosperm. ER Tracker® green and red perfectly co-
localize and label a protein body (arrow). (e–g) Barley endosperm. (e) Neutral red, (f) Autofluorescence, (g)
Merged. See that neutral red stains the protein body (arrowhead) within the storage vacuole (arrow). (h–j)
Barley endosperm. (h) ER Tracker® red, (i) Autofluorescence, (j) Merged. See that ER Tracker® red stains the
protein bodies (arrows). Cw cell wall, s starch. (k–m) Controls. Arabidopsis embryo. (k) Neutral red. (l) ER
Tracker® green, (m) Merged. Note that in Arabidopsis embryos, neutral red stains the lumen of the storage
vacuoles (arrows), while ER Tracker green® reveals the presence of a fine ER network (arrowhead). Bars 5 μm
(a), 10 μm (b–m)
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4. Microfuge.

5. Stock solution of plasmid DNA carrying the transgene of inter-
est for study of the cereal endosperm ER and endomembrane
system.

6. Gold particles (0.7–0.9 μm; Bio-Rad).

7. 100 μM spermidine.

8. 2.5 μm CaCl2.

9. Ice cold 100% (v/v) ethanol.

10. Fine forceps and scalpel.

11. Petri dishes.

12. Culture pots and tubes.

13. Parafilm.

14. Sterile, double-distilled water.

15. 5% (w/v) sodium hypochlorite solution.

16. Cereal endosperm bombardment medium pH 5.8 (KOH): MS
(Murashige and Skoog) salts 4.3 g/L (see Note 1), sucrose
30 g/L, gelrite 3 g/L.

2.2.3 Endosperm

Transient Transformation

1. Confocal laser scanning microscope (CLSM).

2. Free software ImageJ.

3. Razor blades.

4. Forceps.

5. Reagent tubes (see Note 2).

6. Cover Glasses (High precision: 170 � 5 μm).

7. Petroleum jelly.

8. DMSO.

9. 4 μM Neutral red (see Note 3).

10. ER Tracker®stock solution (see Note 4).

2.3 Immuno-

localization of

Endosperm ER and

Endomembrane

System Markers for

CLSM

1. Vibratome.

2. Razor blades.

3. Embryo dishes.

4. Fine forceps.

5. Cyanoacryl glue (see Note 5).

6. 0.1 M Phosphate buffer (pH 7.4): 10.9 g/L Na2HPO4 (anhy-
drous), 3.2 g/L Na2HPO4.

7. Fixative: 4% paraformaldehyde in phosphate buffer 0.1 M
pH 7.4 (see Notes 6 and 7).

8. PBT: phosphate buffer plus 0.25% Tween 20.
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9. Microscopy glass slides.

10. Cover Glasses (High precision: 170 � 5 μm).

11. Blocking solution: 5% BSA (Bovine serum albumin) in phos-
phate buffer, pH 7.4.

2.4 Electron

Microscopy

1. Transmission electron microscope.

2. Ultramicrotome.

3. Fine forceps (see Note 8) and razor blades.

4. Diamond knife.

5. EM grids (see Notes 9 and 10).

6. 0.1 M cacodylate buffer, pH 7.4.

7. Fixative for immunolocalization: 4% paraformaldehyde plus
0.2% glutaraldehyde in cacodylate buffer, pH 7.4.

8. Fixative for ultrastructure: 2% paraformaldehyde plus 2.5%
glutaraldehyde in cacodylate buffer, pH 7.4.

9. Secondary fixative (ultrastructure): 1% OsO4 plus 0.8%
KCNFe in water (see Note 11).

10. 0.5% aqueous uranyl acetate.

11. Epoxy resin (see Note 12).

12. Beem capsules (size 00).

3 Methods

3.1 Cereal

Transformation

3.1.1 Transient

Transformation (Fig. 1b)

Coating of gold particles for particle bombardment

1. Mix 5 mg of sterile gold particles (mixture of 0.9 and 0.7 μm
diameter) with 20 μg circular plasmid DNA.

2. Add sterile water to a final volume of 50 μl.
3. Add 50 μl of 0.1 M spermidine (seeNote 13) and further vortex

for 2 min.

4. Slowly add 50 μl of 2.5 M CaCl2 and further vortex for 10 min.

5. Centrifuge.

6. Wash the gold pellet twice with ice cold 100% (v/v) ethanol.

7. Resuspend in 500 μl ice cold ethanol.

8. Store at �20 �C until further use.

3.2 Particle

Bombardment of

Young Endosperm

Tissue

1. Collect immature ears (see Note 14) from growth chamber-
grown cereals.

2. Remove the kernels from the ears and surface sterilize in 5% (v/v)
NaClO for 20 min at room temperature (seeNote 15).

3. Wash several times the kernels in sterile water.
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4. Cut the kernels in thin sections (seeNote 16) with a sharp razor
blade and place the sections in the center of plates containing
cereal endosperm bombarding medium.

5. Spot 50 μl of the prepared DNA-gold particle suspension in the
core of a microcarrier.

6. Let the ethanol evaporate and assemble the gene gun according
to the manufacturer’s guidelines.

7. Use the appropriate rupture disk for bombardment (see Notes
17 and 18).

8. Reporter gene expression can be already detected 2 days after
bombardment, depending on the experimental conditions.

3.3 Fluorescent Dyes

for Endosperm ER and

Endomembrane

Visualization

(Fig. 1d–j)

1. Collect immature ears from growth chamber-grown cereals (see
Note 19).

2. Cut the kernels in thin sections (0.5–1 mm) with a razor blade.

3. Wash the sections with tap water (electrical conductivity:
280 μS/cm; pH 7.9) (see Note 20).

4. Transfer the sections to a new tube and soak them in the fluo-
rescent dyes in the dark at room temperature.

5. Mount the sections in tap water (see Notes 21 and 22).

6. Immediately analyze the section by CLSM (see Notes 23–25).

3.4 Immuno-

localization of

Endosperm ER and

Endomembrane

System Markers for

CLSM (Fig. 1c)

1. Harvest kernels at the appropriate developmental stage and cut
in small pieces with a sharp razor blade, around 2 mm3 (see
Notes 26 and 27).

2. Fix the samples in 4% paraformaldehyde in phosphate buffer for
2 h at RT (see Notes 28 and 29).

3. Wash at least three times (10 min each) with phosphate buffer
0.1 M pH 7.4.

4. Glue the sample with cyanoacryl glue on the vibratome plate
(see Notes 30 and 31).

5. Obtain vibratome sections and transfer them to a glass embryo
dish (see Notes 32 and 33).

6. Dehydrate and rehydrate the sections through ethanol series
(30%, 50%, 70%, 100%), 50 steps.

7. Apply 2% cellulase in phosphate buffer 0.1 M pH 7.4 for 1 h at
RT to digest the cell wall.

8. Remove the cellulase solution and add 0.5% Triton-100X in
phosphate buffer 0.1 M pH 7.4 (see Notes 34 and 35).

9. Block the nonspecific binding sites with a solution of 5% BSA in
phosphate buffer 0.1 M pH 7.4 for 10 min.
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10. Incubate sections with the appropriate antibody diluted in
phosphate buffer 0.1 M pH 7.4 for 2 h at RT (see Notes 36
and 37).

11. Wash three times (10 min each) in PBT 0.1 M pH 7.4.

12. Incubation sections with the secondary antibody diluted in
phosphate buffer 0.1 M pH 7.4 for 1 h at RT in the dark (see
Notes 38 and 39).

13. Wash three times (10 min each) in PB 0.1 M pH 7.4.

14. Mount and observe (see Notes 40–42).

3.5 Electron

Microscopy

3.5.1 Ultrastructural

Studies of Endosperm ER

and Endomembrane

System

Fixation and embedding: samples for fixation should not be bigger
than 1 mm3.

1. Immerse the tissue in a drop of fixative and cut small pieces (see
Notes 26 and 27).

2. Fix the samples for 2 h at RT (see Note 43).

3. Wash the samples at least four times (10 min each) with caco-
dylate buffer 0.1 M pH 7.4 at 4 �C.

4. Post-fix the samples with 0.5% aqueous OsO4 and 0.8%
KFeCN for 3 h at 4 �C.

5. Wash the samples several times (minimum five changes, 15 min
each) with ddH2O.

6. Incubate the samples with 0.5% aqueous uranyl acetate, 4 �C
overnight.

7. Wash the samples at least four times (10 min each) with
ddH2O.

8. Dehydrate the samples in acetone series, keep the samples at
4 �C (10 min in 50% acetone, 10 min in 70% acetone (three
times), 10 min in 90% acetone (three times), 10 min in 96%
acetone (three times), 15 min in 100% acetone (three times).

9. Infiltrate the samples with epoxy resin. Incubate samples (over-
night in 25% resin in 100% acetone at 4 �C, 3 h in 50% resin in
100% acetone, 3 h in 75% resin in 100% acetone).

10. Incubate overnight in pure resin at 4 �C.

11. Change to fresh resin and incubate for another 3 h.

12. Place the infiltrated tissue samples in beem capsules filled with
resin. Polymerization of the resin takes 48 h at 65 �C (seeNotes
44 and 45).

13. Sectioning: sections showing silver interferences (~90 nm) are
collected on 200 mesh hexagonal grids. Sections can be
directly observed by electron microscopy (see Note 46).
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4 Notes

1. Can be purchased as ready-mixed powders frommany suppliers
(e.g., Duchefa, Sigma).

2. We prefer 2 ml Eppendorf tubes.

3. A 4 mM stock solution in distilled water can be aliquoted and
kept for longer periods of time at �20 �C.

4. ER Tracker® is available in red, green, and blue. Follow manu-
facturer instructions to prepare the working solutions. Stock
solutions can be stored for longer periods of time at �20 �C.
We are using ER Tracker red and green depending on the
experimental conditions, and we have not observed differences
in the staining patterns of both (Fig. 1d).

5. Can be found in hardware stores, should be stored at 4 �C.

6. Cacodylate buffer 0.1 M, pH 7.4; 1�PBS, pH 7.4 are also
suitable buffers.

7. A 10% stock solution can be aliquoted and kept at �20 �C.

8. Number 3–5 nonmagnetic forceps are recommended.

9. Gold or copper grids are suitable. To improve the stability of
the sections under the electron beam, we recommend using
grids coated with a formvar membrane.

10. Grids are available in different mesh and shapes. Grids with a
high mesh number offer better support but less open area. We
prefer 200 hexagonal mesh because they offer a good compro-
mise between support and open area.

11. A stock solution of 4% OsO4 plus 3.2% KFeCN in water can be
kept at 4 �C in a sealed glass vial for longer periods of time.
Discard blackened solutions.

12. Epoxy resins facilitate the sectioning and are more stable under
the electron beam. Spurr resin has been widely used for embed-
ding; however, since one of its components has been retired
from the market, equivalent options are available. Low viscosity
resin kits can be purchased from many suppliers.

13. Drop the solution into the mixture under constant vortexing.

14. 10–14 daps for maize; 8–12 daps for barley.

15. Move to a sterile bench for the following steps.

16. 1 mm in thickness sections are optimal for bombardment.

17. Depending on the species and the developmental stage of the
tissue, different rupture disks will be needed. Usual ranges are
600–1100 psi. An optimization of the protocol for specific
needs is recommended.

18. Bombard each plate twice.
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19. The optimal developmental stage depends on the experimental
purposes. Seeds close to maturation have a higher content in
starch grains that may difficult handling, labeling and imaging.
For consistency between experiments, use seeds of the same
age and cut tissue sections on the same area, we prefer cross
sections on the medial axis of the seed.

20. Transfer the sections to a new specimen holder before washing
them.

21. Sections can be also mounted on fresh fluorescent dye.

22. Use some petroleum jelly along the borders to avoid floating
and to stabilize the cover glasses.

23. Neutral red and ER Tracker need short incubation times on
cereal endosperm (10–15 min).

24. As the section is mounted in tap water for live cell imaging, the
appropriate objective is a water objective.

25. It is important to use the laser settings as low as possible to
avoid any damage to the sample and causing bleed-through if
more fluorescent dyes will be used in parallel. High sensitivity
detectors are recommended.

26. Use a piece of dental wax, put a drop of fixative on the wax
sheet, and place the seed in it prior to cutting. The wax will
prevent squeezing and the cut surface will be immediately in
contact with the fixative improving its preservation.

27. Cut 2 mm thick slices from the endosperm and then cut them
in pieces so that each piece of tissue includes the aleurone and
pericarp. For consistency between experiments, we cut cross
sections on the medial axis of the seed.

28. Work under a fume hood when using paraformaldehyde.

29. Alternatively overnight at 4 �C.

30. Avoid placing the tissue samples on the center of the plate;
preferably place them close to the border of the plate. More
than one sample can be glued together, with 120� separation in
between.

31. For optimal results, glue the samples so that the pericarp faces
the blade.

32. Optimally 30 μm, can be up to 70 μm for cereals.

33. Endosperm sections are very delicate due to the thin cell walls
of endosperm cells. Using embryo dishes will increase the
volume of reagents consumed but facilitates the handling of
the sections.

34. The digestion of the cell walls and the disorganization of the
plasma membrane induced by Triton-100X improve the pene-
tration of the antibodies used for localization. However, these
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treatments can induce many artifacts and destroy the tissue.
Depending on the experimental purposes, these both steps can
be shortened or even skipped.

35. At this point, sections can be difficult to see. Laying a black
cardboard under the embryo dish and working with a binocu-
lar can ease the process of changing reagents.

36. Alternatively overnight at 4 �C.

37. The optimal dilution depends on the antibody used. Com-
monly, dilutions range between 1:100 and 1:500.

38. Cover the embryo dish with aluminium foil.

39. While any fluorophore labeled antibody is suitable for confocal
microscopy, we prefer Alexa Fluor®-labeled antibodies because
they are very bright and do not fade easily.

40. Mount in phosphate buffer or in phosphate buffer: glycerol 1:1
(v/v). Using a bit of petroleum jelly in each corner of the
coverslip will help to fix the preparation and prevents the
sample from squeezing.

41. The laser as well as the detector settings depends on the con-
centration of the epitope to detect and the fluorophore used.

42. The cereal endosperm matures centripetally, which means that
the cells under the aleurone are much younger than the ones in
the deeper layers of the starchy endosperm. For consistency
between experiments, we like to work always with the same cell
layers.

43. Alternatively, overnight at 4 �C.

44. A thin paper strip label can be embedded together with the
sample for easy identification of the resulting blocks.

45. Put one drop of resin in the capsules before adding the tissue
piece to avoid the formation of air bubbles at the block tip. It is
not necessary to embed more than one piece of sample per
capsule.

46. See Note 42.
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